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Chapter 1: Topology Query Language

This chapter includes:

* Topology Query Language (TQL) OVErVIEW ... ... ... 13
® Creating TQL Queries inthe RTSM Managers ... ... 14
* Viewing TQL Query ResUS .. 14
® Compound Relationship . . ... L 16
® Join Relationship ... 16
® Query Node ConditioNs . ... . 16
® Complex Type Condition . il 18
& Subgraph DefinitioN L 19
* The Use Update Value Policy Qualifier ......... ... e 19
® How toDefine a TQL QUEY ... 20
* How to Add Query Nodes and Relationships toa TQL Query ... .. ... 21
* How to Define a Compound Relationship—Scenario ... ... 22
* How to Define a Join Relationship —Scenario . ... ... . .. 25
* How to Define an Attribute Condition —Scenario ... ... ... .. .. 26
* How to Define a Complex Type Condition-Scenario ... .. . .. 26
* How to Create a Subgraph Definition —Scenario .. ... ... . . L 26
® Shortcut Menu OptioNS ... 28
® Attribute Operator Definitions ... 33
O TQL LOGS - e L 35
® Topology Query Language User Interface . ... . 37
® Troubleshooting and Limitations — Topology Query Language ...............oooommmiiiii i 77

Topology Query Language (TQL) Overview

Topology Query Language (TQL) is a language and tool for discovering, organizing, and managing IT
infrastructure data. It enables you to create TQL queries that retrieve business service data from the RTSM.
TQL queries also help you display the data in a visual representation that facilitates data monitoring and
managing.

This section includes the following topics:

« "Topology Query Language" below
« "The Roles of TQL" on the next page

Topology Query Language
TQL extends the standard SQL language by adding two important capabilities:
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TQL enables you to draw conceptual relationships between configuration items (Cls), which represent
their actual interdependencies. Using predefined operators, the different types of interconnections
(relationships) that exist between Cls can be established, and consequently the infrastructure design and
performance are more accurately represented. This representation serves as a basis and a model for the
discovery, arrangement, query, and management of complex infrastructures.

TQL includes a graphical aspect, consisting of visual symbols and syntax, that represents the resources
and their interconnections. This visualization of an IT infrastructure simplifies the understanding,
monitoring, and managing of the IT business operations.

The Roles of TQL

TQL plays several roles:

Builds a business service model that defines and delineates the interconnection between IT assets that
function together as business services. The business service model guides the discovery and
identification of these business services, from the ever-increasing number and complexity of infrastructure
resources. After the resources that comprise the business services are discovered, the business service
model structures the way they are organized and managed in the RTSM.

Constantly searches the RTSM for changes that occur in the state of managed resources. When such
changes are detected, the relevant subsystems are informed and updated.

Creates queries that retrieve business service data from the RTSM, and displays the data in a visual
representation that facilitates data monitoring and managing.

Creating TQL Queries in the RTSM Managers

The following managers enable you to create TQL queries that retrieve specific data from the RTSM and to
display that data:

Impact Analysis Manager. An Impact rule simulates how infrastructure changes can impact your system
and enables you to determine the true origin of a problem and its business impact. During rule creation, you
define the base TQL query type, which can be a new query or an existing query. For details, see "Impact
Analysis Manager" on page 304.

Enrichment Manager. An Enrichment rule enables enlarging the RTSM, deleting Cl instances from the
RTSM, or updating the attributes of a Cl that already exists in the RTSM. During rule creation, you define
the base TQL query type, which can be a new query or an existing query. For details, see "Enrichment
Manager" on page 355.

Modeling Studio. You can build a new TQL query using the TQL Query Editor or you can build a new
query while defining a new view, template, or perspective using the Pattern View Editor. You can also
define the topology report settings for any view in the Pattern View Editor. For details, see "Modeling
Studio" on page 217.

Viewing TQL Query Results

You view the resulting data in a visual representation in IT Universe Manager. The queries define the structure
of the resulting topology map. The view displays only those Cls and relationships that meet the query

definition. You can also view the results of a query by clicking the Preview button on the toolbar to open a

HPE Application Performance Management (9.40) Page 14 of 393



Modeling Guide
Chapter 1: Topology Query Language

preview display identical to IT Universe Manager. For more details about IT Universe Manager, see "IT
Universe Manager" on page 158.

TQL Query Types and Priorities

When you define a TQL query, you define the type of the TQL query in the Type field of the Query Definition
Properties dialog box. The following query types are available:

« View. TQL queries used as the basis for pattern views.

« Integration. TQL queries used for integrations.

« Discovery. TQL queries used as the basis for DFM pattemns.
« Template. TQL queries used as the basis for templates.

« Perspective. TQL queries used as the basis for perspectives.

« Impact Analysis. TQL queries used as the basis for Impact rules. This is the default type for queries
created in Impact Analysis Manager.

« Enrichment. TQL queries used as the basis for Enrichment rules. This is the default type for queries
created in Enrichment Manager.

You cannot change the type of an existing TQL query if it has dependencies (such as views, templates, and
soon).

If a query imported though an integration is not assigned a type, it is considered a hidden query and does not
appear in the query list in the Modeling Studio. To display hidden queries in the query list, change the setting
for hidden queries under General in the User Preferences dialog box. For details, see "User Preferences
Dialog Box" on page 77.

You can also set the priority level of a TQL query, which determines how often the query is rerun automatically
to include updated information. The following priorities are available:

« Low. The TQL query is refreshed every 2 minutes.

« Medium. The TQL query is refreshed every 30 seconds.
« High. The TQL query is refreshed every 10 seconds.

« Express. The TQL query is refreshed continuously.

« Not Active. The TQL query is inactive.

Note: The above refresh times are average values.

If you set the priority of a TQL query to Not Active, the query becomes inactive and is not run automatically;
however, it can be used for manually building a view.

Base Queries

You can select a base query for a TQL query in the Query Definition Properties dialog box. In this case, the
base query is first applied to the entire IT Universe, generating results. The new query is then applied to that
subset of the universe, further refining the results. Selecting a base query enables you to filter the query
results more finely and generate results more quickly in certain cases.

The base query you select must be both active and persistent for your new query to be active. If the base
query is not active and persistent, the new query is automatically assigned a priority of Not Active.

TQL Query Thread Pool

Each TQL query is calculated in a separate thread, taken from a thread pool. If there are many TQL queries
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being calculated, you can increase the thread pool size to improve performance. Edit the TQL Threads Pool
Size setting in the Infrastructure Settings Manager. The pool size can be any integer value between 1 and 64.
If no value is entered, the pool size is automatically set to be the number of CPU cores divided by the number
of customers (if this number is smaller than 4, it is set to a minimum of 4 threads).

Compound Relationship

A compound relationship represents a path in the topological graph. You use a compound relationship to
define the allowed steps in the path between the source and the target Cls.

Each row represents one of the allowed steps in the path leading from the source ClI to the target Cl in the
topology map.

Source | Relationship | Target
IpSubnet Membership % Maode
% Mode Containment @ IpAddress

For an example of a compound definition, see "How to Define a Compound Relationship — Scenario" on page
22. For details on defining compound relationships, see "Add/Edit Compound Relationship Dialog Box" on
page 39.

Join Relationship

A join relationship is a logical connection that represents the relationship between two Cls (and which appears
only in the topology map containing the TQL query results). It does not exist in the RTSM. A join relationship is
created by defining an attribute for each query node, whose values are used for comparison.

The TQL results retrieve all Cls whose attribute values meet the conditions defined in the join definition.

For example, you can create a join definition that links all node Cls connected to IP Address Cls whose
Created By attribute values are equal (see the example below).

Hode | Operator | IpAddress
Created By Equal Created By

Each join definition represents one condition defined for the join relationship.
Note: You can define multiple conditions.

For an example of ajoin definition, see "How to Define a Join Relationship — Scenario" on page 25. For details
on defining join relationships, see "Add/Edit Join Relationship Dialog Box" on page 42.

Query Node Conditions

You can add conditions to the query nodes and relationships of a TQL query in the Query Node Properties
dialog box. The conditions filter the query results by retrieving only Cls and relationships that match the
conditions defined in the query. There are several types of conditions you can define:
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« Attributes. Conditions based on CI property values.

« Cardinality. Conditions based on the number of related query nodes.

« Qualifiers. Conditions based on Cl type qualifiers.

« Element type. Conditions based on Cl subtypes. See below for details.
« ldentity. Conditions based on Cl element IDs.

Each one has a separate tab in the dialog box. For details, see "Query Node/Relationship Properties Dialog
Box" on page 61.

When you define an attribute condition using the attribute name CI Type, the condition is converted to a
complex type condition when you save the query. The condition disappears from the Attribute tab and appears
in the Element Type tab. For Enrichment and Impact type queries, the condition disappears from the Attribute
tab in Enrichment Manager or Impact Analysis Manager, and you need to open the query in Modeling Studio to
edit it in the Element Type tab.

Note: If you define an attribute condition that is not supported for the selected data, the condition is
ignored during the TQL query calculation.

Element Type Conditions

The Element type conditions enable you to specify the subtypes of a query node that should appear in the
query results. There are two options for defining this condition:

« Simple Type Condition. The simple type condition enables you to either include all subtypes of the
selected query node in the query results, or to exclude all of them.

« Complex Type Condition. The complex type condition enables you to select the specific subtypes of the
query node to be included in the query results. For details, see "Complex Type Condition" on the next

page.

Element Layout

You can specify the attributes to include in the query results for each query node or relationship in a TQL query
in the Element Layout tab of the Query Node Properties dialog box. Select the Select attributes for layout
radio button and then select a CIT or relationship in the CIT pane. If you select Specific Attributes for the
Attributes condition, only the attributes you move to the Specific Attributes pane are included in the query
results for that element. If you select All for the Attributes condition, all of the available attributes are included
in the query results for that element. In this case, you can select Exclude specific attributes and move
selected attributes to the Excluded Attributes pane.

There is also an option to select attributes by qualifiers. If you select qualifiers in the Attributes with the
following qualifiers field, all attributes that have the selected qualifiers are included in the query results for
that element, in addition to the attributes selected in the Specific Attributes pane. In this case too, you can
exclude selected attributes by moving them to the Excluded Attributes pane.

By default, the attribute settings you select for a CIT are automatically applied to its descendant CITs in the
query results; however, the settings are not visible in the Element Layout tab of the dialog box. For example, if
you select specific attributes to be included for the Database CIT, the same attributes are included for the
Oracle CIT (a child CIT of Database), but if you select Oracle in the CIT pane, the Attributes condition
displayed is None (the default condition).

You can then make an attributes condition selection for the child CITs themselves. If the parent CIT has All
selected as the attributes condition, then the Specific Attributes option is disabled for the child CITs. If the
parent CIT has Specific Attributes selected as the attributes condition, you can select All or Specific
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Attributes for the child CIT. If you select Specific Attributes, you can add more attributes by moving them to
the Specific Attributes pane. These are included in the query results along with the attributes inherited from
the parent CIT's setting. Similarly, you can select attributes from the parent CIT's setting to exclude for the
child CIT, by moving them to the Excluded Attributes pane. If the parent CIT has qualifiers selected to
determine the attribute selection, these are also inherited by the child CIT. If you select additional qualifiers to
filter the child CIT's attribute selection, the combined set of selected qualifiers is used to filter the attribute
selection for the child CIT.

When you change the type of a query node or relationship using the Change Query Node/Relationship Type
dialog box, the attributes selection for that element is lost.

If you import a package with a query that includes an attributes selection that is invalid for the selected query
node, or if you make an invalid attributes selection using the JMX console, the query can be saved
successfully and a warning appears in the log.

Note: The layout selection is not visible in the query results in the user interface. To view the query
results with the selected attributes, access the JMX console, select TQL services, and invoke the
calculateTqlAdHoc method.

For details on the Element Layout tab, see "Element Layout Tab" on page 69.

Complex Type Condition

The complex type condition enables you to select the specific subtypes of the query node to be included in the
query results. A Cl type tree appears with all the subtypes of the selected query node. By default, instances of
all the displayed subtypes are included in the query results. For each subtype, you can select Exclude
<subtype> from the query which excludes instances of that subtype from the query results. If you select the
Apply this condition recursively on all subtypes check box, instances of the subtype and all of its
descendants are excluded from the results.

If you select a subtype from the tree and you select Include <subtype> in the query without selecting the
Apply this condition recursively on all subtypes check box, only instances of the specified subtype are
included, but not instances of its descendants.

For both the Include and Exclude options, there is a further selection in the Conditions pane. If you select By
Cl type, all instances of the specified subtype are then included or excluded from the results. If you select By
qualifiers and then select qualifiers from the pop-up list, only the instances of the selected subtype with the
selected qualifiers are included or excluded from the query results.

For example, suppose CIT_B and CIT_C are subtypes of CIT_A, and CIT_A and CIT_B have qualifier Q1.
The following are some of the possible configurations of options:

« Select Exclude for CIT_A and all of its descendants. No CITs are included.
« Select Exclude for CIT_A without its descendants. Only CIT_B and CIT_C are included.
« Select Exclude for CIT_A and all of its descendants with qualifier Q1. Only CIT_C is included.

Note:

« ltis possible to apply the Exclude option to the root of the tree (that is, the Cl type of the original
query node). If the Apply this condition recursively on all subtypes check box is selected, no
Cls are included in the results. If the check box is not selected, instances of the root Cl type are
excluded, but instances of its descendants are included.
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« The Element Type Conditions feature is only available in the Modeling Studio. If you define a
complex type condition in the Modeling Studio, and then modify the TQL query in Enrichment
Manager or Impact Analysis Manager, the condition may be overwritten and will no longer be in
effect. If the complex condition is equivalent to a simple condition, you can edit the TQL query from
the Qualifier tab of Enrichment Manager or Impact Analysis Manager.

« If you want to define a qualifier condition on a query node as using the functionality of previous
RTSM versions, select Customize subtypes and select the root query node in the Cl types tree.
Then select the Include option, select By qualifiers, and select the required qualifiers. Similarly,
when accessing a TQL query with qualifier conditions defined in a previous RTSM version or in
Enrichment Manager or Impact Analysis Manager, the condition appears in the Customize
subtypes section of the Element Type tab, using the Include and By qualifiers options.

« Itis sometimes possible to define an attribute condition (using the Cl Type attribute) that generates
the same results as a complex type condition. However, the complex type condition ensures better
performance. In such cases, the RTSM automatically optimizes the query calculation by
substituting an equivalent complex type condition for the simple one. If the query is active, you will
see the complex conditions in the TQL definition the next time you open it.

For details on defining a complex type condition, see "How to Define a Complex Type Condition - Scenario”
on page 26.

Subgraph Definition

A subgraph definition enables you to create a graph that represents additional TQL query data related to a
specific Cl. The DFM job searches for the results from both the TQL query and the subgraph definitions. The
query recursively retrieves all related Cls for a defined depth matching the definition of the subgraph. For
details on defining subgraph definitions, see "Subgraph Definition Dialog Box" on page 75.

In the graph, you can define the relationship that is connected to a specific query node. For example, if one of
the query nodes is of type node, you can specify different relationships for Windows, router, and IP Address.
You can also define attribute conditions for query nodes. For details, see "Subgraph Condition Definition
Dialog Box" on page 74.

DFM jobs retrieve data that meets the criteria defined in the subgraph.

For an example of a subgraph definition, see "How to Create a Subgraph Definition — Scenario" on page 26.

The Use Update Value Policy Qualifier

This qualifier is used to mark attributes that enable minor deviations to their value. For example, there is
probably no need to report a small disk size change (from 8.00008 to 8.00009 GB).

When updating an attribute that is marked with this qualifier, HPE Application Performance Management
checks the new value against the old value. This check is performed on the server as part of the record
update. If the difference between the two values is smaller than the allowed deviation, an update is not
performed (the action is considered a false update).

When the qualifier is selected, the Insensitive Value Deviation parameter applies. Enter a value in the box
and select Percent or Absolute Value from the drop-down list.
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When Percent is selected, the Insensitive Value Deviation must be between 0 and 100. Deviations of a
smaller percentage than this value are considered false updates.

When Absolute Value is selected, the following rules apply:

« Fornumeric attributes, the Insensitive Value Deviation must be of the same type as the attribute

« Fordate attributes, the Insensitive Value Deviation must be an integer, and denotes the deviation in
milliseconds

Deviations smaller than this value are considered false updates.

By default, Use Update Value Policy is enabled for the following numeric or date attributes only:
« CIT: Node

o MemorySize
« SwapMemorySize

These attributes also include comparable and static qualifiers.
« CIT:CPU
o CpuClockSpeed

« CIT: Filesystem
« Disk_size
To deactivate the qualifier:

Access the Infrastructure Settings Manager (Admin > Platform > Setup and Maintenance >
Infrastructure Settings). Locate the Allow Volatility option. Change the value to False.

How to Define a TQL Query

This task describes how to create a TQL query in the Modeling Studio.

Note: You can also create a TQL query during the procedure for creating Impact rules, Enrichment rules,
Views, Templates, and Perspectives.
This task includes the following steps:

« "Create a TQL Query" below
« "Add Query Nodes and Relationships to the Query" below
« "Set the Query Properties" on the next page

1. Create a TQL Query
In the Modeling Studio, select New > Query to open the TQL Query Editor. For details, see "TQL Query
Editor" on page 297.

2. Add Query Nodes and Relationships to the Query

Add the TQL query nodes and relationships that define the query. The TQL query nodes represent the
ClITs, as defined in the Cl Type Manager, and the relationships represent the connections between them.
Relationships are defined one at a time for each pair of TQL query nodes in the query. For details, see
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"How to Add Query Nodes and Relationships to a TQL Query" below.

Note: You can also define a self-relationship from a query node to itself.

3. Set the Query Properties

Click the Query Definition Properties |@ button to open the Query Definition Properties dialog box.
Set the query type, scope, priority, and other properties. For details, see "Query/View Definition
Properties Dialog Box" on page 285.

Example of a TQL Query Definition:

The direction of the relationship indicates which query node is dependent on the other. The following
example displays two nodes, an IP Service Endpoint, and a Client Port, which are linked to one
another via a client/server connection. The TQL query results must comply with the direction of the

arrows.
A 574
i L
Windows : Unix ?
| |
| ontainment i ontainment_1
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Endpoint Server

Note: A TQL query is subject to certain validation restrictions. For details, see "Troubleshooting
and Limitations — Topology Query Language" on page 77.

How to Add Query Nodes and Relationshipsto a TQL
Query

This section explains how to add query nodes and relationships to a TQL query. It is relevant for Impact
Analysis Manager, Enrichment Manager, and the Modeling Studio.

Note: For TQL queries to be valid, they must comply with certain restrictions. For details, see
"Troubleshooting and Limitations — Topology Query Language" on page 77.

To add query nodes and relationships to a TQL query:
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1. InImpact Analysis Manager or Enrichment Manager, select the required query from the tree in the left

pane or click the New |_| button to create one.

In the Modeling Studio, select the Resources tab in the left pane, select Queries as the Resource type,
and select the required query from the tree or click New > Query to create a new one.

2. InImpact Analysis Manager or Enrichment Manager, click and drag one or more required TQL query
nodes from the tree displayed in the Cl Type Selector, onto the editing pane. In the Modeling Studio,
select the Cl Types tab in the left pane and drag the required TQL query nodes from the tree onto the
editing pane. These are the TQL query nodes that are included in the query.

If you want the query to run over federated Cls also, right-click a query node and select Set Integration
Points. In the Select Integration Points dialog box, select the integration points for the external data
sources to use. For details, see "Select Integration Points Dialog Box" on page 291.

3. To add a relationship between two query nodes, do one of the following:

« Select the required TQL query nodes by holding the CTRL key and clicking the TQL query nodes,
right-click and select Add Relationship. The Add Relationship dialog box opens. Select the required
relationship. For details, see "Add/Edit Relationship Dialog Box" on page 45.

« Click the Create Relationship [n icon and draw a line between the required query nodes. The
Select Relationship Type dialog box opens. Select the required relationship type. For details, see
"Select Relationship Type Dialog Box" on page 73.

4. Click OK. The selected query nodes are linked by the relationship you have selected.

How to Define a Compound Relationship - Scenario

This section describes how to define the allowed steps that form a compound relationship between an IP
Subnet Cl and an IP Address ClI.

Note: To reach the required result, you must implement each one of the following steps.

To define a compound relationship between an IP Subnet Cl and an IP Address ClI:

1. Create a TQL query of type view and drag the following query nodes onto the editing pane:
o |P Subnet

o |P Address

2. Right-click the IP Subnet and IP Address query nodes and select Add Compound Relationship to
open the Add Compound Relationship dialog box.

3. Click the Add button. In Enrichment Manager and Impact Analysis Manager, the Add Triplet dialog
box opens. In the Modeling Studio, a row is added to the table. Make the following selections:

o From the Source list, select IP Subnet.
« From the Target list, select Node.

« From the Relationship list, select Membership.
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« Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

4. Click the Add button again and make the following selections:
« From the Source list, select Node.

« From the Targetlist, select IP Address.
« From the Relationship list, select Containment.
« Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.

The following shows an example of compound definitions following the changes:

Source | Relationship | Target
pSubnet Membership % Mode
% Mode Containmenit IE |pAddress

5. Click OK to save your changes.

The TQL query in the editing pane now looks like this:

Tra ) Mittual - Compound =
il < =

IpAddress IpsSubnet

6. Create aview based on your TQL query and save it.

7. Gotothe required view in IT Universe Manager to view the results. If you did not select the Show full
path between source and target Cls option, then the results display the names of the relationships that

link the Cls as Virtual-Compound rather than the actual names of the relationships. See the illustration
below:

192.168.168.0

Yirtual - Compo

@
Lnd

Yirtuals Compo

Fj]
Yirtual - Compo

W W

1892168.01 1659658183 1921631681

You can double-click the Virtual - Compound relationship in IT Universe Manager to open the Link Map,

which displays the Cls and relationships that comprise the allowed steps used to link the IP Subnet and
IP Address Cls.
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192.165.163.0

Membership

b
%

labmlcoml S

Containmernt

¥

In the example above, the 192.168.168.0 (IP Subnet) Cl is linked to the 192.168.0.1 (IP Address) CI
through the labm1cecm15 (Node) ClI.

If you selected the Show full path between source and target Cls option, then the results in IT
Universe Manager display the actual names of the relationships that link the Cls and the full path between

the source and target Cls. See the illustration below:

=

192168.168.0

mMembership

¥

%

[abhmiccmta

Containment
Contaikment

Containment

|

d
16831681 16.59.68183 19216801

192,
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How to Define a Join Relationship - Scenario

This section explains how to define a join relationship that links Node Cls to IP Address Cls whose Created
by attribute values are equal.

Note: To reach the required result, you must implement each one of the following steps.

To define a join relationship that links all IP Address and Node Cls whose Created by attribute
values are equal:

1. Create a TQL query and drag the following query nodes from the Cl Type Selector onto the editing pane:
« Node

o |P Address

2. Select the Node and IP Address query nodes and right-click to open the Add Join Relationship dialog
box.

3. Click the Add button to add a row to the table and do the following:
« Inthe Node Attribute box, select Created by.

« Inthe Operator box, select Equal.
« IntheIP Address Attribute box, select Created by.

In Enrichment Manager and Impact Analysis Manager, you make these selections in the Join
Relationship Condition dialog box.

The Join Definition area now looks like this:

Node | Operator IpAddress
Created By Equal Created By

4. Click OK to save your changes.
The TQL query in the editing pane now looks like this:

(I

Maode

Yirtual - Join

E

IpAddress
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How to Define an Attribute Condition - Scenario

This task describes how to define an attribute condition to select the Node Cls that were created or updated
over the past week.

1.

N o o b~ DN

In the Modeling Studio, Enrichment Manager, or Impact Analysis Manager, open a TQL query, view,
Enrichment rule, or Impact Analysis rule containing a Node CI.

Right-click the Node Cl and select Query Node Properties.

In the Query Node Properties dialog box in the Attributes tab, click the Add | button to add a condition.
For the Attribute name, select Create Time from the drop-down list.

For the Operator, select Changed During [Hour(s)] from the drop-down list.

For the Value, enter 7.

Click OK to save the attribute condition.

How to Define a Complex Type Condition - Scenario

This section describes how to define a complex type condition in the Query Node Properties dialog box. In this
example, you add subtype conditions to a Node query node in a TQL query.

To define a complex type condition:

1. Create a TQL query and drag a query node of type Node onto the editing pane.

Right-click the query node and select Query Node Properties. The Query Node Properties dialog box
opens.

Select the Element Type tab and select Customize subtypes.

In the CI Types pane, select Computer, and in the Conditions pane, select Exclude <Computer> from
the query. Select the Apply this condition recursively on all subtypes of <Computer> check box.
This excludes all Cls of type Computer and its descendants in the query results.

In the CI Types pane, select Unix, and in the Conditions pane, select Include <Unix> in the query.
This includes all Unix Cls in the query results.

In the CI Types pane, select IBM Frame, and in the Conditions pane, select Include <IBM Frame> in
the query. Then select By qualifiers and select the CONTAINER qualifier. This includes all IBM Frame
Cls with the CONTAINER qualifier in the query results.

In the CI Types pane, select Firewall, and in the Conditions pane, select Exclude <Firewall> from the
query. Select By qualifiers and select the HIDDEN_CLASS and MAJOR_APP qualifiers. This
excludes all Firewall Cls with the HIDDEN_CLASS and MAJOR_APP qualifiers from the query results.

Click OK to save your conditions and exit the dialog box.

How to Create a Subgraph Definition - Scenario

This section describes how to create a subgraph definition. In this example, the TQL query results retrieve all
Cls that are connected to a Business Service Cl by a Containment relationship up to a depth of 3.
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Note: To reach the required result, you must implement each one of the following steps.

To create this sample subgraph definition:

Create a TQL query and drag a query node of type Business Service onto the editing pane.

2. Right-click the Business Service query node and select Subgraph Definition to open the Subgraph
Definition dialog box.

3. Click the Add button. In Enrichment Manager and Impact Analysis Manager, the Add Triplet dialog
box opens. In the Modeling Studio, a row is added to the table. Make the following selections:

« From the Source drop-down list, select Managed Object.
« From the Target drop-down list, select Managed Object.

« From the Relationship drop-down list, select Containment.

Set the direction of the relationship as left to right.

In Enrichment Manager and Impact Analysis Manager, click OK to save your changes.
The Subgraph Definition dialog box now looks like this:

Source | Relaticnship | Target | Relationship Direction
Managed Ohject Containment Managed Object =k

4. Set the Depth setting to 3.
5. Click OK in the Subgraph Definition dialog box.
Go to the required view in IT Universe Manager to view the results.
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222
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The results show the Business Service Cl aaa and all of the Cls linked to it in succession by Containment
relationships down to three levels.

Shortcut Menu Options

This section includes a list of TQL query shortcut menu options:

Ul Element (A-Z) Description

Add Calculated Enables you to create a calculated relationship.
Relationship « For details on how to create a calculated relationship, see "Triplets Page" on
page 342.
« Fordetails about Impact Modeling, see "Impact Modeling" on page 82.
Add Compound Enables you to define the connection between two query nodes using a compound
Relationship relationship.

For details, see "Add/Edit Compound Relationship Dialog Box" on page 39.
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Ul Element (A-Z)

Add Join
Relationship

Add Related Query
Node Wizard

Add Relationship

Add to Hierarchy

Add to Model
Output

Change Query
Node/Relationship

Type

Clear

Description

Enables you to define join relationships. You create them by defining an attribute for
each query node. These query node values are used for comparison during
federation.

For details, see "Add/Edit Join Relationship Dialog Box" on page 42.

Displays the Add Related Query Node Wizard which enables you to build a TQL
query. For details, see "Add Related Query Node Wizard" on page 47.

Enables you to create a relationship for your query nodes by selecting it from a
predefined list. Displays the Add Relationship dialog box.

For details, see "Add/Edit Relationship Dialog Box" on page 45.
Note: In Enrichment Manager, this option adds an Enrichment relationship to

the rule when working in Enrichment mode. Applicable for regular and
Enrichment query nodes. For details, see "Enrichment Manager" on page 355.

Added relationships are denoted by an added EI indicator.

Adds the selected query node to the hierarchy as a separate query node.

Note: Only relevant for the Modeling Studio.

Designates the selected query node as output for the pattern-based model.

Note: Only relevant for pattern-based models in the Modeling Studio.

Displays the Change Query Node Type dialog box. Enables you to change the Cl
type of the query node after you have created it. For details, see "Change Query
Node/Relationship Type Dialog Box" on page 246.

Note: Only relevant for the Modeling Studio.

Available by right-clicking a query node or relationship when working in Enrichment
mode in the Enrichment Manager. Clears the query node/relationship's Enrichment
rule definition. For details, see "Enrichment Manager" on page 355.

Appears only if you have updated or deleted a query node/relationship using an
Enrichment rule.

Note: Only relevant for Enrichment Manager.
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Ul Element (A-Z) Description

Copy/Paste Copy/paste an existing TQL query node/relationship in the same query orinto
another TQL query.

The copied TQL query node/relationship includes all TQL definitions.

You can copy and paste relationships provided that the TQL query nodes to which
the relationships are connected are also selected. A relationship on its own cannot
be copied without its connecting TQL query nodes.

You can select multiple TQL query nodes/relationships as well.
Note: The Copy and Paste options are only available in the Modeling Studio.

The Paste option is available only after using the Copy option to copy an
existing TQL query node/relationship.

Define Impacted Defines which query node in the TQL query is the trigger Impact Analysis query
node and which query nodes are impacted by the changes that occur in the system.
For details, see "Impacted Query Nodes Dialog Box" on page 313.

Note: Only relevant for Impact Analysis Manager.

Delete Deletes the selected query node/relationship/ClI.

Note: This option is not available for calculated relationships.

Delete Available by right-clicking a query node or relationship when working in Enrichment
Relationship/Query mode.
Node

Creates a specific Enrichment rule that is designed to delete Cls/relationships from
the RTSM. Applicable to regular query nodes and relationships only. You can use
this option, for example, for removing unnecessary data from the RTSM. For
details, see "Enrichment Manager" on page 355.

Deleted query nodes and relationships are denoted by a removed E| indicator.

Note: Only relevant for Enrichment Manager.

Edit Relationship Displays the Refine Relationship Type dialog box. For details, see "Refine Query
Node Type Dialog Box" on page 72.

Note:

« Not relevant in the Modeling Studio.

« This option appears only when the selected relationship has descendants.
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Ul Element (A-Z)

Hide Element in
Query Results

Hide Element in
View Results

Query
Node/Relationship
Properties

Refine Query Node
Type

Remove Subgraph

Reset Impacted

Description

When this option is selected, a Hidden in Query Results indicator & appears to
the right of the selected TQL query node in the editing pane.

Any query results pertaining to that TQL query node are not displayed in the
topology map. This can be useful when certain relationships or TQL query nodes are
required to build the query but are not needed in the results. At least one query node
must be visible for the view to be valid.

Note: Only relevant for the Modeling Studio.

Hides the selected virtual-compound relationship when viewing the results of an
Automated Service Map in the UCMDB Browser (based on the Service_template
perspective being applied on top of the service's Business Element Cl), as long as
the Cls linked by the virtual-compound relationship are not linked by any other
relationship.

Note:

« This option appears only when you are creating or editing the perspective on
which a service model is based. Only relevant for the Modeling Studio.

« Ifthe Hide Element in Query Results option is selected for a node, this
option will not be available, since the node and all of its relationships will not
appear.

Displays the Query Node/Relationship Properties dialog box, enabling you to define
the attribute conditions for the selected TQL query node/relationship. For details,
see "Query Node/Relationship Properties Dialog Box" on page 61.

Note: This option is not available for calculated relationships.

Displays the Refine Query Node Type dialog box. Enables you to change the ClI
type of the query node after you have created it. For details, see "Refine Query
Node Type Dialog Box" on page 72.

Note: This option only appears if a child of the CI type exists. Only relevant for
Impact Analysis Manager and Enrichment Manager.

Only appears if you have defined a subgraph definition. For details, see "Subgraph
Definition Dialog Box" on page 75.

Removes the Define Impacted definition applied to that query node. For details on
the Define Impacted definition, see "Impacted Query Nodes Dialog Box" on page
313.

Note: Only relevant for Impact Analysis Manager.
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Ul Element (A-Z)

Reset Inner
Relationship

Select All

Set As Contact
Query Node

Set Integration
Points

Show Element in
Query Results

Show Element in
View Results

Show Element
instances

Show Node
Parameters

Subgraph
Definition

HPE Application Performance Management (9.40)

Description

Redraws a self-referential relationship in the Topology map as a square for ease of
viewing.

Note: Only relevant for self-referential relationships that are not square.

Selects all query nodes and relationships in the TQL query.

Note: Only relevant for the Modeling Studio.

Designates the selected query node as a contact query node for the perspective.

Note: Only relevant for perspectives in the Modeling Studio.

Opens the Select Integration Points dialog box which enables you to select the
required data sources for a TQL query node.

Note: Only relevant for the Modeling Studio.

When this option is selected, the results pertaining to the TQL query node are
displayed in the topology map.

Note: Only relevant for the Modeling Studio.

Displays the selected virtual-compound relationship when viewing the results of an
Automated Service Map in the UCMDB Browser (based on the Service_template
perspective being applied on top of the service's Business Element Cl).

Note:

« This option appears only when you are creating or editing the perspective on
which a service model is based. Only relevant for the Modeling Studio.

« Ifthe Show Element in Query Results option is selected for a node, this
option will not be available, since the node and all of its relationships are
already displayed.

Displays the Cl Instances dialog box which displays all the instances found for
each query node in a table. For details, see "Cl Instances Dialog Box" on page 55.

Opens the Template Parameter Values dialog box, which enables you to set the
values of the query node's parameters.

Note: Only relevant for template-based views in the Modeling Studio.

Displays the Subgraph Definition dialog box, where you can create a graph that
represents additional TQL query data related to a specific query node. For details,
see "Subgraph Definition Dialog Box" on page 75.
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Ul Element (A-Z) Description

Update Use an Enrichment rule to update the value of Cl attributes in the RTSM, or to add
Relationship/Query data to attributes that currently do not have values. Opens the Query Node
Node Definition - Attributes dialog box. For details, see "Query Node/Relationship

Definition Dialog Box" on page 375. This is applicable for both regular and
Enrichment query nodes.

Updated query nodes are denoted by an updated Ll indicator.

Note: Only relevant for Enrichment Manager.

Attribute Operator Definitions

This section contains a list of operators used to define attribute conditions in various dialog boxes, such as the
Subgraph Condition dialog box, Impact Rules Definition dialog box, or the Query Node/Relationship
Properties dialog box.

Operator Description

Changed during (Displayed only when you select an attribute of type Date.) Displays only the
instances that changed during the period specified in the Value box.

Equal Checks whether the attribute value is equal to the value specified in the Value
box.

Equal ignore case Checks whether the attribute value is equal to the value specified in the Value

box regardless of the case.

Note: When working with Microsoft SQL Server, this option is identical to
Equal.

Greater Checks whether the attribute value is greater than the value specified in the
Value box.

Note: When comparing attributes of type string, the comparison is based
on the ASCII values of the string characters.

Greater than or equal = Checks whether the attribute value is greater than or equal to the value specified
in the Value box.

In Displays only the instances where this attribute value equals one of the selected
values. For example, for Cls that have a Change state that equals P1an and New,
select the operator In from the Operator list and select both Plan and New from
the Value box.

HPE Application Performance Management (9.40) Page 33 of 393



Modeling Guide
Chapter 1: Topology Query Language

Operator

In ignore case

Is null

Less

Less than or equal

Like

Like ignore case

Not equal

Occurs after

Occurs within

Unchanged during

Note:

Description

Displays only the instances where this attribute value equals one of the selected
values, regardless of the case.

Note: When working with Microsoft SQL Server, this option is identical to
In.

Checks whether the attribute value is null.

Checks whether the attribute value is less than the value specified in the Value
box.

Note: When comparing attributes of type string, the comparison is based
on the ASCII values of the string characters.

Checks whether the attribute value is less than or equal to the value specified in
the Value box.

Uses a wildcard (%). Use Like when you are not sure of the complete name for
which you are searching.

Uses awildcard (%). Use Like ignore case when you are not sure of the
complete name for which you are searching. The case of the string is ignored.

Note: When working with Microsoft SQL Server, this option is identical to
Like.

Checks whether the attribute value is not equal to the value specified in the
Value box.

(Displayed when you select a date type attribute.) Displays only the instances
that occurred after the period specified in the Value box.

(Displayed when you select a date type attribute.) Displays only the instances
that occurred within the period specified in the Value box.

(Displayed when you select a date type attribute.) Displays only the instances
that did not change during the period specified in the Value box.

« Forthe Not equal operator, query results do not include data from the Cl instances that are not
assigned a value. For example, a system contains three nodes: Node1 is assigned the value A,
Node2 is assigned the value B, and Node3 is not assigned a value. If you create a query to retrieve all
nodes that are Not equal to A, the results of your query include Node2 only, because Node3 is not

assigned a value.

« HPE Application Performance Management supports both Microsoft SQL Server and Oracle Server
databases. Microsoft SQL Server is not case sensitive by default (unlike Oracle database which is
case sensitive). Consequently, if you are using Microsoft SQL Server, the Equal operator retrieves
the same query results as the Equal ignore case operator. For example, if you select the attribute
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City, the operator Equal, and type NEW YORK in the Value comparison box, case differences are
ignored and query results include NEW YORK, New York and new york.

TQL Logs

This section contains definitions for TQL parameter log files.
This section includes the following topics:

« "Pattern Statistics Log" below

« "Audit Short/Detailed Log (TQL Perspective)" below
« "Incremental Statistics Log" on the next page

« "Incremental Splitter Log" on the next page

« "Incremental Detailed Log" on page 37

Pattern Statistics Log

The log name is cmdb.pattern.statistics.log.

Log File Description
Purpose General calculation data for each TQL query, updated at predefined
intervals.
Information Level The following information is given for each TQL query:
e hame

« average, minimum, and maximum calculation times
« number of calculations

« last calculation time

« result size
Error Level Not available.
Debug Level Not available.
Basic Troubleshooting « Verify that a specific TQL query was updated.

« Evaluate a TQL query's calculation time.
« Evaluate a TQL query's result size.

Audit Short/Detailed Log (TQL Perspective)
The log name is cmdb.audit.short.log.

Log File Description

Purpose RTSM state changes, Cl Type changes, and TQL query results.

You can use this log to follow the results of TQL queries.
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Log File Description

Information Level Not available.

Error Level Not available.

Debug Level « Final calculation for TQL queries is logged.

« Ifthe final TQL query calculation is unchanged from the previous calculation,
this is noted.

« If the final TQL query calculation is changed from the previous calculation,
results of the Cls and relationships are recorded in the detailed log. The
number of Cls and relationships are recorded in the short log.

Basic Troubleshooting « Use this log to verify which notifications are published by the TQL query
subsystem.

« Check the section at the end of each result. This section includes added,
removed, and updated Cls and relationships.

« Track the CIT changes and see if the query results also change. You can
thus correlate the CIT changes to the results of the query calculations.

Incremental Statistics Log

The log name is cmdb.incremental.statistics.log.

Log File Description

Purpose Traces the calculation procedure, full orincremental, of every query.

Information Not available.

Level

Error Level Not available.

Debug Level « Gives the date, time, query name, and whether an incremental statistic calculation

was performed (yes/no).

« If anincremental statistic calculation was not performed, states the reason, the
number of subcalculations (relevant for incremental calculations only), and the
complete calculation time.

Basic Monitors the calculation process.

Troubleshooting If a specific query calculation takes a long time, check if it is a full or incremental
calculation:

« If full, check whether a full calculation is necessary.
« Ifincremental, check how many subcalculations have been performed.

Incremental Splitter Log

The log name is cmdb.incremental.splitter.log.
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Log File Description
Purpose Monitors the incremental splitter result made during an incremental calculation.

Information Level = Not available.

Error Level Not available.

Debug Level Gives the set of query node numbers of each query graph created by the incremental
splitter.

Basic If the TQL result calculated by the incremental calculator is wrong, verify that the

Troubleshooting splitter result is correct.

Incremental Detailed Log

The log name is cmdb.incremental.detailed.log.

Log File Description

Purpose Monitors the incremental calculation process.
Information Level = Not available.

Error Level Not available.

Debug Level Each incremental subcalculation entry includes the following:

« the trigger query node
« the number of elements classified to the trigger query node

« whether the subcalculation step is driven by new elements added to the model or
by existing elements

« the calculated query graph

Basic Follows the basic steps of an incremental calculation.
Troubleshooting

Topology Query Language User Interface

This section includes (in alphabetical order):

* Add/Edit Calculated Relationship Dialog Box
* Add/Edit Compound Relationship Dialog BOX . . .. ... 39

® Add/Edit Join Relationship Dialog BOX . . . .. L 42
* Add/Edit Relationship Dialog BoX ... ... . 45
* AddRelated Query Node Wizard .. il 47
® Add Triplet Dialog BOX . .. ... 53
® CliInstances DIialog BOX ... ... ... 55
® Conditions Preview Dialog BoX ... ... L 57
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® Element Layout Preview Dialog BoX ... il 58
® Filter Cl Instances Dialog BoX . ... o 58
® Join Relationship Condition Dialog BOX . . . . ... L 59
® Layout Settings Dialog BoX ... 60
* Query Node/Relationship Properties Dialog BOX . ... ... . . 61
* Refine Query Node Type Dialog BOX . ... ... L 72
® Select Relationship Type Dialog BoX ... ... 73
¢ Subgraph Condition Definition Dialog BoX .. ... .. 74
¢ Subgraph Definition Dialog BOX . ... ... L 75
® User Preferences Dialog BoX ... o 77

Add/Edit Calculated Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes using a calculated relationship
from the CI Type model.

To To access in Enrichment Manager, Impact Analysis Manager, and the Modeling Studio:

access Right-click the required query node in the editing pane in Enrichment Manager, Impact Analysis

Manager, or the Modeling Studio and select Add Calculated Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the editing
pane to display the Add Calculated Relationship option.

To access in Adapter Management in Data Flow Management (DFM):
1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query |@ button to the right of the
Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Calculated Relationship.

Relevant | « "How to Define an Impact Rule — Workflow" on page 304

tasks « "How to Define an Enrichment Rule — Scenario" on page 356
» "How to Define a TQL Query" on page 20
« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233
» "How to Create a Perspective" on page 234
See also | « "Impact Modeling" on page 82

o "CI Type Relationships" on page 321

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
Fot
B

Tree View
|é|

<Calculated
relationship
tree>

Relationship
Direction

Relationship
Name

Relationship
Restrictions

Description

Expand All. Expands all the folders in the tree.
Collapse All. Collapses all the folders in the tree.

Tree View. Enables you to select the display format of the calculated relationship tree.
The following options are available:

« by Display label
« by Class name

« by Legacy class name

Select the calculated relationship that defines the connection between two query nodes.

The direction of the relationship that indicates which query node is dependent on the other.

The name of the calculated relationship.

Select an option to define how to handle relationships between identical query nodes or self
relationships in the query results. A self relationship is a relationship that leads from a
query node to itself.

Note: This list appears only when you select one query node or two identical query
nodes.

« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships Only. Only self-relationships (a relationship that leads to
itself) appear in the query results.

« Allow Non Self Relationships Only. Self-relationships do not appear in the query
results.

Add/Edit Compound Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes using a compound

relationship.
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To access To access in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio:

Right-click the required query nodes in the editing pane in Enrichment Manager,
Impact Analysis Manager, or the Modeling Studio and select Add Compound
Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top
of the editing pane to display the Add Compound Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query <! button to
the right of the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Compound
Relationship.

Important information | You can create as many compound definitions as necessary.

Relevant tasks o "How to Define an Impact Rule — Workflow" on page 304
o "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« "Implement a Discovery Adapter” in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

See also « "Compound Relationship" on page 16

« "How to Define a Compound Relationship — Scenario" on page 22

User interface elements are described below:

Ul Element (A-

Z) Description

= Add. Adds a compound definition.
In Impact Analysis Manager, Enrichment Manager, and the Input Query Editor in DFM, it
opens the Add Triplet dialog box. In the Modeling Studio, it enters a default compound
definition in the table. Click the Edit buttons to edit the definition components.

s Delete. Deletes the selected compound definition.
|§| Condition. Enables you to edit the selected compound definition.

In Impact Analysis Manager, Enrichment Manager, and the Input Query Editor in DFM, it
opens the Edit Triplet dialog box. In the Modeling Studio, it opens the Compound
Relationship Condition Definition dialog box.
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Ul Element (A-

Z) Description

Max steps The longest path allowed between the two Cls in the RTSM to be included in the
discovery process.
Default: 5

Min steps The shortest path allowed between the two Cls in the RTSM to be included in the
discovery process.
Default: 1

Relationship The relationship connecting the two query nodes.

Relationship The direction of the relationship that indicates which query node is dependent on the
Direction other.

Relationship The name of the compound relationship.
Name

Relationship Select an option to define how to handle relationships between identical query nodes or
Restrictions self relationships in the query results. A self relationship is a relationship that leads from
a query node to itself.

Note: This list appears only when you select one query node or two identical query
nodes.

« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships only. Only self-relationships (a relationship that leads to
itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appear in the query
results.

Show element Select Show element in query results to include query results relating to a join or

in query compound relationship. By default, this option is selected. When the check box is

results cleared, a Hidden in Query Results indicator E appears to the left of the relationship's
name in the editing pane, denoting that any query results pertaining to the relationship are
not displayed in the topology map.

(@

MHode

Wirtual - Join

=

IpAddress
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Ul Element (A-

Z) Description

Show full path If you select this option, then the query results display the actual names of the
between relationships that link the Cls and the full path between the source and target Cls.
source and

target Cls

Source The required source query node.

Stop at first Select this option if you want the system to stop looking for TQL query results once it
compound reaches the first target in the path.

level

In the following sample compound link definition, Depth is defined as 10 and Stop at
first compound level is selected.

The TQL query results include the Target 1, Target 3, and Target 4 because they are all
at level 1 (the first Cl found in the path). Target 2 is not included in the TQL results
because it is at level 2 (the second Cl found in the path).

Target The required target query node.

Add/Edit Join Relationship Dialog Box

This dialog box enables you to define join relationships.
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To access | Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling Studio:

Right-click the required query nodes in the editing pane in Enrichment Manager, Impact
Analysis Manager, or the Modeling Studio and select Add Join Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the editing
pane to display the Add Join Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query |ﬁ| button to the right of the
Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Join Relationship.

Important When you access the dialog box from the Modeling Studio, you select the attributes and

information = operator within the dialog box itself. When you access the dialog box from Impact Analysis
Manager or Enrichment Manager, you select the attributes and operator from the Join
Relationship Condition dialog box.

Note: You cannot select attributes of type list for a join relationship condition.

Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356

« "How to Define a TQL Query" on page 20

« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232

« "How to Create a Template" on page 233

» "How to Create a Perspective" on page 234

See also « "Join Relationship" on page 16

« "How to Define a Join Relationship — Scenario" on page 25

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description
G Add. Enables you to define a join definition. In Impact Analysis Manager, Enrichment
Manager and the Input Query Editor in DFM, it opens the Join Relationship Condition dialog
box. In the Modeling Studio, it adds the selected attributes and operator to the list.
! Delete. Deletes the selected join definition.
|§| Edit. Enables you to edit the join definition. Opens the Join Relationship Condition dialog

box.

Note: This option is not relevant in the Modeling Studio.
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Ul Element
(A-Z)

<Query
node1
Attribute>
box

<Query
node2
Attribute>
box

<Selected
query
node1>
column

<Selected

query
node2>
column

And

Operator
box

Operator
column

Relationship
Direction

Relationship
Name

Description

Select an attribute for the <end_1> query node.

Note: This option is only available in the Modeling Studio.

Select an attribute for the <end_2> query node.

Note: This option is only available in the Modeling Studio.

A selected query node. The first attribute applies to <end_1>.

A selected query node. The second attribute applies to <end_2>.

All join definitions are linked by the And operator.

Note: This is not relevant in the Modeling Studio.

Select an operator. For details on the available operators, see "Join Relationship Condition
Dialog Box" on page 59.

Note: This option is only available in the Modeling Studio.

The operator selected in the Join Relationship Condition dialog box. For details about
operator definitions, see "Attribute Operator Definitions" on page 33.

The direction of the relationship that indicates which query node is dependent on the other.

The name of the join relationship.
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Ul Element
(A-2) Description

Relationship Select an option to define how to handle relationships between identical query nodes or self
Restrictions  relationships in the query results. A self relationship is a relationship that leads from a query
node to itself.

Note: This list appears only when you select one query node or two identical query
nodes.

« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships only. Only self-relationships (a relationship that leads to
itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appear in the query

results.
Show Select Show relationship in query results to include query results relating to a join or
relationship = compound relationship. By default, this option is selected. When the check box is cleared,
in query a Hidden in Query Results indicator & appears to the left of the relationship's name in the
results editing pane. Any query results pertaining to the relationship are not displayed in the
topology map.

(

Mode

Yirtual - Jdain

-Q—E—I

=

IpAddress

Add/Edit Relationship Dialog Box

This dialog box enables you to define the connection between two query nodes in a TQL query.
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To access | Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling Studio, do
one of the following:

« Right-click the required query node in the editing pane in Enrichment Manager, Impact
Analysis Manager, or the Modeling Studio and select Add Relationship.

« Click the Create Relationship x button and draw a line between the required query
nodes. The Select Relationship Type dialog box opens. Select Regular Relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the editing
pane to display the Add Relationship option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query |ﬁ| button to the right of
the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Relationship.
Important  This option does not appear when two selected query nodes (or a single selected query
information node) do not have a valid relationship between them.
Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

See also « "How to Add Query Nodes and Relationships to a TQL Query" on page 21
o "Cl Type Relationships" on page 321

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
- escription
A-Z D ipti
|§| Expand All. Expands all the folders in the relationship tree.
|§| Collapse All. Collapses all the folders in the relationship tree.
Tree View |Z|  Tree View. Enables you to select the display format of the relationship tree. The following

options are available:
« by Display label
« by Class name
« by Legacy class hame
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Ul Element
(A-2) Description

<Relationship Select the relationship that defines the connection between two query nodes.
tree>

Relationship = The direction of the relationship that indicates which query node is dependent on the
Direction other.

Relationship = The name of the relationship.
Name

Relationship = Select an option to define how to handle relationships between identical query nodes or
Restrictions self relationships in the query results. A self relationship is a relationship that leads from a
query node to itself.

Note: This list appears only when you select one query node or two identical query
nodes.

« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships only. Only self-relationships (a relationship that leads to
itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appear in the query
results.

Add Related Query Node Wizard

This wizard enables you to build a TQL query.

To access | Toaccess in Enrichment Manager, Impact Analysis Manager, and the Modeling Studio:
In the editing pane, right-click the required query node and select Add Related Query
Node.

Note: If you are using Enrichment Manager, select Query mode at the top of the editing
pane to display the Add Related Query Node option.
To access in Universal Discovery in DFM:

1. Select ajob in the Discovery Modules pane.

2. Select a Trigger Query in the Properties tab. Click the Open the Query Editor &
button to open the Trigger Query Editor.

3. Right-click the required query node and select Add Related Query Node Wizard.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query 74 button to the right of the
Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Add Related Query Node Wizard.
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Important If the TQL query is empty, drag the required TQL query nodes on to the editing pane from the
information tree displayed in the CI Type Selector or the Cl Types tab of the left pane.

Relevant o "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356

« "How to Define a TQL Query" on page 20

« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232

« "How to Create a Template" on page 233

» "How to Create a Perspective" on page 234

Wizard The Add Related Query Node Wizard contains:

map Related Query Node Type Page > Relationship Type Page > Related Query Node

Properties Page > Related Query Node Instances Page

See also "Topology Query Language (TQL) Overview" on page 13

Related Query Node Type Page
This wizard page enables you to add a query node to the TQL query.

Important If the TQL query is empty, drag the required TQL query node on to the editing pane from the
information  tree displayed in the Configuration Item Types pane.

For general information on the Add Related Query Node Wizard, see "Add Related Query
Node Wizard" on the previous page.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page > Related Query Node
Properties Page > Related Query Node Instances Page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

|§| Expand All. Expands all the folders in the tree.
|E| Collapse All. Collapses all the folders in the tree.

Tree View | Tree View.Enables you to select the display format of the ClI type tree. The following options
& are available:

« by Display label
« by Class name

« by Legacy class name

Note: This feature is only available in the Modeling Studio.
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Ul Element
(A-Z)

<query
node> is
required

<TQL
Query
Node
hierarchy
tree>

Element
name

Show only
CITs with
instances

Description

Define the relationship cardinality. For details, see "Query Node/Relationship Properties
Dialog Box" on page 61.

« Select the <query node> is required check box for each query node to include a
minimum of one instance of the query node at the other end of the relationship in the
query results. Selecting the check box gives the relationship a cardinality value of 1..*.

« Clearthe <query node> is required check box to give the relationship a cardinality
value of 0..%.
Select the required query node. The query node you select appears in the Element name
box.

This list only includes the query nodes of the CI type that have valid relationships to the
selected (source) query node.

To the right of each query node, the number of Cl instances that exist in the RTSM for that ClI
type is displayed. The number of instances is only updated after you close the Add Related
Query Node Wizard and open it again.

Note: The first query node in the hierarchy tree is selected by default.

(Optional) Contains the name of the selected query node. By default, the Cl type is assigned
as the element's name.

You can rename a TQL query node in the Element name box giving it a unique label. This
can be helpful when there is more than one query node of the same CI type in the TQL query.

Select this check box to display only the CITs of which there are instances in the RTSM. If
this box is not selected, the tree includes all CITs with a valid link to the source query node.

Note: The Show only CITs with instances check box is selected by default.

Relationship Type Page

This wizard page enables you to add a relationship to a TQL query.

Wizard The Add Related Query Node Wizard contains:

map

Related Query Node Type Page > Relationship Type Page > Related Query Node Properties

Page > Related Query Node Instances Page

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-Z) Description

a]

Tree View. Enables you to select the display format of the Relationship tree. The

Tree View = . . .
following options are available:

« by Display label

« by Class name

« by Legacy class hame

Note: This feature is only available in the Modeling Studio.

<TQL Query Select the required relationship.
Relationship
hierarchy tree>
Relationship Select the required relationship direction. The direction indicates which query node is
Direction dependent on the other.
Relationship The name of the relationship.
Name

Note: This feature is only available in the Modeling Studio.

Relationship Select an option to define how to handle relationships between identical query nodes
Restrictions or self relationships in the query results. A self relationship is a relationship that leads
from a query node toitself.

Note: This feature is only available in the Modeling Studio.

Relationship A valid relationship that defines the connection between the selected query nodes.
Type The box displays the relationship you selected in the relationship hierarchy tree.

Note: This feature is only available in Enrichment Manager and Impact Analysis

Manager.
Show only Display only the relationships of which there are instances in the RTSM. If this box is
relationships not selected, the tree includes all valid relationships between the selected query
with instances nodes.

Related Query Node Properties Page

This wizard page enables you to create an expression that restricts the number of query nodes that appear in
the query by adding an attribute condition to a query node or relationship.

Important Each row represents an attribute condition that you specify. Use the And/Or column and the
information Brackets columns to link multiple conditions. In this way, you can construct a more precise
logical statement to generate the required results.

When you access the wizard from the Modeling Studio, this wizard page has three tabs:
Attribute, Element Type, and Element Layout. The Attribute tab includes the elements
described below. For details on the Element Type tab, see "Element Type Tab" on page 67.
For details on the Element Layout tab, see "Element Layout Tab" on page 69.
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Wizard The Add Related Query Node Wizard contains:

map Related Query Node Type Page > Relationship Type Page > Related Query Node

Properties Page > Related Query Node Instances Page

User interface elements are described below:

Ul

Element

(A-Z) Description

CH Add. Adds an attribute condition row. Select the attribute name, operator, and value to define

the attribute condition.

E Delete. Deletes the selected attribute condition.
|F| Up. Moves a selected row up.

; Down. Moves a selected row down.

=% Show Criteria. Displays the criteria of the selected condition in a pop-up dialog box.

And/Or  Click inside the And/Or field and select either And or Or to link multiple conditions.

Attribute Choose an attribute from the list.
name

Brackets Click inside the Brackets box to display a list of brackets you can use to build more complex,
[ logical statements.

Criteria  Contains the attribute condition definition as defined in the Cl Instances Dialog Box.

Include  Display both the selected Cl and its children in the topology map.

subtypes
Note: This check box is only available in the Enrichment Manager and Impact Analysis
Manager.

NOT Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the Cl instances that were
not assigned a value. For example, your system contains three nodes: Node1 is assigned
the value A, Node2 is assigned the value B and Node3 is not assigned a value. You create
a query to retrieve all nodes that are equal to A and select NOT; the results of your query
only include Node2 because Node3 is not assigned a value.

Operator = Select the required operator. For details, see "Attribute Operator Definitions" on page 33.
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ul

Element

(A-2) Description

Show Select Show element in query results to display the selected TQL query node in the editing

element pane. When the check box is cleared, a Hidden in Query Results indicator & appears to the
in query  right of the selected TQL query node in the editing pane.

il

ontainment

[pAddres

% Membership @

Windows — m
[atrmet

Any query results pertaining to that TQL query node are not displayed in the topology map. This
can be useful when certain relationships or TQL query nodes are required to build the query but
are not needed in the results. For example, Windows are connected to the network by defining

specific IP Addresses, but in any query results you may want to view the IP Address elements
only and not the Windows elements.

Value Enter or select the value of the attribute. The Value options vary according to the attribute type
you select.

Related Query Node Instances Page
This wizard page displays all the instances found for the selected TQL query node in a table.

Important = The columns displayed in the report vary according to the ClI type selected.

information By default, only columns corresponding to attributes that have been defined with the Asset

Data, Managed, and Comparabile attribute qualifiers in the Cl Type Manager are displayed
as columns in the dialog box. For details, see "Attributes Page" on page 337.

If required, you can click the Display Hidden Columns button to display the attributes that
are defined as Visible but not Static. For details on Static attributes, see "Attributes Page"
on page 337.

Note: For information on the elements included in the Related Query Node Instances
page, see "Cl Instances Dialog Box" on page 55.

Wizard The Add Related Query Node Wizard contains:

map Related Query Node Type Page > Relationship Type Page > Related Query Node

Properties Page > Related Query Node Instances Page
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Add Triplet Dialog Box

This dialog box enables you to define the allowed steps in a path in the topology graph leading from the source
Cl to the target Cl when creating a subgraph definition, a compound relationship, or a calculated relationship.

To access | In Enrichment Manager, Impact Analysis Manager, or the Input Query Editorin DFM:

« Inthe Add Compound Relationship dialog box, click the Add button. For details, see
"Add/Edit Compound Relationship Dialog Box" on page 39.

« Inthe Subgraph Definition dialog box, click Add . For details, see "Subgraph
Definition Dialog Box" on page 75.

In Cl Type Manager, select Calculated Relationships from the drop-down list in the ClI

Types pane. In the editing pane, select the Triplets page and then click Add .

Important Select the query nodes and relationships to be included in the topology graph.

information
Note: The Condition fields are displayed only when you access the Add Triplet dialog
box from the Subgraph Definition dialog box.
Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233
« "How to Create a Perspective" on page 234
See also « "Compound Relationship" on page 16

« "How to Define a Compound Relationship — Scenario" on page 22

« "Subgraph Definition" on page 19

User interface elements are described below:

Ul Element
(A-Z) Description
|§| Condition. Enables you to define attribute conditions for the source and target query nodes

you selected. When the Add Triplet dialog box is opened from the Subgraph Definition
dialog box, it opens the Subgraph Condition Definition dialog box. When the Add Triplet
dialog box is opened from the Add Compound Relationship dialog box, it opens the
Compound Relationship Condition Definition dialog box.

The Condition button is enabled only after you select a query node from the Source or
Target lists.

Note: You cannot define attribute conditions for the source and target query nodes in
the Cl Type Manager.

HPE Application Performance Management (9.40) Page 53 of 393



Modeling Guide
Chapter 1: Topology Query Language

Ul Element
(A-2) Description

Relationship Select an available relationship connecting the two query nodes. The list of available
relationships appears only after defining both query nodes.

Relationship Select the required direction. Setting different relationship directions can achieve different
Direction query results. For an example, see "Setting Different Relationship Directions for
Compound Definitions" below.

Note: The Relationship list remains empty until you have selected a source and target.

Source Select the required source query node.

Target Select the required target query node.

Setting Different Relationship Directions for Compound Definitions

You can achieve different TQL results by setting different relationship directions. For example, in your
business world, as illustrated below, you want to create a compound relationship that connects between a
query node of the CIT a and a query node of the CIT b. Depth is defined at 5 (for details, see "Depth" on page
76).

In the Add Triplet dialog box, you can create compound definitions to link query nodes a and b using different
relationship directions.

Compound Definition Source Target Relationship Relationship Direction
#1 querynodea | querynodec @ <relationship> | source --> target
#2 querynodec  querynodeb | <relationship> | source --> target
#3 querynodec  querynodeb | <relationship> | source <--target
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« Compound definitions 1 and 2 result in the following query:

Compound definitions 1 and 2
al = bl

« Compound definitions 1 and 3 result in the following query:

Compound definitions 1 and 3
al ={ b2

« Compound definitions 1, 2, and 3 result in the following query:

Cl Instances Dialog Box

This dialog box displays all of the Cl instances found for the selected TQL query node.

To access  To access in Enrichment Manager, Impact Analysis Manager, and the Modeling
Studio:

In the editing pane, right-click the required query node and select Show Element Instances.
Note: If you are using Enrichment Manager, select Query mode at the top of the editing
pane to display the Show Element Instances option.

To access in Adapter Management in DFM:

1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query |ﬁ| button to the right of the
Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Show Element’s Instances.

To access in Integration Studio:

Create an integration point based on a Jython integration adapter. On the Trigger Cl Instance
menu, choose Select Existing ClI.
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Important The columns in the table display the attributes of the selected Cl type. The attributes
information = displayed vary according to the Cl type selected.

By default, only columns corresponding to attributes that have been defined with the Asset
Data, Managed, and Comparable attribute qualifiers in the CIT Manager are displayed as
columns in the dialog box. For details, see "Attributes Page" on page 337.

Relevant "How to Define an Impact Rule — Workflow" on page 304
tasks "How to Define an Enrichment Rule — Scenario" on page 356

"How to Define a TQL Query" on page 20

"How to Create a Pattern View" on page 232

"How to Create a Template" on page 233

"How to Create a Perspective" on page 234

"Work with Population Jobs" in the RTSM Data Flow Management Guide

"Work with Data Push Jobs" in the RTSM Data Flow Management Guide
See also « "Topology Query Language (TQL) Overview" on page 13

« "Topology Query Language User Interface" on page 37

User interface elements are described below (unlabeled elements are shown in angle brackets):
Ul Element (A-Z) Description

Show Cl instances of: | Metwork *.  Specify the CIT you want displayed in the table. The table also includes
the children of the selected CIT.

|§ Delete from CMDB. Deletes the selected Cl.

|; Properties. Opens the Configuration Item Properties dialog box for the

- selected Cl.

|%| Refresh. Refreshes the list of Cl instances.

|?_(| Set Filter. Filters the Cl instances you want to display for the selected

o query node. Opens the Filter Cl Instances dialog box.

|ﬁ| Clear Filter. Clears the filter definitions you created in the Filter Cl

o Instances dialog box.

|@| Select Columns. Enables you to select the columns to be displayed.
For details, see "Select Columns Dialog Box" on page 389.

=t Sort Column Content. Enables you to set the sort order of the Cl
instances. For details, see "Sort Column Content Dialog Box" on page
390.

|E| Find. Displays the Find toolbar.
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Ul Element (A-Z) Description
B4 Send Mail. Enables you to send the table data in an email.
|§| Export Data To File. Enables you to select the format for previewing

and exporting the table data. The available options are:

« Excel. The table datais formatted as an .xIs (Excel) file that can be
displayed in a spreadsheet.

« PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of
columns to display to ensure that the report is legible.

o CSV. Thetable data is formatted as a comma-separated values
(CSV) text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. In Windows, to
verify or modify the list separator value, open Regional Options

from the Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value.

« XML. The table data is formatted as an XML file that can be opened
in a text or XML editor.

Tip: To extract HTML code from the report:

« Open the file in an HTML editor.
« Copy the relevant table into the target file.

Rows per page Select the number of rows to be displayed on each page. You can also
manually enter value for the number of rows per page.

K Q[ 3ories28 | Of Click to navigate through the results page by page or to jump to the first
or last page.

<ClI Instances> The Cl instances found for the selected TQL query node. You can
double-click an instance to open the Configuration Item Properties
dialog box for that ClI.

<Cl instances shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on page 201.

Display Label The name of the Cl instance as it appears in the topology map.

Conditions Preview Dialog Box

This dialog box displays the conditions selected when selecting a complex type condition in the Element Type
tab of the Query Node Properties dialog box.
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To access Click the Preview =] button from the Element Type tab of the Query Node Properties
dialog box.
See also "Query Node Conditions" on page 16

User interface elements are described below:

Ul Element (A-Z) Description

Cl Type Displays the subtypes for which you defined conditions.

Condition Displays the icon of the selected condition, as defined in the Legend.

Filter by Specifies the selected condition (i.e., by Cl type or by qualifier, and for qualifier,

specifies the qualifiers).

Element Layout Preview Dialog Box

This dialog box displays the attributes selected in the Element Layout tab of the Query Node Properties dialog
box to be included in the query results for the selected element.

To access Click the Preview button from the Element Layout tab of the Query Node Properties
dialog box.
See also "Query Node Conditions" on page 16

User interface elements are described below:

Ul Element (A-2) Description

Attributes Mode Displays the Attributes condition selected in the Element Layout tab of the Query
Node Properties dialog box.

Cl Type Displays the CIT of the selected query node or relationship.

Excluded Attributes Displays the attributes appearing in the Excluded Attributes pane in the Element
Layout tab of the Query Node Properties dialog box.

Qualifier Marked Displays the qualifiers selected in the Element Layout tab of the Query Node
Attributes Properties dialog box.

Specific Attributes Displays the attributes appearing in the Specific Attributes pane in the Element
Layout tab of the Query Node Properties dialog box.

Filter Cl Instances Dialog Box

This dialog box enables you to reduce the number of Cl instances to be displayed in a list by selecting a
condition and a value for a specific CI.

Toaccess  c)ick the Filter ' button in the Cl Instances dialog box.
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Important = A description of the filter condition you defined appears above the table columns in the Cl
information Instances dialog box. For example, the following illustration shows that a filter condition was
created to display only Cl instances whose Cl type is Windows.

Filter: Cl Type[Equal nt];

Display Label | Cl Type
WEPUKROT Windows
Relevant « "How to Define an Impact Rule — Workflow" on page 304

tasks « "How to Define an Enrichment Rule — Scenario" on page 356

« "How to Define a TQL Query" on page 20

« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232

« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

User interface elements are described below:

Ul Element (A-

Z) Description

Attribute Displays all the attributes of the CI type to which the CI belongs.

Condition Select the required operator. For details, see "Attribute Operator Definitions" on page
33.

NOT Select tofilter the results by the negation of a condition and value.

Value Select or enter the required value.

Join Relationship Condition Dialog Box

This dialog box enables you to define the connection between two query nodes using a join relationship.

To access In Enrichment Manager or Impact Analysis Manager, click the Add button in the
Add Join Relationship dialog box.

Important You cannot select attributes of type list for a join relationship condition.

information

Relevant tasks « "How to Define an Impact Rule — Workflow" on page 304
o "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul
Element
(A-2) Description

<Selected A selected query node. The first attribute applies to <end_1>.

query
node1>

<Selected A selected query node. The second attribute applies to <end_2>.
query
node2>
Operator = Select one of the following operators:
« Equal. The system checks whether two selected attributes are equal.
« Not equal. The system checks whether two selected attributes are not equal.

« Sub string. The system checks whether the value of the first attribute is a substring of the
value of the second attribute.

« Sub string ignore case. The system checks whether the value of the first attribute is a
substring of the value of the second attribute regardless of the string's case.

Note: When using the operator Not equal, ensure that both sides of the join relationship
have a limited result size. It is recommended to define more specific conditions so as not
to overload the system with large results.

Layout Settings Dialog Box

This dialog box enables you to determine which attributes are used in the calculation of the TQL query when
using the RTSM API. For details, see RTSM (HPE Universal CMDB) Web Service APl in the RTSM
Developer Reference Guide.

To access  Click Advanced layout settings in the Query Node/Relationship Properties dialog box in
Enrichment Manager or Impact Analysis Manager.

Important Since this option is only relevant when querying the RTSM API, the query results in the user
information  interface are not impacted by the attributes you select in this dialog box.
Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« Implement a Discovery Adapter in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233
« "How to Create a Perspective" on page 234

User interface elements are described below:

Ul Element (A-Z) Description

Attribute name The name of the attribute.
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Ul Element (A-Z) Description

Calculate Select this check box to include the attribute in the query's calculation.

Query Node/Relationship Properties Dialog Box

This dialog box enables you to define the attribute conditions for the selected TQL query node/relationship.

To To access in Enrichment Manager, Impact Analysis Manager, and the Modeling Studio:

access In the editing pane, right-click the required query node and select Query Node/Relationship

Properties or double-click the required query node or relationship.

Note: If you are using Enrichment Manager, select Query mode at the top of the editing
pane to display the Query Node Properties option.

To access in DFM:
1. To access from the Adapter Definition tab, select an adapter. Click the Edit Input Query
|£| button to the right of the Input Query box to open the Input Query Editor.
2. Right-click the required query node/relationship and select Query Node Properties or
Relationship Properties or double-click the required query node or relationship.

Relevant | « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356

» "How to Define a TQL Query" on page 20

« Implement a Discovery Adapter in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232

« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

User interface elements are described below:

ul
Element
(A-Z) Description

Element (Optional) The Element name box contains the name of the selected query node/relationship.

name By default, the Cl type is assigned as the element's name. You can rename a TQL query node
in the Element name box giving it a unique label. This can be helpful when there is more than
one query node of the same ClI type in the TQL query.
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ul
Element
(A-2) Description
Element Displays the Cl type of the selected query node. If you want to change the query node type to a
type child of the original type, select a subtype from the drop-down list.
Note:
« If you have already defined a complex type condition for the query node, the condition
is lost when you change the query node type.
« This feature is only available in the Modeling Studio.
Include  Select to display both the selected Cl and its children in the topology map.
subtypes
Note: This feature is only available in Enrichment Manager and Impact Analysis Manager.
Query Click Query Result to display a topology map of the TQL query showing the number of
Result instances of each query node/relationship.
Note: This feature is only available in the Modeling Studio.
Show Select Show element in query results to display the selected TQL query node in the editing
element  pane. When this option is cleared, a Hidden in Query Results indicator B2 appears to the right
in query  of the selected TQL query node in the editing pane.
results
[pAddres
ontainment
(A% | Membership
=)
Windows o
[atrmet
Any query results pertaining to that TQL query node are not displayed in the topology map. This
can be useful when certain relationships or TQL query nodes are required to build the query but
are not needed in the results. For example, Windows are connected to the IP Subnet by
defining specific IP Addresses, but in any query results you may want to view the IP Address
elements only and not the Windows elements.
Attribute Tab

This tab enables you to create an expression defining conditions that restrict the number of query nodes that
appear in the query. You can add an attribute condition to a query node or relationship and filter the query

results.
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To access  Click the Attribute tab in the Query Node/Relationship Properties dialog box.

Important Each row represents an attribute condition that you specify. Use the And/Or column and the
information Brackets columns to link multiple conditions. In this way, you can construct a more precise
logical statement to generate the required results.

Note:

« This tabis not available for calculated relationships.

« When you access the Query Node/Relationship Properties dialog box in Modeling
Studio, this tab is read-only for Enrichment and Impact type queries for which an
Enrichment rule or Impact rule is defined.

Relevant o "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356

« "How to Define a TQL Query" on page 20

« Implement a Discovery Adapter in the RTSM Developer Reference Guide
o "How to Create a Pattern View" on page 232

« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

User interface elements are described below:

Ul Element
(A-Z) Description
CH Add. Adds an attribute condition row. Select the attribute name, operator, and value to
define the attribute condition.
E Delete. Deletes the selected attribute condition.
|F, Up. Moves the selected row up.
|;| Down. Moves the selected row down.
=% Show Criteria. Displays the criteria of the selected condition in a pop-up dialog box.
Advanced Opens the Layout Settings dialog box which enables you to determine which attributes
layout are used in the calculation of the TQL query when querying the RTSM using third-party or
settings custom tools.
Note: This feature appears only in Enrichment Manager and Impact Analysis
Manager.
And/Or Click inside the And/Or field and select either And or Or to link multiple conditions.

HPE Application Performance Management (9.40) Page 63 of 393



Modeling Guide
Chapter 1: Topology Query Language

Ul Element

(A-Z) Description

Attribute Select an attribute from the drop-down list.

name
Note: When you select one of the following attribute types: float, double, or long, the
In operator is not available.

Brackets Click inside the Brackets box to display a list of brackets you can use to build more

{2 complex, logical statements.
Criteria Contains the attribute condition definition as defined in the CI Instances dialog box.

Default Value  For parameterized attributes, enter a default value for the parameter.

Not Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the Cl instances that
were not assigned a value. For example, your system contains three nodes: Node1
is assigned the value A, Node2 is assigned the value B and Node3 is not assigned a
value. You create a query to retrieve all nodes that are equal to A and select NOT;
the results of your query only include Node2 because Node3 is not assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on page 33.

Note: When you select one of the following attribute types: float, double, or long, the
In operator is not available.

Parameterized Select Yes to define a parameterized value for the attribute. Select No to define a fixed
value for the attribute.

Note: This feature is only available in the Modeling Studio.

Parameter If you are defining a parameterized value for the attribute, you must enter the parameter
Name name.

Note: This feature is only available in the Modeling Studio.

Value Enter or select the value of the attribute. The Value options vary according to the attribute
type you select.

Note: You can paste a copied value into the window by pressing CTRL+v on the
keyboard.

Cardinality Tab

In this area, you can define a relationship cardinality, which enables you to define how many Cl instances you
expect to have at the end of a relationship in your query resullt.

To access  Click the Cardinality tab in the Query Node Properties dialog box.
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Important Select the required relationship to which the selected query node is attached. Then define
information = the lower and upper limits for including the query node at the other end of the relationship in
the query results.

Each row represents a cardinality condition that you specify. Use the And/Or column and the
Brackets columns to link multiple conditions.

You can define relationship conditions that enable the relationship's connecting query node
to be included in the TQL query results by creating an expression defining that condition. For
an example, see "Example of a Relationship Condition" on the next page.

Note:

« This tab only appears when a query node is selected.

« When you access the Query Node/Relationship Properties dialog box in Modeling
Studio, this tab is read-only for Enrichment and Impact type queries for which an
Enrichment rule or Impact rule is defined.

Relevant o "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356

« "How to Define a TQL Query" on page 20

« Implement a Discovery Adapter in the RTSM Developer Reference Guide
o "How to Create a Pattern View" on page 232

« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

User interface elements are described below:

Ul Element (A-Z) Description

Add. Adds a cardinality condition row. Select the query node and max and min
values to define the cardinality condition.

|§ Delete. Deletes a cardinality condition from the Cardinality area.
|W, Up. Moves a selected row up.
|;| Down. Moves a selected row down.

=% Show Criteria. Displays the criteria in a pop-up dialog box.

|— Inserts 1 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.
| Inserts 0 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.
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Ul Element (A-Z) Description

And/Or Click inside the And/Or field and select either And or Or to link multiple
conditions.

Brackets { Click inside the Brackets box to display a list of brackets you can use to build

more complex, logical statements.

Criteria Contains the cardinality condition definition as defined in the CI Instances
Dialog Box.
Max Enter the value that defines the upper limits for including the query node at the

other end of the relationship in the query results.

Note: You can use an asterisk (*) in the Max box to represent an infinite
value.

Min Enter the value that defines the lower limits for including the query node at the
other end of the relationship in the query results.

For example, if <end_1> is IpAddress and <end_2> is Windows, entering 1 in
the Min box and asterisk (*) in the Max box instructs the system to retrieve only
those IP Addresses that are connected to at least one Windows operating
system. (The asterisk indicates an infinite value.) Entering 3 in the Min box and
asterisk (*) in the Max box instructs the system to retrieve only those Windows
operating systems that are connected to at least three IP Addresses.

Query Node Select the required relationship to which the selected query node is attached.
The list contains all the relationships that are linked to the selected query node.

Not Select NOT if you want the condition statement to do the opposite of what is
defined.

Note: If you select NOT, query results do not include data from the CI
instances that were not assigned a value. For example, your system
contains three nodes: Node1 is assigned the value A, Node2 is assigned
the value B and Node3 is not assigned a value. You create a query to
retrieve all nodes that are equal to A and select NOT; the results of your
query only include Node2 because Node3 is not assigned a value.

Example of a Relationship Condition

The example of relationship conditions is based on the following TQL query:
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Uy

ontainment

[pAddres

[ Mermbership E
= (=

MHode

]
IpSubnet

In the Relationship Cardinality dialog box, the following relationship conditions are defined for the query:

« Containment —Min: 2, Max: 4
« Membership —Min: 1, Max: *
Using the OR operator, the definitions appear in the Cardinality section, as follows:

wot | ( | Criteria ' ) | Andior
Containment (Mode, lpAddress): 2.4 OR
Membership (pSubnet, Mode) : 1.*

o [Containment (Node, IP Address)] OR [Membership (IP Subnet, Node)] means that the node
must either have between two and four IP Addresses OR be a member of the IP Subnet.

Using the AND operator, the definitions appear in the Cardinality section, as follows:

wot | ( | Criteria ' ) | Andior
Containment (Mode, IpAddress) : 2.4 AMD
Membership (pSubnet, Mode) : 1.*

e [Containment (Node, IP Address)] AND [Membership (IP Subnet, Node)] means that the node
must have between two and four IP Addresses AND also be a member of the IP Subnet.

Note: A cardinality of (0..0) is only valid when both ends of a relationship are defined with that cardinality.
If one end is defined with cardinality (0..0) and the other end is defined with a different cardinality, the
condition is invalid. However, the TQL query is saved (the cardinality has no effect on the query resuits).

Element Type Tab
This area enables you to specify subtype conditions for the selected query node or relationship.
To access Click the Element Type tab in the Query Node/Relationship Properties dialog
box.
Important This tab is only available in the Modeling Studio.
information

This tab is not available for calculated relationships.
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Relevant tasks

» "How to Define a TQL Query" on page 20

« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233

» "How to Create a Perspective" on page 234

« "How to Define a Complex Type Condition - Scenario" on page 26

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)

<Legend>

Cl
Types/Relationships
pane

Conditions pane

Customize subtypes

Element type

Conditions Pane

Ul Element (A-Z)

Apply this condition
recursively on all
subtypes of <selected

Cl type>
By CI types

Description

Indicates the icons displayed next to the subtypes based on the selected
conditions:

« @ |nclude the subtype without its descendants.
« G Include the subtype with its descendants.

« " Exclude the subtype without its descendants.
« " Excludethe subtype with its descendants.

When Customize subtypes is selected, the Cl Types pane displays a tree with all
subtypes of the selected Cl type (for relationships, the Relationships pane
displays a tree with all subtypes of the selected relationship). After selecting
conditions in Conditions pane, click the Preview button to open the Conditions

Preview dialog box.
For details, see "Conditions Pane" below.

Select Customize subtypes to set a complex type condition. Select the required
subtypes from the tree in the Cl Types/Relationships pane and select conditions
for them in the Conditions pane, as described below.

Select Element type to set a simple type condition. If you want to include all
subtypes of the selected Cl type, select the Include subtypes check box. If you
do not want to include all subtypes, clear the check box.

Description

Select this check box to apply the specified condition for the selected Cl type to
all of that Cl type's descendants, recursively.

Select By Cl types to include or exclude all instances of the selected Cl type in
the query results.
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Ul Element (A-Z)

By qualifiers

Condition

Element Layout Tab

Description

Select By qualifiers to include or exclude instances of the selected Cl type
with specific qualifiers in the query results. A pop-up window appears with a list
of qualifiers. Select the required qualifiers for the selected subtype. For details
on the qualifiers, see "Qualifier Tab" on page 71.

Select a condition for the selected Cl type. The following options are available:

« None. No condition is selected for this Cl type. Instances of this Cl type

and all its descendants are included in the query results, unless a parent Cl
type of this Cl type was selected for exclusion and the Apply recursively
check box was selected.

Include <selected subtype> in the query. Includes instances of the
selected Cl type in the query results (according to the condition selected).
An example of a situation where this option is relevant is where a parent of
the ClI type was selected to be excluded and the Apply recursively check
box was selected. You can select certain subtypes to be included, so the
query results exclude all subtypes of the parent CI type except for the
specified ones.

Exclude <selected subtype> from the query. Excludes instances of the
selected Cl type from the query results (according to the condition selected).

This area enables you to select the attribute values retured in the query results for the selected query node or

relationship.

To access  Click the Element Layout tab in the Query Node/Relationship Properties dialog box.

Important When you make a selection of the attributes to include in the query results for a particular
information CIT, the selection also applies to all of its descendant CITs. You can manually exclude
specific attributes for descendant CITs in the Conditions pane.

This option is only relevant when querying the CMDB API. The query results in the user
interface are not impacted by the attributes you select in this dialog box.

This tab is only available in the Modeling Studio.

This tab is not available for calculated relationships.

Relevant o
tasks .

"How to Define a TQL Query" on page 20

"How to Create a Pattern View" on page 232

"How to Create a Template" on page 233

"How to Create a Perspective" on page 234

"How to Define a Complex Type Condition - Scenario" on page 26

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-Z) Description

<Legend> Indicates the icons displayed next to the subtypes based on the selected attributes
condition:

« @ Include all attributes for this subtype.

« % Include only the selected attributes for this subtype.

Cl When Select attributes for layout is selected, the Cl Types pane displays a tree
Types/Relationships = with all subtypes of the selected Cl type (for relationships, the Relationships pane
pane displays a tree with all subtypes of the selected relationship). After selecting

conditions in Conditions pane, click the paview button to open the Element

Layout Preview dialog box.
Conditions pane For details, see "Conditions Pane" below.

No attributes If you select No attributes, no attribute values are returned in the query results for
the selected query node or relationship.

Select attributes for | If you select Select attributes for layout, you can select the attributes to be
layout included in the query results for the selected query node or relationship.

Conditions Pane

Ul Element (A-Z) Description

Attributes condition Select one of the following options:

« None. No attributes are included in the query results for the selected
element.

« All. All attributes defined for the selected element are included in the query
results.

« Specific Attributes. Only the selected attributes are included in the query
results for the selected element.

Attributes with the You can include attributes with specific qualifiers. Click the ellipsis button to
following qualifiers open a dialog box with the available qualifiers and select the required qualifiers.

Note: This feature only appears when you select Specific Attributes for
the Attributes condition.

Available Attributes Displays all of the available attributes for the selected element.
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Ul Element (A-Z) Description

Excluded Attributes When All is selected as the Attributes condition, you can exclude selected
attributes by moving them into the Excluded Attributes pane.

When Specific Attributes is selected as the Attributes condition for a CIT that
has inherited an attribute selection from its parent CIT, you can exclude specific
attributes from the selection by moving them to the Excluded Attributes pane.

Alternatively, if you select attributes with selected qualifiers fora CIT, you can
exclude some attributes from that selection by moving then to the Excluded
Attributes pane.

You can move attributes into and out of the pane using the arrow buttons.

Exclude Specific Select this check box to enable the Available Attributes and Excluded Attributes
Attributes panes and the arrow buttons.

Note: This feature only appears when you select All for the Attributes
condition.

Specific Attributes Displays the attributes to be included in the query results for the selected
element. Move attributes into and out of the pane using the arrow buttons.

Note: This feature only appears when you select Specific Attributes for
the Attributes condition.

Qualifier Tab

This area enables you to define qualifier conditions for the selected query node or relationship. For example,
you can use a qualifier to define a CIT as abstract, meaning you cannot create instances from it.

To access Click the Qualifier tab in the Query Node/Relationship Properties dialog box.
Important By default, multiple selection links the conditions with the OR operator.
information

Note: This tab is only available in Enrichment Manager, Impact Analysis Manager,
and the Input Query Editorin DFM.

Relevant tasks « "How to Define an Impact Rule — Workflow" on page 304
« "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« Implement a Discovery Adapter in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

User interface elements are described below:
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Ul Element
(A-Z) Description
<Qualifiers> Forallist of the available qualifier options, see "Qualifiers Page" on page 340.
Negate If this check box is selected, then the element is included in the query results only if it has
Qualifiers no qualifier in the list of selected qualifiers.
Identity Tab
This area enables you to filter the TQL query results according to the element ID of the instances found for the
selected TQL query node.
To access  Click the Identity tab in the Query Node Properties dialog box.
Important Move the required element from the Optional identities pane on the left to the Selected
information identities pane on the right to define what you want included in the TQL query results using
the left and right arrows.
Note: This tab only appears when a query node is selected.
Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks

o "How to Define an Enrichment Rule — Scenario" on page 356

« "How to Define a TQL Query" on page 20

« Implement a Discovery Adapter in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232

« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

The following elements are included (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Toolbar>

For descriptions of the toolbar buttons, see "Cl Instances Dialog Box" on page 55.

Optional identities Displays all the instances found for the selected TQL query node.

pane
Selected identities Displays the elements that are used to define what should be included in the TQL
pane query results.

Refine Query Node Type Dialog Box

This dialog box enables you to change the ClI type of a TQL query node after you have created a TQL query.

To access

In Impact Analysis Manager or Enrichment Manager, right-click the required query node
and select Refine Query Node Type.

Note: If you are using Enrichment Manager, select Query mode at the top of the editing
pane to display the Refine Query Node Type option.
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Important
information

Relevant
tasks

See also

You can change the Cl type to a type from one of the Cl type's children, if one exists. If no
such ClI type exists, this option does not appear.

"How to Define an Impact Rule — Workflow" on page 304

"How to Define an Enrichment Rule — Scenario" on page 356

"How to Define a TQL Query" on page 20

"Implement a Discovery Adapter" in the RTSM Developer Reference Guide
"How to Create a Pattern View" on page 232

"How to Create a Template" on page 233

"How to Create a Perspective" on page 234

"Topology Query Language (TQL) Overview" on page 13
"Cl Type Manager" on page 319

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)

Description

<List of Cl types from which to choose> Select the required Cl type.

Select Relationship Type Dialog Box

This dialog box enables you to select the type of TQL relationship to be created.

To access  Inthe editing pane of Impact Analysis Manager, Enrichment Manager, and the Modeling

Studio, click the Create Relationship I button on the toolbar and draw a line between
two query nodes. The Select Relationship Type dialog box opens automatically.

Important | Select one of the following relationship types:

information

Relevant o
tasks .
See also .

Regular Relationship. For details, see "Add/Edit Relationship Dialog Box" on page 45.
Join Relationship. For details, see "Add/Edit Join Relationship Dialog Box" on page 42.

Compound Relationship. For details, see "Add/Edit Compound Relationship Dialog
Box" on page 39.

Calculated Relationship. For details, see "Add/Edit Calculated Relationship Dialog
Box" on page 38.

"How to Define an Impact Rule — Workflow" on page 304

"How to Define an Enrichment Rule — Scenario" on page 356

"How to Define a TQL Query" on page 20

"Implement a Discovery Adapter" in the RTSM Developer Reference Guide

"How to Create a Pattern View" on page 232

"How to Create a Template" on page 233

"How to Create a Perspective" on page 234

"How to Add Query Nodes and Relationships to a TQL Query" on page 21
"Cl Type Relationships" on page 321
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Subgraph Condition Definition Dialog Box

This dialog box enables you to create conditions that restrict the number of query nodes that appear in the
query.

To access | InImpact Analysis Manager, Enrichment Manager and the Input Query Editor in DFM, click
Condition [ in the Add Triplet dialog box.

In the Modeling Studio, click Condition |ﬁ| in the Subgraph Definition dialog box.

Important Contains the following tabs:

information « Attribute. Enables you to define attribute conditions for query nodes and relationships.

See a description of the elements in the Attribute tab in the table below. Each row
represents an attribute condition that you specify. Use the And/Or column and the
Brackets columns to link multiple conditions. In this way, you can construct a more
precise logical statement to generate the required results.

« Qualifiers (for Enrichment Manager, Impact Analysis Manager, and the Input Query
Editorin DFM). Enables you to define qualifier conditions for the selected query node or
relationship. For details, see "Qualifier Tab" on page 71.

« Element Type (for the Modeling Studio). Enables you to define subtype conditions for
the selected query node or relationship. For details, see "Element Type Tab" on page 67.

Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233

» "How to Create a Perspective" on page 234

User interface elements are described below:

Ul
Element
(A-2) Description

Add. Adds the subgraph condition definition.
E Delete. Deletes the subgraph condition definition.
|K Up. Moves a selected row up.
|£| Down. Moves a selected row down.
=% Show Criteria. Displays the subgraph condition definition in a pop-up dialog box.
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Ul
Element
(A-2) Description

And/Or  Click inside the And/Or field and select either And or Or to link multiple conditions.

Attribute Choose an attribute from the list.
name

Brackets = Click inside the Brackets box to display a list of brackets you can use to build more complex,
{2 logical statements.

CIT Contains the CIT selected from the Source and Target lists.

Note: This option is not relevant when accessing the dialog box from the Modeling Studio.

Criteria = Contains the attribute condition definition as defined in the Cl Instances Dialog Box.

Not Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the Cl instances that were
not assigned a value. For example, let us assume that your system contains three nodes.
Node1 is assigned the value A, Node2 is assigned the value B and Node3 is not assigned a
value. If you create a query in which you want to retrieve all nodes that are equal to A and
you select NOT, the results of your query only include Node2 because Node3 is not
assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on page 33.

Value Enter or select the value of the attribute. The Value options vary according to the attribute type
you select.

Subgraph Definition Dialog Box

This dialog box enables you to create a graph that represents additional TQL query data related to a specific
Cl.

To access To access in Enrichment Manager, Impact Analysis Manager, and the Modeling Studio:

In the editing pane, right-click the required query node and select Subgraph Definition.

Note: If you are using Enrichment Manager, select Query mode at the top of the
editing pane to display the Subgraph Definition option.

To access in Adapter Management in DFM:
1. Select an adapter in the Resources pane.

2. Inthe Adapter Definition tab, click the Edit Input Query s button to the right of
the Input Query box to open the Input Query Editor.

3. Right-click the required query node and select Subgraph Definition.
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Important The following icon is displayed next to the query node for which you define a subgraph:
information m
Fe
Relevant » "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356

» "How to Define a TQL Query" on page 20

« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide
« "How to Create a Pattern View" on page 232

» "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

See also o "Subgraph Definition" on page 19
« "How to Create a Subgraph Definition — Scenario" on page 26

User interface elements are described below:

Ul Element

(A-Z) Description

Add. Adds a subgraph definition. In Enrichment Manager, Impact Analysis Manager, and
the Input Query Editor in DFM, click to open the Add Triplet dialog box. In the Modeling
Studio, click to add a row to the table.

|§ Delete. Deletes the selected subgraph definition.

|§| Condition. Enables you to edit a subgraph definition. In Impact Analysis Manager,

o Enrichment Manager, and the Input Query Editorin DFM, it opens the Edit Triplet dialog
box. In the Modeling Studio, it opens the Subgraph Condition Definition dialog box.

Depth A number that represents the longest path (that is, the maximum number of connecting
query nodes) allowed between two Cls in the RTSM that should be included in the DFM
process.
Default: 5

Element A green asterisk appears next to either the source, relationship, or target in the subgraph

condition definition if an attribute condition has been defined for one of them in the Subgraph

exists Condition Definition dialog box. For details, see "Subgraph Condition Definition Dialog

Box" on page 74.
Relationship The relationship selected connecting the source to the target query node.

Relationship The direction of the relationship selected, indicating which query node is dependent on the

Direction other.
Source The required source query node selected.
Target The required target query node selected.
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User Preferences Dialog Box

This dialog box enables you to reset system preferences.

To access

Important
information

Select Tools > User Preferences, or click the Configure User Preferences B button on
the Status Bar.

All the preferences you select (such as whether to display certain wizard pages or warning

message preferences) are stored in the system. This dialog box enables you to reset those
preferences.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z)

<Left pane>

<Preferences
list>

Filter by
Reset All

Reset Page

Description

Select the preferences page to edit. The following options are available:

« Wizard Preferences. Enables you to define whether to hide or display certain wizard
pages.

« Optional Messages Preferences. Enables you to define whether to hide or display
certain messages.

« Discovery Preferences. Enables you to define:

« Whether to hide or display certain Discovery warning messages
« The required default external editor (such as Notepad)
« Whether to use Basic or Advanced Discovery mode

« General. Enables you to define general application preferences.

« Reports. Enables you to set the category of Custom Reports selected by default.

The list of warning messages and their user-selected preferences.

Enter a search word to filter the list of options.
Click toreset all the preferences to their default values.

Click to reset the selected preference to its default value.

Troubleshooting and Limitations - Topology Query
Language

This section describes troubleshooting and limitations for Topology Query Language.

« When creating resources, such as TQL queries, views, and Impact rules, make sure that there are no
spaces at the end of the resource name.

« If youreceive the message Active query quota is exceeded when saving the first enrichment rule in a
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new HPE Application Performance Management installation, you can either increase your model capacity
level from small to medium or large (depending on your resources), or manually deactivate TQL queries
which you do not need. You can manually deactivate queries using the JMX Console, or by editing the
query definitions from the Modeling Studio.

« Inamultitenancy environment, TQL query names cannot contain an @ character.

« If an error occurs while working with views in the Modeling managers, when adding Cls to the CMDB, or
when updating existing Cls, and the error log indicates that objects are missing in the database, access
the JMX console and run the following methods under service=DAL services:

« rebuildModelViews
« rebuildModelDBSchemaAndViews

« If the login takes along time when navigating to the Modeling modules, go to Infrastructure Settings
Manager and set the value of the mam.gui.automation.flow.mapping.enabled setting to false. This
disables the Automation Flow functionality but improves the login time for the Modeling modules.

« For TQL queries to be valid, they must comply with certain restrictions.
This section includes the following topics:
« "Understanding Validation Restrictions" below

« "Impact Analysis TQL Query Validation" on the next page

« "Enrichment TQL Query Validation" on page 80

Understanding Validation Restrictions

For Impact Analysis, Discovery, and Enrichment TQL query types to be valid, they must comply with the
following restrictions:

« Unique Names. TQL query elements must have unique names.

« Self Relationships. A TQL query must not contain self relationships, that is, a relationship must not
lead from a query node to itself, as the following example illustrates:

Route

____ Containment ﬁj
———»

IpAddress
Mode

« Cyclic Graph. The TQL query structure cannot be a closed circle, as shown in the following example:
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de
Maraned Relationship
Containment
Configurationltem
Ipﬂaddress '
Membership
aute

Ipﬁddressj

« Separate Query Nodes and Groups. All the TQL query nodes must be linked to one another, that is,
the TQL query cannot contain separate query nodes or groups, as the following example illustrates:

= =

Mode %0de

Containment CDmFJ':lsnu:un

PR

ATHW Fort Bridge

Impact Analysis TQL Query Validation
Impact Analysis TQL queries must also comply with the following restrictions:
« Number of query nodes. An Impact Analysis TQL query must consist of at least two query nodes.

« Trigger and affected query nodes must be connected. There must be a path of relationships from
the triggered query node to the affected query nodes.

« Selecting query nodes to function as Impact Analysis triggers. When selecting query nodes to
function as Impact Analysis triggers, the query nodes must comply with the following restrictions:

o You can select more than one query node as a trigger. However, you cannot define a query node
both as affected and as a trigger.

o If aquery node has a relationship whose minimum limit is 0 (meaning that one of its ends does not
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necessarily have a query node linked to it), the query node that is linked to its other end cannot be a
root cause query node (because it may or may not exist in the TQL query). For details about
minimum limits, see "Cardinality Tab" on page 64. For example, Configuration Item cannot be
either a root cause or affected query node because it is connected to the query node with a Min limit

of 0.

Cardinality: Containment (Mode, [pAddress) : 1. AND
[ | Composition (Mode, Configurationttem) ; 0..*

]
| MHode
r"--
.“"
-~ fainment

s
Coriposition 1
o A
IpAddress
Cardinality: Containment (Mode |, IpAddress) ;1.

Canfigurationltem
Cardinality: Composition (Mode, Configurationtem) : 1.*

I

Note: A query node that is hidden cannot be a root cause or an affected query node.

« The connection between trigger and affected query nodes. The trigger query node and affected
query nodes you define must be connected by a path of relationships from the triggered query node to

the affected query nodes.

Enrichment TQL Query Validation

Enrichment TQL queries must comply with the following restriction:

« Required elements. You cannot perform Enrichment on a non-required query node, that is, a query
node that does not necessarily appear in the TQL query results.
Example 1. In this example, the TQL query results can be either A and B or A and C. Therefore, you
cannot add an Enrichment query node to query nodes B or C because they are not required elements.
You can add an Enrichment query node to query node A because it always appears in the TQL query
results. For details on how to add Enrichment query nodes and relationships, see "How to Add
Enrichment Query Nodes and Relationships to an Enrichment TQL Query" on page 360.
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'l

!
,.rénrichrnent relationship

Example 2. In this example, both A and B are required elements that always appear in the TQL query
results. Only C is not a required element because it has a cardinality of 0. Therefore, you cannot add an
Enrichment query node to it.

1
Envichment relationstip
k!

HPE Application Performance Management (9.40) Page 81 of 393



Chapter 2: Impact Modeling

This chapter includes:

® Impact Modeling OVerviewW ... L 82
® IMPACE LAY O 82
® ImMPaCt RUIES 82
® Propagation Reversal .. ... .. . 83
® Calculated Relationship TYPeS ... L 84
® Creating Views Based on the Impact Model ... ... . 85

Impact Modeling Overview

The impact model enables you to determine the direction of the propagation of the IT infrastructure Cls in your
business world. The direction of the impact is not always the same direction as the physical relationships
taken from the CI Type model.

The impact model uses the impact layer to change the propagation direction. The impact layer is used in the
applications where propagation occurs. You change the direction of the impact using the impact layer,
regardless of the direction of the physical relationships.

All KPI propagation is affected by the impact model. For details on KPI propagation in Service Health, see
"Propagation Rules" in Using Service Health. For details on KPI propagation in Service Level Management,
see "Propagation Rules" in Using Service Level Management.

Impact Layer

The impact layer changes the direction of the impact. The impact layer separates the impact direction from the
CIl Type model, creating an independent layer on top of the Cl Type model. This means that components
affected by the impact model are no longer relying on the physical relationships as defined in the Cl Type
model. As aresult, the impact direction is no longer necessarily identical to the direction of the physical
relationships in the CI Type model.

Impact Rules

The impact layer consists of impact rules. The impact rules are defined in the Cl Type Manager. For details,
see "Triplets Page" on page 342.

An impact rule is defined by one or more triplets. Each triplet is defined by the following components:
« One source Cl type
« Onetarget Cl type
« A physical relationship type (for example, Containment) that links the two ClI types

« The required impact direction. The direction of the impact can be identical to or opposite from the direction
of the physical relationship between the source and target Cls.
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HPE Application Performance Management implements the impact layer by creating calculated relationships
that are defined by impact rules. Once one of the triplets fulfills the impact rule condition, HPE Application
Performance Management automatically creates the calculated relationship based on the triplet definition.

Since calculated relationships are defined by physical relationships from within the class model, their lifetime
is determined by the lifetime of the physical relationships defined in the impact rule. When the physical
relationship in the class model is removed, the corresponding calculated relationship is removed from all view
results as well.

Note: If you create a new ClI type or relationship in the Cl Type Manager, you need to define the required
triplets. For example, to enable the impact model to properly affect KPI propagation. If the triplets are not
defined, the required KPIs are not included in the Dashboard views and SLA agreements.

You can use calculated relationships to create TQL queries just like any other relationship in the Cl Type
model. This enables you to base Enrichment rules, Impact rules, and views on calculated relationships.

Calculated relationships affect the results of all TQLs that use that calculated relationships since calculated
relationships are part of the class model.

Example of an Impact Rule Definition:

.;'_‘-}:,'J Web Service Lirik \Z::? Funning Software =

Propagation Reversal

The following example illustrates a scenario in which propagation is reversed.
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|
| {Calculated relationship -
Containment same direction as physical

_

\

) Calculated relationship -
T SEME direction as physical

Containment
Calculated \
Hh““‘“a._ refationship —
Cnrlﬁinm&}[.—ﬁ dlrEElE;;ﬁfaulsﬁe
Monitored By

Based on the impact rules defined in the Cl Type Manager, the impact is propagating from the Business2 Cl
to Business1, the same direction as the physical relationship that is connecting the Running Software ClI to
Business2.

According to the direction of the physical relationship between the Running Software Cl and the Node, the
Running Software Cl should impact the Node.

But based on the following impact rule, a calculated relationship is automatically created and HPE Application
Performance Management reverses the impact of the propagation.
% Mode Lirk: u Funning Software =

The impact is now propagated from the Node to the Running Software.

Calculated Relationship Types

There is one out-of-the-box calculated relationship called Impacted By. Impacted By contains two subtypes,
each one representing a different type of dependency relationship (complete dependency vs. potential
dependency.)

« Impacted by (Directly). Represents the fact that one Cl that is linked to another Cl using an Impacted By
(Directly) relationship is part of that Cl. You use an Impacted By (Directly) relationship for those Cls that
you want to see in your model. The ownership of the two Cls may be the same, but this is not always the
case.

« Impacted By (Potentially). Represents the fact that one Cl consumes the products of another. Cls that
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are linked by an Impacted By (Potentially) relationship are not part of that model, but are listed as related
Cls. For details, see "Model Editor" on page 258.

Creating Views Based on the Impact Model

As a best practice, you should use Modeling Studio to create a view of calculated relationships based on a
model. Modeling Studio enables you to create perspective-based views that use calculated relationships
instead of physical relationships. For details, see "Modeling Studio" on page 217.

For details on how to create and edit models, see "Model Editor" on page 258.

Note: For an in-depth description of the Impact Modeling Solution, see "Best Practices for Modeling" on
page 151.
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This chapter includes:
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® Generate a Direct Link User Interface

Generate a Direct Link - Overview

Direct Links enables you to create a URL that guides another user to a specific target view or Cl in HPE
Application Performance Management.

You can create a URL that:

« Opens a specific HPE Application Performance Management view or Cl directly in HPE Application
Performance Management. This enables users to retrieve information from HPE Application Performance
Management without being located in the HPE Application Performance Management context.

Note: To open a specific view or Cl directly in HPE Application Performance Management, use the
Open in context links option. For details, see "Select Command Page" on page 89.

« Enables integration with HPE Application Performance Management:

« If you create a URL using the Embedded links option, the URL takes you first to the HPE Application
Performance Management login page. After you enter your login name and password, the target page
opens in your browser.

Note: To open the target page in your browser, use the Embedded links option. For details, see
"Select Command Page" on page 89.

When you create a URL, you can:

« Send the URL to an email recipient
« Copy the URL to the clipboard
« Testthe URL to ensure that the target application page can be found

The user to whom you are sending the URL must have an account with sufficient privileges to open the target
page. You must apply the appropriate viewing and editing permissions to the users and user groups that want
to access the target view. You set permissions in Admin > Platform > Users and Permissions, select a
user or a group and select Permissions. For details, see "How to Assign Permissions" in APM Platform
Administration GuideHPE Universal CMDB Administration Guide.

Note: You can use Link to this Page function to open a target HPE Application Performance
Management page in your browser. While the Link to this Page function enables you to access another
application page in HPE Application Performance Management, it does not enable you to access a
specific Cl or view. For details, see "Linking to a Specific Page" in APM Platform Administration Guide.
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How to Generate a Direct Link - Scenario

This scenario describes how to generate a direct link to email the URL of a specific Cl to another person.

Jane Harrison is a senior engineer in the ABC Software company. She has encountered a problematic Clina
view she has created. She wants to inform Henry Jones, who is working with the same view through HPE
ServiceCenter, about the problematic CI. Since the view Jane has created contains many hundreds of Cls,
she decides to email Henry the URL of the Cl so that he does not have to spend a lot of time searching for that
specific CI.

In IT Universe Manager, Jane selects Generate Direct Link from the Edit menu. On the Select Command
page, she selects Open in context links and then the Show view option, and clicks Next.

On the Direct Link Parameters — Show View page, she selects the view she created, the problematic Cl,
and View topology as the mode in which Henry should open the Cl. When the URL is created, she emails
Henry the link to the problematic Cl.

For details, see "Generate Direct Link Wizard" on page 89.

How to Create a Direct Link to a Template with
Parameter Values

This task describes how to create a direct link to a template by including the parameter values in the URL.
This task includes the following steps:

« "Create a Direct Link to a Template" below

« "Edit the URL" below

« "Paste the URL into a Browser" on the next page

1. Create a Direct Link to a Template

InIT Universe Manager, select Edit > Generate Direct Link to run the Generate Direct Link wizard. On
the Select Command page, select Embedded links. Select Show view topology from the list of
options. On the Direct Link Parameters page, select the required template from the drop-down list.

2. Editthe URL
When the wizard finishes, click Copy URL and paste the URL into a text editor such as Notepad.
Append the following text to the end of the URL:
&params=[parameterl=valuel, parameter2=value2]
where parameterl and parameter2 are the parameter names for the selected template and valuel and

value2 are the values you want to enter for the parameters.

Note: Any special characters must be entered using the URL encoding. In the above example, the
URL encoding for the [ character is %5B, the URL encoding for the ] character is %5D, and the URL
encoding for the comma is %2C. Thus, the actual text to enter is:

&params=%5Bparameterl=valuel%2Cparameter2=value2%5D
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3. Paste the URL into a Browser

Paste the URL into a browser. HPE Application Performance Management opens to the selected
template with the parameters assigned the specified values.

How to Encrypt the Password of a Direct Link Using
the JMX Console

This task describes how to encrypt the password contained within a direct link using the JMX console.
To encrypt the password of a direct link using the JMX console:

1. Launch your Web browser and enter the following address: http://<server_name>:<port number>/jmx-
console, where <server_name> is the name of the machine on which the Run-time Service Model is
installed.

Under UCMDB-UI, locate UCMDB Integration.
3. Under getEncryptedPasswordForURL, enter your user name and the password to encrypt.
4. Click Invoke to view the encrypted string.

Generate a Direct Link User Interface

This section includes (in alphabetical order):

« "Generate Direct Link Dialog Box" below

« "Generate Direct Link Wizard" on the next page

Generate Direct Link Dialog Box

This dialog box enables you to create a URL to send to users so that they can access HPE Application
Performance Management.

To From the Admin > RTSM Administration > Modeling main menu, select Edit > Generate

access Direct Link. After you configure the Direct Link parameters in the "Generate Direct Link
Wizard" on the next page, click Finish on the Finish page to open the Generate Direct Link
dialog box.

In IT Universe Manager, click the Generate Direct Link to View = button on the Cl Selector
toolbar in Browse Views mode.

In the Reports module, click the Generate Direct Link = button on the toolbar or select
Operations > Generate Direct Link > Direct link to application on the Modeling main
menu.

Relevant | "How to Generate a Direct Link — Scenario" on the previous page
tasks

See also | "Generate a Direct Link — Overview" on page 86
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User interface elements are described below:

Ul Element
(A-2) Description

Copy URL  Copies the URL to the clipboard.

Description = Describes the parameters that are included in the URL. For details on selecting the
parameters, see "Select Command Page" below.

Link URL The created URL that accesses the specified HPE Application Performance Management
function.

Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application page can be found.

Note: This button is not available when using Linux.

Generate Direct Link Wizard

This wizard enables you to create a URL that guides another user to a specific target view or Cl in HPE
Application Performance Management.

To access | Fromthe Admin > RTSM Administration > Modeling main menu, select Edit >
Generate Direct Link.

Important By default, this wizard is set to display a Welcome page. You can choose not to display the
information Welcome page by selecting the Do not show this page again check box.

Relevant "How to Generate a Direct Link — Scenario" on page 87

tasks

Wizard The Generate Direct Link wizard contains:

map Select Command Page (<Open in context links options> and <Embedded links options>) >
Finish Page

See also "Generate a Direct Link — Overview" on page 86

Select Command Page

This wizard page enables you to select the required parameters that must be added to the URL.
You can create two types of links:

« Open in context links. Creates a URL that opens a specific view or Cl directly in HPE Application
Performance Management without having to be in the HPE Application Performance Management
context:

« Embedded links. Creates a URL that enables you to embed an RTSM applet into external applications.

Important By default, this wizard is set to display a Welcome page. You can choose not to display the
information Welcome page by selecting the Do not show this page again check box.
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Wizard The Generate Direct Link wizard contains:

map Select Command Page (<Open in context links options> and <Embedded links options>) >
Finish Page

See also "Generate Direct Link Wizard" on the previous page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description

<Left pane> A graphic illustration of the selected command.

Cll Grid Creates a URL that displays all the Cl instances found in the RTSM for a selected Cl type
and its children. For details, see "Direct Link Parameters — Cll Grid Page" on page 93.

Note: Available when you select the Embedded links option.

Cl Selector Creates a URL that embeds the Cl Selector displaying the Cls of a selected view, into
external applications. For details, see "Direct Link Parameters — C| Selector Page" on page
92.

Note: Available when you select the Embedded links option.

Cl Type Creates a URL that embeds the CI type selector into external applications. For details, see
Selector "Direct Link Parameters — Cl Type Selector Page" on page 92.

Note: Available when you select the Embedded links option.

Description A description of the selected command.

Impact Map Creates a URL that embeds an impact map into an external application. For details, see
"Direct Link Parameters — Impact Map Page" on page 94.

Note: Available when you select the Embedded links option.

Model Creates a URL that embeds the Model Editor into an external application, highlighting the
Editor selected Cls in the Cl Selector in the Model Editor. For details, see "Direct Link Parameters
—Model Editor" on page 95.

Note: Available when you select the Embedded links option.

Query Creates a URL that embeds the Model Editor into an external application, displaying the
Editor selected TQL query. For details, see "Direct Link Parameters — Query Editor" on page 95.

Note: Available when you select the Embedded links option.
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Ul Element
(A-Z)

Related Cls

Report
Viewer

Report
Viewer -
Saved
Report

Show ClI
properties

Show view

Show view
topology

Start in
mode

Steps

View Editor

HPE Application Performance Management (9.40)

Description

Creates a URL that opens a topology map displaying the selected Cl and its immediate
neighbors within the selected view. For details, see "Direct Link Parameters — Related Cls
Page" on page 96.

Note: Available when you select the Embedded links option.

Creates a URL that opens a specific report. For details, see "Direct Link Parameters —
Report Viewer Page" on page 96.

Note: Available when you select the Embedded links option.

Creates a URL that opens a saved topology or custom report. For details, see "Direct Link
Parameters — Report Viewer — Saved Report Page" on page 97.

Note: Available when you select the Embedded links option.

Creates a URL that displays a Cl's properties. For details, see "Direct Link Parameters —
Show CI Properties Page" on page 97.

Note: Available when you select the Embedded links option.

Creates a URL that displays the selected view and optionally preselects a query node in it.
For details, see "Direct Link Parameters — Show View Page" on page 99.

Note: Available when you select the Open in context links option.

Creates a URL that displays the topology map of the selected view and embeds it in an
external application. For details, see "Direct Link Parameters — Show View Topology Page"
on page 98.

Note: Available when you select the Embedded links option.

Creates a URL that opens HPE Application Performance Management at the selected
page. For details, see "Direct Link Parameters — Start in Mode Page" on page 100.

Note: Available when you select the Open in context links option.

The current step in the procedure.

Creates a URL that opens a specific view in the Pattern View Editor in Modeling Studio. For
details, see "Direct Link Parameters — View Editor Page" on page 98.

Note: Available when you select the Embedded links option.
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Ul Element

(A-2) Description

Views Creates a URL that embeds the View Selector in an external application, enabling you to
Selector select and display a view in that application. For details, see "Direct Link Parameters —

Views Selector Page" on page 99.

Note: Available when you select the Embedded links option.

Direct Link Parameters - Cl Selector Page

This wizard page enables you to create a URL that embeds the CI Selector displaying the Cls of a selected
view, into external applications.

Wizard map Select Command Page (Embedded links > Cl Selector) > Finish Page
Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

User interface elements are described below:

Ul Element (A-Z) Description
Allow multi selection Allow single or multiple selection of Cls.
Selected view Select the required view from which you want to select the required Cls.

e Click |Z| to open the View Selector dialog box. Select the view you want to
appear in the Cl Selector.

b
B

« Click to delete the selected view.

Direct Link Parameters - Cl Type Selector Page

This wizard page enables you to create a URL to a hierarchical tree or list of selected Cl types, which can be
embedded into an external application.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.
« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Cl Type selector) > Finish Page

User interface elements are described below:
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Ul Element (A-Z) Description

Cl type selector View the selected Cl types in either a hierarchical tree or list.
mode

Invisible CITs (tree = Select the Cl types you do not want to appear in the tree.

only) —
« Click |£| to open the CI Type Selector dialog box. Select the Cl types you

want to appear in the tree.

¥
&,

o Click to delete the selected Cl types.

Root Cl Type (tree Select the Cl type you want to use as the root Cl type in a hierarchical tree.

only) —
« Click |£| to open the CI Type Selector dialog box. Select the Cl type you want

to use as the root Cl type in the tree.

¥
&,

» Click to delete the selected Cl type. The default is Configuration Item.

Selection mode Allow single or multiple selection of Cl types.

Unselectable CITs Select the Cl types which cannot be selected in the tree.

(tree only) —
e Click |£| to open the CI Type Selector dialog box. Select the Cl types which

cannot be selected in the tree.

#
A

e Click to delete the selected Cl types.

Visible CITs (list Select the Cl types which you want to appear in the Cl type list.

only) —
« Click |£| to open the CI Type Selector dialog box. Select the Cl types which

you want to appear in the Cl type list.

#
A

e Click to delete the selected Cl types.

Note: If you choose to view the CITs in a list, then you are required to select
at least one Cl type.

Direct Link Parameters - Cll Grid Page

This wizard page enables you to display all of the Cl instances found in the RTSM for the selected Cl type and
for its children.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Cll Grid) > Finish Page
See also "Cl Instances Dialog Box" on page 55

User interface elements are described below:
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Ul Element (A-Z) Description
Class type Select the required Cl type.

« Click E| to select the required Cl type.
®

e Click to clear the box.

Direct Link Parameters - Impact Map Page

This wizard page enables you to run an Impact Analysis rule defined in Impact Analysis Manager. The URL

you create enables you to embed a topology map showing a simulation of all the Cls that are affected by the
selected trigger Cl for the selected severity and state. For details, see "Run Impact Analysis Dialog Box" on
page 211.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Impact map) > Finish Page
See also "IT Universe Manager" on page 158

User interface elements are described below:

ul
Element
(A-2) Description

Filter by Select the Cl types you do not want to appear in the impact analysis results.

Cl types o )

« Click L to select the required Cl types.

e Click K to delete the selected Cl types.
Rule Enables you to define where you can run Impact Analysis rules.
bundle

Severity Select the required severity from the drop-down list.

Note: The severity list was defined for the state in the System Type Manager. For details,
see "System Type Manager" on page 322.

For example, you can create an Impact rule in the Impact Analysis Manager (see the "Impact
Rules Definition Dialog Box" on page 314, that defines the severity of the trigger query node as
other than No Change. If you select a severity other than No Change, for example, Plan, the
condition is met and the simulated changes in the system are triggered.

For details, see "Run Impact Analysis Dialog Box" on page 211.
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ul
Element
(A-Z) Description

Trigger . Ciick L/ to select the Cls that are used as the triggers in an impact map. These Cls
Cls represent the simulated changes to be made to the system. Opens the Cl Selector dialog
box. For details on how to use the Cl Selector pane, see "C| Selector" on page 112.

b4
e

« Click to delete the selected Cls.

Direct Link Parameters - Model Editor

This wizard page enables you to embed the Model Editor into an external application, highlighting the selected
Cls in the CI Selector in the Model Editor.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Model Editor) > Finish Page
See also "Business Cl Models" on page 223

User interface elements are described below:

Ul Element (A-Z) Description
Model name Select the model you want to display in the Model Editor.

e Click |E| to open the Select Model dialog box. Select the model you want to appear
in the Model Editor.

b4
A

« Click to delete the selected model.

Selected Cl in Select the Cls you want to appear highlighted in the CI Selector in the Model Editor.

search e
« Click =l to open the Cl Selector.

x*
e

« Click to delete the selected Cls.

Direct Link Parameters - Query Editor

This wizard page enables you to embed the Model Editor into an external application, displaying the selected
TQL query.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.
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Wizard map Select Command Page (Embedded links > Query Editor) > Finish Page
See also "Business Cl Models" on page 223

User interface elements are described below:

Ul Element (A-
Z) Description
Query name Select the model you want to display in the Model Editor.

o Click |Z| to open the Select Query dialog box. Select the query you want to appear
in the Model Editor.

=
&+ Ty

e Click to delete the selected query.

Direct Link Parameters - Related Cls Page

This wizard page enables you to embed a topology map into an external application. The map displays a
specific Cl, and all the Cls that are linked to it by a distance of no more than one relationship.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.
« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Related Cls) > Finish Page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
Cls Select the Cl type you want to appear in the topology map.
o Click |£| to select the required Cl types. Opens the CI Selector dialog box.

by

o

« Click to delete the value in the Cls box.

Filter by Cl types  Restrict the results of the topology map to related Cls of one or more ClI types.

o Click ] to select the required Cl types.

b4
T

to delete the value in the Filter by CI types box.

o Click
Restrict to view Restrict the results of the topology map to related Cls from a specific view.
e Click E| to select the required view. Opens the View Selector dialog box.

%

o

« Click to delete the selected view in the Restrict results to view box.

Direct Link Parameters - Report Viewer Page

This wizard page enables you to create a URL that opens a specific report.
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Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Report Viewer) > Finish Page

Direct Link Parameters - Report Viewer - Saved Report Page

This wizard page enables you to create a URL that opens a saved topology or custom report.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Report Viewer - Saved Report) > Finish
Page

User interface elements are described below:
Ul Element (A-Z) Description
Report Select the required saved report.

e Click |j to open the Select Report dialog box. Select the required topology
or custom report.

e Click |E| to delete the selected report.

For information about saved reports, see Reports.

Direct Link Parameters - Show CI Properties Page

This wizard page enables you to view basic information for an existing Cl.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Show CI properties) > Finish Page
See also "Configuration Item Properties Dialog Box" on page 188

User interface elements are described below:
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Ul Element (A-Z) Description

Source Cl object ID Select the required ClI.

e Click |ﬁ| to select the source Cl and retrieve its object ID. Opens the Select
Source ClI dialog box. For details, see "C| Selector" on page 112.

=
&+t

» Click

to delete the value in the Source ClI object ID box.

Direct Link Parameters - Show View Topology Page

This wizard page enables you to display the topology map of the selected view and embed it in an external
application.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Show view topology) > Finish Page

User interface elements are described below:
Ul Element (A-Z) Description

Show topology of view , Cjick [ to select the required view to be opened by the URL. Opens the
View Selector dialog box.

=
A

o Click to delete the selected view in the Show topology of view box.

Direct Link Parameters - View Editor Page

This wizard page enables you to create a URL that opens a specific view in the Pattern View Editor in
Modeling Studio.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > View Editor) > Finish Page
See also "Building a Business View" on page 218

User interface elements are described below:
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Ul Element (A-Z) Description
View name « Click =/ to select the required view to be opened by the URL. Opens the
View Selector dialog box.
e Click x to delete the selected view in the View name box.

Direct Link Parameters - Views Selector Page

This wizard page enables you to embed into an external application, the View Selector, that enables you to
select, and display a view in that application.

Important « Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Embedded links > Views Selector) > Finish Page

See also "Building a Business View" on page 218

Direct Link Parameters - Show View Page

This wizard page enables you to create a URL to a specific view and optionally select a specific query node in
that view. When the view opens, the Cl you chose is selected in the view. The view opens in IT Universe

Manager.
Important » Forgeneral information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.
« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.
Wizard map Select Command Page (Open in context links > Show view) > Finish Page

User interface elements are described below:

Ul Element
(A-2) Description

<Left pane> A graphic illustration of the selected option.

Advanced Hide or display the Advanced pane in IT Universe Manager.
pane
(visibility)
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Ul Element
(A-2) Description
Select CI (Optional) Click to select a Cl and retrieve its object ID. When the view opens, the Cl you
from view chose is selected in the view.
result —
e Click |£| to choose the Cl you want selected in the target view and retrieve its object
ID. Opens the Select Cl dialog box. For details, see "Cl| Selector" on page 112.
e Click L to delete the object ID for the selected Cl in the Select Cl from view result
box.
Selected The target view to be opened by the URL.
View —
e Click |ﬁ| to select the target view to be opened by the URL. Opens the Select View
dialog box.
o Click ® to delete the selected view in the Selected view box.

View mode The view options are:

« View Topology. Displays an entire layer within a view.

« Related in View. Displays the selected Cl and its immediate neighbors within the
current view.

« Related in CMDB. Displays the selected Cl and its immediate neighbors in the
RTSM.

Direct Link Parameters - Start in Mode Page

This wizard page enables you to start the RTSM application at the selected page, for example, in the Modeling
Studio page.

Important « For general information about the Generate Direct Link wizard, see "Generate
information Direct Link Wizard" on page 89.

« Click Finish to close the wizard and create a URL. For details, see "Generate
Direct Link Dialog Box" on page 88.

Wizard map Select Command Page (Open in context links > Start in mode page) > Finish Page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Left pane> A graphic illustration of the selected mode.

Initial mode Starts the RTSM application in the selected mode.
Finish Page

This is the final page of the Generate Direct Link wizard. Click Finish to close the wizard and create a URL.
Opens the Generate Direct Link dialog box.
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Important For general information about the Generate Direct Link wizard, see "Generate Direct
information Link Wizard" on page 89.
Wizard map Select Command Page (<Open in context links options> and <Embedded links

options>) > Finish Page
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Chapter 4. Embedding RTSM Applets Using
Direct Links

This chapter includes:

® Using the Direct Link Functionality to Embed RTSM Applets ... ... 102
* RTSM Applet Tag Overview .. 102
® Direct Link Operation FIoW .. 103

Note: This chapter is relevant to integration developers only.

Using the Direct Link Functionality to Embed RTSM
Applets

You can directly embed RTSM applets into external applications using a direct link. A direct link is a URL that
you create using the Direct Links wizard. For details, see "Generate Direct Link Wizard" on page 89.

You can embed RTSM applets in the following ways:

« Using the URL itself to display RTSM content in an external application. For example, you can create a
URL in the Direct Links wizard to display the properties of a certain Cl. The login page opens if you are not
already logged into HPE Application Performance Management or if Lightweight Single Sign-On
Authentication Support (LW-SSO) is not enabled for HPE Application Performance Management.

Note: Using the URL to enable the integration requires opening the link in an [Frame or a new window.
This does not allow you to manage the resulting RTSM applet using Javascript due to cross-site
scripting issues. For example, if you use a URL that displays the properties of a specific Cl using the
object ID, you cannot use the same URL to display the properties of another CI.

« Using the RTSM applet tag to embed the RTSM applet in an external application. This enables integration
developers to display a part of the HPE Application Performance Management user interface as part of
their own application. In addition, this enables interaction with the embedded HPE Application
Performance Management user interface using Javascript.

RTSM Applet Tag Overview

The RTSM Applet tag creates the environment needed for the RTSM applet to run (HTML, Javascript, and
server session parameters). The code behind the tag can log into the HPE Application Performance
Management server in one of the following cases:

« Thelogin parameters are specified and the user is not already logged in (or if Lightweight Single Sign-On
Authentication Support (LW-SSO) is not enabled for HPE Application Performance Management).

« The clear session parameteris true.

HPE Application Performance Management (9.40) Page 102 of 393



Modeling Guide
Chapter 4: Embedding RTSM Applets Using Direct Links

Once a user session is established, the tag continues to write the required applet environment (HTML and
Javascript code) to the result of the JSP processor. The resulting HTML page includes the required Javascript
code to load the RTSM applet from the specified server. On error, the specified error string is printed to the
page. This string can be customized using the userErrorMessage parameter and may include HTML
elements and HTML wrapped Javascript code to initiate error handling scenarios.

Example of the Usage of an RTSM Applet Tag

<ucmdb:ucmdb_applet
serverConnectionString="http://server_name.server_domain:server_port"
serverType="UCMDB"
directLinkParameters="initViewName=NetworkTopology"
userName="user-name"

userPassword="password"

customerId="1"

encoded="false"

printDebuglLogs="true"

userkrrorMessage="This is your general error"
navigation="false"

clearSessionCookies="false"
command="ShowCISelector"/>

Caution: You retrieve the directLinkParameters from the URL created in the Direct Links wizard.
Insert the values for each parameter in the tag as displayed. If the URL contains values for
parameters not displayed above, copy them into the directLinkParameters line of the tag. For
details on how to create a direct link, see "Generate Direct Link Wizard" on page 89.

The RTSM applet tag is located at <HPE Application Performance Management>\odb\deploy\ucmdb-
ui\WEB-INF\tags\ucmdb_applet.tag on the Gateway Server machine.

You can copy the RTSM applet tag to an external application server. The RTSM applet tag requests the login
data from the HPE Application Performance Management server provided that:

« The external application server can communicate with JSP tags.

« The HPE Application Performance Management server is accessible to the external application server and
to the browser.

Direct Link Operation Flow

This section describes different scenarios in which direct links are used to embed RTSM applets into external
machines.
This section includes the flow descriptions:

« "Regular Login" on the next page
« "An Embedded RTSM Applet Using a Direct Link URL" on page 105
o "An Embedded RTSM Applet Using an RTSM Applet Tag" on page 106
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Regular Login

This flow describes a regular login to the HPE Application Performance Management server. It serves as a
base reference for the direct link flows.

HP Business

Service
Management/HP
Universal CMDB
Browser server
1
Y
2z -

-—

-— CN—

JV |-t

a3}
Y

1. The user enters the direct link URL (into the browser) to log into the HPE Application Performance
Management server.

2. The browser sends the login request to the HPE Application Performance Management server.
3. The server checks the user credentials and creates a user session if required.
4. The server returns the requested first page of HPE Application Performance Management.

Note: This can be any page. For this flow, we assume that it is the Admin > RTSM
Administration > Modeling page in which the RTSM applet is loaded.

5. The browser loads the Java virtual machine (JVM) with the code base location parameter (which

instructs the JVM from where to load the RTSM applet files) as the HPE Application Performance
Management server.

6. RTSM applet files (jars) and data are transferred between the HPE Application Performance
Management server and the JVM loaded in the browser.
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At this point, the RTSM applet is loaded and regards HPE Application Performance Management as the
server with which it should communicate.

An Embedded RTSM Applet Using a Direct Link URL

This flow shows how to use the direct link to open an RTSM applet (opened to a specified context) in a new

browser frame.
HP Business
Service
Management/HP
External Universal CMDB
Browser application server
I
1
Y
- 2
|
3
L
IFrame/MNew
browser window
4 >
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b 5 5
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- T
I
8
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The external application has a page that needs to show the RTSM applet.

The returned page includes a directive to open the direct link in an IFrame or new browser window.
The browser opens a new frame (IFrame or new window) with the direct link as the frame URL.
The new frame sends the direct link to the HPE Application Performance Management server.

a Db~

If the user is not already logged into HPE Application Performance Management, or if Lightweight Single
Sign-On Authentication Support (LW-SSO) is not enabled for HPE Application Performance
Management, HPE Application Performance Management displays the login page and waits for the user
to enter credentials and click the login button.

6. The user sessionis created, if required.

7. The HPE Application Performance Management server returns a page that includes the directive to load
the RTSM applet.

8. The browser processes the page. When the browser encounters the directive to load the RTSM applet, it
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starts the JVM. The browser then passes the needed parameters to the JVM, including the HPE

Application Performance Management server location as "code base."”

Management server and the JVM loaded in the browser.

RTSM applet files (jars) and data are transferred between the HPE Application Performance

Caution: The HPE Application Performance Management server must be accessible from the

browser machine.

An Embedded RTSM Applet Using an RTSM Applet Tag

This flow shows how to use the RTSM applet tag in conjunction with direct links to embed the RTSM applet

(opened to a specified context) in an external application page.

HP Business
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Management/HP
External Universal CMDB
Browser application server
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- 5 -
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JVM - 7 -

1. The RTSM applet tag is included in the processed JSP in the external application.

The RTSM applet tag uses the parameters given to it to create an HTTP/HTTPS connection to the HPE

Application Performance Management server and requests the applet HTML snippet code.

If the user is not already logged in, the parameters from the RTSM applet tag are used (see the tag itself

for reference information regarding this step). If login fails, the RTSM applet tag returns an error
message, either the preset one or the one specified in the RTSM applet tag parameters.

The HPE Application Performance Management server returns the HTML snippet code (with embedded

Javascript) that loads the RTSM applet. The external application can now incorporate this snippet code
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into the page, and send the page to the browser.
5. The external application sends the complete page that includes the HTML snippet code to the browser.

6. The browser processes the page. When the browser encounters the HTML snippet code that loads the
RTSM applet, the JVM is started. The browser then passes the needed parameters to the JVM, including
the HPE Application Performance Management server location as "code base".

7. RTSM applet files (jars) and data are transferred between the HPE Application Performance
Management server and the JVM loaded in the browser.

Caution: The HPE Application Performance Management server must be accessible from both the
browser machine as well as the external application machine.
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This chapter includes:

® Cl Selector OVerVieW .l 108
* How to Display aView inBrowse Mode . ... ... .. 108
* How to Searchfor Clsin Search Mode . ... .. 109
* How to Modify Cl Selector Display OptioNns ... .. . 110
® ClSelectorUserInterface . ... 110
* Troubleshooting and Limitations — Cl Selector . . 122

Cl Selector Overview

Note: The Cl Selector was known as View Explorer in earlier versions of HPE Application Performance
Management.

The Cl Selector presents the elements of the IT universe model in HPE Application Performance
Management through the medium of views. HPE Application Performance Management displays the ClI
Selector in the left pane of IT Universe Manager and the Modeling Studio.

When you select a view in the Cl Selector, the configuration items (Cls) contained in the view are displayed in
a hierarchical tree format according to the relationships defined between the Cls. A view may be empty if no
Cls were found matching the TQL query. For details on views, see "View Formats" on page 218.

You can use the Cl Selector to select views and to locate Cls. You can select a view and browse through the
list of Cls, or you can search for a specific Cl by name or by Cl type. You can also save the search criteria for
future use.

For information on the components of the Cl Selector, see "Cl| Selector User Interface" on page 110.

How to Display a View in Browse Mode

When the CI Selector is set to Browse mode, you can display the contents of a selected view. For details on
the CI Selector user interface in Browse mode, see "C| Selector" on page 112.

This task includes the following steps:

« "Prerequisites" below

« "Select a View to Display" below

1. Prerequisites

In the CI Selector pane, select Browse Views mode.

2. Select a View to Display

Click the ellipsis |Z| button to open the View Selector dialog box and select the view you want to display.
The name of the selected view is shown in the View box. The Cls in the view appear in the Cl tree in the
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lower part of the Cl Selector pane. The view remains selected when you move to other applications in
HPE Application Performance Management.

How to Search for Cls in Search Mode

The CI Selector search tool enables you to locate a specific Cl. The search is executed on the entire RTSM.
For details on the Cl Selector search tool user interface, see "Cl Selector" on page 112.

This task includes the following steps:
« "Prerequisites" below
« "Search by CI Name or Global ID" below
« "Search by Configuration Iltem Type" below
« "Runthe Search and Sort the Results" below

« "Runan Advanced Search" on the next page

Prerequisites

In the CI Selector pane, select Search Cls mode and select the Simple tab.

Search by Cl Name or Global ID

To search for Cls by name, enter a string in the CI Name box, representing the name of the Cl, or part of the
name. The search returns all Cls that contain the entered string somewhere in their names (within the
boundaries of the other search criteria that you define).

Alternatively, enter the global ID of a Cl in the C| Name box. You need to enter the full global ID.

Note: The search by Cl name option is not case sensitive.

Search by Configuration ltem Type

You can search for Cls using the Cl Type box. This search returns Cls of the type specified in the Cl Type
box.

Click the ellipsis IZI button and select the required Cl type. You cannot manually enter a CIT in the Cl Type
box.

After defining a Cl in the Cl Type box, HPE Application Performance Management remembers your selection
until you move to a different application, or until you define a different value.

Run the Search and Sort the Results

Run the search. The results appear in the lower part of the Cl Selector pane, showing the Cl name and type
for each entry. You can sort the search results by clicking the appropriate heading.

When you select the required CI from the results list, the right pane displays details for the Cl you selected, in
the context in which you are working. To see a Cl in the context of its view, right-click the Cl and select
Locate Cl in View. The Cl Selector reverts to Browse mode and displays the view that contains the ClI, with
the Cl selected in the view tree.

When you select a Cl in the search results, the Cl appears in the topology map with its related Cls in the
RTSM.
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Optionally, save the search criteria by clicking the Save || button and entering a name for the search. For
details, see "Save Search Criteria Dialog Box" on page 121.

Run an Advanced Search

You can select the Advanced tab for other search options. For details on the Cl Conditional search, see "Cl
Conditional Search Dialog Box" on the next page. For details on the Running Software search, see "Running
Software Search Dialog Box" on page 121.

How to Modify Cl Selector Display Options

You can modify the display options for the CI Selector. These options are configured in the Infrastructure
Settings Manager.

Caution: Modifying certain settings in the Infrastructure Settings Manager can adversely affect the
performance of HPE Application Performance Management. Do not modify settings without first
consulting HPE Software Support or your HPE Professional Services representative.

This task includes the following steps:

« "Prerequisites" below
+ "Modify Selected Settings" below

1. Prerequisites

Access the Infrastructure Settings Manager by selecting Admin > Platform > Setup and Maintenance
> Infrastructure Settings.

2. Modify Selected Settings

The following settings under RTSM - General properties can be modified:

« Immediate Children Count. Number of children immediately displayed when expanding their
parent's query node in the Cl Selector.

« Maximal Children Count. Maximum number of children displayed under their parent's query node in
the CI Selector.

« Maximal search results size. Maximum number of CMDB instances that can be returned in one
search operation.

« Recently Used Views List size. Maximal number of recently used views to store per user.

Cl Selector User Interface

This section includes (in alphabetical order):

¢ Cl Conditional Search Dialog BoX ... ... . 111
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R O 1= 1Yo (o 112
® Organize Searches Dialog BOX ... 120
* Running Software Search Dialog BOX ... ... .. .. 121
¢ Save Search Criteria Dialog BOX ... il 121

Cl Conditional Search Dialog Box

This dialog box enables you to search for Cls by attribute conditions, by related Cls, and by attribute
conditions of related Cls.

To In the CI Selector, select the Advanced tab in Search mode and click the ellipsis button next to
access  Cl Conditional Search.

See "Cl Selector Overview" on page 108

also

User interface elements are described below:

Ul Element

(A-Z) Description

Attribute Select an attribute from the drop-down list.

name
Note: If you select Display Label from the Attribute name list, the operator Like
ignore case does not appear in the Operator list since a Display Label Like ignore
case condition can be added using the Cl name/Related Cl Name.

Cl Name Enter a Cl name for which to search.

Cl Type Click the ellipsis =/ button to select a Cl type from the tree.

Intc_egration If you want to run your search over federated Cls also, click the ellipsis | button to select

Points the target integration points for the Cls.
Note: If you select a disconnected integration point for your search, an error message
appears when the search is run, asking if you want to see local search results.

Operator Select an operator from the drop-down list.

Related CI Enter the name of arelated CI for the search.

Name

Related CI Click the ellipsis -/ button to select a Cl type from the tree for a search by related Cl.

Type

Relationship  cjick the ellipsis =/ button to select a relationship from the tree for a search by related ClI.

Type
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Ul Element
(A-2) Description

Search by Select the check box to run a search for Cls with the specified conditions.
Cl

(e Each row represents an attribute condition that you specify. Use the And/Or column and
conditions

the Brackets columns to link multiple conditions. Select NOT if you want the condition
statement to do the opposite of what is defined. In this way, you can construct a more
precise logical statement to generate the required results.

5 Add attribute condition. Adds an attribute condition row. Select the attribute name,
operator, and value to define the attribute condition.

22)

“/ Delete selected row. Deletes the selected attribute condition.
W Move selected row up. Moves the selected row up.

| Move selected row down. Moves the selected row down.
. Show Criteria. Displays the criteria of the selected condition in a pop-up dialog box.

Search by Select to run a search for Cls related to Cls with the specified conditions.

related CI
conditions Note: If you select Display Label from the Attribute name list, the operator Like

ignore case does not appear in the Operator list since a Display Label Like ignore
case condition can be added using the Cl name/Related Cl| Name.

Search by Select to run a search for Cls related to the specified Cls or Cl types.

related CI

criteria

Value Enter a value for the attribute condition.
Cl Selector

This feature enables you to select views and to locate Cls.

To access | Appears in the left pane of the IT Universe Manager page and the Modeling Studio.

Important = The CI Selector consists of two functional formats: Browse Views mode and Search Cls
information mode.

« InBrowse Views mode, you can search for and display a view, and browse through the
view to locate a particular Cl. You can also perform operations on the Cl from a shortcut
menu.

« In Search Cls mode you can search for one or more Cls in the RTSM by name or by ClI
type.

Note: Many of the features of the Cl Selector are only relevant in the RTSM and not in
other HPE Application Performance Management modules.
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Relevant "How to Display a View in Browse Mode" on page 108

tasks "How to Search for Cls in Search Mode" on page 109

See also "Cl Selector Overview" on page 108

Browse Views Mode

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
|%| Refresh Cls Tree. Refreshes the data content of the hierarchical tree
o structure that may have been modified by other users.
Py Show Template Parameters. Opens the Template Parameter Values
dialog box, which enables you to edit the parameters of the selected
template.

Note: This button is only active when a template is selected.

3 Add selected Cls to model/view. Adds the selected Cls to the current
model or view.

Note: This button only appears in the Modeling Studio.

& Add to model as related Cls. Adds the selected Cl to the model as a
related ClI.

Note: This button is only active in the Model Editor of the Modeling
Studio.

1Y Open selected model in a new tab. Opens the selected model in the
Model Editor.

Note: This button is only active when a model is selected in the
Modeling Studio.

B Show models containing selected Cl. Displays a list of models
containing the selected CI.

Note: This button only appears in the Modeling Studio.

| In IT Universe Manager, this represents Show View Definition, which
takes you directly to the view definition in the Modeling Studio for the
current view.

In the Modeling Studio, this represents Open selected view, which opens
the selected view in the Editor pane.

HPE Application Performance Management (9.40) Page 113 of 393



Modeling Guide

Chapter 5: Working with the CI Selector

Ul Element (A-Z)

)

L3

(G

Description

Show views containing selected Cl/model. Displays a list of views
containing the selected Cl or model.

Note: This button only appears in the Modeling Studio.

Generate view for selected model. Opens the Creating New View dialog
box which enables you to build a view based on the selected model.

Note: This button is only active when a model is selected in the
Modeling Studio.

Show Discovery and Changes Summary. Enables you to rediscover all
the Cls in a selected view by manually starting the DFM jobs that originally
discovered them. For details, see "Show Discovery Status and Changes
Dialog Box" on page 213.

Note: This button only appears in IT Universe Manager.

Generate Direct Link to View. Enables you to create a direct link to the
view using the Direct Links wizard.

Note: This button only appears in IT Universe Manager.
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Ul Element (A-Z) Description

& Export Browse Results to File. Enables you to export the browse results.
Choose the export format from the following options:

« Excel. The table data is formatted as an .xIs (Excel) file that can be
displayed in a spreadsheet.
« PDF. The table data is exported in PDF format.

Note: When exporting Cls to PDF format, the maximum number of
Cls that can be exported is approximately 20,000, depending on the
amount of text associated with the exported Cls. It is also
important to select a reasonable number of columns to display to
ensure that the report is legible.

« RTF. The table data is exported in Rich Text Format.
« CSV. The table data is formatted as a comma-separated values (CSV)
text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. In Windows, to
verify or modify the list separator value, open Regional Options

from the Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value.

o XML. The table data is formatted as an XML file which can be opened in
a text or XML editor.

Tip: To extract HTML code from the report:

o Open the file in an HTML editor.
« Copy the relevant table into the target file.

i Snapshots. Enables you to work with snapshots. The following options are
available:

« Save Snapshot. Select to open the Save Snapshot dialog box, which
enables you to save a snapshot of the view. For details, see "Save
Snapshot Dialog Box" on page 213.

« Compare Snapshots. Select to run the Compare Snapshots Report.
« Schedule Snapshot. Select to open the Schedule Job dialog box.

« Show Scheduled Snapshot Jobs. Select to open the Job List dialog
box.

Note: This button only appears in IT Universe Manager.

[R View Based Report. Displays the topology report for the selected view.

Note: This button only appears in IT Universe Manager.
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Ul Element (A-Z) Description

[H Note: This button only appears in IT Universe Manager.
Asset Report. Opens the Asset report for the selected view.
Click the ellipsis button to the right of the View box, to open the View

Selector dialog box. You can browse through the folder tree to locate the
view you want to display.

&) @ Enables you to move to the next or previous result of the search for the
string entered in the Find box.

<Cls> The Cls contained in the currently selected view.

<Tooltip> Hold the cursor over a Cl to display a tooltip with the relevant Cl type.

Find Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in
the Cl tree.

View The View box displays the currently selected view. To select a view to

display, click the down arrow on the right side of the View box; this displays
an abridged list of views, containing the most recently accessed views.
Click the arrow at the bottom of the list to scroll through the entire list. The
recently accessed views appear at the top of the drop-down, above the
dividing line. The complete list of views appears below the line.

Alternatively, place the cursor in the list and begin typing the view name. If
the first few letters that you type match an existing entry, HPE Application
Performance Management completes the view name. If the names of
several views begin with those letters, all matching views are displayed in
the list.

Note: If the selected view in the View box fails to load, the value in the
View box is set to the default (empty) selection.

Search Cls Mode

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
&3 Show Search Results in Table. Opens a separate pane with a table of

the Cls in the search results.

Note: This button only appears in IT Universe Manager.
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Ul Element (A-Z) Description

E ) Add selected Cls to model/view. Adds the selected Cls to the current
model or view.

Note: This button only appears in the Modeling Studio.

i Add to model as related Cls. Adds the selected Cl to the model as a
related CI.

Note: This button is only active in the Model Editor of the Modeling
Studio.

1N Open selected model in a new tab. Opens the selected model in the
Model Editor.

Note: This button is only active when a model is selected in the
Modeling Studio.

£ Show models containing selected Cl. Displays a list of the models
containing the selected ClI.

Note: This button only appears in the Modeling Studio.

e Show views containing selected Cl/model. Displays a list of the views
containing the selected CI or model.

Note: This button only appears in the Modeling Studio.

Ll Generate view for selected model. Opens the Creating New View
dialog box which enables you to build a view based on the selected model.

Note: This button is only active when a model is selected in the
Modeling Studio.
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Ul Element (A-Z) Description

& Export Search Results to File. Enables you to export the search results.
Choose the export format from the following options:

« Excel. The table data is formatted as an .xIs (Excel) file that can be
displayed in a spreadsheet.

« PDF. The table data is exported in PDF format.

Note: When exporting Cls to PDF format, the maximum number
of Cls that can be exported is approximately 20,000, depending on
the amount of text associated with the exported Cls. Itis also
important to select a reasonable number of columns to display to
ensure that the report is legible.

« RTF. The table data is exported in Rich Text Format.

« CSV. The table data is formatted as a comma-separated values (CSV)
text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. In Windows, to
verify or modify the list separator value, open Regional Options
from the Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value.

o XML. The table data is formatted as an XML file that can be opened in
atext or XML editor.

Tip: To extract HTML code from the report:
o Open the file in an HTML editor.

o Copy the relevant table into the target file.

Manage the list of saved searches. Opens the Organize Searches
dialog box, where you can edit or delete searches from the list of saved
searches.

|_|||__f]

Collapse/Expand Search Criteria Panel. Collapses or expands the
search criteria area.

¥

Start the Search. Runs the search. The search results are displayed in
the lower part of the Cl Selector pane.

J Save the Last Search Pattern. Saves the current search criteria for
future use.

&) @ Enables you to move to the next or previous result of the search for the
string entered in the Find field.
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Ul Element (A-Z)

<Search results>

Advanced tab

Cl Name

Cl Type

Find

Searches

Search results count

Simple tab

Description

After you run the search, the results are listed in the lower part of the ClI
Selector pane. The results are shown in two columns:

« Name. Contains the name of the CI.
« CI Type. Contains the Cl type of the CI.

If the Cl or view name is abbreviated, hold the pointer over the entry to see
the full name. You can sort the search results by clicking the appropriate
heading.

The following detailed search options are available:

« CI Conditional Search. Enables you to search for Cls by attribute
conditions, by related Cls, and by attribute conditions of related Cls.

« Running Software Search. Enables you to search for hosts by the
applications running on them and for applications by the host on which
they are running.

For each of the searches, click the ellipsis L=/ button to open the search

dialog box. After running a search, click Save J to save the search for
future use.

To search for a Cl by name, enter the name or global ID of the Cl for which
to search.

To search for Cls by Cl type, click the ellipsis button to select a Cl from
the Select Configuration Item Type dialog box.

Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in
the search results.

Select a search from the drop-down list of saved searches.

The Search results count below the Find box displays the total number of
Cls found in the search.

The Simple tab includes the standard search functionality. Click the
Advanced tab for more detailed search options.

Shortcut Menu Options

Menu Item

<IT Universe
Manager shortcut
menu options>

Add

Description

The regular shortcut menu for the topology map in IT Universe Manager is also
available from the Cl Selector. For details on the menu options, see "IT Universe
Manager Page" on page 197.

Adds the selected ClI to the current model or view.

Note: This feature only appears in the Modeling Studio.
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Menu Item Description
Add to model as Adds the selected Cl as arelated Cl to the current model.
related Cls

Note: This feature only appears in the Modeling Studio.

Generate view for Select to create a view based on the current model. The Creating New View dialog
selected model box opens which enables you to select a perspective to apply.

Note: This feature only appears in the Modeling Studio.

Open selected Opens the selected model in a new tab in the Model Editor.
model in a new tab
Note: This feature only appears in the Modeling Studio.

Show containing Select Show models containing selected CI to display a list of the models
models containing the selected CI.

Note: This option only appears in the Modeling Studio.

Show containing Select Show views containing selected Cl/model to display a list of the views
views containing the selected Cl or model.

Note: This option only appears in the Modeling Studio.

Organize Searches Dialog Box
This dialog box enables you to edit or delete searches from the list of saved searches.

To access Click the Manage the list of saved searches i button in the ClI Selector.

See also "Cl Selector Overview" on page 108

User interface elements are described below:

ul

Element

(A-2) Description

pe Click to edit the selected search. For simple searches, the Cl Simple Search dialog box
opens, which enables you to edit the name and type of the Cl. For Cl Conditional searches,
the CI Conditional Search dialog box opens.

S Click to delete the selected search.

Es Click to expand the search tree.

Bl Click to collapse the search tree.
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ul

Element

(A-2) Description

<Searches Displays all the saved searches in tree format.

tree>

Find Enter a search name or a portion of a search name in the Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Click to go to the previous occurrence of the selected search phrase in the list.
Previous

Running Software Search Dialog Box

This dialog box enables you to search for hosts by the applications running on them and to search for
applications by the host on which they are running.

To In the CI Selector, select the Advanced tab in Search mode and click the ellipsis button next to
access Running Software Search.

See "Cl Selector Overview" on page 108
also

User interface elements are described below:

ul

Element

(A-Z) Description

Host Enter the name of the node for which you are searching.
name

Running | Select a running software Cl from the drop-down list.

Software
Note: The drop-down list may not display an accurate list of available running software Cl

types (only the option Any appears). In this event, perform the Host name search only.

Search Select Running Software or Node.

for
Note: To search for a running software CI running on a specific node, enter a node name,

select the required running software Cl and click Search to search for it.

Save Search Criteria Dialog Box

This dialog box enables you to save the current search criteria for future use.

To access Click Save ] from Search mode in the Cl Selector.

See also "Cl Selector Overview" on page 108
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User interface elements are described below:

Ul Element (A-Z) Description

Existing Queries Displays a list of existing searches in tree format.

Name Enter a name for the current search.

Find Enter a search name or a portion of a search name in the Find box to locate it in the list.
Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Previous Click to go to the previous occurrence of the selected search phrase in the list.

Troubleshooting and Limitations - Cl Selector

This section describes troubleshooting and limitations for the Cl Selector.

Unavailable Views and Cls

The View list in the Cl Selector may not display all views in the RTSM, or it may not display the contents of a
view, for any of the following reasons:

« The View list includes only the views for which you have the necessary permissions. Similarly, Search
mode is only available if you have Cl Search permission. To set permissions, select Admin > Platform >
Users and Permissions, select a user or a group and select Permissions. For more information, see
"How to Assign Permissions" in APM Platform Administration Guide.

« Views that are currently inactive appear in red in the View list, but they cannot be selected. In IT Universe
Manager, inactive views appear in faded text.

« Out-of-the-box views for which you do not have a license may appear in the View list, but these views do
not contain Cls. For information on the out-of-the-box views, see "Predefined Folders and Views" on page
221.

Note: After deleting one or more query nodes from a TQL query, it can take time for changes to be
updated to the view; meanwhile, the removed Cls appear in the view. If you select one of these Cls
before it is updated, an error message is displayed. Click the Refresh button to update the view.
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This chapter includes:

® Topology Map OVEIVIEW .. ... ...t 123
® Handling Large VieWs ... 123
® Topology Map UserInterface ... . ... . . 124

Topology Map Overview

The Topology Map provides a graphical display of a view. All the Cls in a given layer of the view are
represented by icons and the connecting lines represent relationships. You can select a Cl in the Topology
Map or in the Cl Selector in the left pane. You can also drill down in the CI Selector to display different layers
of the view in the Topology Map.

The label of a Cl appears under the icon. You can set the maximum number of characters per line and the
maximum number of lines in a Cl label in the User Preferences dialog box under General. For details, see
"User Preferences Dialog Box" on page 77.

A Cl that has an additional Cl layer beneath it, created by the hierarchy set for the view, appears with a
downward arrow icon in the Topology Map, as well as a count indicator displaying the total number of Cls in all
of the sublayers under it. You can click the arrow to display the Cls contained in the sublayer.

g

=

182.168.214.012

When you hold the pointer over the Cl icon, a tooltip displays the Cl's details. When you hold the pointer of the
count indicator, a tooltip displays a breakdown of the Cls beneath that CI by CI type.

The topology map is automatically updated dynamically with changes in the IT Universe data, such as new
Cls discovered by the Data Flow Management process.

The toolbar and Main Menu above the Topology Map enable you to zoom in, change the layout of the Topology
Map, and print the Topology Map. Additional functionality is available from the shortcut menu by right-clicking
a Cl in the Topology Map or in the Cl Selector.

Handling Large Views

The Topology Map cannot display a view with more than 900 Cls in a single layer. When you select a view
which contains a layer with more than this number of Cls, the Topology Map appears empty. A layer with
more than 900 Cls can be displayed in a table in Text mode.

To display large views in the Topology Map, use one of the following methods:

« Reduce the TQL query results by redefining the view in the Modeling Studio. For details, see "Change
Query Node/Relationship Type Dialog Box" on page 246.

« Define a different hierarchy for the view to redistribute the Cls among the view's layers. For details on
defining hierarchy, see "Setting the View Hierarchy" on page 219.
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« Reset the maximum number of Cls allowed in the configuration parameters. Select the Max Object

Count GUI for TS parameter under RTSM - Visualization Settings in the Infrastructure Settings
Manager. However, be aware that increasing the maximum number of Cls per layer may significantly slow
down the redrawing of the Topology Map.

To modify the setting, select Admin > Platform > Setup and Maintenance > Infrastructure Settings >
Foundations > RTSM. Locate Max Object Count GUI for TS and change the value to the required
number.

Topology Map User Interface

This section includes (in alphabetical order):

Export Map to Image Dialog BOX .. ... 124
Layout Properties Dialog BOX ... ... oo 125
Maain M eNU . 136
Print Dialog BoOX . ... 137
Print Preview Dialog BOX . ... 138
Print Setup Dialog BoX ... ... L 138
Toolbar OptioNS il 139
Topology Map Sidebar ... ... . L 147

Export Map to Image Dialog Box

This dialog box enables you to save a topology map to afile.

To access From a topology map, select Operations > Export Map to Image.
Relevant tasks "How to Print and Save a Topology Map to File" on page 182
See also « "Topology Map Overview" on the previous page

« "Topology Map User Interface" above

User interface elements are described below:

HPE

Ul Element (A-Z) Description
Actual Size Save the view so that the graph node sizes are at maximum.
Current Zoom Level Save the view as you see it on the topology map. For example, if

you have used the Interactive Zoom mode to decrease the view
magnification, the graph nodes also appear smaller in the saved
view. For details, see "Interactive Zoom" on page 143.

Custom Specify the size of the view you want to save in the Width and
Height boxes.
File Name Specify the required file name and location (or click Browse to

search for the file and location).
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Ul Element (A-Z) Description

Fit in Canvas Expand or shrink the view so that it fits in the pane.

Image Quality The quality of the printed map. Select High, Medium, or Low.

Selected Objects Only Saves only the graph nodes/Cls and their relationships that you
selected in the map.

Type Select the required file format.

Visible Window Only Saves only the part of the graph that appears in the pane.

Layout Properties Dialog Box

This dialog box enables you to customize the layout of a specific layer in a view, to achieve the clearest
presentation possible and to better understand and monitor the managed data.

To access | Select Layout > Layout Properties.

Important | You define the layout of a view's layers by assigning logical positions for the graph's nodes
information = and relationships that appear in a layer. You customize the layer layouts by modifying the
default values.

You set layout definitions for a specific layer only. The definitions cannot be saved for a
different layer or a different view.

Parameter values are in pixels.

See also » "Topology Map Overview" on page 123
« "Topology Map User Interface" on the previous page

Global Tab

This area enables you to define global layout parameters.
To access Click the Global tab in the Layout Properties dialog box.
Important information The Global tab enables you to define global settings for the layout.

User interface elements are described below:

ul
Element
(A-2) Description

Drawing Select one of the following options for fitting the layout:
Fitting « Fit to Canvas. Fit the layout to the canvas on the screen.
« Fit for Printing. Fit the layout to a page for printing.

« No Fitting. Do not change the layout.
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ul
Element
(A-2) Description

Labeling Select Perform Labeling to ensure that the labels appear when the layout is redrawn. If this
field is not selected, labels do not appear in the redrawn layout.

Style Select Apply Style Deeply to apply the layout selected to all nested layers of the topology
map.
All Styles Tab

To access Click the All Styles tab in the Layout Properties dialog box.

Important The All Styles tab enables you to define general layout parameters for disconnected graph
information nodes and connected components.

« Adisconnected graph node is a node that is not connected to any other graph node.

« Adisconnected component is a component that is not connected to any other
component. It contains a set of graph nodes that can be connected to each other.

This illustrates a connected component with five graph nodes:

e

This illustrates a connected component with two graph nodes:

O—0

This illustrates four disconnected components, each made up of a single, disconnected

graph node:

OO
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User interface elements are described below:

Ul Element
(A-Z)

Components

Disconnected
Graph Nodes

Margin
Spacing

Circular Tab

To access

Important
information

Description

The spacing between the components in a disconnected graph consists of both a constant
value and a proportional value based on the sizes of the components.

Select Detect Components to view the disconnected components. You can specify that
all components be laid out together or individually, regardless of the other components. If
the grouping for components is selected, each component is laid out, and the resulting
components are packed together.

When Detect Components is selected, enter values for the following settings:

« Constant Spacing. Set constant spacing (horizontal and vertical) around each
disconnected component.
Default value: 20

« Proportional Spacing. Set spacing (horizontal and vertical) that is proportional to the
size of the component around each disconnected component.
Default value: 0.05

The spacing between the graph nodes in a disconnected graph consists of both a constant
value and a proportional value based on the sizes of the graph nodes.

Select Detect Disconnected Graph Nodes to view the disconnected graph nodes. You
can specify that disconnected graph nodes be grouped into one component or laid out
individually.

When Detect Disconnected Graph Nodes is selected, enter values for the following
settings:

« Constant Spacing. Set constant spacing (horizontal and vertical) around each
disconnected graph node.
Default value: 20

« Proportional Spacing. Set spacing (horizontal and vertical) that is proportional to the
size of the component around each disconnected graph node.
Default value: 0.05

Enter values for the right, left, top, and bottom margin spacing for the layout.

Click the Circular tab in the Layout Properties dialog box.

The Circular tab enables you to group a graph's nodes into groups or clusters based on the
grouping options you select. It is particularly suited for visualizing ring and star network
topologies, and for link analysis.

User interface elements are described below:
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ul
Element
(A-2) Description

Clustering = Set the values for the following settings:

« Cluster Size Factor. Specifies the ratio between the average cluster size and the number
of clusters. The size of a cluster is defined as the sum of the weights of all graph nodes in
the cluster. You can assign a weight value to each graph node.

o Min Number of Clusters. The minimum number of clusters in a layer.

« Max Number of Clusters. The maximum number of clusters in a layer.

Cluster Displays clusters either in a symmetric or circular layout style.
;?ny:LIt Select one of the following options:

« Symmetric. Displays clusters in a symmetric layout style.

R e

Circular. Displays clusters in a circular layout style.
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ul

Element

(A-2) Description

Layout Adjusts the quality of the layout produced to fit your application's needs. The quality reflects
Quality the number of steps or the method used to produce the layout. For example, high quality is

sharper but takes more time to set the layout.
Select one of the following options:

« Draft. Produces faster results (faster than Medium and Proof).

o Medium. Produces a result that is a combination of Draft and Proof, that is, it produces a
more accurate graph layout than Draft, but not as accurate as Proof.

« Proof. Produces a more refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality setting
varies depending on the nature of the graph being laid out. You can try each option to
determine which works best for you.

HPE Application Performance Management (9.40) Page 129 of 393



Modeling Guide
Chapter 6: Working with the Topology Map

ul
Element
(A-2) Description

Spacing Sets the spacing around each graph node within the same cluster and between clusters.

Enter values for the following settings:

« Between Graph Nodes. Sets the spacing around each graph node within the same
cluster. The larger the spacing, the more graph nodes there are on the cluster boundary.

Default value: 50
This illustration shows smaller graph node spacing:

This illustration shows larger graph node spacing:

« Between Clusters. Sets the spacing between clusters.

Default value: 50
This illustration shows smaller cluster spacing:

s

This illustration shows larger cluster spacing:

-

Hierarchical Tab

To access  Click the Hierarchical tab in the Layout Properties dialog box.

Important The Hierarchical tab shows the precedence relationships that can represent organizational

information = or information management system dependencies, as well as process models, software call
graphs, and work flows. The hierarchical layout emphasizes dependencies by placing the
graph nodes at different levels.

User interface elements are described below:
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Ul Element
(A-Z)

Backward
Edges

Horizontal
Spacing

Layout
Quality

Description

Specifies how backward relationships are displayed in the hierarchical layout.
Select one of the following options:

o Minimize Backward Edges. Sets the number of backward relationships displayed in a
layer to a minimum.

« Optimize for Feedback Flow. Sets the number of backward relationships displayed in a
layer to a maximum. This mode is more appropriate for flow charts.

Enables you to set the minimum horizontal distance between two neighboring graph nodes at
each level.

Enter values for the following settings:

- Between Graph Nodes. Sets a horizontal space around each graph node in the layer.
Default value: 28

« Between Edges. This setting is available only when you select Routing > Orthogonal.
It sets a horizontal space between edges in the graph.
Default value: 12

Adjusts the quality of the layout produced to fit your application's needs. The quality reflects
the number of steps or the method used to produce the layout. For example, high quality is
sharper but takes more time to set the layout.

Select one of the following options:
« Draft. Produces faster results (faster than Medium and Proof).

Draft

o Medium. Produces a result that is a combination of Draft and Proof, that is, it produces a
more accurate graph layout than Draft, but not as accurate as Proof.

o Proof. Produces a more refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality setting
varies depending on the nature of the graph being laid out. You can try each option to
determine which works best for you.
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Ul Element

(A-Z) Description

Level Enables you to set the way graph nodes are vertically aligned.
Alignment

Select one of the following options:

o Top. This illustration shows that the top of the graph nodes at the same level of the
hierarchy are aligned:

« Center. This illustration shows that the center of the graph nodes at the same level of the
hierarchy are aligned:

« Bottom. This illustration shows that the bottom of the graph nodes at the same level of
the hierarchy are aligned:

Orientation Enables you to set the orientation of the hierarchy.
Select one of the following options:

« Top to Bottom. The children are located above the parent.

« Left to Right. The children are located to the left of the parent.
- Bottom to Top. The children are located below the parent.

« Right to Left. The children are located to the right of the parent.

Orthogonal This setting is available only when you select Routing > Orthogonal. Maintain the size of a

Routing - graph node. Clear this option if you want the layout to increase the size of a graph node, if it
Fix Node is necessary to maintain the specified relationship spacing, when more than one relationship
Sizes is attached to the same side of the graph node.
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Ul Element
(A-Z) Description
Polyline This setting is available only when you select Routing > Polyline. Polyline routing routes
Routing - edges (connecting lines) as one or more straight line segments with arbitrary angles. Path
Spacing nodes are added automatically to prevent the edges (connecting lines) from overlapping.
Between b ofault Value: 12
Bends
Routing Select the type of routing for the layout. The available options are:

« Orthogonal

« Polyline

Undirected Edge direction is not used to build the levels of the hierarchical drawing.

Layout

Variable Variable level spacing adjusts the spacing between pairs of neighboring levels according to

Level the density of edges between the levels.

Spacing If the drawing's edges are orthogonally routed, this ensures the desired vertical spacing
between horizontal edges (in a top-to-bottom or bottom-to-top layout) routed between levels.
If the routing is polyline, variable level spacing makes it easier to distinguish among edges in
very dense drawings.

Vertical Enables you to set the minimum vertical distance between two neighboring graph nodes on

Spacing different levels.

Enter values for the following settings:

. Between Graph Nodes. Sets a vertical space around each graph node in the level.
Default value: 28

« Between Edges. This setting is available only when you select Routing > Orthogonal.
It sets a vertical space between edges in the graph.
Default value: 12
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Orthogonal Tab

To access Click the Orthogonal tab in the Layout Properties dialog box.
Important The Orthogonal tab enables you to set orthogonal layout route relationships horizontally
information and vertically. This results in relationships bending at 90-degree angles only.

User interface elements are described below:

ul
Element
(A-2) Description

Fix Node | Maintain the size of a graph node. Clear this option if you want the layout to increase the size
Sizes of a graph node if it is necessary to maintain the specified relationship spacing when more
than one relationship is attached to the same side of the graph node.

Horizontal Enables you to set the minimum horizontal distance between graph nodes.

Spacing  goject one of the following options:

« Between Graph Nodes. Set a horizontal space around each graph node in the layer.
Default value: 20
« Between Edges. Set a horizontal space between elements in the layer.
Default value: 12
Layout Adjusts the quality of the layout produced to fit your application's needs. The quality reflects

Quality the number of steps or the method used to produce the layout. For example, high quality is
sharper but takes more time to set the layout.

Select one of the following options:

« Draft. Set the layout to draft quality.
o Medium. Set the layout to medium quality.
« Proof. Set the layout to proof quality.
Vertical Enables you to set the minimum vertical distance between graph nodes.
Spacing Select one of the following options:
« Between Graph Nodes. Set a vertical space around each graph node in the layer.
Default value: 100
- Between Edges. Set a vertical space between elements in the layer.

Default value: 20

Symmetric Tab
To access Click the Symmetric tab in the Layout Properties dialog box.

Important The Symmetric tab displays a clear representation of complex networks. The symmetric
information  layout emphasizes the symmetries that may occur in a graph.

HPE Application Performance Management (9.40) Page 134 of 393



Modeling Guide
Chapter 6: Working with the Topology Map

User interface elements are described below:

Ul
Element
(A-2) Description

Layout = Adjusts the quality of the layout produced to fit your application's needs. The quality reflects the
Quality | number of steps or the method used to produce the layout. For example, high quality is sharper
but takes more time to set the layout.

Select one of the following options:

« Draft. Produces faster results (faster than Medium and Proof).

« Medium. Produces a result that is a combination of Draft and Proof, that is, it produces a
more accurate graph layout than Draft, but not as accurate as Proof.

« Proof. Produces a more refined result but takes more time.

Note: The differences between the speed and resulting layout of each quality setting varies
depending on the nature of the graph being laid out. You can try each option to determine
which works best for you.

Spacing Allows you to set constant horizontal and vertical spacing around each graph node in the layer.
The value you specify is a guideline for the layout, so that it is possible that the spacing for a
particular pair of graph nodes might be different from the one you specified. The larger the graph
node spacing, the farther apart the graph nodes are spaced in the final layout.

Default value: 50

The following figure illustrates smaller and larger spacing:

node spacing=75

node spacing=150
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Routing Tab
To access Click the Routing tab in the Layout Properties dialog box.
Important The Routing tab enables you to produce drawings that leave graph nodes essentially

information where they are, and reroute the lines orthogonally.

User interface elements are described below:

ul
Element
(A-2) Description

Fix Node | Maintain the position of all the graph nodes in the display. Clear this option for the layout to
Positions = move the graph nodes if it is necessary to improve the layout. The movement is minimal,
avoids overlaps, and minimizes bend points.

Fix Node | Maintain the size of a graph node. Clear this option if you want the layout to increase the size
Sizes of a graph node if it is necessary to maintain the specified relationship spacing when more
than one relationship is attached to the same side of the graph node.

Horizontal Enables you to set the minimum horizontal distance between graph nodes.

Spacing  geiect one of the following options:

« Between Graph Nodes. Set a horizontal space around each graph node in the layer.
Default value: 20

- Between Edges. Set a horizontal space between elements in the layer.
Default value: 12

Vertical Enables you to set the minimum vertical distance between graph nodes.
Spacing Select one of the following options:
. Between Graph Nodes. Set a vertical space around each graph node in the layer.
Default value: 20
. Between Edges. Set a vertical space between elements in the layer.

Default value: 12

Main Menu

This feature contains the options for working with the topology map.

To access Located in the upper left portion of the screen.

Important The specific options contained within the Main Menu drop-downs are detailed in
information "Toolbar Options" on page 139.

See also o "Topology Map Overview" on page 123

« "Topology Map User Interface" on page 124

User interface elements are described below:
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Ul Element
(A-2) Description
Edit Contains selection options for the topology map.

Editor Item | Contains the topology map shortcut menu options for the current manager.

Note: This drop-down does not appear in Cl Type Manager.

Layout Contains options for changing the layout of the topology map.
Operations = Contains options for printing or exporting the topology map.

Resources  Contains the left pane shortcut menu options for the current manager.

Note: This drop-down does not appear in IT Universe Manager, and in Cl Type
Manager it is called CI Types.

Tools Contains the User Preferences, User Profile, Log Configuration, Screen Capture, and
Refresh User Authentication tools.

View Enables you to hide or display the different panes of the module.

Print Dialog Box
This dialog box enables you to print the contents of the topology map.

To access  Select Operations > Print.

Important | The results of printing a topology map is similar to a screen capture. Therefore, before
information | printing, it is recommended to:

« Define your print settings and arrange the contents of the topology map according to your
requirements. For details, see "Print Setup Dialog Box" on the next page.

« Arrange the contents of the topology map for print. You can use the Layout option and
Layout Properties. For details about the layout options, see "Layout Properties" on
page 143. For details about layout properties, see "Layout Properties Dialog Box" on

page 125.
Relevant "How to Print and Save a Topology Map to File" on page 182
tasks
See also « "Topology Map Overview" on page 123

« "Topology Map User Interface" on page 124

User interface elements are described below:

Ul Element (A-2) Description
Number of copies Enter the number of copies you want to print.
Properties Define document properties as required.
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Print Preview Dialog Box

This dialog box enables you to preview the content of the topology map before printing.

To access Select Operations > Print Preview.
Relevant tasks "How to Print and Save a Topology Map to File" on page 182
See also « "Topology Map Overview" on page 123

» "Topology Map User Interface" on page 124

User interface elements are described below:

Menu Item  Description

Print Setup. Opens the Print Setup dialog box where you can define the print settings.

E] Print. Prints the map. For details, see "Print Dialog Box" on the previous page.
L Zoom In. Zooms in to focus on specific details of the map.
L Zoom Out. Zooms out to view the map.
4 Fit. Fit the complete view in the pane.

Print Setup Dialog Box

This dialog box enables you to define the print settings for a topology map.

To access Select Operations > Print Setup.
Relevant tasks "How to Print and Save a Topology Map to File" on page 182
See also « "Topology Map Overview" on page 123

» "Topology Map User Interface" on page 124

User interface elements are described below:

Ul Element
(A-2) Description

Actual Size | Print the view as it really is.
Color Set the text color.
Font Set the required font.

Page Setup  Set the printer settings.
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Ul Element
(A-Z)

Pages

Position

Print
Background

Print Border

Print
Caption

Print Crop
Marks

Print
Current
Selection

Print
Current
Window

Print Entire
Drawing

Print Page
Numbers

Zoom Level

Description

Divide the map into rows and columns and print each section separately. Enter the number
of columns and rows in the Page Columns and Page Rows boxes.

Select the position of the caption from the Position list.

Print the background behind the view.

Print the map with a border. Click Color to select the required border color.

Enter the caption in the text area and click Font to select the required custom font.

Print the crop marks.

Print the selected graph nodes and their relationships.

Print the part of the view that appears in the pane.

Print the complete view.

Print the page numbers.

Print the view at the current zoom level.

Toolbar Options

The following table contains a description of each Topology Map toolbar option, organized alphabetically.

Note: These toolbar options are relevant for RTSM applications.
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Button Option Name Use This Option to...

e Additions Count Calculate the number of instances that are created as a
result of an Enrichment Rule. The number of TQL query
node instances and relationships that are created
appear next to the Enrichment query
nodes/relationships, as seen in the figure below.

(=
IpSubnet(d)

Membershipal)

|

+

|New Nude{ﬁﬂl

Note: This option appears on the toolbar in
Enrichment Manager only.

Advanced Pane Toggle between hiding and displaying the Advanced
Pane at the bottom center of the screen.

To access: Select View > Advanced Pane.

Calculate Query Calculate the number of instances found for each TQL
Result Count query node/relationship.

Change Label Enter the maximum number of characters that the
Length/Properties labels should contain.

To access: In IT Universe Manager and the Modeling
Studio, select Layout > Change Label Properties. In
the other managers, select Layout > Change Label
Length.

Cl Types Tree Toggle between hiding and displaying the Cl Type
Selector at the right of the screen.

To access: Select View > Cl Types Tree.

Note: In the Modeling Studio, this option is called
Cl Types.
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Button

[

Option Name

Create Relationship

Delete Selected Item

(s)

Drag Map

Drill Down One Layer

Enable/Disable
Related Cls Retrieval

Entities Tree

Export Map to Image

HPE Application Performance Management (9.40)

Use This Option to...

In most managers, create a relationship between two
existing TQL query nodes. For details, see "How to Add
Query Nodes and Relationships to a TQL Query" on
page 21.

In IT Universe Manager, create a relationship between
existing Cls. For details, see "Attaching Existing Cls"
on page 165.

Delete a Cl from IT Universe Manager or a TQL query
node from Impact Analysis Manager or Enrichment
Manager.

Drag the view.

To access: Open the drop-down menu in the Mode box
or select View > Drag Map. In IT Universe Manager
and the Modeling Studio, select Layout > Dragging
Mode.

Move down one level in the topology map. This option is
enabled only if there is an additional Cl layer below it,
created by setting the hierarchy of the view. For details
on setting the hierarchy, see "Setting the View
Hierarchy" on page 219.

Note: This option appears only in IT Universe
Manager.

Toggle between disabling and enabling the redrawing of
the topology map with related Cls when selecting a new
Cl in the CI Selector.

Note: This option appears only in IT Universe
Manager in the Related Cls tab.

Toggle between hiding and displaying the manager
specific entities tree at the left of the screen.

To access: Select View > Entities Tree.
Note: In the Modeling Studio, each of the tabs of

the Left pane (Resources, Cl Types, Cl Selector)
is listed as a separate option.

Save the topology map to afile. For details, see "Export
Map to Image Dialog Box" on page 124.

To access: Select Operations > Export Map to
Image.
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Button Option Name Use This Option to...

Fit to Window Fit the complete map in the pane.

To access: Select Layout > Fit to Window.

Generate Direct Link Generate a direct link to a view or Cl.

To access: Select Edit > Generate Direct Link.

1t Go Up One Layer Move up one level in the topology map. This option is
enabled only if there is an additional Cl layer above it,
created by setting the hierarchy of the view. For details
on setting the hierarchy, see "Setting the View
Hierarchy" on page 219.

Note: This option appears only in IT Universe
Manager.

Hide All Inheritance Toggle between showing and hiding Inheritance_f
From Map relationships and their connecting query nodes.

To access: Select Layout > Hide All Inheritance
From Map.

Note: This option is only active on the toolbarin Cl
Type Manager.

Hide All Query Node  Toggle between showing or hiding the CI/CIT/query
Labels node/pattern labels.

To access: Select Layout > Hide All Query Node
Labels.

Note: This option is not available in IT Universe
Manager and the Modeling Studio.

Hide All Relationship | Toggle between showing or hiding the relationship
Labels labels.

To access: Select Layout > Hide All Relationship
Labels.

Note: This option is called Hide edges' labels in
IT Universe Manager and the Modeling Studio.

Hide All Toggle between showing and hiding the relationships in
Relationships the displayed map.

To access: Select Layout > Hide All Relationships.

Note: This option is not available in IT Universe
Manager and the Modeling Studio.
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Button Option Name
..'ﬁq Hide/Show Get

Related Cls pane

Interactive Zoom

Layout

Layout Properties

Log Configuration

HPE Application Performance Management (9.40)

Use This Option to...

Toggle between hiding and displaying the Get Related
Cls pane.

Note: This option appears only in IT Universe
Manager in the Related Cls tab.

« Decrease the view magnification by clicking and
pushing the pointer upwards.

« Magnify the view by clicking and pulling the pointer
downwards.

To access: Open the drop-down menu in the Mode box
or select View > Interactive Zoom.

Note: This option is not available in IT Universe
Manager and the Modeling Studio.

Select the layout display from the list. The options are:

« Hierarchical Layout. Enables you to display the
precedence relations in the topology map.

« Hierarchical Layout with Orthogonal Routing.
Displays a hierarchical layout with edges composed
exclusively of horizontal and vertical lines, forming
right angles where they intersect.

o Symmetric Layout. Enables you to display clear
representations of complex networks.

« Circular Layout. Groups a graph's nodes into
groups or clusters.

« Orthogonal Layout. Displays a layout with edges
composed exclusively of horizontal and vertical
lines, forming right angles where they intersect.

For further details about each of the options, see
"Layout Properties Dialog Box" on page 125.

Note: These layout options are only relevant for
Enrichment Manager, CIT Manager, and Impact
Analysis Manager.

Define the view's layer layout, by assigning positions
for the query nodes and relationships of the view. For
details, see "Layout Properties Dialog Box" on page
125.

To access: Select Layout > Layout Properties.

Open the Log Configuration dialog box.

To access: Select Tools > Log Configuration.
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Button Option Name

Map overview

|E Maximize
— Workspace/Restore
Workspace
Navigation
2 New CI
= New Related CI

Place in Center

HPE Application Performance Management (9.40)

Use This Option to...

Open a small box with a copy of the topology map. This
is useful in large views when zooming in.

To access: Select Layout > Map Overview. In T
Universe Manager and the Modeling Studio, select
Layout > Show Map Overview.

Toggle between the regular display and a full-screen
display of the topology map.

Take the pointer to the next connected CI/CIT/TQL
query node in a clockwise direction.
« Left-click to move in a clockwise direction.

« Right-click to point to the next CI/CIT/query
node/pattern in a clockwise direction.

To access: Open the drop-down menu in the Mode box
or select View > Navigation.

Note:

« You can use this option only on CI/CIT/query
nodes/patterns that are connected by
relationships.

« This option is not available in IT Universe
Manager and the Modeling Studio.

Define a new unrelated CI. For details, see "Working
with Cls" on page 161.

Note: This option appears on the toolbarin IT
Universe Manager only.

Define a new related Cl. For details, see "Working with
Cls" on page 161.

Note: This option appears on the toolbarin IT
Universe Manager only.

Place the selected CI/CIT/query nodes/pattern in the
center of the map.

To access: Select Layout > Place in Center.

Note: This option is not available in IT Universe
Manager and the Modeling Studio.
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Button

Option Name

Print

Print Preview

Print Setup

Remove Enrichment
Results

Screen Capture

Select

Select All

Select All Query
Nodes

Select Columns

HPE Application Performance Management (9.40)

Use This Option to...

Print the contents of the topology map. For details, see
"Print Dialog Box" on page 137.

To access: Select Operations > Print...

Preview the contents of the map before printing.

To access: Select Operations > Print Preview.

Define print settings for printing the topology map. For
details, see "Print Setup Dialog Box" on page 138.

To access: Select Operations > Print Setup...

Remove the instances created from an Enrichment rule
from the RTSM.

Note: This option appears on the toolbar in
Enrichment Manager only.

Take a snapshot of the screen using the Screen
Capture tool.

To access: Select Tools > Screen Capture.

Select a Cl/CIT/TQL query node or multiple
Cls/CITs/TQL query nodes.

To access: Open the drop-down menu in the Mode box
or select View > Select. In IT Universe Manager and
the Modeling Studio, select Layout > Selection Mode.

Select all the Cls and relationships in a selected layer.

To access: Select Edit > Select All.

Note: This option is not available in IT Universe
Manager and the Modeling Studio.

Select all the query nodes in a selected layer.

To access: Select Edit > Select All Query Nodes.

Note: This option is not available in IT Universe
Manager and the Modeling Studio.

Enables you to select the columns to be displayed. For
details, see "Select Columns Dialog Box" on page 389.

Note: This option is displayed in Text mode of IT
Universe Manager only.
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Button Option Name

Set Change
Timeframe

£1 Show Candidates for
Deletion

D Show Schedule Info

=t Sort Column Content
Straighten

User Preferences

User Profile

HPE Application Performance Management (9.40)

Use This Option to...

Open the Change Timeframe dialog box, which enables
you to set the period for the display of added or changed
Cl indicators.

Note: This option appears on the toolbarin IT
Universe Manager only.

Identify the Cls in the current view which are
candidates for deletion.

Note: This option appears on the toolbarin IT
Universe Manager only.

Display the scheduling information for the selected job.
For details, see "Discovery Scheduler Dialog Box" in
the RTSM Data Flow Management Guide.

Note: This option appears on the toolbar in Data
Flow Management > Discovery Module/Jobs >
Dependency Map tab. For details, see
"Dependency Map Tab" in the RTSM Data Flow
Management Guide.

Enables you to set the order of the visible columns. For
details, see "Sort Column Content Dialog Box" on page
390.

Note: This option is displayed in Text mode of IT
Universe Manager only.

Straightens any selected relationship between two
query nodes that has angles.

To access: Select Layout > Straighten.

Note: This option is only available in Enrichment
Manager and Impact Analysis Manager.

Opens the User Preferences dialog box which enables
you to reset warning message preferences. For details,
see "User Preferences Dialog Box" on page 77.

To access: Select Tools > User Preferences.

Opens the User Profile dialog box which displays the
user details for the user currently logged in.

To access: Select Tools > User Profile
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Button Option Name Use This Option to...

Zoom In Zoom in on a specific section of the topology map by
clicking and drawing a selection rectangle around the
part to magnify. The area you select is displayed at the
highest percentage that fits in the topology map.

To access: Open the drop-down menu in the Mode box
or select View > Zoom In. In IT Universe Manager and
the Modeling Studio, select Layout > Zoom in.

Topology Map Sidebar

The following table contains a description of each Topology Map sidebar option. The Topology Map sidebar
appears in IT Universe Manager and the Modeling Studio.

Button Option Name Use This Option to...
B Move Layout Move the sidebar to the right or left side of the screen.
Toolbar to
[ Right/Left
@, Zoom In/Out Zoom in or out on the topology map.
a
m Selection Toggle between Selection mode and Dragging mode in the
Mode/Dragging topology map.
. Mode
“af

Refresh to get an | Refresh the topology map to optimize the layout.
optimal layout

Fit to Window Fit the complete map in the pane.
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Button Option Name Use This Option to...
Change Map Select the map layout. The following options are available:
Layout

« “* Hierarchical Layout. Displays the precedence
relations in the topology map.

. Hierarchical Layout with Orthogonal Routing.
Displays a hierarchical layout with edges composed
exclusively of horizontal and vertical lines, forming right
angles where they intersect.

« = Circular Layout. Groups a graph's nodes into groups or
clusters.

. :=Orthogonal Layout. Displays a layout with edges
composed exclusively of horizontal and vertical lines,
forming right angles where they intersect.

. Symmetric Layout. Displays clear representations of
complex networks.

¢ Map Settings You can modify the following settings:

« < Hide/Show Edges' Labels. Hide or display the labels
of all relationships.

. "'Jr Hide/Show Count Indicators. Hide or display the
count indicators for the query nodes.

""?

. Enable/Disable Edges’ Highlighting. Highlight all
the relationships to and from the selected query node.

. ide/Show Legend. Toggle between hiding an

H'd /Show L d. Toggle bet hidi d
displaying the topology map legend.
iT Map Tools The following tools are available:

. P Show Map Overview. Open a small box with a copy of
the topology map. This is useful in large views when
zooming in.

« @ Print. Print the topology map.

2 ,

« L Export Map to Image. Save the topology map to afile.

|§| Expand All Expand all the CI groupings in the topology map.

Groups
Note: This option is only available when a grouping option
is selected.
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Button Option Name Use This Option to...
|E| Collapse All Collapse all the CI groupings in the topology map.
Groups

Note: This option is only available when a grouping option
is selected.
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This chapter includes:
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Using Modeling Studio

The Modeling Studio is the RTSM module for building and modeling views for display in Service Health. This
document details the required flow to create Service Health views using the Modeling Studio.

The motivation behind developing the Modeling Studio is to create a separation between the need to change
the RTSM content by creating Cls and relationships and the need to consume (view) the RTSM content. In
earlier versions, altering the RTSM content was part of the view creation workflow. Hence, users were
unintentionally changing the RTSM and influencing other users' views. In the Modeling Studio, you build
models and transform your content into views to be consumed by HPE Application Performance
Management.

Models and Perspectives

A model is a Cl collection that represents a managed business entity such as an application, business
service, or line of business. A model is usually created by solution or application architects who are familiar
with the content and hierarchy of the model. The model content can include system Cls (typically nodes),
running software Cls (such as web servers, databases, and J2EE servers), end user monitoring components
(Business Process Monitor or Real User Monitor applications), business processes, groups, and other
existing models.

To generate a view from a model, a perspective needs to be applied. A perspective is a TQL-based tool that
enriches the model content by adding additional Cls, thus creating a view. The default perspectives that are
applied to create Service Health views add all descendent Cls that are related by impact links down to the
level of monitor Cls. There are other perspectives provided out of the box that can be used to address
additional use cases.

The resulting view shows the model content as it is monitored by HPE Application Performance Management.

Building Models

The information required to define a model includes the CI content, the hierarchy, and the dependencies upon
additional Cls.
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HPE Application Performance Management is configured with a predefined list of Cl types that represent your

business entities. When creating a new model using the Modeling Studio, the following list of valid models
appears:

Select Cl Type

@ BuzinezzApplication
BusineszFunction

@J BuzineszsService

@ BusinessTransactionFlow
(O] CiCollection

8‘.: Infrastructure Service

& Organization

The model Cl types can be arranged in hierarchies to reflect the organization's specific needs. Here is an
example of a typical recommended model hierarchy:
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Line of Business

Unit

Business Service/Business

Business Process

Application

l

Groups (infra/End User)

Software Elements/
System Monitors

BPM/RUM

A model can be nested in any logical hierarchy, but it is best to create a hierarchy that starts from high level

business entities down to more specific model types.

It is strongly recommended to build models in a way that allows them to be reused as components of other

models.

Building a model creates a contains link between the model and its Cls according to the defined hierarchy.

The creation of a Cl which is a model Cl results in the creation of an empty model by default. Therefore, if you
want to create a model for a Cl that does not yet exist, you create a new model and thus, a new ClI. If you
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want to model an existing CI for the first time, select the Cl in the Cl Selector, drag it onto the canvas and

select Create a New Model.

Preconfigured Models

HPE Application Performance Management creates out-of-the-box models for applications monitored by

Business Process Monitor and Real User Monitor.

The Business Process Monitor model is of type business transaction flow and it contains business

transaction Cls.

G2 Banking® % .
152 wep (BT '@ TE 1 X[6% W% -G B o[ Qe
Mame | Cl Type
=8 @ Banking BusinessApplication
=8 @ Credit cards BusineszTransactionFlow
@ trans_1 BusinessTransaction
@ trans_2 BusinessTransaction
@ trans_3 BusinessTransaction
@ trans_4 BusinessTransaction

The Real User Monitor model is of type application and contains the End User Management Application
related group and business process step Cls. The Real User Monitor model is also impacted by the Real User
Monitor Sessions monitor Cls, Real User Monitor Errors events Cls, and Real User Monitor Informational

events Cls, which are visible in the Related Cls pane.

) Saving A nt <
Text Mode  w | 60 G L1 B A My - Gy - -| QFind
EE Name | Cl Type
|= % saving nt | ]
% Business Processes End User Management Application Related Group

7% Show accounts list Business Process Step
‘_J Select account Business Process Step
‘_J update profie Business Process Step
‘_J Search by dates Business Process Step
‘_.! request check book Business Process Step
‘_.! Account history Business Process Step

Properties Felated Clz ‘Watchpoints

Saving Account (Application)

=] [

Fitter | <Show All= |v | by | |

Direction | cl Cltype | Relation type
> <% Rum Info Everts RUM Informational Everts J Impacted By (Potentially)
> Application Sessions RUM Sessions monitor J Impacted By (Potertially)
= <% Rum Errors RUM Errors events J Impacted By (Potertially)

Building Model Content

Create a model of the desired type and assign it a name. The new model appears as the top Cl in the content
pane of the Model Editor. Drag and drop Cls from the CI Selector into the content pane to build the model

content.

A model can contain system Cls, running software Cls, SiteScope groups, and other models (both existing

models and new ones created during the modeling process).

The only Cls that cannot be part of a model containment tree are monitors. Monitor Cls are added to a model
after you generate a view from the model using one of the monitor perspectives. You can include monitors in
view by dragging them into the Related Cls pane when a model Cl is selected in the upper pane of the Model
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Editor. If you try to drop a monitor Cl into the upper pane, a message appears prompting you to add the
monitor Cl to the Related Cls pane.

The CI Selector pane offers two ways to search for a Cl (both model Cls and non-model Cls):

« Browse Views

Use this option when you are familiar with a view that contains the CI you are looking for. The following out-

of-the-box views can help you find commonly used Cls:

« End User Monitors view - contains business process groups and their content.

« System Monitors view - contains SiteScope groups hierarchy.

« System Software Monitoring view - contains running software Cls and the servers on which they are

deployed.

Inthe CI Selector, select Browse Views and begin entering the view name or use the view tree to look for

a Cl in a specific folder.
« Search Cls

If you know the CI type you are looking for, select the Search Cls mode and use the quick search dialog to
locate the desired Cl. Use the Advanced Search option for Cls that do not appear in the quick search mode.

The search result appears in the left pane. After the list of Cls is refreshed, you can drag and drop Cls into

the model content pane. It is possible to drag and drop multiple Cls in a single selection.

Models can be placed in a hierarchical mode. During the process of building the content you can insert new

models and create groups.

Hierarchies between Cl types which are not models is not supported.

Grouping

In some cases, there is a need to divide the model into logical groups according to ownerships, locations or
any other custom representation.

In the following example the application contains two groups that represent data centers:

& Bank One Data Centers® x|

T vep | EEText| BB IGee I1 K G = % fo -Gy -F - QFind

Name

Cl Type

- (& Bank One Data Centers

T [E} NY Data Center

[E] 10-EMD18

& 127.001 DefautDomain

Business Service
CiCollection
Mode

Windows

| = [E} LA Data Center

CiCollection

[E] Lagw aPPO3
[E] LaBM3AMINTOE

@ ilogh89362eaf devlab.ad
@ ilogh893734wa.devlab ad

Windows
Windows
Windows
Windows

For details on creating groups in a model, see "Model Editor" on page 258.
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Model Dependencies on Other Cls in the RTSM

Each model Cl in the model can be dependent on other Cls that exist in the RTSM but are not part of the
model itself. Examples of such Cls include shared resources such as database servers and storage devices.

The model structure may vary between organizations according to policies and responsibilities in the IT
department. There are organizations where shared resources are considered to be part of the application and
are monitored as part of it, while in other organizations they are considered external to the application. In the
first case, shared resources are part of the model and appear in the content pane, whereas in the second case
they appear as related Cls (in the lower pane of the Model Editor).

To create a dependency between a Cl in the model and another Cl in the RTSM, search for a Cl in the left
pane and drag it into the Related Cls tab. This operation creates a usage link in the RTSM.

In order to create a dependency relationship between two Cls, there must be a valid link in the RTSM between
the two Cl types. By default, all business Cls can be dependent on other business Cls.

The following example shows an application that depends on a web server and Oracle software elements:

[ Credit cards*x -
Text Mode ¥ |ES o0 G LT B My - G - B 2| QFind
Name Cl Type
= 4 Credit cards Business Process Group
‘_.5 Future debits Business Process Step
‘_.5 Select credit card Business Process Step
‘_.5 Request data from Amex Business Process Step
‘_.5 Request new credit card Business Process Step
‘_.5 Last statement Business Process Step

Properties Related Clz ‘Watchpairts
<Show All> ¥ | by
Direction | c Cltype | Relation type

i » 4 Microsoft 115 WebServer (16.59.57.145) s J Depends On
i > "% DB3E (abm2amdb11) Oracle J Depends On
-

Fiter

HPE Application Performance Management offers a revised out-of-the-box impact model. The impact model
describes the impact relationships between Cl types. For example, a running software Cl is impacted by the
node on which it is deployed. In the Modeling Studio, when you include a running software Cl as part of a
model, the node on which it is deployed appears in the Related Cls tab, since the running software is
dependent on the server.

Modeling an Application with Running Software

Running software Cls are Cls that describe the implementation components of an application. Examples
include web servers such as 1S or Apache, application servers such as Webshpere or Weblogic, and
databases.

To build the implementation model of a three tier application using its running software Cls, create an
application model.

You can use the Running Software search in the Advanced Search dialog or browse the System Software
Monitoring view to locate running software Cls. The names of the running software Cls are formed by
combining the running software Cl type with the server name, for example, Microsoft IIS web server
(Serverl).
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Drag the relevant running software Cls into the modeling pane. The server on which the running software was
deployed as well as the monitor of the running software both appear automatically in the Related Cls pane.
This change derives from the new SiteScope monitoring model. In previous versions, all monitors (of both
hardware and software) were connected to the Server Cl. The SiteScope model was enhanced and now
hardware monitors are connected to the server Cl, while software monitors are connected to the running
software Cls.

Creating Views Using the Modeling Studio

There are two methods of creating perspective-based views using the Modeling Studio. The first option is to
create a view based on a model (or on several models); the second one is to create a view out of Cl collection
that is not a model.

A view based on a model is updated automatically when the model content is updated. For example, a view
was generated using a business process group model that initially contained five business process steps. The
business process group was then updated to include additional business process steps. Those changes are
automatically reflected in the view.

This option is the recommended one, since it creates a dynamic view.

In a view based both on models and individual Cls, the view content is updated according to changes in the
models.

Generating a View from a Model

After building a model and saving the model definition, select the top model and select Generate view for
selected model. In the dialog box that opens, select the desired perspective according to the desired view
content.

The recommended perspective is the Impact Perspective. It creates a view with all the Cls in the model and
for each Cl, it adds all the child Cls including the monitor Cls. Additional perspectives that may be used for
other purposes are described in "Predefined Folders and Views" on page 221.

If the selected model includes dependent Cls (which appear in the Related Cls tab), they are also enriched by
the perspective and become part of the view.

The Content Only perspective does not make any changes in the view, even for model Cls.

Hiding Irrelevant Cls from a View

The view result appears in the View Results pane. At this point, you may choose to hide Cls that appear in the
view.

Hiding Cls from a view does not change the status calculation of Cls in the view (the status calculation is
performed according to the RTSM hierarchy). For example, hiding two business process steps from a
business process group with five steps does not affect the business process group status. If a hidden Cl has
a critical status and the remaining Cls are OK, the business process group shows a critical status.

For details on hiding Cls and restoring them to a view, see "Building a Perspective-based View" on page 225.
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IT Universe Manager Overview

IT Universe Manager enables you to manage the content of your IT Universe model. The following tasks
represent the basic functionality of the application:

« Creating Cls without creating relationships. You can define new Cls that are added to the RTSM
individually, so that no new relationships are created. For details, see "Creating a Non-Related CI" on
page 161.

« Creating Cls with relationships for them. You can define new Cls and attach them to existing Cls, so
defining a new Cl and a new relationship in the RTSM. For details, see "Creating a Related CI" on page
161.

« Adding existing Cls and creating relationships for them. You can attach Cls to an existing Cl, so
creating new relationships for existing Cls. For details, see "Attaching Existing Cls" on page 165.

« Deleting Cls. You can delete Cls from the RTSM. For details, see "Deleting Cls" on page 162.

« Getting Impact Analysis results. You can run the Impact rules you defined for a view to simulate how
certain defined changes impact your system, and to discover the root causes of the changes. For more
information about Impact rules, see "Impact Analysis Manager Overview" on page 304.

Populating the IT Universe Model

The IT Universe model in the RTSM contains the Cls and relationships produced by the Cl-generating tools
that operate within HPE Application Performance Management. Most Cls and relationships originate from one
of the following sources:
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« Data Flow Management (DFM). Automatically creates Cls and relationships based on the discovered IT
resources and topology in your company's infrastructure. For details, see Data Flow Management
Overview in the RTSM Data Flow Management Guide.

« IT Universe Manager. Enables you to manually create Cls and relationships that represent logical and
physical elements of the business. For details, see "Working with Cls" on page 161.

« End User Management Administration and System Availability Management Administration.
Enables you to manually create relationships between the Cls for monitor objects and Cls in the RTSM.
For details, see "Integrating SiteScope Data with APM's Configuration Items" in the APM Application
Administration Guide.

« Enrichment Manager. Enables you to add Cls and relationships to the RTSM by receiving data from the
attributes of Enrichment query nodes as defined in the Enrichment TQL query. For details, see
"Enrichment Manager" on page 355.

Working with Views in IT Universe Manager

In IT Universe Manager, you analyze data at the view level. Views are subsets of the IT Universe, containing
only those Cls relating to a specific area of interest. All views are based on a pattern which determines the
content of the view.

« Pattern views and template-based views are built from a TQL (Topology Query Language) query that
defines the structure of the view. The view displays only those Cls and relationships that satisfy the query
definition.

« Perspective-based views are built manually, by selecting a group of Cls and applying perspectives to
them. A perspective is a pattern used to define which related Cls are included in the view.

You build all views in the Modeling Studio, using the appropriate editor for each view type. For information on
the different view types and how they function, see "View Formats" on page 218.

Note: You must have Update permissions for a view to edit the view. If you do not have the necessary
permissions, contact your HPE Application Performance Management Administrator.

Cls created by DFM are automatically added to each view where the Cls (and their relationships) fit the TQL
definition for the view. When you open a view in the Cl Selector, the TQL query for the view queries the RTSM
for Cls that match the defined pattern. If there are no matches (for example, in the case of a view fora DFM
process where the process has not yet run) then the view remains empty.

You can also include Cls from external data sources (federated Cls) in your view, by defining the query to run
over integration points for federated data sources. The federated Cls appear in the view with an arrow icon
indicating that they are from a federated source.

3

—

For details on federated data sources, see Integration Studio Overview in the RTSM Data Flow Management
Guide.

Note: For out-of-the-box queries that have integration points defined, the data source is set as UCMDB.
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When you define a new CI while working in any view in IT Universe Manager, the Cl (and any associated
relationship) is created in the RTSM. The Cl is added to your current view only if it meets the view's TQL
specifications.

If the created Cl and relationship do not meet the TQL requirements, then the CI and relationship are created
in the RTSM but are not visible in the view. Similarly, if you attach an existing Cl to a Cl in the view, and the
new pattern does not meet the TQL requirements, then the attached Cls do not appear in the view, but the
relationship is still created.

Templates and Template-based Views
If you open a template in IT Universe Manager, it is displayed in the topology map like a pattern view. Click

the Show Template Parameters “F> button on the CI Selector toolbar to open the Template Parameter
Values dialog box, where you can change the values of the template parameters and thereby affect the view
results displayed in the topology map. You can try different parameter values and see the resulting topology
map, but you cannot save changes to the template itself. To save the view results as a template-based view
with the selected parameters, click the Save As View button in the Template Parameter Values dialog box.

You can also create a direct link to a template in IT Universe Manager and insert the parameter values directly
into the URL. For details, see "How to Create a Direct Link to a Template with Parameter Values" on page 87.

View Lifecycle

If you do not access a view from the CI Selector for a specified period of time, the view is cleared out, to save
memory in the system. It is not deleted from the RTSM; the view can be retrieved by clicking on it. The default
time period for clearing out unused views is one hour.

Note: Views defined as persistent are not cleared out and always remain in the memory.

Hidden Views

You can designate a view as a hidden view that does not appearin IT Universe Manager by defining a bundle
for hidden views and assigning the view to that bundle.

To designate a view as a hidden view:

In the Infrastructure Settings Manager, select Hidden Bundles Names in Cl Selector.

2. Enterthe name of the new bundle as the default value and save the setting.

3. Inthe Modeling Studio, open the relevant view and click the View Definition Properties ﬁ'i:l" button on
the toolbar.

4. Inthe View Definition Properties dialog box, select the hidden views bundle and assign the view toit.

View Tree Structure

Views are organized in a hierarchical tree format in the left pane of IT Universe Manager, which is known as
the CI Selector. The view name appears in the View box above the tree and acts as the containing folder for
the Cls in the view.

The first level of the Cl Selector tree consists of the query nodes for the root Cls. A root Cl is the starting point
for a view subtree. A view may contain any number of subtrees. Under the root Cls come the branch Cls,
expanding down to the leaf Cls as the last query nodes at the ends of each branch.
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The Cls at each level in a subtree are considered to be attached to the Cl on the branch directly above. This
attachment generally depicts a dependent relationship, so that the higher branch (closer to the root Cl)
represents a component of your business that depends on the Cls on the next branch down (closer to the leaf
Cls)inthe business process. For example, an application depends on the servers running the application.

The attachment between a higher and a lower query node is referred to as a parent-child relationship. The
parent Cl may have many attached child Cls, and the child Cls pass operational status to the parent. The
status at each level is viewed in Service Health.
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The tree topology is determined by the hierarchy defined for the view. In a pattern view, these are defined for
the specific view. In a template-based or a perspective-based view, the hierarchy is defined as part of the
template or perspective. For details on defining the hierarchy, see "Setting the View Hierarchy" on page 219.

Working with Cls

In IT Universe Manager, you can create related and non-related Cls, delete Cls, edit the CI properties, and
remove out-of-date Cls using the aging mechanism.

This section includes the following topics:

« "Creating a Non-Related CI" below

« "Creating a Related CI" below

« "Deleting Cls" on the next page

o "CI Properties" on the next page

« "Removing Out-of-Date Cls Using the Aging Mechanism" on page 163

Creating a Non-Related ClI
You can define a new Cl in IT Universe Manager by clicking the New ClI =~ ® button on the toolbar. The New
Cl dialog box opens, which enables you to define the properties for the new ClI. The Cl is created in the

RTSM. For details, see "New Cl/New Related C| Dialog Box" on page 206.

Note: The Cl is added to the view only if it meets the specifications of the pattern of the view, template,
or perspective.

A Cl created in this way is added as an independent entity without any relationship to any other existing Cl in
the RTSM.

Creating a Related ClI

You can define a new Cl to be added as a parent, child, or sibling of an existing CI.
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To define a new related Cl:

1. Select the Cl in your view to which you want to attach the new CI.

2. Click the New Related ClI ] button on the toolbar.

3. Inthe New Related CI dialog box, define the properties and relationship for the CI. For details, see "New
Cl/New Related CI Dialog Box" on page 206.

The Cl and relationship are created in the RTSM.

Note: The Cl and relationship are added to the view only if they meet the specifications of the pattern
of the view, template, or perspective.

Deleting Cls

You can delete a Cl by selecting Delete from CMDB from the shortcut menu in IT Universe Manager. The Cl
is deleted from the RTSM and from all views. If the CI has children, they are not automatically deleted when
you delete the parent Cl. If you delete a Cl without first deleting the relationship between the Cl and any child
Cls that appear with the parent Cl in a view, the child Cls are removed from the view.

If the child Cls do not appear in any other view, they remain in the RTSM without appearing in a view. The
child Cls might appear in the future in views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and parent Cl is a Composition
relationship; in that case, when the parent Cl is deleted, the contained Cl is also removed from the RTSM. For
example, if a node Cl is the container for a child CPU ClI, then when the node Cl is deleted, the CPU is also
removed from the RTSM.

When you delete a Cl that was created by the DFM process, the Cl is restored the next time that DFM runs (if
the Cl is still valid), and it reappears in all relevant views.

If an application, business transaction flow, business transaction, or location Cl that has a RUM or BPM
configuration was removed from the RTSM, it is automatically restored by EUM to ensure the stability of the
EUM configuration. The restored Cl name comprises the Cl ID number concatenated with _restored. In some
cases, links torelated Cls are not restored.

Note: Sometimes, a Cl is deleted from the RTSM but it still appears in a TQL query because the query
was not yet updated due to its priority level. When the query is consumed in IT Universe Manager,
RTSM cannot find any of the Cl's properties, and it is displayed with a no label name in the topology
map.

Cl Properties

In IT Universe Manager, you can edit the properties of a Cl. The CI properties are divided into several
categories which appear in the New CI dialog box:

« The general properties of a Cl are common to all Cls. Some general properties are defined automatically
during Cl creation; others can only be defined manually in the New CI dialog box.

« ClIT-specific properties are created as part of the CIT definition in the Cl Type Manager. The values for the
CIT-specific properties are taken from the Cls discovered during DFM. The values can also be entered
manually, when you manually create Cls to represent entities in your infrastructure. For details, see "Cl
Type Manager" on page 319.

« Key properties can be general or CIT-specific properties, which must be assigned a value to create an
instance of the Cl type.
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You can access the Configuration Item Properties dialog box to view the CI properties from IT Universe
Manager by right-clicking the Cl and selecting Properties or by clicking the Properties tab in the Advanced
pane. You can also edit the Cl properties if you have the necessary permissions for editing Cls. For details on
ClI properties, see "Configuration Item Properties Dialog Box" on page 188.

The CIT-specific properties are displayed in the Specific Properties section of the Configuration Item
Properties dialog box when you sort the properties using the Categorized button. Some properties for the
automatically created Cls can be edited, however, if the Cl is configured to Allow Cl Update (in the General
Properties), then DFM may override your changes when it updates the CI. A description of the selected
property can be found in the Description area at the bottom of the Configuration Item Properties dialog box.

Some of the CIT-specific properties for DFM Cls are set by default to be monitored for changes. When one of
these properties has been modified, information on the change can be viewed in a Cl change report, and in
some cases, an icon is displayed in Service Health. For more information, see Cl Change Report.

Removing Out-of-Date Cls Using the Aging Mechanism

If a Cl or relationship is not updated or refreshed over a period of time (for example, a Cl is not rediscovered by
DFM and no manual update occurs), an aging mechanism deletes the CI from the RTSM. For details, see Cl
Lifecycle and the Aging Mechanism in the RTSM Administration Guide.

Note: The following actions that apply to Cls cannot be performed on federated Cls:
« Editing the CI properties
« Deleting the CI
» Creating a relationship to another CI
« Viewing the Cl History
« Adding the Cl to a Discovery job
« Removing the Cl from a Discovery job

Working with Relationships

Many of the relationships between Cls in the RTSM are created automatically, for example, by DFM. In
addition, you can create relationships manually in IT Universe Manager, Enrichment Manager, Impact
Analysis Manager, or the Modeling Studio. You can also create relationships in System Availability
Management and End User Management Administration.

This section includes the following topics:

« "Creating Relationships" on the next page

« "Creating Hierarchical Relationships" on the next page
« "Attaching Existing Cls" on page 165

« "Setting the View Hierarchy" on page 165

« "Relationship Properties" on page 166

« "Viewing Related Cls" on page 166

« "Deleting Relationships" on page 166

« "Inter-Layer Relationships" on page 166
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Creating Relationships

You can create relationships in IT Universe Manager by right-clicking a Cl or multiple Cls in the Cl Selector
pane or the Topology Map and selecting Relate to Cl from the shortcut menu. In the Topology Map, you can
define arelationship between two Cls in the view by drawing a line between the two, using the Create

Relationship [ button from the toolbar. Either of these actions opens the Insert Relationship dialog box.
For details, see "Insert Relationship Dialog Box" on page 193.

You can create as many relationships as necessary between a Cl in the RTSM and other Cls. Each new
relationship exists as its own entity in the RTSM, and has its own properties that can be edited in IT Universe
Manager (as described in "Configuration Item Properties Dialog Box" on page 188). You can also create more
than one relationship between the same two Cls, when each relationship is based on a different relationship
type. In the following example, host7 has both a Backbone and a Talk relationship with switch3.

=

Talk
ackhone

&

switch3

haost?

Note: If a Running Software Cl is related to another Cl with a Containment relationship, you cannot
create another Containment relationship from the Running Software CI.

Creating Hierarchical Relationships

By attaching one CI to another in IT Universe Manager or System Availability Management or End User
Management Administration you create a hierarchical relationship (parent-child) between them, so that one Cl
is influenced by the other.

Certain relationships defined in this way are restricted to the relationship type usage (if the relationship is
between two non-monitoring Cls), or the relationship type Monitored By (if the child Cl in the relationship is a
monitor type CI); however, other relationship types are used between specific types of Cls. For example, if a
relationship is defined between two node Cls, there are several possible relationship types.
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Note: When you attach a child Cl to a parent CI, you are creating that relationship in the RTSM. The child
therefore impacts on the parent Cl in every view where the relationship exists, and is displayed in every
view where the child and relationship match the TQL query.

When performing status calculations, the Business Logic Engine only recognizes calculated relationships.
For details on calculated relationships, see "Impact Rules" on page 82

Attaching Existing Cls
You can attach existing Cls using the Insert Relationship dialog box. The dialog box has two modes:

« Selecting the Cls that you want to attach.
« Defining the relationship between the original Cl and the Cls to attach.

When selecting the Cls to attach, you can select multiple Cls from a view to attach to the original ClI.
However, all Cls that you want to attach in one operation must have the same relationship type. For example,
you cannot attach a Cl that uses the relationship usage in the same operation as a Cl that uses the
relationship Monitored By.

Note: SiteScope monitor Cls should not be attached to other Cls from within the RTSM. You should only
create links to SiteScope monitor Cls from within SiteScope.

Setting the View Hierarchy

After setting the query node and relationship definitions of a view, you can set a hierarchy for the view. This
enables you to define the organizational structure of Cls in the view by displaying selected Cls at different
levels. When no hierarchy is defined, the Topology Map or table displays all Cls included in the query results
on one level by default. For example, if the query results include nodes and IP Subnets, both Cl types are
displayed on the same level in the Topology Map or table.

Note: The maximum number of Cls that can be displayed in a single layer of the Topology Map is 900. If
a view contains a layer with more than 900 Cls, the view is not displayed in the Topology Map until the
hierarchy is changed. However, a layer with more than 900 Cls can be displayed in a table in Text mode.

For details on setting the hierarchy, see "Setting the View Hierarchy" on page 219.
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Relationship Properties

Relationships have properties, similar to Cls. You can access the Configuration Iltem Properties dialog box to
view the relationship properties from IT Universe Manager by right-clicking the relationship and selecting
Properties or by clicking the Properties tab in the Advanced pane. You can also edit the relationship
properties if you have the necessary permissions for editing Cls. For details on relationship properties, see
"Configuration Item Properties Dialog Box" on page 188.

Note: For relationships of type composition connected to a Cl of type Node Element or its descendant
Cl types, relationship properties are not saved. When a TQL query containing such a relationship is run,
the default values for the relationship properties are used even if you edited the properties.

Viewing Related Cls

You can view all the Cls related to a selected Cl in the topology map. Select a Cl in a view and then select the
Related Cls tab. The Get Related Cls pane enables you to select the scope of the display. If you select
View, the topology map displays only the selected Cl and its related Cls in the view (no matter where it is in
the view hierarchy). If you select CMDB, it displays the selected Cl and all of its related Cls in the RTSM.
You can also filter the results from the Get Related Cls pane by Cl type and apply perspectives toa Cl. For
details, see "Get Related Cls Pane" on page 205.

You can also display Related Cls using the Get Related Cls from CMDB dialog box. For details, see "Get
Related Cls From CMDB Dialog Box" on page 193.

Deleting Relationships

The Topology Map shows only the relationships for the Cls that are part of the current view; however, the
same relationships may also be part of other views. When you delete a relationship in IT Universe Manager, it
is deleted from the RTSM and from all views.

When a relationship is deleted, the Cl on the other end of the relationship may remain in the view, if it still
matches the pattern of the view. However, if the deleted relationship is a composition link, the target Cl is
deleted with it.

In a perspective-based view, you can remove the Cl completely from the view (without deleting it from the
RTSM), by hiding it from the view in the Perspective-based View Editor in the Modeling Studio.

When you delete a relationship that was created by the DFM process, the relationship is restored the next
time that DFM runs (if the relationship is still valid), and it reappears in all relevant pattern views.

It can take a few minutes to delete subtrees, or multiple Cls and relationships, from a view.

Inter-Layer Relationships

In certain circumstances, IT Universe Manager displays a relationship between Cls in a layer of a view that
does not reflect an actual relationship between the Cls in that layer, but rather a relationship between Cls on
deeper layers of the view. Such a relationship is known as an inter-layer relationship.

For example, in the following view, two node Cls are related to each other with a dependency relationship.
Each is also related to an IP Subnet by a membership relationship and the view hierarchy is defined such that
the nodes are on the layer beneath the IP Subnet.
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When you consume the view in IT Universe Manager, the relationship between the node Cls (which are under
different IP Subnets) is displayed in the higher layer of the view as a relationship between the parent IP
Subnets, even though the actual relationship only exists between the Cls in the lower layer of the view. You
can double-click the relationship to display the full path between the IP Subnets.

Another form of inter-layer relationship occurs when the same Cl appears under more than one parent Cl of
the same type in the layer above it. In such a case, the child Cl and its relationships are duplicated in the view
display, due to the hierarchy definition. The relationships of such child Cls result in inter-layer relationships
between the parent Cls. This type of inter-layer relationship is known as a duplication metalink.

For example, in the following view, a single node Cl appears under two IP Subnet Cls in the hierarchy. The
node and its children thus appear twice in the view - once under each IP Subnet. Each node is effectively
related to the child Cls of the node under the other IP Subnet, which generates an inter-layer relationship
between the two IP Subnets.
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Inter-layer relationships and duplication metalinks are displayed in gray in the topology map. The following
options are available for viewing inter-layer relationships (defined in the View Definition Properties dialog box

in Modeling Studio):

« None. Hide all inter-layer relationships.

« Inter-Layer. Display inter-layer relationships of the first type, but not duplication metalinks.
« Full. Display all inter-layer relationships, including duplication metalinks.

A tooltip for the inter-layer relationship displays the inner relationships which it represents. If there is only one
inner relationship, the relationship label displays that relationship type. If there are multiple inner relationships,
the label becomes Inter-layer and the tooltip displays a list of all the inner relationships. If there are more than
ten inner relationships, only the first ten are displayed, and a note indicates that there are more inner
relationships.

How to Create Cls and Relationships

This task describes how to create related and non-related Cls, as well as relationships between Cls, in the
RTSM.
This task includes the following steps:

« "Define a New Non-related CI" below
« "Define a New Related CI" on the next page

« "Attach Existing Cls" on the next page

Define a New Non-related CI

Click the New CI ¥ button on the toolbar. In the New Cl dialog box, select a Cl type from the tree and
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define the properties for the new ClI. For details, see "New Cl/New Related C| Dialog Box" on page 206.
Define a New Related ClI

Click the New Related CI %/ button on the toolbar. In the New Related CI dialog box, select a Cl type from
the tree and define the properties for the new CIl. On the Relationship page of the dialog box, select the type of
relationship and define its properties. For details, see "New ClI/New Related C| Dialog Box" on page 206.
Attach Existing Cls

Select a Cl in a view. Right-click the Cl and select Relate to Cl. In the Insert Relationship dialog box, select
atarget Cl. On the Relationship page of the dialog box, select the type of relationship and define its properties.
For details, see "Insert Relationship Dialog Box" on page 193.

How to View Related Cls

The following steps describe the options for viewing related Cls in IT Universe Manager.

« "Display Related Cls" below
« "Select the Scope of the Display" below
« "Filter the Related Cls" below

« "Apply Perspectives to a Cl" below

Display Related Cls

InIT Universe Manager, select a Cl in the Topology map or the Cl Selector and select the Related Cls tab.

Click the Enable Related Cls Retrieval ‘&2 button. The selected Cl is displayed with its related Cls. Select
a different Cl or multiple Cls from the CI Selector, and the display changes accordingly.

Note: You can display the Related Cls content in map mode or in text mode.
For details on the Get Related Cls user interface, see "Get Related Cls Pane" on page 205.

Select the Scope of the Display

In the Get Related Cls pane, select the scope of the related Cls display. Click the Show Related Cls button.
The display changes according to your selection.

Filter the Related Cls

In the Filter Related Cls by Cl Type section, select the Cl types to appear in the related Cls display. Click the
Filter Related Cls button. The filtered results appear in the tab. The scope selected above still applies and
the display is reduced according to your filter selection.

Apply Perspectives to a Cl

In the Apply Perspectives to Cl section, select the perspectives to apply to your selected ClI. Click the Apply
Perspectives button. The results are displayed in the tab.

Note: This feature is only relevant when CMDB is selected as the scope.
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How to Check the Status of Application Discovery
(Rediscover a View)

As an application owner or administrator, you need to be kept informed of any problems with your application.
So, for example, it is important to know that discovery is working properly and that its current configuration
can connect to the application database. This section explains how to run the rediscovery procedure that
enables you to check the current status of the discovery of an application.

Note:

« Set up and configuration is performed by the HPE Application Performance Management
administrator. For details, see "Prerequisites" below.

« Rediscovery is performed by the application owner/administrator. For details, see "Access the View"
below.

« You do not need any knowledge of Data Flow Management (DFM) to run this procedure.

« By default, you can run the rediscovery procedure on views that contain fewer than 10,000 Cls. For
details on changing this number, see "Important information" on page 214.

This task includes the following steps:

« "Prerequisites" below
« "Access the View" below
« "View Results in the View" on the next page

« "Schedule the Rediscovery" on the next page

1. Prerequisites

Note: This step is performed by the HPE Application Performance Management administrator.

a. InDFM, create a module that contains the jobs that must discover the application. For details, see
How to Run Module/Job-Based Discovery in the RTSM Data Flow Management Guide.

b. Activate the module and all the jobs. The jobs must remain activated.

c. Verify that the module has run without errors. For details, see Error Messages Overview and
Discovery Module/Jobs - Details Tab in the RTSM Data Flow Management Guide.

d. Correct any errors in the application and confirm that DFM finds no errors during the next run.

Caution: The application owner cannot rediscover a view if DFM is reporting errors. You must
set an error-free baseline.

e. Inthe Modeling Studio, define a view that includes the application Cl or Cls to be rediscovered.
These are the Cls that are created when you activate the jobs that discover the application. For
details, see "How to Create a Pattern View" on page 232.

f. Notify the application owner of the name of the view.

2. Access the View

Note: This step is performed by the application owner/administrator.
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In IT Universe Manager, access the view that includes the application Cls to be rediscovered. For
details, see "How to Search for Cls in Search Mode" on page 109.

3. View Results in the View

(0]
a. Check the complete application. Click the Show Discovery and Changes Summary {'D

button on the CI Selector toolbar. The Show Discovery Status and Changes of View dialog box is
displayed. The dialog box displays information about which jobs and trigger Cl discovered the Cls in
the view, on the last occasion that DFM ran the discovery for the jobs. For details, see "Show
Discovery Status and Changes Dialog Box" on page 213.

To run the discovery, click the Rerun Discovery button. To view information about the jobs and
trigger Cls, use the links to drill down. For details, see Error Messages Overview in the RTSM
Developer Reference Guide.

Check specific components of your application. Select the component's Cl in the Topology Map
pane and display the Discovery tab in the Advanced pane. For details, see "Show Discovery Status
and Changes Dialog Box" on page 213.

Torediscover several Cls, press CTRL, select the Cls and display the Discovery tab.

To run the discovery, click the Rerun Discovery button.

4. Schedule the Rediscovery

You can schedule how often the rediscovery procedure should run. In the Job Definition window, choose
the Rerun Discovery on View action. For details, see Job Definition Dialog Box.

How to Check the Network Availability of an Inventory

Cl

As a discovery administrator, you might often need to perform troubleshooting of network connection issues
and/or credential related issues. This section explains how to use the network ping options available in the
new Check Network Availability dialog box to troubleshoot network connection issues and/or credential
related issues against an inventory Cl in IT Universe Manager.

Note:

« This feature is available for Node type inventory Cls only.
« Touse this feature, you need to have the Run Discovery and Integration and the Check Network

Availability permissions. The out-of-the-box Discovery and Integrations Admin role has all these
permissions by default.

This task includes the following steps:

o Prerequisites
o Check the Network Availability of an Inventory ClI

1.

HPE Application Performance Management (9.40)

Prerequisites

To use this feature, you need to have the Run Discovery and Integration and the Check Network
Availability permissions. The out-of-the-box Discovery and Integrations Admin role has these
permissions by default.
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If you want to assign these permissions to a custom role (say, IT Administrator), do the following:

a.
b.

Note: This step is performed by the system administrator.

Loginto RTSM and go to Security > Roles Manager > Roles.
Select a role for which you want to assign the required permissions.

You may need to create one if you do not have such arole. In this case, IT Administrator is created
and selected.

In the Resources tab of the IT Administrator window, select CIT Menu Items in the Resource Types
pane, select Node in the Resources pane, and then select Check Network Availability in the
Available Actions pane and move it the Selected Actions pane.

Go to the General Actions tab of the IT Administrator window, select Run Discovery and
Integration in the Available Actions pane and move it the Selected Actions pane.

2. Check the Network Availability of an Inventory CI

To check the network availability of an inventory Cl of the Node type,

a.
b.
c.

In RTSM, go to Modeling > IT Universe Manager.
In IT Universe Manager, search for Node type inventory Cls.

Select a Cl of your interest from the returned result, and then right-click the inventory Cl in the map
and select Actions > Check Network Availability from the shortcut menu.

Click a desired icon and provide necessary values in order to perform a network ping.
1P
o () IP Ping. Displays the IP Ping Settings dialog box, which enables you to specify the
necessary values to perform a network IP ping.

« IP Address. Select the IP address of your target node (in IPv4 or IPv6 format) from the drop-
down list of available IP addresses. You can also manually enter the IP address (in IPv4 or
IPv6 format) of a target node.

« Probe. Select a probe from the drop-down list of connected probes to perform IP ping.
« Ping Times. Number of attempts for the selected probe to perform IP ping. Default value: 4.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to perform IP
ping. Default value: 60,000 (ms).

o E"ﬁ Ping with UD Agent. Displays the UD Agent Ping Settings dialog box, which enables you to
specify the necessary values to perform a network ping with UD agent.

« IP Address. Select an IP address from the drop-down list of available IP addresses. You can
also manually enter the IP address (in IPv4 or IPv6 format) of a target node.

« Credential. Click \:::l to open the Choose Credential dialog box, which enables you to select
an existing credential for the probe to use. By default all credentials available for the selected
protocol type are selected.

If there is no existing credential, click L1 to create one.

« Probe. Select a probe from the drop-down list of connected probes to ping with UD agent.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to ping with UD
agent. Default value: 60,000 (ms).

m|
o (i) Ping with SNMP. Displays the SNMP Ping Settings dialog box, which enables you to
specify the necessary values to perform a network ping with SNMP.

HPE Application Performance Management (9.40) Page 172 of 393



Modeling Guide
Chapter 8: IT Universe Manager

« IP Address. Select an IP address from the drop-down list of available IP addresses. You can
also manually enter the IP address (in IPv4 or IPv6 format) of a target node.

« Credential. Click \:::l to open the Choose Credential dialog box, which enables you to select
an existing credential for the probe to use. By default all credentials available for the selected
protocol type are selected.

If there is no existing credential, click L1 to create one.
« Probe. Select a probe from the drop-down list of connected probes.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to ping. Default
value: 60,000 (ms).

e. Click OK to perform the network ping.

RTSM server dispatches an ad hoc task to the selected probe, and the probe will ping the target
node.

f. The result pane displays the ping result.
For IP Ping, the result is the output of the ping command.

For Ping with UD Agent or Ping with SNMP, the result is either success or failure. An error
message follows when the network ping fails.

How to View Discovery Status and Errors for a
Selected CI

As an IT administrator, with the new View Discovery Status and Error permission, you are able to run the
enhanced Show Discovery Progress action in IT Universe Manager. This allows you to,

« Show Errors. You can view all error/warning messages during the discovery progress for a selected Cl.

« Show All “<Error Message>” Issues. Displays all similar discovery issues related to a specific job,
thus allowing you to view all Cls impacted by this particular discovery issue.

This enables you to focus on troubleshooting the root cause of the errors and warnings for a particular Cl or
Cls impacted by a particular discovery issue, without having to access the Universal Discovery module
which contains too many unnecessary information. Then you can verify if a Cl data error is caused by any
discovery issue.

Note: Running the Show Discovery Progress action in Universal Discovery allows you to view
discovery statuses and error/warning messages for all triggered Cl instances.

This task includes the following steps:

o Prerequisites: Grant the Required Permissions
« View Discovery Status and Errors in IT Universe Manager

1. Prerequisites: Grant the Required Permissions
Note: This step is performed by the system administrator.

To view discovery status and errors in IT Universe Manager, your administrator need to grant the
following permissions to you:
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« View Discovery Status and Error

Show Discovery Status

Log into RTSM and go to Security > Roles Manager > Roles.

b. Select a role for which you want to assign the required permissions.
Create a new role if you do not have such arole. In this case, IT Administrator is created and
selected.

Note: The View Discovery Status and Error permission is not available for all out-of-the-box
roles.

c. IntheIT Administrator window, go to the General Actions tab, select the View Discovery Status
and Error action in the Available Actions pane and move it the Selected Actions pane.

d. Gotothe Resources tab, select CIT Menu Items in the Resource Types pane, select

Configurationltem CI type in the Resources pane, and then select Show Discovery Status in the
Available Actions pane and move it the Selected Actions pane.

To view all discovery status and errors in Universal Discovery, you also need the access to the
Universal Discovery module.

a. Enable the View Discovery Status and Error and Show Discovery Status permissions by
following the instructions above.

b. Go tothe Resources tab, select Ul Modules in the Resource Types pane, and then select and move
Universal Discovery to the Selected Ul Modules with Permissions pane.

2. View Discovery Status, Errors, and Warnings for a Selected Cl in IT Universe
Manager

a. Loginto RTSM with the new role IT Administrator, go to Modeling > IT Universe Manager.

b. Inthe Cl Selector pane, go to the Search Cls tab, click the Start the Search A icon for the CI
Name field.
From the returned results, select a discovered node to allow the page to load.
Right click the discovered node, select Actions > Show Discovery Progress.

The Discovery Progress dialog box pops up and loads discovery statistics.
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-

Discovery Progress

o

Trggered Cls

Progress

e. Inthe Cl Instances table,

o Click thelink in the X column and select Show errors.

o Click the link in the A column and select Show warnings.

The Discovery Progress dialog loads error or warning messages that are related to the selected
node.
-

@ Discovery Progress

2 E D

Trggered Cls » Completed with Errors

Error Message | Job
Inwvalid user name or password Host Connection by Shell
Key exchange failed Host Connection by Shell
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f. To view details of an error/warning message entry, double-click the error/warning message, or,

select it and click the Show Triggered Cls icon.

Detailed error/'warning messages occurred during the discovery progress for the particular pair of
error message and job you selected are displayed.

A2FOT

@ Discavery Progress

Filter: Status[Ermors by message]; Look for:

E-‘

b

Triggered Cls > Completed with Errors > Host Connection by Shell

Detailed Mes. . | Cl | Probe | ReltedHost | RelatedIPs | Reported
NTCMD: Inv... 16.187.180...  DatsFlowPr..  sgditvm0351 | 16.187.189..  05/12/2015 ..
Page 1= of1 1-1outof1

g. Toview all Cls impacted by a particular discovery issue,

i. Go back to the Completed with Errors page by clicking Up One Level .
ii. Right-click the error/warning message of your interest and select Show All <Error Message>

Issues.
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-

@J Discovery Progress g

N LD se

Trggered Clg > Completed with Errors

Emor Message |
Invalid user name or pag
Key exchange failed

Remove Cl
Rerun Discovery
Show All "Invald user...” |ssues

iii. All Cls impacted by this particular discovery issue are displayed.

@ Discovery Progress :

,ﬂﬂ? il | Filter: Status[Errors by message]; Lock for:

Trnggered Cls » Completed with Errors > Hest Connection by Shell - Al

DetaledMe..| €l | Probe | RelatedHost | RelatedPs | Reported
NTCMD: In... 16.187.189.... DataFlowPr... 16.187.189.... | 05M2/2015 ..
NTCMD: In... 16.187.189... DataFlowPr.. sgditvm0380 16.187.189... 05/12/2015 .
NTCMD: In... | 16.187.189.... | DataFlowPr.. | sgditvm0349 | 16.187.189.... | 05/12/2015 ..
NTCMD: In.. 16.187.189... DataFlowPr.. 16.187.189.... 051212015 ..
NTCMD: In... 16.187.189... DataFlowPr..  sgditvm0432  16.187.189... 051212015 .
NTCMD: In... 16.187.189.... DataFlowPr... 16.187.189... 051212015 ...
NTCMD: In... | 16.187.189.... | DataFlowPr.. | sgditvm0327 | 16.187.189.... | 05/12/2015 ..
NTCMD: In.. 16.187.189... DataFlowPr.. 16.187.189.... 051212015 ..

-
RBITRAMN - Al ADTT 4O Pimdim o e A 4D AO0 AC A MALT ]

Page of 8 1 - 25 out of 190
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How to Retrieve Impact Analysis Results - Scenario

Impact Analysis Manager enables you to create an Impact rule that allows you to simulate the impact certain
infrastructure changes have on your system. The results of the Impact rule are displayed in IT Universe
Manager. The Impact Analysis results in this task describe how a change in CPU operation impacts the node
towhichit is connected.

This task includes the following steps:
» "Define an Impact Analysis TQL Query " below
« "Define an Impact Rule" below
« "Create a View in the Modeling Studio" on the next page

« "Get Impact Analysis Results" on page 180

1. Define an Impact Analysis TQL Query

To define an Impact Analysis TQL query, you need to create an Impact rule and then add the TQL query
nodes and relationships that define the query.

To create an Impact Analysis TQL query, select Admin > RTSM Administration > Modeling >
Impact Analysis Manager. For details about how to add query nodes and relationships to a query, see
"How to Add Query Nodes and Relationships to a TQL Query" on page 21.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a Composition relationship.

(

=
2
(a1}

Camposition

' — o — -

Cpu

2. Define an Impact Rule

When you define an Impact rule, you must specify the required causal relationship between the query
nodes. Define one query node as the trigger, or the query node that represents the changes you want to
make to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger and select Define Impacted to open the
Impacted Query Nodes dialog box. Select the query node that you want the trigger query node to impact
and click Next. Then click the Add button to open the Impact Rules Definition dialog box to set
conditions for defining impacted query nodes. For details about how to define an Impact rule, see "Impact
Rules Definition Dialog Box" on page 314.

Note: The change state option in the Impact rule definition is no longer relevant for Impact Analysis.
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The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the conditions under which the
simulated change in the system is triggered. The Severity area defines the severity of the impact on

the impacted query node.

The Impact rule in this example states that when the CPU operation is not in the normal state, the
node is impacted. Since the severity is set to 100% of the trigger's severity, the severity of the node
is the same as the severity of the CPU, which is determined when Impact Analysis is run.

B impact Rules Definition
Description: | |
i| Conditions
|| state: | operation 4
Operator: | Not equal =]
=

‘“alue comparison: | Marmal

) Range ¥ -

() Fixed severity:

(®) Severity relative to trigger severity (%):

%

In the resulting TQL query, an upward arrow appears next to the query node defined as the trigger
query node and a downward arrow appears next to the query node defined as the impacted query

node.

=K
MHode

Composition

Cpu

3. Create a View in the Modeling Studio
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HPE Application Performance Management (9.40)

Go to the Modeling Studio and create a view matching the TQL query of the Impact rule you defined. For
details, see "Pattern View Editor" on page 273.

Get Impact Analysis Results

Select Admin > RTSM Administration > Modeling > IT Universe Manager and select the required
view in the C| Selector. To get Impact Analysis results, run the Impact rule on a Cl instance in the
topology map that is a trigger. Right-click a trigger Cl and select Run Impact Analysis to open the Run
Impact Analysis dialog box. In the dialog box, select the Impact rules to run. If you want to select Only
Impact rules located in specified bundle, make sure to add your Impact rule to the required bundle using
the Properties option for the selected Impact rule. For details, see "Impact Rule Groups Page" on page
318.

For details on how to run an Impact rule, see "Run Impact Analysis Dialog Box" on page 211.

Example for Getting Impact Analysis Results:

An Impact Analysis TQL query is created containing a CPU and node connected by a Composition
relationship. The CPU query node is defined as the trigger query node and the query node of type
node is defined as the impacted query node.

The following Impact rule is defined for the query.

B3 impact Rules Definition

Description; | |

| Conditions

State: | operation | - |

Operataor: | Mat equsal |v |

‘Value comparizon: | Marmal |" |

Scope

(®) lany

A

() Range o4 = %

() Fixed severity:

(®) Severity relative to trigger severity (%):

Right-click a CPU Cl in the view, and select Run Impact Analysis to open the Run Impact
Analysis dialog box. Set the trigger severity to a value other than Normal.
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Hu..n Impact Analysis

(= Run Impact Analysis
=

Select the impact analysis trigger and the set of impact rules that will be executed

Trigger Severity

-

I I I I I I I
Critical

Correlation Rules

(®) Al Impact Rules
@) Only impact rules located in specified bundle

To see results, click one of the following:

« Show in Views. This assigns a status to all the Cls in the view. Only the node CI connected to
the CPU CI (whose severity was changed), becomes impacted. The trigger Cl and the impacted
Cl turn orange because the trigger severity was set as Major (7) on the scale in the Run Impact
Analysis dialog box, which is assigned an orange color.

[g+

WhAMCIATEE
Composition
3
{ FI LABMIAMODEDT
Composition
CPUN
Compogition
£ et (A2 |
CPLUN CPLM
LABM 24071
Composition
Composgition
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« Show Map. A map appears in a separate window containing only the trigger CPU CI and the
node Cl it impacted. The relationship connecting the two Cls contains the name of the Impact
rule defined in Impact Analysis Manager.

Note: Optionally, you can create a URL that enables you to embed the map. For details, see
"Direct Link Parameters — Impact Map Page" on page 94.

[g+

WIAMCIAT 26

Composition

o
CPLO
« Generate Report. Generates an Impact Analysis report that displays a list of Cls that are

impacted in the system as a result of the simulated changes. For details, see "Run Impact
Analysis Dialog Box" on page 211.

How to Take a Snapshot of a View

You can take a snapshot of a view in IT Universe Manager, save it, and then compare snapshots of the same
view taken at different times using the Compare Snapshots Report. For details on how to take a snapshot of a
view, see "Save Snapshot Dialog Box" on page 213. For details on how to view actual differences in the
compared views, see "Compare Snapshots Report" (on page 1).

How to Print and Save a Topology Map to File

You can print the content of any topology map and then save it to file. Before printing, it is recommended to
define your print settings and arrange the contents of the topology map according to your requirements. For
details on how to define print settings, see "Print Setup Dialog Box" on page 138. For details on how to
preview the content of the topology map before printing, see "Print Preview Dialog Box" on page 138. For
details on how to print the content of a topology map, see "Print Dialog Box" on page 137. For details on how
to save a topology map to file, see "Export Map to Image Dialog Box" on page 124.

IT Universe Manager User Interface

This section includes (in alphabetical order):

® Add ClstoModel Dialog BOX ........ ... o 183

HPE Application Performance Management (9.40) Page 182 of 393



Modeling Guide
Chapter 8: IT Universe Manager

® Add Cls to View Dialog BOX . ... 183
® Change Timeframe Dialog BOX . ... ... ..o 184
® Check Network Availability Dialog BOX .. ... ... ... . 185
¢ Cl/Relationship History Dialog BoX ... ... .. 187
* Configuration Item Properties Dialog BOX . ... oo 188
® Generate Sub Report Dialog BoX ... il 192
* Get Related Cls From CMDB Dialog BOX .. ... . 193
*® Insert Relationship Dialog BOX ... ... .. . L 193
® [T Universe Manager Page ...........o o 197
* New CI/New Related Cl Dialog BOX ... ... . 206
* Recently Discovered By Dialog BOX . ... 210
® Run Impact Analysis Dialog BoX ... ... 211
® Save Snapshot Dialog BOX ... ... 213
* Show Discovery Status and Changes Dialog Box ... .. ... 213

® Show Impact Pane

Add Cls to Model Dialog Box

This dialog box enables you to add selected Cls to a model.

To access Select Admin > RTSM Administration > Modeling > IT Universe Manager. Right-click
a Cl or multiple Cls in the Cl Selector and select Add Cls to Model.

Important This feature is only relevant for instance based models. You cannot add selected Cls to a
information = pattern based model.

See also « "IT Universe Manager Overview" on page 158
« "IT Universe Manager User Interface" on the previous page
o "Business Cl Models" on page 223

User interface elements are described below:
Ul Element (A-Z) Description
<Model tree> When Existing Model is selected, select a model from the tree.

Define New CI Properties \When New Model is selected, define the name and properties of the model.

Existing Model Select Existing Model to add the selected Cls to an existing model.
New Model Select New Model to add the selected Cls to a new model.
Select Cl Type When New Model is selected, select a Cl type for the model.

Add Cls to View Dialog Box

This dialog box enables you to add selected Cls to a perspective-based view.
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To Select Admin > RTSM Administration > Modeling > IT Universe Manager. Right-click a Cl
access or multiple Cls in the Cl Selector and select Add Cls to View.

See « "IT Universe Manager Overview" on page 158

also « "Working with Views in IT Universe Manager" on page 159

« "IT Universe Manager User Interface" on page 182

User interface elements are described below:

Ul Element (A-Z) Description

<View tree> When Existing View is selected, select a view from the tree.

Existing View Select Existing View to add the selected Cls to an existing perspective-based view.
New View Select New View to add the selected Cls to a new perspective-based view.

View Name When New View is selected, edit the name of the view.

Change Timeframe Dialog Box

This dialog box enables you to display changes in the topology map and set the time frame for the changes to
display.

To access | Select Admin > RTSM Administration > Modeling > IT Universe Manager. Click the
Set Change Timeframe button on the main toolbar or the IT Universe status bar.

Important = When the change indicators are displayed in the topology map, a message appears on the IT
information Universe status bar Change Timeframe is Active.

To hide the indicators, open th_edialog box and select Do not display changes, or click the
Reset Change Timeframe |9| button on the IT Universe status bar.

See also « "IT Universe Manager Overview" on page 158

« "IT Universe Manager User Interface" on page 182

User interface elements are described below:
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Ul Element (A-Z) Description

Display changes Select this option to display an indicator next to each Cl that was added or changed
according to the within the selected period as follows:

selected

timeframe « “ Indicator for an added ClI
« £ Indicator for a changed ClI
Select a time period from the drop-down list. If you select Custom, click the ellipsis
== button to select the Date From and Date Until fields. The changes to the Cls of
the view within the selected period are displayed in the map.
When the indicators are displayed, you can click the indicator to open the Cl History
dialog box, which displays the history for the Cl over the selected period.

Do not display Select this option to hide the change indicators.

changes

Check Network Availability Dialog Box

This dialog box displays the result returned from performing IP ping, UD agent ping, or SNMP ping against a
selected inventory Cl of the Node Cl type.

To access  Use one of the following:

« InIT Universe Manager, go to the Cl Selector pane > Search Cls tab > search for Node
type Cls > right-click an inventory CI from the returned result and select Actions
> Check Network Availability from the shortcut menu.

« Inthe Cl Instances dialog box, right-click an inventory Cl instance, click Actions, and
select Check Network Availability. For information about the Cl Instances dialog box,
see Cl Instances Dialog Box in the HPE Universal CMDB Modeling Guide.

Important « The Check Network Availability option is only available in the Actions list for a
information selected inventory Cl of the Node Cl type.

« The Check Network Availability option is only available with Content Pack 16.00.

Relevant How to Check the Network Availability of an Inventory Cl
tasks

User interface elements are described below:

ul
Element
(A-2) Description

Name Name of the selected Node type inventory CI.
ID ID of the selected Node type inventory CI.

Cl Type @ Subtype of the selected Node type inventory CI.
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Ul
Element
(A-2) Description

{Ef;} IP Ping. Displays the IP Ping Settings dialog box, which enables you to specify the following
values to perform a network IP ping:

« IP Address. Select the IP address of your target node (in IPv4 or IPv6 format) from the drop-
down list of available IP addresses. You can also manually enter the IP address (in IPv4 or
IPv6 format) of a target node.

« Probe. Select a probe from the drop-down list of connected probes to perform IP ping.

« Ping Times. Number of attempts for the selected probe to perform IP ping. Default value: 4.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to perform IP
ping. Default value: 60,000 (ms).

) Ping with UD Agent. Displays the UD Agent Ping Settings dialog box, which enables you to
specify the following values to perform a network ping with UD agent:

« IP Address. Select an IP address from the drop-down list of available IP addresses. You
can also manually enter the IP address (in IPv4 or IPv6 format) of a target node.

« Credential. Click =22/ to open the Choose Credential dialog box, which enables you to select
an existing credential for the probe to use. By default all credentials available for the selected
protocol type are selected.

If there is no existing credential, click %! to create one.

« Probe. Select a probe from the drop-down list of connected probes to ping with UD agent.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to ping with UD
agent. Default value: 60,000 (ms).

o Ping with SNMP. Displays the SNMP Ping Settings dialog box, which enables you to specify
the following values to perform a network ping with SNMP:

« IP Address. Select an IP address from the drop-down list of available IP addresses. You
can also manually enter the IP address (in IPv4 or IPv6 format) of a target node.

« Credential. Click l:::/ to open the Choose Credential dialog box, which enables you to select
an existing credential for the probe to use. By default all credentials available for the selected
protocol type are selected.

If there is no existing credential, click %! to create one.
« Probe. Select a probe from the drop-down list of connected probes to ping with UD agent.

« Timeout (ms). Frequency (in milliseconds) that the selected probe shall try to ping with UD
agent. Default value: 60,000 (ms).

<Result | Displays the result returned by the selected probe after performing IP ping, UD agent ping, or
Pane> SNMP ping against a selected inventory Cl of the Node ClI type.

For IP Ping, the result is the output of the ping command.

For Ping with UD Agent or Ping with SNMP, the result is either success or failure. An error
message follows when the network ping fails.
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Cl/Relationship History Dialog Box

This dialog box displays a list of Cl or relationship attributes in which changes have occurred as well as the
differences between two configuration files.

To access | InIT Universe Manager, right-click the selected ClI or relationship in the Cl Selector or the
Topology Map and select Cl History.

Note: Cl and relationship history data is also available in the History tab of the
Advanced pane in IT Universe Manager.

Important All Cl and relationship attributes are included in the History, except for attributes marked
information = with the Not Tracked for History qualifier in the Cl Type Manager. For details, see
"Add/Edit Attribute Dialog Box" on page 328.

See also o "IT Universe Manager Overview" on page 158

o "IT Universe Manager User Interface" on page 182

User interface elements are described below:

Ul Element (A-2) Description
|%| Refresh. Refreshes the data in the table.
|E| Show Difference. Enables you to view the difference between two

history entries for the content of a configuration file. This is relevant in the
following situations:

« Select two history entries for the Document Content attribute for Cls
of the type Configuration Document to compare to each other.

« Select one history entry for the Document Content attribute for Cls
of the type Configuration Document to compare to the current
content for that ClI.

Click the Show difference button to open the Visualdiff report, which
displays a comparison of the two entries. Text added to the second entry
appears highlighted in yellow. Text removed from the first entry appears
highlighted in red. Differences between the entries appear highlighted in
green.
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Ul Element (A-Z) Description

9 Export Data To File. Enables you to export the history data. Choose the
export format from the following options:

« XLS. The table data is formatted as an .xIs (Excel) file that can be
displayed in a spreadsheet.

« PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of
columns to display to ensure that the report is legible.

« RTF. The table data is exported in Rich Text Format.
« CSV. Thetable data is formatted as a comma-separated values
(CSV) text file that can be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the
comma (,) must be defined as the list separator. In Windows, to
verify or modify the list separator value, open Regional Options

from the Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value.

« XML. The table data is formatted as an XML file that can be opened in
a text or XML editor.

Tip: To extract HTML code from the report:

« Open the file in an HTML editor.
« Copy the relevant table into the target file.

Attribute The name of the attribute.
Change Date The date when the last change occurred.
Filter by Filter the data in the table by one or more of the following filters:

« Time Range. Select the time period for which the CI history is
displayed.

« Change Type. Select the type of changes displayed in the table.
« Attribute. Select the attribute types displayed in the table.

Modified By Indicates the cause of the change. For example, the field can contain the
name of a user ora DFM job.

New Value The new value of the attribute.

Old Value The previous value of the attribute.

Configuration ltem Properties Dialog Box

This dialog box enables you to view and edit basic information for an existing ClI or relationship.
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To access  Select Admin > RTSM Administration > Modeling > IT Universe Manager and use one
of the following:

« Select a Cl or relationship in the topology map or a Cl in the CI Selector. In the Advanced
Pane, select the Properties tab and click Edit.

« Select a Cl or relationship in the topology map or a Cl the CI Selector and click the Show

Cl Properties @' button.

« Right-click a Cl or relationship in the Topology map or a Cl in the Cl Selector and select
Properties.

Important The Configuration Item Properties dialog box contains two types of properties:

information « General properties, which include general information about the CI or relationship. These

properties are common to all CITs and are documented below.

« ClIT-specific properties, which include properties specific to that Cl. These properties
vary according to the type of Cl or relationship and are not documented.

When you sort the properties by category, the CIT-specific properties appear at the top of
the list and the general properties appear at the bottom.

You can view a description of the selected property in the Description Area at the bottom of
the dialog box. Click the Show/Hide Description Area button to display the Description
Area.

When accessing the Configuration Item Properties dialog box from within certain
applications, the fields are not editable.

Mandatory fields are marked with an asterisk (*).

Note: HPE Universal CMDB does not fully support surrogate pairs and combining
characters.

See also « CI Lifecycle and the Aging Mechanism in the RTSM Administration Guide
« "Working with Cls" on page 161

« "IT Universe Manager User Interface" on page 182

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-Z) Description
=) Categorized. Displays the properties by category.
B Alphabetic. Displays the properties alphabetically.
i Show/Hide Description Area. Toggles between showing and hiding the description area at

the bottom of the CI Properties dialog box.

Expand. Expands the properties tree when the properties are displayed by category.

£

Collapse. Collapses the properties tree when the properties are displayed by category.

e
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Ul Element
(A-2) Description

#Expart - Export Data To File. Enables you to export the table data. Choose the export format from
the following options:

« Excel. The table data is formatted as an .xIs (Excel) file that can be displayed in a
spreadsheet.
« PDF. The table data is exported in PDF format.

Note: When exporting to PDF, select a reasonable number of columns to display to
ensure that the report is legible.

« RTF. The table data is exported in Rich Text Format.

« CSV. The table data is formatted as a comma-separated values (CSV) text file that can
be displayed in a spreadsheet.

Note: For the CSV formatted table data to display correctly, the comma (,) must be
defined as the list separator. In Windows, to verify or modify the list separator value,
open Regional Options from the Control Panel, and on the Numbers tab ensure that
the comma is defined as the List Separator value.

« XML. The table data is formatted as an XML file that can be opened in a text or XML
editor.

Tip: To extract HTML code from the report:
o Open the file in an HTML editor.

« Copy the relevant table into the target file.

<Quick Enter a string in the Quick filter box to filter the property names and values. Click the left end
filter> of the box to open the drop-down menu of filter options:

« Select All to search for the filter string in both property names and property values.
Select Name to search for the filter string in property names only. Select Value to search
for the filter string in property values only.

« Select Case sensitive to search for the filter string exactly as entered. Select Case
insensitive to ignore the case of the filter string.

« Select Use wild cards to use the wildcard symbol * in the filter string.

« Select Match from start to search for the filter string at the beginning of a property name

or value. Select Match exactly to search for the exact filter string. Select Match
anywhere to search for the filter string anywhere in the properties.

Actual The number of days after which the CI or relationship is deleted.
Deletion
Period
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Ul Element

(A-2) Description

Allow CI When selected, this option allows the DFM process to automatically update the ClI or

Update relationship properties with information that it discovers. If you change the value of a
property supplied by the DFM process, the value is overridden by the discovered value.
When this option is cleared, the CI or relationship properties are not overridden by the DFM
process.

Apply Click Apply to save the changes made to the Cl or relationship properties.

Cl Type The type of the CI or relationship (read-only value). For information about CITs in HPE
Application Performance Management, see "C| Type Manager" on page 319.

Created By The user name of the administrator who manually created the Cl or relationship, where
applicable (read-only value).

Create The date and time when the ClI or relationship was created.

Time

Deletion The period after which the Cl becomes a candidate for deletion when the aging mechanism
Candidate  is enabled.

Period

Description A brief description of the Cl or relationship.

Display The name of the Cl or relationship as it appears in the Cl Selector.

Label

Edit In the Properties tab of the Advanced pane, you can view a Cl's properties but you cannot
edit them. Click Edit to open the Configuration Item Properties dialog box where you can
edit the properties.

Enable If a Cl or relationship is not updated or refreshed over a period of time (for example, a Cl is

Aging not rediscovered by DFM and no manual update occurs), an aging mechanism deletes the

CI from the RTSM. For details, see The Aging Mechanism Overview in the RTSM
Administration Guide.

True: the aging mechanism is enabled for this CI or relationship.

False: the aging mechanism is disabled for this CI or relationship.

Note:

« If the aging mechanism is disabled in Aging Status, this field is ignored.
« This field is displayed for certain Cls only.

« The default value is determined by the default value of the Enable Aging attribute
for the Cl type of the selected ClI.

Global Id The internal ID of the Cl or relationship in the RTSM (read-only value).
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Ul Element

(A-2) Description

Last The time that the Cl or relationship was last accessed, whether when being updated or being

Access discovered by DFM. This field is only displayed for certain Cls or relationships.

Time This parameter is used by the aging mechanism. For details, see Cl Lifecycle and the Aging

Mechanism in the RTSM Administration Guide.

Note: By default, this property is updated every time the Cl is touched by a running
discovery job or integration. To prevent this property from being updated by a discovery
job or integration, go to the Data Flow Management module, and in the Adapter
Management > Adapter Configuration tab, clear the Update last access time
option. For more details, see Adapter Configuration Tab in the RTSM Data Flow
Management Guide.

Last The date and time when the ClI or relationship properties were last updated.

Modified

Time

Monitored | Indicates whether the Cl is monitored by a SiteScope monitor or an EMS Integration

By monitor.

Name The name of the ClI or relationship.

Note Enables you to enter other information about the CI or relationship.

Origin An ID for the source that automatically created the CI or relationship, or the application

where the Cl or relationship was created (read-only value).
Reset Click the Reset button to restore the original property settings of the Cl or relationship.
Updated by The user name of the administrator who updated the CI or relationship properties.
User Label Enables you to define a display label for the Cl or relationship. If no value is entered, the CI
name appears as the default label.

Shortcut Menu

Menu Item Description

Copy Property Name Copies the name and value of the selected property to the memory.
and Value

Generate Sub Report Dialog Box

This dialog box enables you to generate a Sub Report for the selected ClI.

To access | InIT Universe Manager, right-click a Cl in the topology map or the Cl Selector and select
Generate Sub Report.
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Important A Sub Report enables you to apply a perspective to a selected Cl and view the results in
information  report format. Select a perspective from the list and click OK. The Sub Report opens ina
separate window.

See also o "IT Universe Manager Overview" on page 158
« "IT Universe Manager User Interface" on page 182

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<List of available perspectives> The list includes only perspectives that are designated as a Sub
Report perspective in its Report Properties. Only perspectives
matching the selected Cl type are displayed.

Description A description of the selected perspective.

Get Related Cls From CMDB Dialog Box

This dialog box enables you to view the Cls related to a specified Cl in the RTSM in map or table format.

To access  InIT Universe Manager, right-click the required Cl and select Get Related Cls.

Important = The Get Related Cls From CMDB dialog box is a standalone version of the Related Cls tab
information in IT Universe Manager. You can control the content of the display using the features in the
Get Related Cls pane. For details, see "Get Related Cls Pane" on page 205.

You cannot select the scope of the related Cls displayed in the Get Related Cls From
CMDB dialog box. The scope is the entire CMDB.

Note: The text mode format includes the icons found in the CI Instances dialog box. For
details, see "Cl Instances Dialog Box" on page 55.

Relevant "How to View Related Cls" on page 169
tasks
See also « "IT Universe Manager Overview" on page 158

« "IT Universe Manager User Interface" on page 182

Insert Relationship Dialog Box

This dialog box enables you to attach Cls to the Cl you selected in the Cl Selector.

To access In IT Universe Manager, right-click a Cl in the Topology Map or the Cl Selector, and select
Relate to CI.
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Important To create a relationship between two Cls, select the source Cl in the Cl Selector or the

information | Topology Map and then select Relate to Cl from the shortcut menu. On the first page of
the dialog box (the CI Selection page), you select the target Cl(s). Then click
Relationship, to select the relationship type on the second page of the dialog box.

You can also create a relationship between two Cls graphically by clicking the Create

Relationship I button on the toolbar and drawing a line between the two Cls. In this
case, a smaller version of the Insert Relationship dialog box opens, which contains the
following tabs:

« Select Relationship. Displays a tree with the available relationship types. Select the
required relationship.

Note: You can double-click the relationship you select to save using the default
properties.

« Relationship Properties. Displays the properties of the selected relationship. You
can edit the properties as described in "Define Relationship Properties Pane" on the

next page.
Relevant "How to Create Cls and Relationships" on page 168
tasks
See also « "ClI Selector" on page 112

« "Relationship Page" below

User interface elements are described below:

Ul Element (A-
Z) Description
3 Adds the selected Cls in the left pane to the Target Cls pane.
4 Removes the selected Cls from the Target Cls pane (this does not delete the Cls from
the RTSM).

Select target Select a view to display in the view tree and select Cls to move to the Target Cls pane.

Cls For details on the Select target Cls pane, see "C| Selector" on page 112.
Source CI The Cl you selected as the source ClI.
Target Cls Displays the Cls you have selected as target Cls for the relationship.

Relationship Page

This page enables you to define the relationship to be created between the original Cl and the Cls selected on
the CI Selection page of the dialog box.

To access | Click the Relationship button from the Insert Relationship dialog box.

Important When defining multiple relationships, you can define different descriptions and property
information = values for each relationship. Skip the property definitions here and edit each relationship
individually after it is created.
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User interface elements are described below:

Select Relationship Pane

Ul Element
(A-Z) Description
Direction Select the direction of the relationship.

For some relationship types (for example, Composition, or between a group Cl and a
monitor CI), only one direction is valid.

Relationship Define the type of relationship created between the original Cl and the Cls being attached.
Select an option from the list.

Source CI Displays the name of the Cl on the first end of the relationship. This is the Cl that you
selected in the view.

Target ClI Displays the name of the Cl on the second end of the relationship, that is attached to the

original CI.

Define Relationship Properties Pane

Ul Element
(A-Z) Description

Actual The period after which the relationship is deleted when the aging mechanism is enabled.
Deletion
Period

Allow CI When the value is set to true, the DFM process automatically updates the relationship.
Update

Created By The user name of the administrator who manually created the relationship, where applicable.

Create The date and time when the relationship was created.

Time

Deletion The number of days after which the relationship becomes a candidate for deletion.
Candidate

Period

Description A detailed description of the relationship.

Destination Defined only for route links. Indicates the destination network address to which this route is
Network configured.
Address
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Ul Element
(A-Z)

Enable
Aging

Last
Access
Time

Last
Modified
Time

Must

Name

Note

Origin

Updated
By

User Label

HPE Application Performance Management (9.40)

Description

If a Cl or relationship is not updated or refreshed over a period of time (for example, a Cl is
not rediscovered by DFM and no manual update occurs), an aging mechanism deletes the
Cl from the RTSM. For details, see "ClI Lifecycle and the Aging Mechanism" in the RTSM
Administration Guide.

True: the aging mechanism is enabled for this CI or relationship.

Default value: false. The default value for DFM Cls is true.

Note:

« If the aging mechanism is disabled, this field is ignored.
« This field is only displayed for certain Cls.

The time that the relationship was last accessed, whether when being updated or being
discovered by DFM. This field is only displayed for certain Cls.

This parameter is used by the aging mechanism. For details, see "Cl Lifecycle and the Aging
Mechanism" in the RTSM Administration Guide.

The date and time when the relationship properties were last updated.

When the value is set to true, the child Cl is dominant when the percentage rule is used to
calculate status for the parent Cl. If the Cl has low status, the parent must take the child CI
status, if necessary overriding the percentage rule calculation. This is useful to give
emphasis to an important Cl. For example, you might want to define Must for a database Cl,
so that status is critical all the way up the subtree if the database falls, regardless of the
status of the other Cls in the subtree.

The must status defined for a relationship applies for that relationship only — it is not used in
any other relationships of the child Cl. For details, see "Understanding the Percentage Rule"
in Using Service Health.

A brief description of the relationship. If no value is entered, the relationship type is used in
place of the name.

Enables you to enter other information about the relationship.

An ID for the source that automatically created the relationship, or the application where the
relationship was created.

The user name of the administrator who updated the CI properties.

Enables you to define a display label for the relationship. If no value is entered, the
relationship name appears as the default label.

Page 196 of 393



Modeling Guide
Chapter 8: IT Universe Manager

Ul Element
(A-Z) Description
Weight When a weight value is entered, the child Cl is given more weight in percentage

calculations, when percentage rule is used to calculate status for the parent Cl. For
example, if a child Cl is given a weight of 3, then it has three times more impact on the
parent status calculation than its unweighted siblings.

The weight defined for a relationship applies for that relationship only —it is not used in any
other relationships the child Cl may have. For more details, see "Understanding the
Percentage Rule" in Using Service Health.

IT Universe Manager Page
This page enables you to define and manage the Cls and relationships in your views.

To access | Select Admin > RTSM Administration > Modeling > IT Universe Manager.

Important The IT Universe Manager page contains the following panes:

information « CI Selector. Displays the Cls of a selected view. You can select the view from a drop—

down list or search for a specific Cl. For details, see "C| Selector" on page 112.
« Topology Map. Displays the Cls of a selected view in Map mode or Text mode.
« Advanced Pane. Displays properties, history, and discovery for the selected Cl or view.

« Get Related Cls. This pane can be accessed from the Related Cls tab of the Topology
Map. It controls the content of the display in the tab.

In IT Universe Manager, you can create new Cls, modify existing Cls, or delete Cls. All of
these actions have a direct effect on the entire IT Universe model. For example, if you delete
aClinyourview, that Cl is deleted from the IT Universe model and no longer appears in any

view.
Relevant « "How to Create Cls and Relationships" on page 168
tasks « "How to Print and Save a Topology Map to File" on page 182

« "How to Check the Status of Application Discovery (Rediscover a View)" on page 170
« "How to Retrieve Impact Analysis Results — Scenario" on page 178

« "How to Take a Snapshot of a View" on page 182

« "How to View Related Cls" on page 169

See also o "IT Universe Manager Overview" on page 158
« "Working with Views in IT Universe Manager" on page 159
o "CI Selector" on page 112
« "Topology Map Overview" on page 123

o "IT Universe Manager User Interface" on page 182
Topology Map

This area displays the Cls of the currently selected view in graphical or table format. By default, the Cls are
displayed in graphical format.
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To access | Select Admin > RTSM Administration > Modeling > IT Universe Manager.

Important = You can customize the Topology Map shortcut menu to include other commands (for

information example, ping, run a program, open a URL) from within Cl Type Manager. For details, see
"Create Configuration Item Type/Relationship/Calculated Relationship Wizard" on page
335.

Note: For grouped Cls and the relationships between them, not all of the shortcut menu
options are active. Grouped Cls appear in parentheses in the Cl Selector and in the
Topology Map. You can double-click a link to a grouped CI to open the Link Map, which
displays the individual Cls and relationships. Right-click a Cl or relationship in the Link
Map to display the regular shortcut menu. For details about grouping Cls, see "Query
Node Grouping Dialog Box" on page 285.

See also "Working with the Topology Map" on page 123

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

T Map. Displays the selected layer of Cls in topology map format.

M&P Map mode

Note: If the selected layer of the view is too large to display in
topology map format, a message appears with a link to display the
layer in text format.

Text. Displays the attribute properties of the Cls in the selected layerin

B Text
Text mode table format.

For details on some of the toolbar icons in Text Mode, see "Cl Instances
Dialog Box" on page 55.

Show Cl instances of. | Metwork ¥ Specify the CIT you want displayed in the table. The table also includes
the children of the selected CIT.

Note: This option is displayed in Text mode only.

<Breadcrumbs> At the top of the topology map, the breadcrumbs indicate the relevant
query nodes in each layer of the view for the path to the selected layer.
The first item in the path is the Top Layer. When you select a Cl from the
layer below, the parent Cl forms the next item in the breadcrumb path. You
can click on any item in the path to display that layer in the topology map.

<ClI type attributes> The columns appearing in Text mode represent the CIT attributes of the
selected Cls.
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Ul Element (A-Z) Description

<Group by> The Cls in the topology map are displayed according to the default
grouping selected in the view definition. When consuming the view in
IT Universe Manager, you can manually select a different grouping
method. The available options are:

« Group by Layer. Group the Cls according to the value of the layer
attribute of their Cl type.

o Group by CI Type. Group the Cls according to their Cl type.

« Group by Classification. Group the Cls according to the value of the
classification attribute of their Cl type.

« No Grouping. Do not group Cls.

Note:

« This option is available in Map mode only.

« When a grouping option is selected, each group contains an
indicator displaying the number of Cls in the group. If a group
contains alarge number of Cls, it opens in collapsed format,
displaying only the name and count indicator. Click the + sign
button to expand the group and display all the Cls. You can set the
threshold of Cls for automatically collapsing the group by
modifying the Initially expand group max Cls threshold setting
in the Infrastructure Settings Manager.

<IT Universe Status Bar> The status bar below the topology map indicates the status of the
following processes:

- if Impact Analysis is active or not

« if Change Timeframe is active or not

« if Candidates for Deletion are shown or not
« the time of the last update of the data

HPE Application Performance Management (9.40) Page 199 of 393



Modeling Guide
Chapter 8: IT Universe Manager

Ul Element (A-Z) Description
<Legend> Indicates the icons displayed next to Cls with any of the following special
statuses:

o Added. When Change Timeframe is active, indicates that the Cl was
added.

« Candidate for Deletion. Indicates that the Cl is a candidate for
deletion.

« Changed. When Change Timeframe is active, indicates that the Cl
was changed.

« Drill Down One Layer. Indicates that there are Cls under the Cl on a
lower layer.

« External. Indicates that the Cl is a federated ClI.
o Impacted. When Impact Analysis is active, indicates an impacted ClI.

» Impacted and Trigger. When Impact Analysis is active, indicates a
trigger Cl that is impacted.

« Note. Indicates that a note was added for the CI.
« Trigger. When Impact Analysis is active, indicates a trigger ClI.

<Main Menu> For details, see "Main Menu" on page 136.

<Query Node> The query nodes in the topology map represent Cls.
Hold the pointer over a query node to display its tooltip which describes
the type of the CI.

<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, which describes
the type of the relationship.

b4
ot

Note: When you select a calculated relationship, the Delete
button on the toolbar is disabled.

<Toolbar> For details, see "Toolbar Options" on page 139.
Note: When accessing the Topology map via direct links, the toolbar

includes options from the Related Cls Map. For details, see "Get
Related Cls From CMDB Dialog Box" on page 193.
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Ul Element (A-Z) Description

<Tooltip> Hold the pointer over a Cl to display a tooltip which shows Cl data. The
tooltip displays all attributes for the Cl which are marked with one of the
following qualifiers:
o Comparable
« AssetData
« Managed

When you hold the pointer over a count indicator, the tooltip displays the
breakdown of the Cls under it by Cl type. When a grouping option is
selected, hold the pointer over the group to display a tooltip showing the
breakdown of Cls in the group by Cl type.

<Topology Map Sidebar> For details, see "Topology Map Sidebar" on page 147.

Related Cls Click the Related Cls tab to display the interdependencies of the selected
CI within the view or the entire RTSM. You can control the scope of the
display from the Get Related Cls pane.

View Results Click the View Results tab to display an entire layer within a view.

IT Universe Manager Shortcut Menu

The IT Universe Manager page includes the following elements (listed alphabetically) available by right-
clicking a Cl or relationship in the Cl Selector pane or the Topology Map:
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Menu Item Description

Actions Select one of the following options:

« Add ClI to Discovery Job. Displays the Add ClI to Discovery Job dialog box,
which enables you to manually invoke a DFM job for the selected Cl. You can use
this option to discover additional information about the CI through one of the
available DFM jobs.

« Remove CI from Discovery Job. Displays the Remove CI from Discovery Job
dialog box, which enables you to manually remove a Cl from the DFM job.

« Show Discovery Progress. Opens the Discovery Progress dialog box for the
selected Cl.

« Recently Discovered By. Opens the Recently Discovered By dialog box for the
selected Cl.

« Check Network Availability. Opens the Check Network Availability dialog box
for the selected Cl.

« Open CI Credentials. Displays the Protocol Parameter dialog box, which
enables you to view the details of a previously-defined credential for that Cl. You
cannot make any changes.

Note: This option is only relevant for Cls that include a credentials property.

For details, see Protocol Parameter Dialog Box in the RTSM Data Flow
Management Guide.

« Edit Cl Credentials. Displays the Choose Credentials dialog box, which
enables you to choose another credentials set or edit the existing credentials.

Note: This option is only relevant for Cls that include a credentials property.

For details, see the supported protocols in the HPE Universal CMDB Discovery
and Integration Content Guide.

« Reprocess Scan File. Reprocesses the scan files for the selected node.

Note: This option is only available for Cls of type node or its subtypes.

Add Cls to Adds selected Cls to a new or existing model.
Model

Add Cls to View = Adds selected Cls to a new or existing perspective-based view.

Assign Tenants = Open the Assign Tenants dialog box which enables you to assign tenants to the ClI.

Note: This option is only available when multi-tenancy is enabled.

Cl/Relationship | Displays the Cl History dialog box. For details, see "Cl/Relationship History Dialog

History Box" on page 187.
Compare Cls Run a Compare Cls Report for the selected Cl. For details, see Compare Cls Report.
Report

Note: This option is only active when one or two Cls are selected.
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Menu ltem

Delete from
CMDB

Generate Sub
Report

Get Related Cls

Label

Note

Open
UCMDB Browser

Properties

Relate to CI

Run Impact
Analysis

Show
Compound Path

HPE Application Performance Management (9.40)

Description

Enables you to delete the selected Cl or relationship from the view and from the
RTSM.

Note: When you delete a parent Cl, the selected Cl and its children are removed
from the view, but only the selected Cl is removed from the database.

Opens the Generate Sub Report dialog box, which enables you to select perspectives
for the Cl to create a Sub Report. For details, see "Generate Sub Report Dialog Box"
on page 192.

Opens the Get Related Cls from CMDB dialog box. For details, see "Get Related Cls
From CMDB Dialog Box" on page 193.

Select one of the following options:

« Edit Label. Opens the Edit Label dialog box which enables you to edit the name of
the CI.

« Restore Default Label. Resets the Cl name to its default value from the RTSM.
Select one of the following options:
« Add Note. Opens an editing box where you can add a note to the ClI.

« Delete Note. Deletes all text saved in a note for the selected ClI.

Opens the UCMDB Browser.

Note: This option is only available when a single Cl is selected. It is not relevant
for relationships.

Displays the Properties page for the selected Cl or relationship. For details, see
"Configuration Item Properties Dialog Box" on page 188.

Opens the Insert Relationship dialog box. For details, see "Insert Relationship Dialog
Box" on page 193.

Enables you to run the Impact rule you defined in the Impact Analysis Manager.
Displays the Run Impact Analysis dialog box. For details, see "Impact Analysis
Manager" on page 304.

Note: You can only see Impact Analysis results if you defined an Impact rule for
that view in Impact Analysis Manager.

Appears only for compound relationships. Displays the Link Map for the selected
relationship, which shows the Cls involved in the compound relationship.
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Menu ltem

Show Impact

Show Root
Cause

Advanced Pane

Description

Enables you to select a Cl that is defined by an Impact rule as a root cause Cl, and to
display all the Cls that are impacted by it, and their statuses, in a separate window.

This option appears only after the following has occurred:

« You defined an Impact rule for the selected view in Impact Analysis Manager (for
details, see "Impact Analysis Manager" on page 304).

« You clicked Show in Views in the Run Impact Analysis dialog box.
« Impact Analysis results appear in the Topology Map.

For example, suppose an Impact rule is defined (for an IP Address Cl) that specifies
that the rule impacts nodes, ports, and client-servers linked to the IP Address.

By using the Show Impact option, you can display all Cls that are impacted by the IP
Address ClI.

This option enables you to retrieve root cause information for Cls that are impacted by
a chain of Impact rules. The output of Show Root Cause displays a logical map that
describes a chain of trigger/impacted CITs that impact the CI.

The root cause Cl is displayed in a separate window. If only one Impact rule is defined
for this Cl, the Impact Analysis window is directly displayed.

This option appears only after the following has occurred:

« You defined an Impact rule for the selected view in the Impact Analysis Manager
(for details, see "Impact Analysis Manager" on page 304).

« Youclicked Show in Views in the Run Impact Analysis dialog box.
« Impact Analysis results appear in the Topology Map.

A window is displayed containing the root cause Cl and all the other CITs in the
Impact rule chain.

To view the information about specific Cls that are triggered or impacted by the Impact
rule, double-click the relationship connecting the Cls. A map is displayed.

User interface elements are described below:

Ul
Element

(A-2) Description

Discovery Displays the discovery progress for the selected Cls. For details, see Discovery Progress
tab Dialog Box in the RTSM Data Flow Management Guide.

History Displays the history for the selected Cl. For details, see "Cl/Relationship History Dialog Box"
tab on page 187.
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ul
Element
(A-2) Description

Properties Displays the selected Cl's properties (the same properties that appear in the Configuration

tab Item Properties dialog box). You can view the properties in the properties tab, but you must
open the dialog box to edit the properties. For details, see "Configuration Item Properties
Dialog Box" on page 188.

Get Related Cls Pane

This pane enables you to control the different options for viewing related Cls for a selected Cl.

To access | Appears in the Related Cls tab of IT Universe Manager. If it is hidden, click the Show Get
Related Cls pane “4 button on the toolbar to display it.

Important | You can control the display in the Related Cls tab with the following controls:

information « Set the scope of the display

« Filter the related Cls by Cl type
o Apply perspectives to the selected Cl

Itis possible to display related Cls for several Cls at the same time. Hold down the CTRL
key to select multiple Cls at the same time in the Cl Selector or the topology map.

Note: You can select to run the Get Related Cls search over integrated Cls also. If the
search results include Cls from a federated data source, they appear in the topology
map with an arrow icon, indicating that they are federated Cls. However, you cannot
display related Cls of a federated CI.

Relevant "How to View Related Cls" on page 169
tasks

User interface elements are described below:

Ul Element
(A-Z) Description

< Back. Displays the previous search results.

) Forward. Display the next search results.

& Clear Current Display. When the button is selected, the related Cls are added to the
current results. When it is not selected, the current display content is cleared and only the
new related Cls are displayed.

El=3| Display search results with/without grouping. When the button is selected, the related

Cls are displayed with the hierarchical grouping of the applied perspective. When it is not
selected, the related Cls are displayed without any grouping.
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Ul Element
(A-Z) Description
+ Select Target Integration Points. Enables you to include integrated Cls in your search
- results. Select the required integration points from the pop-up dialog box.
Note: If you select a disconnected integration point for your search, an error message
appears when the search is run, asking if you want to see local search results.
Apply Select perspectives from the list to apply to the selected Cl. Only perspectives relevant to
perspectives the selected Cl appear in the list. The selected Cl is used as content for the selected
to Cl perspectives and the view results are displayed.
Filter Select the Cl types from the list to display in the related Cl results. Only the selected Cl
Related Cls  types appear in the displayed results.
by Cl Type
Select Select the scope of the related Cls displayed:
scope o View. All related Cls in the selected view.
o CMBDB. All related Cls in the RTSM.
Note: This feature is not available in the Get Related Cls from CMDB dialog box
opened from the shortcut menu.
Show Click to display the related Cls according to your selection.
Related Cls

New Cl/New Related CI Dialog Box

This dialog box enables you to define a new CI or a new related CI.

To access In IT Universe Manager, click the New CI ® button on the toolbar to create a non-related
Cl. Select a Cl in the topology map and click the New Related CI w button to create a
related Cl.

Important = To define a new Cl, select the ClI type from the tree at the top of the dialog box. The Cl types
information  in the tree that are available to be instantiated appear in black. The Cl types in faded text
cannot be instantiated.

Edit the properties in the Define new CI properties area. The table below includes the
properties which are common to all Cls. In addition, there are other properties specific to
each ClI.

If you are creating a related Cl, click Relationship to go to the relationship mode of the
dialog box. Select a relationship and edit its properties.

Relevant "How to Create Cls and Relationships" on page 168
tasks
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See also « "CI Selector" on page 112
« "Relationship Dialog Box" on the next page
« "Cl Lifecycle and the Aging Mechanism" in the RTSM Administration Guide

User interface elements are described below:

Ul Element

(A-Z) Description

Actual The period after which the Cl is deleted when the aging mechanism is enabled.

Deletion

Period

Allow CI When the value is set to true, this option enables the DFM process to automatically update
Update the CI properties with information that it discovers. If you change the value of a property

supplied by the DFM process, the value is overridden by the discovered value.

When the value is set to false, the Cl properties are not overridden by the DFM process.
Created By  The user name of the administrator who manually created the CI, where applicable.

Create Time @ The date and time when the Cl was created.

Deletion The period after which the Cl becomes a candidate for deletion when the aging mechanism
Candidate is enabled.
Period

Description A description of the CI.

Display The label that appears for the Cl in the topology map.

Label

Enable If a Cl or relationship is not updated or refreshed over a period of time (for example, a Cl is
Aging not rediscovered by DFM and no manual update occurs), an aging mechanism deletes the

CI from the RTSM. For details, see "The Aging Mechanism Overview" in the RTSM
Administration Guide.

True: the aging mechanism is enabled for this CI.
False: the aging mechanism is disabled for this CI.
The default value is determined by the default value of the Enable Aging attribute of the Cl
type.
Note:

« If the aging mechanism is disabled in Aging Status, this field is ignored.
« This field is displayed for certain Cls only.

« You can change the default value for all new Cls of this type by editing the default
value of the Enable Aging attribute for this Cl type. For details, see "How to
Enable and Run the Aging Mechanism" in the RTSM Administration Guide.

Is Candidate Indicates if the Cl is a candidate for deletion.
For Deletion
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Ul Element
(A-2) Description

Last Access Thetime that the Cl was last accessed, whether when being updated or being discovered
Time by DFM. This field is displayed only for certain Cls.

This parameter is used by the aging mechanism. For details, see "Cl Lifecycle and the
Aging Mechanism" in the RTSM Administration Guide.

Last The date and time when the CI properties were last updated.

Modified

Time

Name The name of the ClI.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the ClI, or the application where the Cl was
created.

Relationship Forarelated Cl, click Relationship to go to the relationship mode of the dialog box.

Select CI Enables you to select the Cl type from the tree for the new CI. The Cl types that are
Type available for the selected Cl or view appear active in the Cl type tree. The other Cl types
appear in faded text and cannot be selected.

To limit the Cl type tree to Cl types from the current view, select Cl Types from the
current view on the right. To display all Cl types in the tree, select All Cl Types.

Updated By The user name of the administrator who updated the CI properties.

User Label Enables you to define a display label for the CI. If no value is entered, the Cl name appears
as the default label.

Relationship Dialog Box

This page enables you to define the relationship between the new Cl and the Cl selected in the view, as well
as the properties of the relationship.

To access Click Relationship from the New Related CI dialog box.
Important information = This page only appears for new related Cls.

User interface elements are described below:

Ul Element

(A-Z) Description

Allow CI When the value is set to true, the DFM process automatically updates the relationship.
Update

Cl Definition CI Definition. Returns to the CI properties mode of the dialog box.

HPE Application Performance Management (9.40) Page 208 of 393



Modeling Guide
Chapter 8: IT Universe Manager

Ul Element
(A-2) Description

Created By  The user name of the administrator who manually created the relationship, where
applicable.

Create Time @ The date and time when the relationship was created.

Description A description of the relationship.

Direction Select the relationship direction from the drop-down box.
Enable If a Cl or relationship is not updated or refreshed over a period of time (for example, a Cl is
Aging not rediscovered by DFM and no manual update occurs), an aging mechanism deletes the

CI from the RTSM. For details, see The Aging Mechanism Overview in the RTSM
Administration Guide.

True: the aging mechanism is enabled for this relationship.
False: the aging mechanism is disabled for this relationship.

The default value is determined by the default value of the Enable Aging attribute of the Cl
type.

Note:

« If the aging mechanism is disabled in Aging Status, this field is ignored.
« This field is displayed for certain relationships only.

« You can change the default value for all new relationships of this type by editing the
default value of the Enable Aging attribute for this relationship type. For details,
see How to Enable and Run the Aging Mechanism in the RTSM Administration
Guide.

Last Access The time that the relationship was last accessed, whether when being updated or being
Time discovered by DFM. This field is only displayed for certain relationships.

This parameter is used by the aging mechanism. For details, see Cl Lifecycle and the
Aging Mechanism in the RTSM Administration Guide.

Must When the value is set to true, the child Cl is dominant when the percentage rule is used to
calculate status for the parent CI. If the Cl has low status, the parent must take the child CI
status, overriding the percentage rule calculation if necessary. This is useful to give
emphasis to an important Cl. For example, you might want to define Must for a database
Cl, sothat status is critical all the way up the subtree if the database falls, regardless of the
status of the other Cls in the subtree.

The Must status defined for a relationship applies to that relationship only —it is not used in
any other relationships of the child CI.

Name The name of the CI.

Network Defined only for route links. Indicates the destination network address to which this route is
Address configured.

Note Enables you to enter other information about the CI.
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Ul Element
(A-2) Description
Origin An ID for the source that automatically created the relationship, or the application where the

relationship was created.

Relationship Enables you to define the type of relationship that is created between the two Cls.

Note: If you receive an error message about a lack of reconciliation data when you
create a Cl, use either a Composition or Containment relationship. You can change the
relationship to a different type after you create the CI.

Source CI The name of the CI on the first side of the relationship. This is the Cl that you selected in
the view.

Target CI The name of the Cl on the second side of the relationship. This is the new CI that you are
creating.

Updated By = The user name of the administrator who updated the relationship properties.
Update Time The date and time when the CI properties were last updated.
User Label Enables you to define a display label for the relationship.

Weight When a weight value is entered, the child Cl is given more weight in percentage
calculations, when the percentage rule is used to calculate status for the parent CI. For
example, if a child Cl is given a weight of 3, then it has three times more impact on the
parent status calculation than its unweighted siblings.

The weight defined for a relationship applies to that relationship only — it is not used in any
other relationships of the child CI.

Recently Discovered By Dialog Box
This dialog box displays the discovery jobs that discovered the selected Cl within the specified time period.

To In IT Universe Manager, right-click a Cl and select Actions > Recently Discovered By from
access  the shortcut menu.

User interface elements are described below:

Ul Element
(A-Z) Description
3 Refresh. Refreshes the data.

Discovered The date the Cl was discovered by the discovery job.
On

From Date Select the time period to check for jobs that discovered the selected ClI. You can select
Custom and a specific date to search all discovery jobs from that date until now.

Job Name  The name of the job that discovered the selected CI.
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Ul Element
(A-2) Description
Probe The probe on which the Cl was discovered.

Trigger ClI | The trigger CI for the discovery job.

Run Impact Analysis Dialog Box

This dialog box enables you to run the Impact rule you defined in Impact Analysis Manager for that view.

To access | Select Admin > RTSM Administration > Modeling > IT Universe Manager. Right-click
atrigger query node in thil’ opology Map and select Run Impact Analysis or click the Run

Impact Analysis Now |£| button on the IT Universe status bar.

Important You can:

information « Display in a new window all the Cls that are impacted by the trigger Cl. The relationships
in the map represent the Impact rules. The name of the relationship is the name of the
Impact rule you defined in the Impact Analysis Manager. For details, see "Show Map" on
the next page.
« Simulate how the statuses of the impacted Cls are impacted. For details, see "Show in
Views" on the next page.
« Generate a report that displays a list of Cls that are impacted in the system as a result of
the simulated changes. For details, see "Generate Report" on the next page.
Note: This dialog only appears if an Impact rule is defined for that view. For details, see
"Impact Analysis Manager" on page 304.
Relevant "How to Retrieve Impact Analysis Results — Scenario" on page 178
tasks
See also o "IT Universe Manager Overview" on page 158

o "Impact Analysis Manager Overview" on page 304
« "IT Universe Manager User Interface" on page 182

User interface elements are described below:

Ul Element (A-Z) Description

All Impact rules Select to execute all impact rules in the system in the impact analysis.
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Ul Element (A-Z) Description
Generate Report Generates an Impact Analysis report, which displays information that is divided
as follows:

o Grouping by CIT. All the impacted Cls (the Cls that are impacted in the
system as aresult of the simulated changes), sorted by CIT.

« Affected Application. All the impacted Cls that belong to a specific
business service.

« Triggered Cls. The Cls that represent the changes you want to make to the
system.

For details on the Impact Analysis report, see Impact Analysis Report.

Impact rules bundle Select the bundle containing the required impact rules for the impact analysis.
Only Impact rules Select to execute the impact rules from the specified bundle in the impact
located in specified analysis.

bundle

Show in Views Simulates how the statuses of the impacted Cls are impacted for the selected

state. The Topology Map displays the statuses of the trigger Cls as well as all
statuses of the Cls that are impacted by it.

The Topology Map also displays the Impact Analysis indicators:

« Atrigger Cl is marked by this indicator: .
« ACl thatis both animpacted and a trigger Cl is marked by this indicator: E|
« Animpacted Cl is marked by this indicator: .

Note: The statuses that appear here and the colors that represent each
status are defined in the severity list for that state in the System Type
Manager. For details, see "Create/Update List/Enumeration Definition
Dialog Box" on page 348.

Show Map Enables you to select an Impact rule, and then display in a new window, a
simulation of all the Cls that are impacted by the trigger Cl for the selected
state. If only one Impact rule is defined for this Cl, the Impact Rules window is
displayed directly. For more details, see "Show Impact Pane" on page 214.

The relationships in the map represent the Impact rules and the name of the
relationship is the name of the Impact rule you defined in the Impact Analysis
Manager.

Note: Show Map enables you to view the results of multiple triggers.
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Ul Element (A-Z) Description

Trigger Severity Select the required severity on the scale.

Note: The severity scale was defined for the state in the System Type
Manager. For details, see "System Type Manager" on page 322.

For example, you can create an Impact rule in the Impact Analysis Manager that
defines the severity of the trigger query node as other than Warning (1). If you
select a severity other than Warning (1), for example, Minor (3), the condition
is met and the simulated changes in the system are triggered.

For details, see the "Impact Rules Definition Dialog Box" on page 314.

Save Snapshot Dialog Box

This dialog box enables you to take a snapshot of a view and save it.

To access In IT Universe Manager, click the Snapshot [ button in the Cl Selector and select Save

Snapshot.

Important = You can compare snapshots of the same view taken at different times using the Compare
information Snapshots Report. For details, see "Compare Snapshots Report" on page 1.

Relevant » "How to Take a Snapshot of a View" on page 182
tasks « "How to Compare Snapshots" on page 1
See also o "IT Universe Manager Overview" on page 158

« "IT Universe Manager User Interface" on page 182

User interface elements are described below:

Ul Element (A-Z) Description

Description A description of the snapshot (optional).
Note A note about the snapshot (optional).
View Name The name of the view as it appears in the Cl Selector. This field cannot be edited.

Show Discovery Status and Changes Dialog Box

This dialog box enables you to find recent changes, for example, to an application, by rediscovering the Cls
and jobs in a view.
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To access  InIT Universe Manager:
« Torediscover all Cls of a view, click the Show Discovery and Changes Summary

e
{E> button on the toolbar of the Browse Views tab in the Cl Selector. The Show
Discovery Status and Changes dialog box is displayed.

« Torediscoverone Cl or several Cls in a view, select the Cl and display the Discovery
tab in the Advanced pane.

Important By default, you can run the rediscovery procedure on views that include less than 10,000
information Cls.

Toincrease the number of Cls that you can rediscover in a view:

1. Access the Infrastructure Settings Manager (Admin > Platform > Setup and
Maintenance > Infrastructure Settings).

2. Select the Max Cls in view supported to rediscover setting in the infrastructure
settings table.

3. Click the Value column and change the number.
4. Restart the server for the change to take effect.

For details on working with the Infrastructure Settings Manager, see "Infrastructure
Settings" in APM Platform Administration Guide.

Relevant "How to Check the Status of Application Discovery (Rediscover a View)" on page 170
tasks
See also « "Discovery Control Panel - Details Tab" in the RTSM Data Flow Management Guide

« "IT Universe Manager User Interface" on page 182
User interface elements are described below:
Ul Element (A-Z) Description

|%| Refresh. Refreshes the status of the selected Cls.

This button is disabled when there is no data to be reloaded.

|E| Rerun Discovery. Reruns the discovery.
Discovery Progress For details, see "Discovery Control Panel - Details Tab" in the RTSM Data
Status on View Flow Management Guide.

History Changes on View  For details, see "Cl/Relationship History Dialog Box" on page 187.

Show Impact Pane

This page opens a window that displays the statuses of the trigger Cl as well as all statuses of the Cls that
are impacted by it.
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To access | Inthe Run Impact Analysis Dialog box, click Show Map.

If Impact Analysis is already active, click the Impact Analysis Is Active link onthe IT
Universe status bar.

Important The following tabs are available:

information « Impact Results. Displays a map of all Cls impacted by the selected ClI.

« Trigger Cls. Displays a table of information on the selected trigger Cls.

You can only see Impact Analysis results if you defined an Impact rule for that view in
Impact Analysis Manager. For details, see "Impact Analysis Manager" on page 304.

To view information about specific Cls that are triggered or impacted by the Impact rule,
double-click the relationship connecting the Cls. A map is displayed.

The relationships in the map represent the Impact rules. The name of the relationship is the
name of the Impact rule you defined in the Impact Analysis Manager.

Relevant "How to Retrieve Impact Analysis Results — Scenario" on page 178
tasks
See also « "IT Universe Manager Overview" on page 158

« "Impact Analysis Manager Overview" on page 304

« "IT Universe Manager User Interface" on page 182

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Legend> Indicates the icons displayed next to Cls with any of the following special statuses:

« Added. When Change Timeframe is active, indicates that the Cl was added.
« Candidate for Deletion. Indicates that the Cl is a candidate for deletion.

« Changed. When Change Timeframe is active, indicates that the Cl was
changed.

« Drill Down One Layer. Indicates that there are Cls under the Cl on a lower layer.
« External. Indicates that the Cl is a federated Cl.
« Impacted. When Impact Analysis is active, indicates an impacted CI.

« Impacted and Trigger. When Impact Analysis is active, indicates a trigger CI
that is impacted.

« Note. Indicates that a note was added for the CI.
« Trigger. When Impact Analysis is active, indicates a trigger Cl.

<Relationship> The relationships represent the Impact rule you defined in the Impact Analysis
Manager. For details, see "Impact Rules Definition Dialog Box" on page 314.

<The statuses The statuses that appear and the colors that represent each status are the ones that
and the colors are defined in the severity list for that state in the System Type Manager. For details,
that represent see "Create/Update List/Enumeration Definition Dialog Box" on page 348.

each one>
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Ul Element (A-Z) Description

<Toolbar> The Show Impact pane toolbar contains most of the buttons on the IT Universe
Manager toolbar.

<Topology Map For details, see "Topology Map Sidebar" on page 147.
Sidebar>
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This chapter includes:
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Tip: For more information about using Modeling Studio in HPE Application Performance Management,
see "Best Practices for Modeling" on page 151.

Modeling Studio Overview

Modeling Studio is a tool for creating and managing views. You can create your own views, or work with the
out-of-the-box (factory) views provided with your HPE Application Performance Management installation.

The IT Universe model in the configuration management database can be very large, holding thousands of
configuration items (Cls). A view enables you to build a subset of the overall IT universe model, containing
only those Cls relating to a specific area of interest. You can define your own views to display only the
information that is relevant to your organization's business needs.

The views are used to display performance status in Service Health, and for setting up SLAs in Service Level
Management. HPE Application Performance Management supports three view formats: pattern views,
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template based views, and perspective-based views, which are populated through different processes. For
details, see "View Formats" below.

View Formats

HPE Application Performance Management supports three view formats that can be used to populate your
view:

« Pattern views are built from a Topology Query Language (TQL) query that defines the structure of the
view. You can create a new TQL query as you build the view or base the view on an existing query. The
view displays only those Cls and relationships that satisfy the query definition. When the view is
displayed or refreshed, the Modeling Studio queries the RTSM for all elements that fit the query, and
automatically updates the view with those elements.

« Template based views are based on a TQL query, to which a template is then applied. The template is a
reusable view that includes parameters, which are saved as part of the template. This enables you to build
multiple views with the same settings without having to re-enter the parameter information. The view
displays only those Cls and relationships that satisfy the query definition and the conditions of the
template. For details on templates, see "Templates and Perspectives" on page 220.

« Perspective-based views are built by selecting a collection of individual Cls and applying a special type
of template, known as a perspective, to it. Instance views, which no longer exist, are replaced by
perspective-based views. For details on perspectives, see "Templates and Perspectives" on page 220.

When you select a view for editing from the view tree in the left pane, it opens on the editing pane in the
appropriate editor.

Local Impact Views

Within Service Health Administration, you can use the View Builder to create Local impact views, which are
independent of all other views. For example, suppose you have a global view which contains a number of Cls
representing business transactions, and you are only interested in the data coming from two or three
significant transactions. You can create a local impact view based on the global view and remove the less
important transactions from the local impact view. The calculations within the view are performed using only
those transactions that are visible within the view. For details, see the section on View Builder in the HPE
Application Performance Management Application Administration Guide.

Building a Business View

In the Modeling Studio, you can define your own views to model your business environment.
This section includes the following topics:

¢ "The Structure of a View" below

« "Setting the View Hierarchy" on the next page

The Structure of a View

The views you create should provide the business users with logical representations of your company's
structure, processes, and goals. To meet these requirements, you generally build multiple views representing
different aspects of your business; for example, you could build business views that revolve around any of the
following:
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« Company structure, so that data is organized by the geographical location of branches, or by data centers.
« Business processes, so that data is organized by line of business, or by applications.
« Business goals, so that data is organized by sales, or by key customers.

The views depend on the particular demands of your organization and the actual hierarchical structure of the
views should reflect those demands.

The usual hierarchical format of a view is as follows:

« Top level. The highest levels of the view, consisting of the root Cl and the branches below it, are normally
built from logical Business Cl types such as Location, Line of Business, Customer, Application, and
soon.

« Intermediate level. The intermediate branches of the view normally consist of System Cl types,
representing actual hardware and software and/or monitoring group ClI types, representing groups
containing monitors.

« Bottom level. The lowest level of the view, consisting of leaf Cls at the ends of the subtrees, is built from
the Monitor Cl types. These Cls receive the actual data from the data sources, used to determine KPI
status all the way up the view subtrees, and so provide business context to the view.

Note: The bottom level is only relevant when a monitoring solution such as HPE Application
Performance Management is connected and modeled in the RTSM.

Setting the View Hierarchy

The Pattern View Editor enables you to set the view hierarchy using the Hierarchy pane on the right side of the
screen. There are two methods available for setting the hierarchy: Manual and Rule-based. The manual
method is selected by default.

« Manual Hierarchy Method

In the manual hierarchy method, the query nodes of the view are displayed in a tree format. You can create
the hierarchy by manually dragging a selected query node under another query node or by using the toolbar
buttons. The system only allows you to move a query node under another query node when the resulting
hierarchy is valid. For details, see "Hierarchy Pane" on page 274.

Itis possible to place a single query node from the view into the hierarchy multiple times. You can then
adjust the hierarchy so that the query node appears in different layers, according to the required layout.
The view results in such an instance would be the same as if you added another query node to the TQL
query. Using the same query node twice in the hierarchy enables you to achieve the desired view results
using a simpler TQL query.

Query Node Grouping

When setting the view hierarchy manually, you can create subgroups to group Cls by different criteria for

the convenience of viewing the display. Click the Add Group By =] button and select one of the
options. You can create a subgroup for Cls of the same type in the Topology Map using the Add Group
by CI Type option. You can create a subgroup for a specific query node by selecting the Add Group by
View Node option. You can group Cls by a common attribute using the Add Group by Attribute button
and entering a regular expression as described in "Query Node Grouping Dialog Box" on page 285. For
details about regular expressions, see "Regular Expression Examples" on page 392.

You can also create nested groups (a query node group inside another query node group) to help fine-tune
the TQL query results that are displayed in the Topology Map.
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For example, after grouping query nodes of type node by their CIT, you can use their operation state
attribute to create more focused groups.

« Rule-Based Hierarchy Method

In the rule-based hierarchy method, you define hierarchy rules, using the Hierarchy Rules dialog box. You
select a source CIT, target CIT, relationship type, and relationship direction, which define the conditions
for a hierarchy rule. Any Cls in the view which satisfy the defined conditions are subject to the rule, that is,
the target Cl is placed on the layer below the source Cl. For details on defining hierarchy rules, see
"Hierarchy Rules Dialog Box" on page 252.

Hiding and Displaying Query Nodes in the View Results

You can select to hide certain query nodes so they do not appear in the view results. The following options are
available:

« Hide/Show Element in Query Results. These options are available by right-clicking a query node in the
Query Definition pane. Cls matching a query node that is set as hidden are excluded from the query
results. You cannot set all of the query nodes as hidden; at least one query node must be shown for the
query definition to be valid.

- Set View Node Invisible/Visible. These options are available by right-clicking a query node in the
Hierarchy pane. Cls matching a query node that is set as invisible are excluded from the view results.
However, if a function is defined in the Report Layout pane, it takes invisible query nodes into account. For
example, a Count function will include Cls corresponding to invisible query nodes in the total count.

When a query node is set as invisible in the hierarchy, all of its descendants are automatically set as
invisible. This enables you to hide an entire branch of the view results. The query definition cannot have
visible query nodes under an invisible query node. When an invisible query node is set as visible, its
descendants are not changed automatically.

A valid hierarchy definition must have at least one visible query node, other than the root query node. The
root query node can never be set as invisible.

When the TQL query is calculated, the RTSM first filters the query results by the Hide/Show Element in
Query Results settings. The query results are then filtered again by the Set Query Node Invisible/Visible
settings. The final view results reflect the combination of both filters and are displayed in IT Universe
Manager, the Result Preview in Modeling Studio, and the topology report for the view in Reports.

Templates and Perspectives

A template is a reusable pattern view with defined parameters. You use templates to build template-based
views, setting the values of the parameters for each specific view. Any changes made to a template affect all
existing views based on that template.

Template-based views can be opened in IT Universe Manager, like pattern views. You can also open the
template itself in IT Universe Manager to view the results for various parameter values. If you want to save
the results, you must save it as a template-based view. You define templates, template-based views, and
pattern views in the Pattern View Editor.

Perspectives are a type of template designed to be applied to a specific collection of Cls, similar to the pattern
in a pattern view. For example, a perspective could comprise a node containing an IP Address. In that case,
the resulting perspective-based view would include all the Cls from among the Cls in the Cl selection, along
with the IP Addresses contained in the node Cls.
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The most basic perspective is known as the Content Only perspective and consists of only the query node
itself. If you apply the Content Only perspective to a Cl collection, the resulting view contains only the
selected Cls themselves.

Perspectives are also created and edited in the Pattern View Editor. You can have multiple views, templates,
and perspectives open in the Pattern View Editor simultaneously, each with its own tab.

Perspectives do not appear in the list of views in the IT Universe Manager; however, perspective-based views
can be opened in the IT Universe Manager, like all other views. For details, see "Building a Perspective-based
View" on page 225.

In summary, the Views tree in the Resources tab of the Cl Selector in the Modeling Studio can include the
following distinct entities:

« pattern views

« templates

« template based views

» perspectives

« perspective-based views

You canfilter the tree to select the types of views or templates to display.

The following table summarizes the types of views and where they are created and viewed:

Type of View Created in: Can be opened in IT Universe Manager
Pattern View Pattern View Editor Yes

Template Pattern View Editor Yes, for the current session only
Template-based View Pattern View Editor Yes

Perspective Pattern View Editor No

Perspective-based View  Perspective-based View Editor = Yes

Predefined Folders and Views

The Views tree in the Resources tab of the Cl Selector in the Modeling Studio includes predefined folders and
views, as described in the following sections:

« "Predefined Folders" below
« "Factory Views" on the next page

« "Predefined Perspectives" on the next page

Predefined Folders

The hierarchical file folder system in the Cl Selector can help you organize your views. Predefined folders are
provided for the out-of-the-box views; you can modify these folders, or add additional folders according to your
organization's requirements.
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Factory Views

Your HPE Application Performance Management installation includes out-of-the-box pattern views,
templates, and perspectives. These views provide a quick start for working with the RTSM for setting up
SLAs, and for viewing system performance information in Service Health.

The out-of-the-box views are initially empty. As soon as Cls are added to the RTSM by one of the Cl
generators, the TQL query built into each pattern view is able to identify the Cls that meet the pattern
requirements, and add them to the view.

Views for Cls are created when a discovery process is run; the out-of-the-box views that are provided
correspond to the relevant Universal Discovery packages. For example, the Oracle view (Root > Database >
Oracle > Oracle) is populated with Cls that are created when Data Flow Management activates the
Database - Oracle module. For details on running DFM, see "Module/Job-Based Discovery Workflow" in the
RTSM Data Flow Management Guide.

For details on the cross-application processes for setting up the SAP views, see "Application Management for
SAP Reports and Views" in Solutions and Integrations.

Some of the out-of-the-box views are set by default to display in specific HPE Application Performance
Management applications. There are some out-of-the-box views that are hidden by default.

Some of the out-of-the-box views are considered basic to the system and cannot be deleted from the folders.

Predefined Perspectives

HPE Application Performance Management also provides out-of-the-box perspectives. One example is the
Content Only perspective, which includes only the elements of the view content itself, without any additional
Cls.

The following out-of-the-box perspectives are intended to be used in Service Health:

« System Monitors only. This perspective enriches the model by adding child Cls down to the level of
monitors. Use this perspective to create a Service Health view that includes System monitors only.

« End User Monitors. This perspective enriches the model by adding child Cls related to the end user
experience of the application, such as Business Transaction and Business Transaction Flow. Use this
perspective to create a Service Health view that includes monitoring statuses for End User Management
only.

« Impact. This perspective enriches the model with all child Cls related by impact links. Use this
perspective to configure additional monitors using the Monitor Deployment Wizard.

« Model and Dependency Hierarchy. This perspective enriches the model with all dependent Cls in the
RTSM. Use this perspective to create a view with the full model hierarchy.

« APM Perspective. This perspective enriches the model with Business Transactions Flow and Business
Transaction Cls. Use this perspective to add related infrastructure elements and SiteScope monitors to
create a view that includes all APM information.

Creating Template Based Views

Template-based views based on the same template contain the same query nodes and relationships. They
differ only in their parameter values. You create template-based views using the Template-based View
wizard. The wizard enables you to create multiple views at one time based on the same template. When
creating multiple views, you have the option of entering parameter values manually or importing them from a

HPE Application Performance Management (9.40) Page 222 of 393



Modeling Guide
Chapter 9: Modeling Studio

CSV file. The CSV file must be formatted correctly for the wizard to import the values. It must contain the
name of at least one of the template parameters in the first row and it must contain at least one record. The
records should be in separate rows and the parameter values for each record should be in the same row,
separated by commas.

The wizard also provides an Advanced Naming feature, which enables you to define an expression for the
view names based on parameter values. For example, if your base template is called Server_Template, and
one of the template parameters is Serial Number, you could define the view names to be Server <Serial
Number>. In this way, the wizard automatically inserts the respective value of the parameter Serial Number
into the name of each view.

An alternate way to assign names to the views when importing values from a CSV file is to include a column
in the file called template_based_view_name. The file entries corresponding to this column are automatically
entered by the wizard as the view names. Note that this naming method overrides the Advanced Naming
feature; that is, view names are assigned the entries in the template_based view_name column of the file,
even when the Advanced Naming feature is selected.

For details on creating template-based views, see "Template-based View Wizard" on page 292.

You can also edit the parameters of a template-based view when the view is open in the Editor, from the
Template Parameter Values dialog box. For details, see "Template Parameter VValues Dialog Box" on page
297.

You cannot edit the report layout for a template-based view. To change the report layout, you need to make
changes in the base template of the view.

Business Cl Models

This section includes the following topics:

« "Instance-based Models" below
« "Pattern-based Models" on the next page
« "Defining a Pattern-based Model over an Instance-based Model" on the next page

The collection of Cls which compose the view content of perspective-based views can be selected in two
ways. You can select Cls from the Cl Selector and drag them onto the editing pane. In this case, you can
build a view by applying a perspective to the collection and the collection cannot be reused in another view
without repeating the selection process. The other way to select the Cls to appear in the view is by creating a
model.

A model is a reusable collection of Cl instances that define a business entity, such as a business service or
line of business. By creating a model, you are building a Cl collection that can be reused with other
perspectives to create different views. Any changes you subsequently make to the model are reflected in all
the views based on that model. There are two types of models: instance-based models and pattern-based
models.

Instance-based Models

You build an instance-based model by first selecting a business Cl to serve as its basis. The available
business Cls include group, application, business service, business unit, and line of business. Then, you can
add Cls to your model in the following ways:
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« Manually, by dragging Cls from the Cl Selector into the Model Editor
« Revealing related Cls using a reveal path and selecting the ones to add to the model
« Defining a watchpoint for a selected Cl and automatically adding Cls to the model

You can also begin building a model by dragging Cls onto the empty canvas and selecting Create a new
model.

The model you create is a Cl itself and the Cls in your model are related to the model by Contains
relationships. You must save your model before applying a perspective to it to build a view.

Caution: The changes you make in a model affect the entire universe, not just the views based on that
model. Thus, if you delete a Cl from a model, you are deleting the relationship that existed between the
Cls from the RTSM.

When working in IT Universe Manager, you can add selected Cls directly to a new model or an existing
model. For details, see "Add Cls to Model Dialog Box" on page 183.

Pattern-based Models

Another type of model you can build is a pattern-based model. In a pattern-based model, you define a TQL
query to determine the Cls included, rather than selecting them manually. You can base your pattern-based
model on an existing TQL query or create a new TQL query.

You must designate at least one query node in the model's TQL query as output for the model. The Cls of that
type which match the pattern of the TQL query are the ones included in the model output.

The pattern-based model created is saved as a Cl like an ordinary model, and can be used to form the content
of a perspective-based view. The new TQL query created is saved as an ordinary query and can be used as
the basis for a pattern view.

Pattern-based models are not updated continuously. Each model is calculated at the time it is saved and the
TQL query runs at specific intervals to update the model. All existing pattern-based models are updated at the

same time. To set the frequency of the pattern-based model updates, click the @ button in the Resources
tab of the left pane to open the Pattern Based Model Scheduler dialog box. The settings you select also apply
to all pattern-based models created subsequently. For details, see "Pattern Based Model Scheduler Dialog
Box" on page 270.

Note:

« When you export a pattern-based model in Package Manager, the underlying TQL query of the model,
as well as an enrichment used to update the model content, are added to the package. When you view
the package resource, or deploy or undeploy the package, only those resources are displayed. The
model name does not appear. A pattern-based model exported from UCMDB 10.x cannot be imported
into a UCMDB version earlier than 10.00.

« When you delete a pattern-based model (either from the Modeling Studio or from the IT Universe), the
Business Enrichment, Job Scheduler, and pattern-based model Cl are also deleted.

Defining a Pattern-based Model over an Instance-based Model

When defining a pattern-based model, it is possible build it on top of an existing instance-based model. In this
case, only the pattern of the model that you build is visible on the canvas, as in a new pattern-based model.
However, the Cls in the instance-based model also remain in the new model and appear in the view results
when the model is used to build a perspective-based view. Similarly, when you access the model in IT
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Universe Manager, both the Cls in the instance-based model and those retrieved by the pattern-based model
are visible. The model is saved with the name of the original instance-based model, in effect creating a hybrid
model with both instance-based and pattern-based components.

If you delete the model, only the additional pattern-based part of the model is deleted. The model reverts to an
instance-based model and the Cls included in it become visible in the Model Editor.

Building a Perspective-based View

A perspective-based view is composed of perspectives applied to a model or a collection of Cls. The
perspective is a special type of template which is designed to be applied to a subset of the IT Universe model.

The Content pane of the Perspective-based View Editor displays the models or Cls you have selected to
serve as the basis of your view. The Perspective pane displays the selected perspectives. The Preview pane
displays the resulting view based upon your content and perspective selections. When you make a change in
the content or perspective selections, the view is updated accordingly in the Preview pane. For details, see
"Perspective-based View Editor" on page 279.

This section includes the following topics:

« "Content" below
« "Perspectives" below
« "Views Based on Multiple Perspectives" on the next page

« "Including and Excluding Child Cls" on page 227

Content
The content in a perspective-based view can be selected in two ways:

« You can add individual Cls to the view manually, using the Cl Selector. The Cls in the collection are
independent of each other. In this case, the collection of Cls is not defined as a model and cannot be
reused in another view.

« You can add one or more models to the view, using the Cl Selector. Alternatively, you can start by working
with a model in the Model Editor and select Generate View for Selected Model to build a view based on
that model. In this case, the identical content can be used to build another view by selecting the same
models.

You can select both individual Cls and models to form the content of a perspective-based view; however in
that case, the models are treated as ordinary Cls. The models themselves are included in the view without
their hierarchy of child Cls.

When working in IT Universe Manager, you can add selected Cls directly to the content of a new or an
existing perspective-based view. For details, see "Add Cls to View Dialog Box" on page 183.

Perspectives

The perspectives you select for your view determine which Cls are included in the view. A perspective is a
reusable pattern, similar to a template. The difference between a perspective and a regular template is that the
perspective includes one or more query nodes designated as contact query nodes. A contact query node is a
query node in the pattern which is used to apply the pattern to specific content and it is indicated by a small
icon that appears next to the query node . .
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For example, in the following perspective, a query node of type Windows is designated as the contact query
node and it has an IP Address related to it by a containment relationship.

=
A
indows

Contalnment

m

IpAddress

When this perspective is applied to a Cl collection, the resulting view contains all the Cls in the original
collection as well as the IP Addresses connected to the Windows Cls in the collection (the Cls that were
added by applying the perspective).

A perspective can have several contact query nodes, but every disconnected graph within a perspective must
have at least one contact query node.

If you make a change to a perspective, all views based on that perspective are affected.

Views Based on Multiple Perspectives

You can select multiple perspectives to apply to the content of your view. There are two ways to select
multiple perspectives:

« Perspective groups
« Perspective chains

In a perspective group, you select two or more perspectives to apply simultaneously to the same input
content.

In a perspective chain, you select two or more perspectives at different levels of the view creation. The
perspective in the first level is applied to the original view content to generate results in the form of a Cl
collection that serves as input content for the next level. The perspective in the second level is then applied to
this content to generate the view results. You can build views based on multiple levels of perspectives, each
one generating input content for the following level.

It is possible to apply both of the above methods at the same time, that is, by selecting multiple perspectives
in each of the levels of a perspective selection.

For example, select a collection of IP Subnet Cls as your input content and select a perspective that adds the
node Cls related to the IP Subnets as the first level perspective. The results of this stage consist of the
original IP Subnets and their related nodes. Then add a second perspective level and select two perspectives
forit: one that adds CPU Cls related to nodes and one that adds File System Cls related to nodes. The final
results include the original IP Subnets, their related nodes, and the CPUs and File Systems related to those
nodes.

These options help to simplify the process of creating a perspective-based view, by breaking down the
functionality of a perspective into its component parts. Instead of building a separate large and complex
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perspective for each required view, you can construct a custom perspective combination to match the
requirements of your specific case from smaller and more basic perspectives.

Including and Excluding Child Cls

When adding Cls that have children to a view, the Cl and its children are only included in the view if the
pattern of the perspective includes children for the selected Cl type. In that case, children are included for all
Cls of that type. After creating a view, you can hide specific Cls from the view by selecting the Cl in the View
Results pane and selecting Hide CI from View from the shortcut menu or clicking the Hide CI from View
button on the toolbar. This option is only available for Cls that were added to the view via the perspective and
were not part of the original content on which the view was based. Thus, if the view was based on a collection
of Cls, the Cls in that collection cannot be hidden from the view. If the view was based on a model, the model
itself cannot be hidden from the view, but the Cls contained in the model can be hidden.

When KPI status is calculated for a Cl and displayed in Service Health, the status is based on all child Cls
that exist in the RTSM for the parent Cl. The Business Logic Engine calculates status from all child Cls
attached to that parent Cl, across all views. The calculation is based on all the relationships for the Cl in the
RTSM, without connection to the child Cls displayed in any particular view. To restrict the number of Cls
displayed in the view, you can change the perspective to hide child Cls. This has no effect on KPI status —
status is still calculated based on all child Cls, whether they are displayed in the view or hidden.

Whether or not all child Cls are displayed in the view does not influence the status calculations made for the
parent Cl and the status displayed in Service Health.

For example, the following pictures show status in Service Health for the same ClI, Groupl, in two views: In
the first view, child Cls are included, and in the second, they are excluded. The same status result is shown
for the ClI in both views, regardless of the perspective in use.

Top View | Console | Filters | Geographical Map | Custom Map | | Reports |

BPM_Profile1 -

Performance a*g Availability O ta ack &

Hierarchy KPIs Business Impact Ale
Hame Perfnrmi:
Ej ‘_.r cnn? ¥ a*ﬁ
--_' cnn2 ™ G*ﬁ
= ‘-"" google * (V] #
--_‘ google * VAL

Top View I Console | Filters Geographical Map Custom Map Reports

BPM_Profile1 ~

Performance G*G Availability ':..-'*e Ack =

When a Cl has child Cls that are excluded from the view, the KPI tooltip in Service Health shows the number
of hidden child Cls with KPls attached, to indicate that the KPI status of the parent is based on Cls that are
not in the view.
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Details - Performance

CI name: fist_bprn_profile_1
Status: Critical

Calculation Rule: Warst Child Rule
Held status since: 1006 10:02:50 AM
Hidden child CIs

(with attached 5

KPIs):

You can use the Find Visible and Hidden Child Cls option to view information on hidden children. For
details, see "How to Find Visible and Hidden Child Cls" in Using Service Health.

Revealed Cls and Watchpoints

The Modeling Studio provides two advanced methods of adding Cls to an existing model: revealing related
Cls and defining watchpoints.

This section includes the following topics:

« "Revealing Cls" below

« "Watchpoints" on page 231

Revealing Cls

One approach to building a model is to add Cls related to the Cls in the model. The Modeling Studio provides a
tool to help you reveal those Cls. The process of revealing related Cls involves constructing a reveal path,
which is a chain of Cl types that are related to each other. The first item in your reveal path is the Cl type of
the CI from which you started to reveal Cls. The Modeling Studio locates all of its related Cls and lists their CI
types. By selecting one of those types, you build the next step of your path. All the related Cls of that type
appear in the lower pane of the dialog box. You can select the ones you want to include in your model. The
process is repeated to build the following step of the path.

For example, if you begin to reveal Cls from a Cl of type Windows, the Modeling Studio may reveal related
Cls of types Interface, Network, and IP. If you select Network, the related Cls of type Network appear in the
lower pane and can be added to the model by dragging them into the Cls Basket or clicking the Cls Basket
icon:
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Reveal (Is |
Revealing Related Cls... (2)
éh At each step ofthe reveal path, select revealed Cls to add to your model.
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Click Next to build the next step of the path using Network as your selection. The Modeling Studio reveals
related Cls of type Windows, Unix, and IP. Unix is selected and the Unix Cls appear in the lower pane and
can be added to the model by dragging the selected ones into the Cls Basket pane:
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Reveal CIs
Revealing Related Clis... (3)
At each step ofthe reveal path, select revealed Cls to add to your model.
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Click Next to build the next step of the path using Unix as your selection:
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In this case, a reveal path of Windows > Network > Unix was constructed. At each step, you have the
option of adding any of the revealed related Cls to your model. For details on revealing Cls, see "Reveal Cls
Dialog Box" on page 287.

It is also possible to construct a reveal path without revealing Cls. For details, see "Create/Edit/Save Reveal
Path Dialog Box" on page 249.

Watchpoints

Another method of locating related Cls to add to the model is by defining a watchpoint for a selected Cl in the
model. A watchpoint is a mechanism which is triggered when a new related CI of a specified type is created.
Every watchpoint is defined in connection with a reveal path. If a new related Cl of any Cl type included in the
path is created, the watchpoint is triggered and an indicator appears next to the model. For details on defining
awatchpoint, see "New Watchpoint Dialog Box" on page 268.

Note: You must save a new model before defining watchpoints for its Cls.

All the related Cls detected by the watchpoint are displayed in the Watchpoints Updates dialog box. The
dialog box enables you to select the ones to add to your model and the ones to suppress, or exclude from your
model. For details, see "Watchpoints Updates Dialog Box" on page 302.

You also have the option to include the detected Cls in your model automatically by selecting the check box in
the New Watchpoint dialog box. In this case, all Cls detected by the watchpoint are added to the model.
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A watchpoint can also be used to detect Cls included in the model which are no longer related to the model. If
such Cls are found along the reveal path connected to the watchpoint, they also appear in the Watchpoints
Updates dialog box. You can accept the suggestion to remove the Cls from your model, or you can suppress
the suggestion, thereby keeping the Cls in your model.

Note:

« Although a watchpoint is defined for an individual Cl, the watchpoint results display related Cls of the
Cl types included in the reveal path for all Cls in the model.

« When adding Cls to a model using watchpoints or revealed Cls in a multi-tenancy environment, only
Cls with a consumer tenant matching the owner tenant or consumer tenants of the model are added.

How to Create a Pattern View

This task describes how to create a pattern view and define its TQL query.
This task includes the following steps:

« "OpenaNew View in the Pattern View Editor" below

« "Add Query Nodes and Relationships to a TQL Query" below

« "Set the View Hierarchy" below

« "Set the View Properties" below

« "Define the Report Settings - Optional" on the next page

« "Set Permissions" on the next page

1. Open a New View in the Pattern View Editor

Click New |_| and select Pattern View. In the New Pattern View dialog box, select the base TQL query
on which your new view is based, or select Create new query to build a new TQL query. The Pattern
View Editor opens. For details, see "New Pattern View/Template/Perspective Dialog Box" on page 267.

2. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query nodes and
relationships to a TQL query, see "How to Add Query Nodes and Relationships to a TQL Query" on page
21.

Note: If you are starting with a blank view, you must add at least one query node in order to save
your view.

3. Set the View Hierarchy

Set the hierarchy for the view by moving the required query nodes in the Hierarchy pane. For details, see
"Setting the View Hierarchy" on page 219.

When you are finished, click Save |@]| to save the view.

4. Setthe View Properties

Set the view properties, such as the priority and the default layout for the view in the View Definition
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Properties dialog box. For details, see "Query/View Definition Properties Dialog Box" on page 285.

5. Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the report for
each query node of the view. You can also set the order of the report columns, set the sort order of each
column, and add a chart. For details, see "How to Define Report Settings" on page 239.

6. Set Permissions

Apply viewing and editing permissions to users and user groups for the new view. You set permissions in
Admin > Platform > Users and Permissions, select a user or a group and select Permissions. For
details, see "How to Assign Permissions" in APM Platform Administration GuideHPE Universal CMDB
Administration Guide.

How to Create a Template

This task describes how to define a new template.
This task includes the following steps:

« "Open aNew Template in the Pattern View Editor" below

« "Add Query Nodes and Relationships to a TQL Query" below
« "Set Parameter Values" below

« "Set the Template Hierarchy" on the next page

« "Set the Template Properties" on the next page

« "Define the Report Settings - Optional" on the next page

o "Set Permissions" on the next page

1. Open a New Template in the Pattern View Editor

Click New |_| and select Template. In the New Template dialog box, select the base TQL query on
which your new template is based, or select Create new query to build a new TQL query. For details,
see "New Pattern View/Template/Perspective Dialog Box" on page 267.

2. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query nodes and
relationships to a TQL query, see "How to Add Query Nodes and Relationships to a TQL Query" on page
21.

Note: If you are starting with a blank template, you must add at least one query node in order to save
your template.

3. Set Parameter Values

Right-click a query node or relationship in the TQL query and select Query Node Properties. In the
Attributes tab, add an attribute with a parameterized value. For details, see "Query Node/Relationship
Properties Dialog Box" on page 61.
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Note: If you do not set any parameters, when you try to save your template, you must save it as a
pattern view.

Set the Template Hierarchy
Set the hierarchy for the template by moving the required query nodes in the Hierarchy pane. For details,
see "Setting the View Hierarchy" on page 219.

When you are finished, click Save |@| to save the template.

Set the Template Properties

Set the template properties, such as the priority and the default layout for the template in the View
Definition Properties dialog box. For details, see "Query/View Definition Properties Dialog Box" on page
285.

Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the report for
each query node of the view. You can also set the order of the report columns, set the sort order of each
column, and add a chart. For details, see "How to Define Report Settings" on page 239.

Set Permissions

Apply viewing and editing permissions to users and user groups for the new template. You set
permissions in Admin > Platform > Users and Permissions, select a user or a group and select
Permissions. For details, see "How to Assign Permissions" in APM Platform Administration GuideHPE
Universal CMDB Administration Guide.

How to Create a Perspective

This task describes how to define a new perspective.

This task includes the following steps:

L]

"Open a New Perspective in the Pattern View Editor" below
"Add Query Nodes and Relationships to a TQL Query" below
"Select a Contact Query Node" on the next page

"Set the Perspective Hierarchy" on the next page

"Set the Perspective Properties" on the next page

"Define the Report Settings - Optional" on the next page

"Set Permissions" on the next page

Open a New Perspective in the Pattern View Editor

Click New |_| and select Perspective. In the New Perspective dialog box, select the base TQL query
on which your new Perspective is based, or select Create new query to build a new TQL query. For
details, see "New Pattern View/Template/Perspective Dialog Box" on page 267.

Add Query Nodes and Relationships to a TQL Query
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Add the query nodes and relationships that define the query. For details on how to add query nodes and
relationships to a TQL query, see "How to Add Query Nodes and Relationships to a TQL Query" on page
21.

3. Select a Contact Query Node

Select at least one query node in the TQL query to be a contact query node. Right-click the query node
and select Use As Contact Query Node.

Note: If you do not select a contact query node, when you try to save your perspective, you must
save it as a pattern view.

4. Set the Perspective Hierarchy
Set the hierarchy for the perspective by moving the required query nodes in the Hierarchy pane. For
details, see "Setting the View Hierarchy" on page 219.

When you are finished, click Save |@]| to save the perspective.

5. Setthe Perspective Properties

Set the perspective properties, such as the priority and the default layout for the perspective in the View
Definition Properties dialog box. For details, see "Query/View Definition Properties Dialog Box" on page
285,

6. Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you want to include in the report for
each query node of the view. You can also set the order of the report columns, set the sort order of each
column, and add a chart. For details, see "How to Define Report Settings" on page 239.

7. Set Permissions

Apply viewing and editing permissions to users and user groups for the new perspective. You set
permissions in Admin > Platform > Users and Permissions, select a user or a group and select
Permissions. For details, see "How to Assign Permissions" in APM Platform Administration GuideHPE
Universal CMDB Administration Guide.

How to Create a Dynamic Widget

This task describes how to define a new dynamic widget for the UCMDB Browser.
This task includes the following steps:

« "Create a New Dynamic Widget in the Pattern View Editor" below

« "Add Query Nodes and Relationships to a TQL Query" on the next page

"Select Attributes for the Widget" on the next page
« "Set Values for the Widget's Attributes" on the next page

1. Create a New Dynamic Widget in the Pattern View Editor

Click New |_| and select Dynamic Widget. In the New Dynamic Widget dialog box, select the base
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TQL query on which your new dynamic widget is based, or select Create new query to build a new TQL
query.

2. Add Query Nodes and Relationships to a TQL Query

In the View tab, add the query nodes and relationships that define the query. For details, see "How to Add
Query Nodes and Relationships to a TQL Query" on page 21.

Note: The root (and only the root) of the folding definition in the TQL query must be designated as a
contact query node for the dynamic widget to display data about that node in the UCMDB Browser.
If no contact query node is specified, the TQL query is saved as a pattern view and not as a dynamic
widget.

a. Specify whether to use a manual (default) or rule-based hierarchy when defining the TQL query. For
details, see "Setting the View Hierarchy" on page 219.

Note: If you are starting with a blank widget, you must add at least one query node in order to
save your widget.

b. Foreach property for which you want data to be displayed in notifications, do the following:
i. Right-click a node in the topology map and select Query Node Properties.
ii. Click the Element Layout tab.
iii. Select the Select attributes for layout radio button.

iv. Inthe Conditions pane, select either All (to display all attributes of the selected node) or
Specific Attributes (to display only the attributes you select).

V. Select attributes in the Available Attributes pane and click ) to add them to the Specific
Attributes pane.

vi. Click OK when you are finished.

3. Select Attributes for the Widget

In the Report tab, select a node in the Hierarchy pane, and choose the attributes for that node for which
you want data to be displayed in the widget.

Note: In the Hierarchy pane in either the Report tab or the View tab, you can specify a grouping
option on any node. Although you can choose between different grouping options, the Cl's attributes
are always displayed in groups by CI type when you view the dynamic widget in the UCMDB
Browser in Widget Details mode. To set a grouping option, right-click a node in the hierarchy tree and
select one of the grouping options (attribute, Cl type, or view node).

4. Set Values for the Widget's Attributes

In the Widget tab, select a node and specify how and where you want the selected attributes to be visible
in the widget. For details, see "Pattern View Editor" on page 273.

« Select the Show path check box to cause the UCMDB Browser to display the route in the dynamic
widget from a specific node in the view definition to all the node's children.

« Select the Browser Cl access control check box to ensure that the dynamic widget displays data
only according to the permissions that were specified on the Browser Cl Access Control tab in the
Roles manager. If the check box is not selected, the dynamic widget will display all data, without
permission enforcement.
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« Select aninitial display mode for the dynamic widget.
o Properties Mode. Displays individual properties for Cls.

Note: If you do not select a Widget Type value, Properties Mode is enabled by default.

o Topology Map Mode. Displays Cls according to your current topology.
o Topology CIT Group Mode. Displays Cls grouped by CI type according to your current model.
o Topology Textual Mode. Displays a list of Cls broken down by CI type.

The topology mode that you select is the initial view selection until you change to another one in the
UCMDB Browser.

When you are finished, click Save |@|

How to Create a Template Based View

This task describes how to define a single template based view.
This task includes the following steps:

« "Prerequisites" below

« "Define a New Template Based View" below

« "Select a Template" below

« "Select the Method for Adding Parameter Values" below

« "Set Parameters" below

« "Set Permissions" on the next page

1. Prerequisites

If you want to base your view on a new template, create the template first. For details, see "How to
Create a Template" on page 233.

2. Define a New Template Based View

You define a new template based view using the Template-based View wizard. Click New |_| and
select Template Based View.

3. Select a Template
On the Select Template page of the wizard, select a template on which to base your view. For details,
see "Select Template Page" on page 293.

4. Select the Method for Adding Parameter Values
On the Import Parameter Values page of the wizard, select the method for adding the parameter values.
For details, see "Import Parameter Values Page" on page 294.

5. Set Parameters

On the Enter Parameters page, enter the parameter values for the view. For details, see "Enter
Parameters Page" on page 294.
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Note: You can also edit the parameters from within the Editor after creating the view, by selecting

<P

Show Parameters from the toolbar or the shortcut menu.

When you are finished, click Finish to open the view in the Editor. Click Save || to save the view.

6. Set Permissions

Apply viewing and editing permissions to users and user groups for that view. You set permissions in
Admin > Platform > Users and Permissions, select a user or a group and select Permissions. For
details, see "How to Assign Permissions" in APM Platform Administration GuideHPE Universal CMDB
Administration Guide.

How to Create Multiple Template Based Views

This task describes how to define multiple template-based views.
This task includes the following steps:

« "Prerequisites" below

« "Define New Template Based Views" below

« "Select a Template" below

« "Select the Methods for Adding Parameter Values and Naming Views" below
o "Set Parameters" below

« "Select the Location for Saving the Views" on the next page

« "Save the Views" on the next page

« "Set Permissions" on the next page

1. Prerequisites
If you want to base your views on a new template, create the template first. For details, see "How to
Create a Template" on page 233.

2. Define New Template Based Views

You define new template based views using the Template-based View wizard. Click New |_| and select
Template Based View.

3. Select a Template
On the Select Template page of the wizard, select a template on which to base your views. For details,
see "Select Template Page" on page 293.

4. Select the Methods for Adding Parameter Values and Naming Views

On the Import Parameter Values page of the wizard, select the method for adding the parameter values.
Also, if you want to use the Advanced Naming feature, select the check box on this page. For details,
see "Import Parameter Values Page" on page 294.

5. Set Parameters
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On the Enter Parameters page, enter the parameter values for the view. If you selected to import the
parameter values from a CSV file, they are automatically entered in the table. You can edit the view
names and parameter values manually on this page. You can also add new views to the table or delete
views from the table. For details, see "Enter Parameters Page" on page 294.

6. Select the Location for Saving the Views

On the Select Location page, select the location in the view tree in which to save the new views. For
details, see "Select Location for Views Page" on page 295.

7. Save the Views

On the Summary page, review the details of the views you created. If there are no further changes, click
Save to save the views in the selected location.

8. Set Permissions

Apply viewing and editing permissions to users and user groups for each view created. You set
permissions in Admin > Platform > Users and Permissions, select a user or a group and select
Permissions. For details, see "How to Assign Permissions" in APM Platform Administration GuideHPE
Universal CMDB Administration Guide.

How to Define Report Settings

This task describes how to define report settings for a view, template, or perspective.
This task includes the following steps:

« "Prerequisites" below

« "Select Attributes to Appear as Report Columns" below

o "Add Function Columns to the Report - Optional" below

« "Set the Sort Order of the Column Content" on the next page
« "Add a Chart to the Report - Optional" on the next page

« "Set the Report Properties" on the next page

1. Prerequisites

After defining the content and hierarchy of a view, template, or perspective, you can define the report
settings. Select the Report tab in the Pattern View Editor.

2. Select Attributes to Appear as Report Columns

For each query node in the view, select the query node in the Hierarchy pane and select the attributes to
appear as columns in the report for that query node. You select attributes in the Query Node Definition
pane by moving them from the Attributes list to the Report Layout list. Set the order of the columns using
the arrow buttons in the Report Layout list. For details, see "Pattern View Editor" on page 273.

3. Add Function Columns to the Report - Optional

You have the option of adding a column for a selected query node consisting of data derived from a

function performed on one of its child query nodes. Click the Add Function & button to open the Add
Function dialog box where you can select the relevant settings. For details, see "Add/Edit Function

HPE Application Performance Management (9.40) Page 239 of 393



Modeling Guide
Chapter 9: Modeling Studio

Dialog Box" on page 245.

4. Set the Sort Order of the Column Content

Click the Set Sort Order =1 button to open the Sort Column Content dialog box. Determine the columns
by which to sort the report by moving columns from the Available Columns list to the Sorted Columns
list. Use the arrow buttons to set the sort order of the columns. Use the Sort Ascending/Sort Descending
buttons to set the sort direction for each column. For details, see "Sort Column Content Dialog Box" on
page 291.

5. Add a Chart to the Report - Optional

You have the option of adding a chart to your report, in place of a table, for a selected layer of the view.
When the necessary conditions for adding a chart are satisfied, the Define Chart link in the Chart
Properties section of the Query Node Definition pane is active. Click the link and enter the chart settings.
For details, see "Chart Properties" on page 278.

6. Setthe Report Properties

Select the View tab in the Pattern View Editor. Select the Report Properties [u1 button to assign a title
and subtitle to the report and to select the report format. For details, see "Report Properties Dialog Box"
on page 1.

How to Build an Instance-based Model

This task describes how to build an instance-based business Cl model which can serve as the basis for a
view.

This task includes the following steps:

o "Create the New Model" below
« "Add Cls to the Model Manually" below

"Reveal Cls" on the next page

"Define Watchpoints for Cls in the Model" on the next page

1. Create the New Model

In the Modeling Studio, click New |_| and select Instance Based Model to open the New Model dialog
box. Select a Cl type and enter the values for its properties. For details, see "New Model Dialog Box" on
page 267.

Note: You cannot create an instance-based model with an already existing name.

2. Add Cls to the Model Manually

In the CI Selector, search for the Cls you want to include in your model. Select them and drag them into
the model.

Tip: You can select more than one CI by holding the CTRL key while selecting Cls.
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3. Reveal Cls

Select a Cl in the model and reveal its related Cls along a reveal path. Add selected Cls from among the
revealed Cls to your model. When you are done, save the model. For details, see "Reveal Cls Dialog
Box" on page 287.

4. Define Watchpoints for Cls in the Model

Right-click a Cl in the model and select Watchpoint > New Watchpoint. The New Watchpoint dialog
box opens. Select a reveal path and click OK. A small icon appears next to the Cl indicating that a
watchpoint is defined for it. For details, see "New Watchpoint Dialog Box" on page 268.

How to Build a New Pattern-based Model

This task describes how to build a new pattern-based model which can serve as the basis for a perspective-
based view.

This task includes the following steps:

« "Define the New Model" below

« "Enterthe Model Details" below

« "Select a TQL Query" below

« "Add Query Nodes and Relationships to a TQL Query" below
« "Set Output Query Nodes" below

« "Save the Model" on the next page

1. Define the New Model

You define a new pattern-based model using the Pattern-based Model wizard. Click New |_| and select
Pattern Based Model.

Note: You cannot create a pattern-based model with an already existing name.

2. Enter the Model Details
On the first wizard page, select New Model. Then select a Cl type for the model and enter the properties.
For details, see "Select Cl Type Page" on page 272.

3. Selecta TQL Query
On the next wizard page, select a TQL query for the model. You can create a new TQL query or select an
existing query from the tree. The TQL Query Editor opens with the selected query. For details, see
"Query Selection Page" on page 272.

4. Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details on how to add query nodes and
relationships to a TQL query, see "How to Add Query Nodes and Relationships to a TQL Query" on page
21.

5. Set Output Query Nodes
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Select one or more query nodes in the TQL query to serve as output for the model by right-clicking them
and selecting Add to Model Output. The query node is indicated by a small icon next to it.

6. Save the Model

When you are finished, save the model with a unique name. If you created a new TQL query, the query is
also saved independently of the model and can be re-used as a regular TQL query.

How to Build a Perspective-based View Based on a
Model

This task describes how to build a view in the Modeling Studio based on a model and a perspective.
This task includes the following steps:

o "Open the Model" below
o "Select a Perspective" below

« "Save the View" below

1. Open the Model
In the Modeling Studio, select Models as the Resource type in the left pane, select the relevant model,

and click Open Model & on the left pane toolbar.

2. Select a Perspective

In the Model Editor, right-click the model and select Generate View for selected model. The Creating
New View dialog box opens. Select perspectives to apply to the model. For details, see "Creating New
View Dialog Box" on page 250.

3. Save the View

The Perspective-based View Editor opens with your new view. Optionally, build a perspective chain by
selecting perspectives for additional levels of the view creation. Rename the view and save it in the
correct folder. For details, see "Perspective-based View Editor" on page 279.

How to Build a Perspective-based View Based on a
Collection of Cls

This task describes how to build a view in the Modeling Studio based on a collection of Cls and a perspective.

This task includes the following steps:

« "Create the New View" on the next page
« "Add Cls to the View" on the next page
« "Select a Perspective and Save the View" on the next page
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1. Create the New View

In the Modeling Studio, click New |_| and select Perspective Based View to open the Perspective-
based View Editor. For details, see "Perspective-based View Editor" on page 279.

2. Add Cls to the View

In the CI Selector, search for the Cls you want to include in your view. Select them and drag them into
the view. For details on the Cl Selector, see "C| Selector" on page 112.

Tip: You can select more than one CI by holding the CTRL key while selecting Cls.

3. Select a Perspective and Save the View

In the Perspective pane, select perspectives to apply to your ClI collection. Optionally, you can build a
perspective chain by selecting perspectives for additional levels of the view creation. Rename the view
and save it in the correct folder. For details, see "Perspective-based View Editor" on page 279.

How to Build a Business Cl Model - Scenario

This scenario describes how to build a business Cl model for use in a human resources application.
This task includes the following steps:

« "Create a Model" below

« "Create Application Cl Models Within Your Model" below
« "Add System Cls to Your Model" on the next page

« "Add Cls to Your Model as Related Cls" on the next page

1. Create a Model

To create a model, you need to select a Cl type and enter its key properties.
Select Admin > RTSM Administration > Modeling > Modeling Studio to open the Modeling Studio.

For details about how to create a model, see "New Model Dialog Box" on page 267.
Exampleof a Business Cl Model:

In this example, a human resources application called Onboard Employee is to be created. Select
Business Process as the Cl type and enter Onboard Employee as the name under the key
properties.

2. Create Application Cl Models Within Your Model

You can create models within your model by clicking the New Model g button in the Model Editor. For
details, see "Model Editor" on page 258

Exampleof Application Cl Models:

Within the Onboard Employee model, create a model of type Application. Enter HR Enterprise
Resource Planning (ERP) as the name under the key properties. The application Cl is created as a
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model within the Onboard Employee model. Repeat the process to create the following applications:
Active Directory (AD) and Customer Relationship Management (CRM). The Onboard
Employee model now includes three application models.

3. Add System Cls to Your Model
Add to your model the Cls for the servers or other software elements on which the applications are
running.
Example of System Cl Models:

Under the HR ERPapplication, drag the System Cl| SAP System. Under the AD application, drag
the System CI Node. The System Cls are included in the model and their related Cls, such as
Hosts and Monitors, are automatically added to the model as related Cls.

4. Add Cls to Your Model as Related Cls

Add the Cls that are to be related to the Cls in the model but are not included in the model. For details,
see "Model Editor" on page 258.

Example of Related Cls:

Create an application CI of type Portal. Select the CRM application and click the Related Cls tab in
the Information pane. Drag the Portal Cl into the Information pane. The Cl is added as arelated Cl to
CRM.

Modeling Studio User Interface

This section includes (in alphabetical order):

® Add/Edit Function Dialog BOX ... .. oL 245
* Change Query Node/Relationship Type Dialog Box ... ... ... ... 246
* Choose Operation for Selected Items Dialog BOX ....... .. ... ... .. 247
* Conditions of Related Cls Dialog Box ... .. ... 248
* Create/Edit/Save Reveal Path Dialog BoX ... . ... 249
® Creating New View Dialog BOX ... o 250
¢ Cycle Definition Dialog BOX ... ..o L 250
¢ Hidden Cls Dialog BOX . ... L 251
® Hierarchy Rules Dialog BOX . . ... ... . L 252
O et Pane | 253
* Manage Cl Watchpoints Dialog BOX ... ... ... 258
® Model EditOr _ . 258
® Modeling Studio Page . ... ... 264
® Models Containing Selected Cl Dialog BOX ... .. 266
® New Model Dialog BOX ... 267
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* New Pattern View/Template/Perspective Dialog Box ... . .. .. ... 267
* New Watchpoint Dialog BOX ...........o o 268
® Open Reveal Path Dialog BOX ... .. 269
* Pattern Based Model Scheduler Dialog BoX . ... ... L 270
® Pattern Based Model Wizard . ... ... 271
® Pattern View Editor ... . e 273
® Perspective-based View Editor ... ... . 279
® Query Node Grouping Dialog BOX ... .. i 285
* Query/View Definition Properties Dialog BOX ... .. 285
® Reveal Cls Dialog BOX .. . 287
¢ Save Query Dialog BOX . ... L 289
* Save View/Template/Perspective Dialog BOX .. .. ... . 290
® Select Integration Points Dialog BOX . ..........o oo 291
® Sort Column Content Dialog BoX ... .. 291
® Template-based View Wizard ... . 292
* Template Parameter Values Dialog BoX . ... ... 297
® TQL QuUEry EditOr o 297
* Views Containing Selected Cl Dialog BOX ... ... .. . 301
* Watchpoints Updates Dialog BoX ... ... iiiiiiiiiii.. 302
* <Query/Template/Perspective Name> Dependencies Dialog BOX ... ... ... . i i, 303

Add/Edit Function Dialog Box

This dialog box enables you to define which of the query node's functions and parameters you want to include
in the report.

To access  Click the Add Function & button under the Report Layout box in the Query Node Definition
pane of the Pattern View Editor.

Important When defining the report columns for a selected query node in a view, template, or

information = perspective, you can define a column consisting of data deriving from a function defined for

one of its child query nodes. Select the relevant child query node, attribute, and function that
you want to define.

First, select the required query node and function. The attribute list adjusts to display the
relevant attribute for the selected combination. Select the required attribute.

Relevant "How to Define Report Settings" on page 239
tasks

See also « "Building a Business View" on page 218
« "Modeling Studio User Interface" on the previous page
» "Best Practices for Modeling" on page 151

User interface elements are described below:
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Ul Element (A-

Z)
Attribute

Function

Description

Select an attribute from the list.

From the Function list, select the function you want to use to calculate the results on
these columns.

The following are the available options:

Average. The average value of the selected attribute for all the Cl instances of the
selected query node.

Concatenated List. Lists the values of the selected attribute for all the Cl instances
of the selected query node.

Count. Calculates the number of Cl instances of the selected query node.

Distinct List. Lists the unique values of the selected attribute for all the Cl instances
of the selected query node.

Max. The maximum value of the selected attribute for all the Cl instances of the
selected query node.

Min. The minimum value of the selected attribute for all the Cl instances of the
selected query node.

Sum. The sum of the selected attribute values for all the Cl instances of the
selected query node.

Related Query  The child query node on which you want to perform the function.

Node

Title

The name of the function attribute displayed in the report.

Change Query Node/Relationship Type Dialog Box

This dialog box enables you to change the ClI type of a TQL query node or relationship after you have created a

TQL query.

To access

Important
information

Relevant
tasks

See also

In the TQL Query Editor or Pattern View Editor, right-click the required query node and select
Change Query Node Type. For relationships, right-click the required relationship and
select Change Relationship Type.

You can change the ClI type of the selected query node to any other valid type based on the
existing relationships and conditions of the selected query node.

« "How to Define a TQL Query" on page 20
« "Implement a Discovery Adapter" in the RTSM Developer Reference Guide

« "How to Create a Pattern View" on page 232

« "Building a Business View" on page 218
o "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-Z) Description

o Expand All. Expands all the folders in the tree.
B Collapse All. Collapses all the folders in the tree.
Tree View & Click Tree View to select the display format of the ClI type/Relationship tree. The

following options are available:
« by Display label
» by Class name

« by Legacy class name

<ClI Select the required CI type or relationship.
type/Relationship

tree>

Relationship Select the direction of the relationship.
Direction

Note: Only relevant for relationships.

Relationship The name of the relationship.
Name
Note: Only relevant for relationships.

Relationship Select an option to define how to handle relationships between identical query nodes
Restrictions or self relationships in the query results. A self relationship is a relationship that leads
from a query node to itself.

« Allow All Relationships. All relationships appear in the query results.

« Allow Self Relationships only. Only self-relationships (a relationship that leads
to itself) appear in the query results.

« Allow Non Self Relationships only. Self-relationships do not appear in the
query results.

Note: Only relevant for relationships.

Choose Operation for Selected ltems Dialog Box
This dialog box enables you to create models and views from selected Cls.

To access  Inthe Modeling Studio, drag Cls from the Cl Selector onto the empty canvas.

Important You can drag individual or multiple Cls onto the canvas. You can select ordinary Cls and/or
information = models to drag onto the canvas. To select multiple Cls, hold the CTRL key while selecting
Cls.
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See also « "Building a Business View" on page 218
« "Business Cl Models" on page 223
« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below:

Ul Element
(A-2) Description

Create a new  Select to build a model comprising the Cls in your selection. If the Cls you dragged onto
model the canvas include at least one Cl that has no valid links to any of the model Cl types, this
option is disabled.

Create anew  Select to build a view based on the CI collection formed by your selection.

view

Edit the Select to edit the selected model in the Model Editor.

model of the

selected ClI Note: This option only appears when a single model is dragged onto the canvas.

Conditions of Related Cls Dialog Box
This dialog box enables you to define conditions for the Cl types in a reveal path.

To Click the Add Condition or Edit Condition button from the Conditions column of the Reveal
access  Cls dialog box.

See also | . "Revealed Cls and Watchpoints" on page 228
« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below:

Ul Element (A-

Z) Description

Add the attribute condition you have defined.

|§ Delete an attribute condition.

[ Move a selected row up.

[l Move a selected row down.

View the condition definition.

And/Or Click inside the And/Or field and select either And or Or to link multiple conditions.
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Ul Element (A-
Z) Description

Attribute name  Select an attribute from the list.

Click inside the Brackets box to display a list of brackets you can use to build more
complex, logical statements.

L ) Brackets

Criteria Contains the attribute condition definition as defined in the Cl Instances dialog box.

Not Select NOT if you want the condition statement to do the opposite of what is defined.

Note: If you select NOT, query results do not include data from the Cl instances
that were not assigned a value. For example, your system contains three node
Cls: Node1 is assigned the value A, Node2 is assigned the value B and Node3 is
not assigned a value. You create a query to retrieve all nodes that are equal to A
and select NOT; the results of your query only include Node2 because Node3 is
not assigned a value.

Operator Select the required operator. For details, see "Attribute Operator Definitions" on page
33.
Value Enter or select the value of the attribute. The Value options vary according to the

attribute type you select.

Create/Edit/Save Reveal Path Dialog Box

This dialog box enables you to define a new reveal path or edit an existing path.

To .
access To define a new reveal path, click the Reveal ““4 putton from the Model Editor, and select
Create Reveal Path.
To edit an existing reveal path, select a path from the Open Reveal Path dialog box and click
Edit.
To save areveal path, click Save Path from the Reveal Cls dialog box.
See « "Revealed Cls and Watchpoints" on page 228
also « "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below:

Ul Element
(A-2) Description

Description Enter a description of the path.

Name Enter the name of the path.
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Ul Element
(A-2) Description

Preview Opens the Reveal Cls dialog box displaying the related Cls in the path.

Note: This button does not appear in the Save Reveal Path dialog box.

Ee;;\eal Build the path by clicking the button to open a dialog box with a Cl type tree. Select the
a Cl type for the next item in the path.

When you hold the pointer over a reveal path item, the following options are available:

« Delete Selected Item(s). Deletes the selected item from the reveal path.

« Add condition. Opens the Conditions of Related Cls dialog box, which enables you to
set conditions for the reveal path item.

« Refine Query Node Type. Opens a Cl type tree, which enables you to change the ClI
type of the reveal path item.

Creating New View Dialog Box
This dialog box enables you to select a perspective to create a view from a model.

To access | Inthe Modeling Studio, right-click a model in the Model Editor, Perspective-based View
Editor, or Cl Selector and select Generate view for selected Model or click the Generate

view for selected model ];{. button from the Model Editor.

Important You select perspectives in the left pane and move them to the right pane using the arrow
information = buttons.

Relevant "How to Build a Perspective-based View Based on a Model " on page 242
tasks
See also » "Building a Business View" on page 218

« "Modeling Studio User Interface" on page 244
« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
Available Perspectives A list of the available perspectives to apply to your model.
Selected Perspectives The perspectives you selected to apply to your model.

Cycle Definition Dialog Box

This dialog box enables you to define a cyclical hierarchy in a view.
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To access | Inthe Modeling Studio, right-click a query node in the Hierarchy pane of the Pattern View
Editor and select Define Cycles.

Important | You can extend the TQL query definition of a view by defining a cycle in the view hierarchy.

information Select a query node in the Hierarchy pane to be the source query node. The Cycle Definition
dialog box displays the valid target query nodes for that source. The target query node in the
cycle, along with its hierarchy, is treated as a child or sibling of the source query node
(depending on your folding rule selection).

Relevant "How to Create a Pattern View" on page 232, "How to Create a Template" on page 233,
tasks "How to Create a Perspective" on page 234
See also « "Building a Business View" on page 218

» "Modeling Studio User Interface" on page 244
« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Element
(A-Z) Description

Folding  Select one of the following options:

Rule « Folded cycle under source. The target query node becomes a child of the source query

node.

« Flattened cycle under parent. The target query node becomes a sibling of the source
query node.

Target Displays the valid target query nodes for the selected source query node. A query node is
defined as a valid target query node if all of the following conditions are true:

« itis related to the source query node
« itis an ancestor of the source query node (or the source query node itself)

« itis aquery based node (not a grouping node)

Hidden Cls Dialog Box

This dialog box enables you to restore hidden Cls to a view.

To From the Perspective-based View Editor, click the Show Hidden Cls button from the toolbar of
access  the View Results pane.

See » "Building a Perspective-based View" on page 225
also « "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-Z) Description

<check box> Select the check boxes for the Cls you want to restore.

Cl Type The Cl type of the excluded CI.

Name The name of the excluded CI.

Restore Click Restore to include the selected Cls in the view.

Select All Click Select All to select all the Cls in the list for inclusion in the view.
Unselect All Click Unselect All to clear the check boxes of all the Cls in the list.

Hierarchy Rules Dialog Box
This dialog box enables you to set the hierarchy of a view by defining hierarchy rules.

To access  From the Hierarchy pane of the Pattern View Editor, when Rule Based is selected as the

hierarchy method, click the Add Hierarchy Rule button from the toolbar.

Important For each hierarchy rule you define, select a source Cl type, target Cl type, relationship, and
information = direction.

Relevant "How to Create a Pattern View" on page 232, "How to Create a Template" on page 233,
tasks "How to Create a Perspective" on page 234
See also » "Building a Business View" on page 218

« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

Add. Adds a hierarchy rule.

E Delete. Deletes the selected hierarchy rule.

Relationship Select a relationship from the drop-down list to edit the selected hierarchy rule.
Relationship Select a direction from the drop-down list to edit the selected hierarchy rule.
Direction

Source Select a Cl type for the source Cl type from the drop-down tree to edit the selected

hierarchy rule.

Target Select a Cl type for the target Cl type from the drop-down tree to edit the selected
hierarchy rule.
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Left Pane

This area enables you to browse views (including dynamic widgets) and TQL queries, search for Cls or
models to open in the Editor pane, and select Cl types to use in the TQL Query Editor or Pattern View Editor.

To access Located to the left of the Editor pane in Modeling Studio.
Important The following tabs are available:
information

« Resources. Enables you to select a model, view, or TQL query to open in the
Editor pane.

« CI Selector. See "Cl Selector" on page 112.
« CI Types. Enables you to select Cl types from the tree to add as a query node to
your TQL query.
See also « "Templates and Perspectives" on page 220
« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

Resources Tab

Important When Views or Queries is selected as the resource type, you can drag and drop views,
information  queries, or folders to move them from one folder to another.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

& New Folder. Creates a new folder in the resource tree.
Note: This button only appears when Queries or Views are selected as the resource
type.

E Delete. Deletes the selected resource from the RTSM.
Note: When you delete a resource with dependent resources, the dependent
resources are also deleted. Dependent resources can include queries, views, or
custom reports.

|%| Refresh. Refreshes the resource tree.

|§| Expand All. Expands all the folders in the resource tree.

Note: This button only appears when Queries or Views are selected as the resource
type.
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Ul Element
(A-Z) Description

B Collapse All. Collapses all the folders in the resource tree.

Note: This button only appears when Queries or Views are selected as the resource
type.

| When Queries or Views are selected as the resource type, click Hide Empty Folders to
display only folders containing views or TQL queries.

When Models is selected as the resource type, click Show only models with content to
display only models containing Cls.

Filter Tree/Table.

<0

When Views is selected as the resource type, click Filter Tree tofilter the types of views,
templates, and dynamic widgets that appear in the tree.

When Queries is selected as the resource type, click Filter Tree to filter the TQL queries
that appear in the tree by query type.

When Models is selected as the resource type, click Filter Table to filter the models in the
table by Cl type.

Filter Tree by Bundle. Allows you to filter queries or views by predefined bundle.

[}

If you select more than one bundle from the available list, each resource that belongs to at
least one of the bundles is displayed.

Note: This button is active only when the Filterable Bundles List setting is configured

in the Infrastructure Settings Manager. For details, see "Infrastructure Settings
Manager Page" in the HPE Universal CMDB Administration Guide.

O Open Query. Opens the selected TQL query in a new tab.

Note: This button only appears when Queries is selected as the resource type.

| Open View. Opens the selected view in a new tab.

Note: This button only appears when Views is selected as the resource type.

CI Properties. Enables you to view the properties of the selected model.

!

Note: This button only appears when Models is selected as the resource type.

e Show views containing selected Cl/model. Displays a list of views including the
selected Cl or model.

Note: This button only appears when Models is selected as the resource type.
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Ul Element
(A-Z) Description
5] Open Model. Opens the selected model in the Model Editor.
Note: This button only appears when Models is selected as the resource type.
D Pattern Based Model Scheduler. Enables you to modify the starting time and repeat
interval for all pattern-based models.
Note: This button only appears when Models is selected as the resource type.
& Assign Tenants. Opens the Assign Tenants dialog box which enables you to assign
tenants to a model.
Note:
« This button only appears when Models is selected as the resource type.
« This button is only available when multi-tenancy is enabled.
& Import From XML. Enables you to import XML files that contain saved views or queries
to the Modeling Studio.
Note: This button only appears when Queries or Views are selected as the resource
type.
) Export To XML. Enables you to export the view or query as an XML script. This option

can be used to move a view or query from one workstation to another.

Note: This button only appears when Queries or Views are selected as the resource
type.

<Resources> When Views or Queries is selected as the resource type, the available views or TQL
queries are displayed under their respective folders in tree format. When Models is
selected as the resource type, the available models are displayed in a table.

For views, the following view types are included:

| Denotes a pattern view.

. = Denotes a template.

. Lk Denotes a template-based view.
. E Denotes a perspective.

. LB Denotes a perspective-based view.

. U Denotes an automation flow mapping. Only relevant when the Automation Flow
Adapter has been deployed. For details, see the UCMDB Browser documentation.

« % Denotes a dynamic widget.
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Ul Element

(A-Z) Description

Resource Select the resource type to display in the pane. The available options are Models, Views,
Type and Queries.

Note: The maximum number of models to be loaded into the Modeling Studio is set to
400,000 by default. To change this setting, change the Maximum number of
models in view result setting in the Infrastructure Settings Manager. For details, see
"Infrastructure Settings Manager Page" in the HPE Universal CMDB Administration

Guide.

Resources Tab Shortcut Menu

The Resources tab includes the following elements (listed alphabetically) available by right-clicking a

resource:

Menu Item

Assign Tenants
Create a new

View/Template/Perspective

Delete

Export To XML

Manage Security

New Folder

New Template Based View

Open Query/View/Model

Properties

Description

Open the Assign Tenants dialog box which enables you to assign tenants to
the resource.

Create a new view, template, or perspective.

Delete the selected resource from the RTSM.

Note: When you delete a resource with dependent resources, the
dependent resources are also deleted. Dependent resources can
include queries, views, or custom reports.

Export the view or query as an XML script. This option can be used to move
a view or query from one workstation to another.

Assign the selected resource to specific roles or resource groups.
Note: This option is not relevant for models.

Create a new folder in the resource tree.

Edit the parameters of the selected template to define a new template-
based view.

Note: This option is only active when a template is selected in the view
tree.

Open the selected view, TQL query, or model in a new tab.

Opens the CI Properties dialog box for the selected model.

Note: This option is only relevant for models.
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Menu Item Description
Refresh Refresh the resource tree.
Remove Remove the selected model.

Note: This option is only relevant for models.

Rename Folder Rename the selected folder.
Save As Save the selected TQL query with a new name.
Show containing views Opens the Views containing selected ClI dialog box for the selected model.

Note: This option is only relevant for models.

ClTypes Tab
User interface elements are described below (unlabeled elements are shown in angle brackets):
Ul Element
(A-2) Description
E Expand All. Expands all the folders in the Cl Type tree.
B Collapse All. Collapses all the folders in the Cl Type tree.
Tree View |Z] Displays the format of the Cl type tree. The following options are available:
« by Display label
« by Class name
« by Legacy class name
g ) Add Selected CITs to Query. Adds the selected Cl type to the TQL query which is open
in the Editor pane.
Note: This button is only active when a view or TQL query is open in the Editor pane.
3 Refresh. Refreshes the Cl Type tree.
<CI Type The available Cl types are displayed in tree format.
tree>

Cl Types Tab Shortcut Menu
The CI Types tab includes the following elements (listed alphabetically) available by right-clicking a Cl type:
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Menu Item Description

Add Selected Select to add the selected Cl type to the TQL query open in the Editor pane.
CITs to Query

Go to Cl Type Takes you directly to the selected Cl type in CIT Manager.
Definition

Show Element Opens the Cl Instances window, which displays all instances of the selected CIT. For
Instances details, see "Cl Instances Dialog Box" on page 55.

Manage Cl Watchpoints Dialog Box

This dialog box enables you to add or remove watchpoints for a Cl in a model.

To
access From within a model in the Model Editor, click the Watchpoint ~# button and select Manage ClI

Watchpoints or right-click a Cl in the model and select Watchpoint > Manage Cl Watchpoints.

See o "Revealed Cls and Watchpoints" on page 228
also « "Modeling Studio User Interface" on page 244

User interface elements are described below:

Ul Element (A-
Z) Description
Add Opens the New Watchpoint dialog box which enables you to add a new watchpoint.
s Deletes the selected watchpoint.
“* Remove
Automated A check mark indicates that the new Cls found by the watchpoint are to be added to the
view automatically.
Source CI Displays the CI forming the beginning of the reveal path.
Watchpoint The name of the reveal path associated with the watchpoint.
Name

Watchpoint Displays the reveal path for the watchpoint.
Path

Model Editor

This feature enables you to create and edit models.

In the Modeling Studio, click the New|;| button and select Instance Based Model to
create a new model or select Models as the Resource type and open an existing model.

To access
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Important The Model Editor contains the following panes:

information « Content pane. Lists the Cls and models contained in the model.

« Information pane. Displays the properties, related Cls and watchpoints for the selected
Cl or model.

You can drag Cls from the Cl Selector into the Content pane of an existing model to add
them to the model. However, you cannot drag in a Cl that is already included in the model.

You can drag Cls from the Cl Selector into the Related Cls tab of the Information pane
provided that the selected source and target Cl can be related by a usage relationship.

Relevant "How to Build an Instance-based Model " on page 240
tasks
See also « "Business Cl Models" on page 223

» "Modeling Studio User Interface" on page 244
« "Best Practices for Modeling" on page 151

Content Pane

User interface elements are described below:

Ul Element (A-Z) Description
1% Map Map. Displays the Cls as icons in a diagram.
EH Text Text. Displays the Cls in a list.
|§l.| CI Properties. Opens the Configuration Item Properties dialog box for the
- selected Cl.
B Show models containing selected Cl. Displays a list of the models

containing the selected ClI.

] Show views containing selected Cl/model. Displays a list of the views
containing the selected CI or model.

oy Open selected model in a new tab. Opens the selected model in a separate
Model Editor tab.

Ll Generate view for selected model. Enables you to create a view based on the
current model. The Creating New View dialog box opens, which enables you to
select a perspective to apply.

ﬁ Remove Selected Cl(s) from the Model. Removes a selected Cl from the
model (it remains in the RTSM).

53 Insert new model Opens the New Model dialog box which enables you to
define a new model within the existing model.

|§| Expand All. Expands the model hierarchy.
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Ul Element (A-Z) Description
B Collapse All. Collapses the model hierarchy.
--?C{ Reveal. Includes the following options:

« Start Revealing. Opens the Reveal Cls dialog box. For details, see Reveal
Cls dialog box.

« Create Reveal Path. Opens the Create Reveal Path dialog box. For details,
see Create Reveal Path dialog box.

« Open Reveal Path. Opens the Open Reveal Path dialog box. For details,
see Open Reveal Path dialog box.

:. h Watchpoint. Includes the following options:

« Watchpoints Updates. Enables you to display the watchpoint results and
select Cls to add to the model. For details, see Watchpoints Updates dialog
box.

« New Watchpoint. Enables you to define a new watchpoint for the selected
Cl. For details, see New Watchpoint dialog box.

« Manage Cl Watchpoints. Enables you to add new watchpoints to the Cl or
remove existing ones. For details, see Manage Cl Watchpoints dialog box.

=) CI Collection. Enables you to group Cls in a collection under a model. Select
one of the following options:

« Insert New CI Collection. Create a new empty Cl Collection. After
creating the collection, you can drag Cls into it from the CI Selector, the
related Cls tab, or from the model itself.

« Join to CI Collection. Select a Cl or several Cls in the model and join them
to an existing CI collection or form a new collection.

« Decompose Cl Collection. Select a Cl collection and decompose it. Its
Cls remain directly under the main model.

Find. Toggles between displaying and hiding the Find box and arrow controls.
Note: This button only appears in Text mode.
=N Refresh. Refreshes the map to optimize the layout.
Note: This button only appears in Map mode.
Fit to Window. Resizes the map to fit the size of the pane.

Note: This button only appears in Map mode.
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Ul Element (A-Z) Description

k Select - Select the functionality of the cursor from the Mode drop-down. The following
options are available:

o Select
« Drag Map
e Zoom In

Note: This feature only appears in Map mode.

[ Prirt... Print. Enables you to select Print, Print Preview or Print Setup.

Show External Relationships. Displays the related Cls for the selected CI.

]

Note: This button only appears in Map mode.

g Hide External Relationships. Hides the related Cls of the selected Cl.

Note: This button only appears in Map mode.

Indicates that watchpoints are defined for the current CI.

U. Indicates that the watchpoints have detected new Cls related to the current
model. Click it to open the Watchpoints Updates dialog box.

Cl Type column Displays the type of each Cl in the model.

Find Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in the
model.

Find Next Click to go to the next occurrence of the selected search phrase in the model.

Find Previous Click to go to the previous occurrence of the selected search phrase in the
model.

Highlight Click to highlight all occurrences of the search phrase in the model.

Name column Displays the name of each Cl in the model.

Shortcut Menu Options
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Menu ltem

Cl Collection

Fit to Window

Generate view for
selected model

Hide External
Relationships

Insert New Model

Open selected
model in a new
tab

Print

Properties

Refresh Layout

Remove Selected
Cli(s) from the
Model

HPE Application Performance Management (9.40)

Description

Click CI Collection to group Cls in a collection under a model. Select one of the
following options:

« Insert New CI Collection. Create a new empty collection. After creating the
collection, you can drag Cls into it from the CI Selector, the related Cls tab, or
from the model itself.

« Join to Cl Collection. Select a Cl or several Cls in the model and join them to an
existing Cl collection or form a new group.

- Decompose Cl Collection. Select a Cl collection and decompose it. Its Cls
remain directly under the main model.

Resizes the map to fit the size of the pane.

Note: This option only appears in Map mode.

Creates a view based on the current model. The Creating New View dialog box opens
which enables you to select a perspective to apply.

Hides the related Cls from the map.

Note: This option only appears in Map mode.

Opens the New Model dialog box which enables you to create a new model within the
existing model.

Opens the selected model in a separate Model Editor tab.

Select one of the following options:

e Print
e Print Preview

o Print Setup
Opens the Configuration Item Properties dialog box for the selected ClI.

Refreshes the map and optimizes the map layout.

Note: This option only appears in Map mode.

Deletes the selected Cls from the model (it remains in the RTSM).
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Menu Item Description

Reveal The following options are available:

« Start Revealing. Opens the Reveal Cls dialog box. For details, see Reveal Cls
dialog box.

« Open Reveal Path. Opens the Open Reveal Path dialog box. For details, see
Open Reveal Path dialog box.

Select Select the functionality of the cursor. The following options are available:

o Select
o Drap Map
e ZoomIn

Note: This option only appears in Map mode.

Show Containing Displays a list of the models containing the selected Cl.

Models

Show Containing Displays a list of the views containing the selected CI or model.
Views

Show External Displays the related Cls for the selected Cl.

Relationships
Note: This option only appears in Map mode.
Watchpoint The following options are available:

« Watchpoints Updates. Display the watchpoint results and select Cls to add to
the model. For details, see Watchpoints Updates dialog box.

« New Watchpoint. Define a new watchpoint for the selected Cl. For details, see
New Watchpoint dialog box.

« Manage Cl Watchpoints. Add new watchpoints to the Cl or remove existing
ones. For details, see Manage Cl Watchpoints dialog box.

Zoom Select the size of the map from the list of percents.

Note: This option only appears in Map mode.

Information Pane - Properties Tab

This area displays the properties of the selected ClI.

Important  This pane is identical to the Properties tab of the Information pane in IT Universe Manager.
information = For details, see "Configuration Item Properties Dialog Box" on page 188.

Information Pane - Related Cls Tab

This area displays the Cls related to the model by one of the triplets that includes an Impacted By (Potentially)
relationship.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element
(A-2) Description
3¢ Click to delete the relationship to the selected CI.
=2 Click Invert Direction to switch the direction of the relationship for the selected ClI.
Note: This option is only active for Cls related by a usage relationship.
<Cl list> Lists the name and ClI type of the Cls related to the model by usage relationships, as well as
the direction of the relationship.
Filter by Select a field by which to filter the results and enter the value in the by box.

Information Pane - Watchpoints Tab
This area displays the watchpoints defined for the selected ClI.

User interface elements are described below:

Ul Element (A-

Z) Description

e Click to open the Manage Cl Watchpoints dialog box, which enables you to edit the
watchpoint.

Automated Indicates whether the new Cls found by the watchpoint are automatically added to the
view.

Source CI Displays the Cl forming the beginning of the reveal path.

Watchpoint The name of the reveal path associated with the watchpoint.

Name

Watchpoint Displays the reveal path of the watchpoint.

Path

Modeling Studio Page

This page enables you to create and edit models and views.

Tip: For more information about using Modeling Studio in HPE Application Performance Management,
see "Best Practices for Modeling" on page 151.

To access  Select Admin > RTSM Administration > Modeling > Modeling Studio.
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Important = The Modeling Studio page contains the following panes:

information « Left pane. Enables you to search for Cls or select a view, model, or TQL query to open.

For details, see "Left Pane" on page 253.
« Editor pane. Displays the topology map of a selected view, model, or TQL query.

The Editor pane is a blank canvas before any views or models are opened. When you open a
view, model, or TQL query, the relevant editor appears there. Multiple views, models, and
queries can be open at the same time in the Editor pane, each within a separate tab.

Relevant « "How to Create a Pattern View" on page 232
tasks « "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

« "How to Create a Dynamic Widget" on page 235

« "How to Create a Template Based View" on page 237

« "How to Create Multiple Template Based Views" on page 238

« "How to Build an Instance-based Model " on page 240

« "How to Build a New Pattern-based Model " on page 241

« "How to Define Report Settings" on page 239

« "How to Build a Perspective-based View Based on a Collection of Cls" on page 242

« "How to Build a Perspective-based View Based on a Model " on page 242

See also « "Building a Perspective-based View" on page 225
« "Business Cl Models" on page 223
« "Creating Template Based Views" on page 222
« "Templates and Perspectives" on page 220
o "View Formats" on page 218
« "Modeling Studio User Interface" on page 244

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul
Element
(A-2) Description

| | New. Select one of the following options:

New « Instance Based Model. To create a new instance based model.
« Pattern Based Model. To create a new pattern based model.
« Pattern View. To create a new pattern view.
« Template Based View. To create a new template-based view.
« Perspective Based View. To create a new perspective-based view.
« Template. To create a new template.
« Perspective. To create a new perspective.
« Dynamic Widget. To create a new dynamic widget for the UCMDB Browser.
o Query. To create anew TQL query.

« Automation Flow Mapping. To create an automation flow mapping. Only relevant when
the Automation Flow Adapter has been deployed. For details, see the UCMDB Browser
documentation.

|| Save. Saves the changes to your view, model, or query.
For views, a dialog box opens which enables you to rename your view and save it in the
appropriate folder.

Save As. Enables you to save your view, model, or TQL query under a new name.

|__| Undo. Reverses the last change you made.

2 Redo. Repeats the last action you took.
|ﬁ| Maximize Workspace. Toggles between the regular display and a full-screen display of the
- editor.

<Menu> | For details, see "Main Menu" on page 136.

Models Containing Selected CI Dialog Box

This dialog box enables you to display a list of the models containing the selected CI.

To Click the Show models containing selected CI @ button in the Model Editor or select Show
access .
containing models from the shortcut menu.
See « "Business Cl Models" on page 223
also

« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below:
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Ul Element

(A-2) Description

|; Cl Properties. Opens the Configuration Item Properties dialog box for the selected

o model.

i Show views containing selected Cl/model. Displays a list of views containing the
selected model.

ﬁ Remove model. Deletes the selected model.

Cl Type Displays the CI types of the models containing the selected Cl.

Find Enter a model name or a portion of a model name in the Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Previous = Click to go to the previous occurrence of the selected search phrase in the list.

Name Displays the names of the models containing the selected ClI.

Note: The name of the current model appears in faded text.

New Model Dialog Box

This dialog box enables you to define a reusable model containing a collection of Cls.

To access Click the New |_| button and select Instance Based Model or drag a Cl from
the tree in the Cl Selector onto the editing pane and select Create a new
model.

Relevant tasks "How to Build an Instance-based Model " on page 240

See also « "Business Cl Models" on page 223

o "Modeling Studio User Interface" on page 244
« "Best Practices for Modeling" on page 151

User interface elements are described below:

Ul Element (A-
Z) Description

Define new CI Enter the values for the CI properties. You must enter values for required properties. The
Properties required properties are marked with an asterisk.

Select Cl Type  Select a Cl type from the list to serve as the basis for your model.

New Pattern View/Template/Perspective Dialog Box

This dialog box enables you to define a new pattern view, template, or perspective using the Pattern View
Editor.
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To access

Important

In the Modeling Studio, click the New|;| button and select Pattern View, Template, or
Perspective from the drop-down menu.

After making your selection and clicking OK, you go directly to the Pattern View Editor to

information = begin building your view. For details, see "Pattern View Editor" on page 273.

Relevant
tasks

See also

"How to Create a Pattern View" on page 232, "How to Create a Template" on page 233,
"How to Create a Perspective" on page 234

» "Building a Business View" on page 218

« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-Z)

=

<TQL

query
tree>

Choose
base

query

Create
new

query
Find

Description

Find Next. Goes to the next occurrence of the selected search phrase in the list of TQL
queries.

Find Previous. Goes to the previous occurrence of the selected search phrase in the list of
TQL queries.

Highlight All. Highlights all occurrences of the search phrase in the list of TQL queries.

Displays the existing TQL queries in tree format.

If you want to base your new view on an existing TQL query, select this option and select a TQL
query from the tree. The Pattern View Editor opens with the selected TQL query on the canvas.

If you want to base your new view on a new TQL query, select this option. The Pattern View
Editor opens with a blank canvas.

Enter a TQL query name or a portion of a query name in the Find box to locate a TQL query in
the list.

New Watchpoint Dialog Box

This dialog box enables you to define a watchpoint for a Cl in a model.

To access

From within a model in the Model Editor, click the Watchpoint 4 button and select New
Watchpoint or right-click a Cl in the model and select Watchpoint > New Watchpoint.
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Important If no reveal paths are found for the selected Cl, no watchpoints can be defined.

information You cannot define watchpoints for Cls in a new model until you save the model.
Relevant "How to Build an Instance-based Model " on page 240

tasks

See also « "Revealed Cls and Watchpoints" on page 228

» "Modeling Studio User Interface" on page 244

User interface elements are described below:

Ul Element (A-Z) Description

Automatically Select to automatically add all revealed Cls from the selected path to the model.

update model
Note: In a multi-tenancy environment, this action requires Data Update

permission in connection with all tenants of the model.

Control updates Select to manually add revealed Cls from the selected path to the model.
manually

Select Watchpoint = Select a reveal path from the drop-down list.
reveal path

Show reveal paths = Select a Cl type from the drop-down list. All reveal paths beginning with that Cl type
for CI type appear in the list in the lower drop-down box.

Open Reveal Path Dialog Box

This dialog box enables you to open an existing path.

To access . , ) )
From within a model in the Model Editor, click the Reveal "“L putton and select Open

Reveal Path orright-click a Cl in the model and select Reveal > Open Reveal Path.

Important | After selecting the reveal path you want to use, click Execute. If Cls are found on the
information = selected path, the Reveal Cls dialog box opens for that path. If no Cls are found, a message
appears stating that no Cls were found on the path.

See also « "Revealed Cls and Watchpoints" on page 228
« "Modeling Studio User Interface" on page 244
« "Best Practices for Modeling" on page 151

User interface elements are described below:
Ul Element (A-Z) Description

Description column Displays the descriptions of the existing paths.

Edit Opens the Edit Reveal Path dialog box which enables you to edit the selected
path.
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Ul Element (A-Z) Description

Execute Opens the Reveal Cls dialog box for the selected reveal path.

Find Enter a path name or a portion of a path name in the Find box to locate a path in
the list.

Find Next Click to go to the next occurrence of the selected search phrase in the list of
paths.

Find Previous Click to go to the previous occurrence of the selected search phrase in the list of
paths.

Highlight Click to highlight all occurrences of the search phrase in the list of paths.

Name column Displays the names of the existing paths.

Remove Deletes the selected path.

Show reveal paths for = Select a Cl type from the drop-down list. All paths beginning with the selected Cl
Cl type appear in the table below.

Pattern Based Model Scheduler Dialog Box

This dialog box enables you to set the starting date and time and the repeat interval for Pattern-based models.

To access In the Modeling Studio, click the Pattern Based Model Scheduler @ button in the
Resources tab of the left pane.

Important  All the pattemn-based models are updated at the same time. The settings you select apply to

information | all existing pattem-based models as well as those created subsequently. The default
starting time for model updates is the server time at the time the first model is created. When
you open the dialog box, the default starting time is the current server time at that moment.
The default repeat interval is 12-hours.

Relevant "How to Build a New Pattern-based Model " on page 241
tasks
See also « "Business Cl Models" on page 223

» "Modeling Studio User Interface" on page 244
« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

Advanced Pattern Based Model = Select this option to schedule the pattern-based model updates using
Scheduler Updates a Cron expression.
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Ul Element (A-Z) Description

Cron Expression When Advanced Pattern Based Model Scheduler Updates is

selected, enter a Cron expression.

For a description of the fields used in Cron expressions and
examples of how to use them, see Cron Expressions.

Daily Pattern Based Model Select this option to schedule the pattern-based model updates using
Scheduler Updates a starting date and time and a repeat interval.
Repeat interval When Daily Pattern Based Model Scheduler Updates is selected,

select an option for the repeat interval (in hours). This determines the
frequency of the pattern-based model updates.

Note: The repeat interval must be evenly divisible in a 24-hour
period to ensure that the updates are performed at the same
hours each day.

Server time Displays the time on the server.
Start at Select a starting date and time for the pattern-based model updates.
Validate Expression After entering a Cron expression, click the Validate Expression

button to confirm that the expression is valid.

Pattern Based Model Wizard

This wizard enables you to build a pattern-based model.

To access

Important
information

Relevant
tasks

Wizard
map

See also

HPE Application Performance Management (9.40)

In the Modeling Studio, click the New |_| button and select Pattern Based Model from the
drop-down menu.

When you create a pattern-based model, the model is saved as a Cl, as with an instance-
based model. If you based your model on a new TQL query, the query is also saved and
appears in the TQL query tree.

When you build a pattern-based model over an existing instance-based model, the model is
saved with the name of the instance-based model.

If you create a new pattern-based model with the same name as a previously deleted
pattern-based model, you can select an old query on which to base the new pattern-based
model or you can create a new query.

"How to Build a New Pattern-based Model " on page 241

The Pattern Based Model Wizard contains:

Select Cl Type Page > Query Selection Page

« "Pattern-based Models" on page 224
« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151
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Select Cl Type Page
This wizard page enables you to select a Cl type for the model and define its details.

Wizard map The Pattern Based Model Wizard contains:

Select Cl Type Page > Query Selection Page
User interface elements are described below:

ul
Element
(A-Z) Description

Existing Select Existing Model to build a pattemn-based model over an existing instance-based model.
Model Select an existing model from the tree.

New Select New Model to create a new pattern-based model (unrelated to any other model). In the
Model Select Cl Type section, select a Cl type from the list to serve as the basis for your model. Then
enter the values for the Cl properties in the Define New CI Properties section.

Query Selection Page

This wizard page enables you to select a TQL query upon which the model is based.

Wizard map The Pattern Based Model Wizard contains:

Select Cl Type Page > Query Selection Page

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul

Element

(A-Z) Description

) Find Next. Goes to the next occurrence of the selected search phrase in the list of TQL

) queries.

@ Find Previous. Goes to the previous occurrence of the selected search phrase in the list of
TQL queries.

[=] Highlight All. Highlights all occurrences of the search phrase in the list of TQL queries.

<TQL Displays the existing TQL queries in tree format.

Query

tree>

Choose If you want to base your model on an existing TQL query, select this option and select a query
base from the tree. The TQL Query Editor opens with the selected query on the canvas.
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ul
Element
(A-2) Description
Create If you want to base your model on a new TQL query, select this option. The TQL Query Editor
new opens with a blank canvas.
query
Note: When you create a pattern-based model based on a new query, the query's priority
is automatically set to Not Active.
Find Enter a TQL query name or a portion of a query name in the Find box to locate a query in the

list.

Pattern View Editor

This feature enables you to build and edit pattern views, templates, and perspectives.

To access To open a new view in the Pattemn View Editor, go to the Modeling Studio, click the New |_|

button and select the required type of view.

To open an existing view in the Pattern View Editor, go to the Resources tab of the left pane
in the Modeling Studio and select Views as the Resource type. Right-click a view in the tree
and select Open View or double click a view or drag a view onto the Editor pane. The
topology map of the view opens in the Editor pane.
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Important You can access the Editor in one of the following modes:

information |\ mode, the following panes are included:

« Query Definition pane. For details, see "TQL Query Editor" on page 297.
« Advanced pane. For details, see "Advanced Pane" on page 1.

« Hierarchy pane. Enables you to set the hierarchy of the view. (Located in the right
portion of the Editor page.)

« InReport mode, the following panes are included:

« Hierarchy pane. Enables you to set the hierarchy of the view. (Located in the left
portion of the Editor page.)

« Query Node Definition. Enables you to select the attributes to be included in the
report and to set their order.

« InWidget mode, the following panes are included:

« Hierarchy pane. Enables you to set the hierarchy of the view. (Located in the left
portion of the Editor page.)

« Widget Node Definition. Enables you to specify options for the Cl's attributes to be
included in the dynamic widget.

Note: Widget mode is available only when creating or editing a dynamic widget.

Note: To save your view, template, perspective, or dynamic widget, use the Save
button on the Modeling Studio main toolbar.

Relevant « "How to Create a Pattern View" on page 232
tasks « "How to Create a Template" on page 233
« "How to Create a Perspective" on page 234

« "How to Create a Dynamic Widget" on page 235

See also « "Building a Perspective-based View" on page 225
« "Templates and Perspectives" on page 220
« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

Hierarchy Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):
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ul
Element
(A-2) Description

= Add Group By. Enables you to create a subgroup in the hierarchy. The following options are

available:
« Add Group By Attribute. Opens the Query Node Grouping dialog box, which enables
you to select an attribute for a subgroup in the hierarchy.
« Add Group By CI Type. Create a subgroup in the hierarchy for the Cl type of the
selected query node.
« Add Group by View Node. Create a subgroup in the hierarchy for the selected query
node only.
Note: You cannot define subgroups on a contact query node of a perspective.

e Edit Group By Attribute. Opens the Query Node Grouping dialog box, which enables you to
edit the attribute for a subgroup in the hierarchy.

Rename. Enables you to rename the selected query node.

5 Delete View Node Deletes the selected query node from the hierarchy tree.

'S Move View Node Layer Up. Moves the selected query node one layer higher in the
hierarchy.

™ Move View Node Layer Down. Moves the selected query node under the query node above
it in the hierarchy.
Note: If the selected query node is located at the top of the hierarchy tree, clicking Move
View Node Layer Down places it under the query node beneath it in the hierarchy.

g Move View Node Up. Moves the selected query node up in the hierarchy tree. The query
node order in the hierarchy determines the query node order in the report generated for the
view in Reports.

¥ Move View Node Down. Moves the selected query node down in the hierarchy tree. The
query node order in the hierarchy determines the query node order in the report generated for
the view in Reports.

[ Preview. Displays a preview of the topology report.

Note: This option only appears in the Hierarchy pane when Report mode is selected.
[ Report Properties. Opens the Report Properties dialog box, which enables you to set the

title, subtitle, and format for the view's topology report. For details, see "Report Properties
Dialog Box" on page 1.
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Ul
Element
(A-Z)

<Hierarchy
tree>

Description

The query nodes of the TQL query are arranged in a hierarchical tree reflecting the hierarchy
defined for the view.

You can click and drag query nodes to change the hierarchy. When you click a query node
and begin to drag it, the query nodes under which it is possible to place your query node are
highlighted in green.

Hierarchy
Method

Select the method of setting the hierarchy:

« Manual. Set the hierarchy manually, by dragging query nodes and using the toolbar

buttons.

« Rule Based. Open the Hierarchy Rules dialog box which enables you to set rules for the

Shortcut Menu

hierarchy.

The Hierarchy pane includes the following elements (listed alphabetically) available by right-clicking a query
node in the hierarchy tree:

Menu ltem

Add Group
By Attribute

Add Group
By Cl Type

Add Group
By View Node

Define Cycles

Delete View
Node

Move View
Node Down

Move View
Node Layer
Down

Move View
Node Layer
Up

HPE Application Performance Management (9.40)

Description

Select Add Group By Attribute to open the Query Node Grouping dialog box, which
enables you to select an attribute for a subgroup in the hierarchy.

Select Add Group By Cl Type to create a subgroup in the hierarchy for the Cl type of
the selected query node.

Select Add Group By View Node to create a subgroup in the hierarchy for the selected
query node only.

Select Define Cycles to define a cyclical hierarchy. For details, see "Cycle Definition
Dialog Box" on page 250.

Select to delete the selected query node from the hierarchy tree.
Select to move the selected query node down in the hierarchy tree.
Select Move View Node Layer Down to place the selected query node under the query

node above it in the hierarchy.

Note: If the selected query node is located at the top of the hierarchy tree, selecting
Move View Node Layer Down places it under the query node beneath it in the
hierarchy

Select Move View Node Layer Up to place the selected query node one layer higher in
the hierarchy.
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Menu Item Description

Move View Select to move the selected query node up in the hierarchy tree.

Node Up

Rename Select to rename the selected query node.

Set View Select to set the selected query node invisible. Cls of this type do not appear in the view
Node results.

Invisible

When this option is selected, a Hidden in Query Results indicator & appears in the
corner of the selected query node in the hierarchy tree.

Set View Select to set the selected query node visible. Cls of this type appear in the view results.
Node Visible

Subgraph Enables you to define whether the subgraph defined for the selected query node is
Hierarchy displayed as flat or as folded under the query node.

Note: This option is only relevant for query nodes that have a defined subgraph.

Query Node Definition Pane

Important  The Query Node Definition pane is disabled for template based views. To make changes to

information = the report layout, edit the based template of the view. When you open a template based view
in the Editor and select the Report tab, a warning message appears containing a link to the
base template of the view.

User interface elements are described below:

ul
Element
(A-Z) Description
g Up. Moves a selected attribute up in the report layout order.
W Down. Moves a selected attribute down in the report layout order.
e Edit. Enables you to edit the function for the selected attribute.
3¢ Delete. Deletes the selected attribute from the report layout.
g 3 Moves the selected attributes to the Report Layout list.
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ul

Element

(A-2) Description

Add Click Add Function to open the Add Function dialog box, which enables you to define the

Function | functions to include in the report for the selected query node. Each function that you add is
treated as an attribute and becomes a column in the report.

Note: This button is only active if there is a query node below the selected query node in
the view hierarchy.

Attributes The list of available attributes for the selected query node.

Define Click Define Chart to display the data for the current layer of the view in a graphical chart
Chart format. The Chart Properties fields are displayed.

The Define Chart option is only active for a query node or a grouping node that:

« is the top layer of the view and has a layer below it in the view hierarchy
« is the only query node on its layer of the view
« has at least one numeric attribute selected for the report layout

Report Displays the list of attributes selected to appear in the report. Use the toolbar buttons to
Layout change the order of the attributes in the report and to add functions.

Set Sort  Click to open the Set Column Sort Order dialog box which enables you to set the order of the
Order report columns.

Chart Properties

The Chart Properties portion of the pane includes the following elements (listed alphabetically):

Ul Element (A-
Z) Description
5 Remove Chart. Removes the chart from the report. The report is generated in table

format.

Breakdown by  The chart is broken down by the CI or grouping node display label. This is fixed for all

reports.
Chart Type Select Pie to create a pie chart or Bar to create a bar chart.
Value Select a value from the drop-down list.

Widget Definition Pane

User interface elements are described below:
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Ul Element

(A-Z) Description

<Enforce Select this check box to ensure that the dynamic widget displays data only according to the
Browser ClI | permissions that were specified on the Browser Cl Access Control tab in the Roles

access manager. If the check box is not selected, the dynamic widget displays all data, without
control> permission enforcement.

<Show Select this check box to cause the UCMDB Browser to display the route in the dynamic
path> widget from a specific node in the view definition to all the node's children.

Attribute The attributes for the selected node that are displayed in the dynamic widget.

name

Details Specifies whether this attribute appears in the Widget Details mode.

Group Specifies the name under which the attribute is grouped in the Widget Details mode.
Name

Overview Specifies whether this attribute appears in the Cl Overview mode.

Refocusable ' Specifies whether this attribute is displayed as a hyperlink, able to refocus on the Cl on
which the attribute is defined.

Widget Enables you to select an initial display mode. The available types are:
Type « Properties Mode. Displays individual properties for Cls.
Note: If you do not select a Widget Type value, Properties Mode is enabled by
default.

Topology Map Mode. Displays Cls according to your current topology.

Topology CIT Group Mode. Displays Cls grouped by Cl type according to your
current model.

Topology Textual Mode. Displays alist of Cls broken down by ClI type.

The topology mode that you select is the initial view selection until you change to another
one in the UCMDB Browser.

Perspective-based View Editor
This feature enables you to create and edit perspective-based views.

T
© access In the Modeling Studio, click the New =/ button and select Perspective Based View to

create a new view or drag Cls from the Cl Selector onto the blank canvas and select Create
a new view.

To open an existing view in the Editor, select Views as the resource type in the Resources

pane, select the required perspective-based view from the tree, and click Open View - or
double-click the view.
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Important The Perspective-based View Editor contains the following panes:

Ll « Content pane. Drag Cls and/or models onto this pane to include them in your view.
« Perspective pane. Select perspectives to apply to the content to build a view.
« View Results pane. Displays a topology map with a preview of the current view. This
pane includes most of the IT Universe Manager functionality.
Relevant « "How to Build a Perspective-based View Based on a Model " on page 242
tasks « "How to Build a Perspective-based View Based on a Collection of Cls" on page 242
See also « "Building a Perspective-based View" on page 225

« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

Content Pane

User interface elements are described below:

ul

Element

(A-2) Description

Bt Show View Results in IT Universe. Goes directly to the current view in IT Universe
Manager.

|§l|| Properties. Opens the Configuration Item Properties dialog box for the selected ClI.

55 Show models containing selected CI. Displays a list of the models containing the selected
Cl.

i Show views containing selected Cl/model. Displays a list of the views containing the
selected Cl or model.

iy Open selected model in a new tab. Opens the selected model in a separate Model Editor
tab.

L] Generate view for selected model. Enables you to create a view based on the selected
model. Opens the Creating New View dialog box where you can select a perspective to apply.

E Remove Base Cls. Removes the selected Cl from the view content.

e View Definition Properties. Opens the View Definition Properties dialog box which enables
you to set properties for the view.

Find. Toggles between displaying and hiding the Find box and arrow controls.

Cl Type Displays the type of each Cl in the view.

column

Find Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in the view.
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ul
Element
(A-2) Description

Find Click to go to the next occurrence of the selected search phrase in the view.
Next

Find Click to go to the previous occurrence of the selected search phrase in the view.
Previous

Highlight Click to highlight all occurrences of the search phrase in the view.

Name Displays the name of each Cl in the view.
column

Shortcut Menu Options

Menu Item Description

Generate view for = Select to create a view based on the selected model. The Creating New View dialog

selected model box opens which enables you to select a perspective to apply.

Open selected Opens the selected model in a separate Model Editor tab.

model in a new

tab

Properties Opens the Configuration Item Properties dialog box for the selected CI.

Remove Base Cls | Deletes the selected Cl or model from the view content.

Show Containing  Click to display alist of the models containing the selected CI.
Models

Show Containing  Click to display alist of the views containing the selected CI or model.

Views

Perspective Pane

User interface elements are described below:

Ul Element

(A-Z) Description

5 Remove perspective step. Deletes the selected level of the perspective selection.

1. Move step up. Shifts the perspective selection from the current level to the previous one.

s Move step down. Shifts the perspective selection from the current level to the following
one.

=k Add perspective step. Adds a new level to the perspective selection. The results of the

previous perspective level serve as the input content for the new level.
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Ul Element
(A-Z) Description

Select perspectives. Opens a dialog box with the available perspectives. Move the
required perspectives from the available column to the selected column using the arrow
buttons.

To view a perspective definition, select a perspective in either column and click the Open
Definition link. The perspective definition opens in a separate tab.

Apply Over | Forviews based on models, select the Apply Over Model Hierarchy check box to include

Model the model hierarchy in the view and apply the perspectives to the Cls included in the model

Hierarchy as well as to the model itself. Clear the check box to exclude the model hierarchy from the
view and apply the perspectives to the model itself only. In this case, the model is treated
as an ordinary ClI.

Note: This option is disabled for a view based on a collection of Cls or on a model and
a collection of Cls.

Perspectives Lists the selected perspectives.

A default perspective appears in the window before any selection is made. You can set the
value of the default perspective using the Selected perspectives for new perspective
based views infrastructure setting.

View Results Pane

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z) Description

Map Displays the view results in Map mode.
Text Displays the view results in Text mode.
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Ul Element (A-
Z) Description

Group by Select a grouping method for the Cls in the topology map. The available options are:

« Group by Layer. Group the Cls according to the value of the layer attribute of their
Cl type.

« Group by CI Type. Group the Cls according to their Cl type.

« Group by Classification. Group the Cls according to the value of the
classification attribute of their Cl type.

« No Grouping. Do not group Cls.
Note:

« This option is available in Map mode only.

« When a grouping option is selected, each group contains an indicator displaying
the number of Cls in the group. If a group contains a large number of Cls, it
opens in collapsed format, displaying only the name and count indicator. Click
the + sign button to expand the group and display all the Cls. You can set the
threshold of Cls for automatically collapsing the group by modifying the
Initially expand group max Cls threshold setting in the Infrastructure
Settings Manager.

T Create Relationship. Creates a relationship between two Cls in the view.

it Go Up One Layer. Moves up one level in the topology map.
{F Drill Down One Layer. Moves down one level in the topology map.

¢ Delete from CMDB. Deletes the selected Cl from the CMDB.

s Show CI Properties. Opens the Configuration Item Properties dialog box for the
selected Cl.

£ Refresh. Refreshes the view results.

\I| Hide CI from View. Hides the selected Cl from the view. This option is only relevant
for Cls that were added to the view via the perspective. You cannot hide Cls from the
original view content from the view.

Note: Hidden Cls can be restored from the Hidden Cls dialog box.

=S Show Hidden Cls. Opens the Hidden Cls dialog box which enables you to restore Cls
that were hidden from the view manually.

L] Create view based on selected Cl/s. Enables you to create a new view based on the
Cls selected from the View Results pane.
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Ul Element (A-
Z) Description
= Expand preview display. Displays the preview in a separate pane.

<Breadcrumbs> At the top of the topology map, the breadcrumbs indicate the relevant query nodes in
each layer of the view for the path to the selected layer. The first item in the path is the
Top Layer. When you select a Cl from the layer below, the parent Cl forms the next
item in the breadcrumb path. You can click on any item in the path to display that layer
in the topology map.

<Legend> Indicates the icons displayed next to Cls with any of the following special statuses:

« Added. When Change Timeframe is active, indicates that the Cl was added.

« Candidate for Deletion. Indicates that the Cl is a candidate for deletion.

« Changed. When Change Timeframe is active, indicates that the Cl was changed.
« Drill Down One Layer. Indicates that there are Cls under the Cl on a lower layer.
« External. Indicates that the Cl is a federated CI.

« Impacted. When Impact Analysis is active, indicates an impacted Cl.

« Impacted and Trigger. When Impact Analysis is active, indicates a trigger CI that
is impacted.

« Note. Indicates that a note was added for the ClI.
« Trigger. When Impact Analysis is active, indicates a trigger Cl.

<Topology The topology map in the View Results pane follows the layout of the topology map in IT
Map> Universe Manager. For details, see "Topology Map" on page 197.

<Topology Map ' For details, see "Topology Map Sidebar" on page 147.
Sidebar>

Shortcut Menu Options

Menu Item  Description

<IT The IT Universe Manager shortcut menu options are available. For details, see "IT Universe
Universe Manager Page" on page 197.

Shortcut

Menu

options>

Create Select Create view based on selected Cl/s to create a new view based on the Cls

view based = selected from the View Results pane.

on selected

Cl/s

Hide CI Click to hide the selected CI from the view. This option is only relevant for Cls that were

from View  added to the view via the perspective. You cannot hide Cls from the original view content
from the view. In the case of a view based on a model, the model cannot be hidden but its
Cls can.
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Menu Item  Description

Show Restore hidden Cls to the view.
Hidden Cls

Query Node Grouping Dialog Box

This dialog box enables you to define a new grouping of Cls or to edit an existing grouping.

To

access Click the Add Group by El':"==| button in the Hierarchy pane of the Pattern View Editor and

select Add Group by Attribute or right-click the required query node and select Add Group
by Attribute from the shortcut menu.

Relevant | "How to Create a Pattern View" on page 232, "How to Create a Template" on page 233, "How
tasks to Create a Perspective" on page 234

See also | « "Building a Business View" on page 218
« "Modeling Studio User Interface" on page 244
» "Best Practices for Modeling" on page 151

User interface elements are described below:

Ul Element (A-Z) Description

Expression capture Enter the number of the relevant portion of the regular expression. Enter 0 if the

group index entire expression is relevant.

Group by Select an attribute from the drop-down list.

Mask to group by Enter a regular expression pattern representing the structure of the selected
attribute.

For details, see "Query Node Grouping" on page 219.

Query/View Definition Properties Dialog Box

This dialog box enables you to configure the properties of a TQL query or view.

Toaceess | e Modeling Studio, click the Query/View Definition Properties 21 button in the TQL

Query Editor or Pattern View Editor.

Important In the View Definition Properties dialog box, you can select a default layout for the view.
information = Select an option under Map Layout or under Group by (only one option can be selected).
Relevant « "How to Create a Pattern View" on page 232
tasks « "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

« "How to Define a TQL Query" on page 20
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See also « "Building a Business View" on page 218
» "Modeling Studio User Interface" on page 244

» "Best Practices for Modeling" on page 151

User interface elements are described below:

Ul Element (A-Z) Description
Base Query Select an existing TQL query on which to base your new query. Click Clear
Base Query |9| to remove the selected base query.
Note:

« This field is only relevant for TQL queries.

o This field is optional.

Bundles A method of grouping TQL queries or views by category. Select the bundles
associated with the current query or view or create a new bundle for it.

Note: This field is optional.

Description A description of the TQL query or view.

Group by Select a default layout for the view, when consuming it in IT Universe Manager
or the view preview. The available options are the ones described under Group
by in "Topology Map" on page 197.
Note:

« This field is only relevant for views.

« If you select a default layout (other than No Grouping) from this drop-
down, the Map Layout field is disabled.

Inter-Layer Links Set the scope of inter-layer relationships displayed in the topology results. For
details, see "Inter-Layer Relationships" on page 166.

Note: This field is only relevant for views.

Managed by Select the check box to denote the view as managed in HPE Universal CMDB
Configuration Manager Configuration Manager.

Note: This field is only relevant for views and only when HPE Universal
CMDB Configuration Manager is configured and running.
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Ul Element (A-Z) Description

Map Layout Select a default layout for the view, when consuming it in IT Universe Manager
or the view preview. The available options are the ones appearing under Layout
in the Main Menu.

Note:

« This field is only relevant for views.

« This field is only active when No Grouping is selected under Group
by.

Persistent Select to define the TQL query as persistent. A persistent query remains in the
memory permanently.

Priority Select a priority level for the TQL query or view from the drop-down list (Low,
Medium, High, Express, Not Active). This setting determines how often the
query should be rerun automatically by the system to include updated
information from the RTSM.

Note: When you change the priority of a view, the priority of the TQL query
on which the view is based is also changed.

Scope Select the scope of the TQL query from the drop-down list.

Note: This field is only relevant for Integration TQL queries.

Type Select the type of the TQL query from the drop-down list.

Note: This field is only relevant for TQL queries.

View refresh rate in If the view is set as Managed by Configuration Manager, select the view
Configuration Manager ' refresh rate from the drop-down list.

Note: This field is only relevant for views and only when HPE Universal
CMDB Configuration Manager is configured and running.

View type in If the view is set as Managed by Configuration Manager, select the view
Configuration Manager type from the drop-down list.

Note: This field is only relevant for views and only when HPE Universal
CMDB Configuration Manager is configured and running.

Reveal Cls Dialog Box

This dialog box enables you to search for Cls related to the Cls in a model and add them to the model.
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To access ) , , ,
In the Model Editor of the Modeling Studio, select a Cl, click the Reveal ““U button, and

select Start Revealing or right-click a Cl in the model and select Reveal > Start
Revealing.

Important | The upper pane displays the Cl types of the Cls related to the selected CI. The lower pane
information = displays the Cls of the type selected in the upper pane.

The first step in the reveal path is the ClI type of the Cl you began with. When you select a CI
type from the list in the upper pane, that Cl type becomes the second step in the path. Click
Next to display the Cl types available for the next step of the path.

The number at the top of the box in parentheses indicates the length of the constructed path

thus far.
Relevant "How to Build an Instance-based Model " on page 240
tasks
See also « "Revealed Cls and Watchpoints" on page 228

« "Modeling Studio User Interface" on page 244

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-2) Description

ﬁ Delete Selected Item(s). Deletes a selected item from the Cls basket.

|; CI Properties. Opens the Cl Properties dialog box for the selected ClI.

™ Add Cls to basket. Adds a selected Cl from the lower pane to the Cls basket.

o Find Next. Goes to the next occurrence of the selected search phrase in the list of Cls.
Find Previous. Goes to the previous occurrence of the selected search phrase in the list of
Cls.

<Lower Displays a list of related Cls of the type selected in the upper pane.

pane>

Cl count Indicates how many related Cls of each type were found.

Cls Basket Displays the related Cls you selected to include in the model.
Cl Type Displays a list of Cl types of the Cls related to the selected ClI.

Conditions A check mark indicates that conditions were defined for the selected Cl type. Click the
Conditions column for the CI type you want to select and click the Add Condition or Edit
Condition button to open the Conditions of Related Cls dialog box. This enables you to
define and edit conditions for the Cl type.

Find Enter a Cl name or a portion of a Cl name in the Find box to locate a Cl in the list of Cls.

Finish Click Finish when you have finished adding Cls to the Cl basket.
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Ul Element

(A-2) Description

Next Click Next to display the Cl types available for the next step of the path.
Reveal Displays the reveal path being constructed.

path

Clicking the blue arrows in the path > displays a drop-down list of the CI types available for
the next step of the path.

Clicking the Cl types in the path displays the following options:

« Jump to page. Refreshes the table with the available CI types for the selected step of
the path.

« Edit Condition. Opens the Conditions of Related Cls dialog box.

« Delete Selected Item(s). Deletes the selected Cl type from the reveal path (the path
ends at the previous Cl type).

Save Path | Opens the Save Reveal Path dialog box which enables you to save the path. This option is
only active when a unique reveal path has been constructed.

Save Query Dialog Box

This dialog box enables you to save a new TQL query.

To access In the Modeling Studio, click Save || when defining a new TQL query.
Relevant tasks "How to Define a TQL Query" on page 20
See also « "Viewing TQL Query Results" on page 14

» "Modeling Studio User Interface" on page 244
» "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
EE] New Folder. Creates a new folder in the resource tree.

. Delete. Deletes the selected resource from the RTSM.
|%| Refresh. Refreshes the resource tree.
|§| Expand All. Expands all the folders in the resource tree.
|§| Collapse All. Collapses all the folders in the resource tree.

Find Next. Goes to the next occurrence of the selected search phrase in the tree.
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Ul Element (A-
Z) Description
a Find Previous. Goes to the previous occurrence of the selected search phrase in the
tree.
=] Highlight All. Highlights all occurrences of the search phrase in the tree.
<Resource Select a folder in the tree in which to save the query.
tree>
Find Enter a folder name or a portion of a name in the Find box to locate a folder in the list.

Query Name Enter the name of the new TQL query.

Save View/Template/Perspective Dialog Box

This dialog box enables you to save a new pattern view, template-based view, perspective-based view,
template, or perspective.

To In the Modeling Studio, click the Save || button when defining a new pattern view, template-
access : . : \
based view, perspective-based view, template, or perspective.
See » "Building a Business View" on page 218
also

« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
& New Folder. Creates a new folder in the resource tree.
4 Delete. Deletes the selected resource from the RTSM.
|%| Refresh. Refreshes the resource tree.
|§| Expand All. Expands all the folders in the resource tree.
|§| Collapse All. Collapses all the folders in the resource tree.
&) Find Next. Goes to the next occurrence of the selected search phrase in the tree.
a Find Previous. Goes to the previous occurrence of the selected search phrase in the
tree.
=] Highlight All. Highlights all occurrences of the search phrase in the tree.
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Ul Element (A-
Z)

<Resource
tree>

Find

New query

View Name

Select Integration Points Dialog Box

Description

Select New query if the view is based on a new TQL query.

Enter the name of the new view, template, or perspective.

Select a folder in the tree in which to save the view, template, or perspective.

Enter a folder name or a portion of a name in the Find box to locate a folder in the list.

Note: This field is not relevant for template-based views and perspective-based

This dialog box enables you to select integration points to access the required data sources for a TQL query

node.

To access  Inthe Modeling Studio, right-click a TQL query node and select Select Integration Points.

Important You can select the data sources from which the TQL query generates the results for each
information = query node. For details on data sources, see "Integration Studio Overview " in the RTSM

Data Flow Management Guide.

See also "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z)

<Integration
Point list>

All Integration
Points

Local Data
Source

Select
Integration
Points

Sort Column Content Dialog Box

This dialog box enables you to set the order of the column content in a report.

HPE Application Performance Management (9.40)

Description

A list of integration points for available data sources.

Enables you to include Cls from all RTSM and external data sources for the selected
query node in the TQL query results.

Note: Only includes integration points where the CI type of the selected query node
is marked as federated.

Enables you to include Cls from the RTSM only for the selected query node in the TQL
query results.

Enables you to select integration points to include Cls from the required data sources
only for the selected query node in the TQL query results.
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To access | Inthe Modeling Studio, click Set Sort Order in the Query Node Definition pane of the
Pattern View Editor (in Report mode).

Important | The report is sorted by columns following the order of the attributes in the Sorted Columns
information pane. Each selected column is sorted in ascending or descending order according to your

selection.
Relevant "How to Define Report Settings" on page 239
tasks
See also « "Building a Business View" on page 218

« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below:

Ul Element (A-Z) Description

3 Move to Sorted Columns. Moves the selected attribute to the Sorted Columns
pane.
&+ Move to Available Columns. Moves the selected attribute to the Available Columns
pane.
= Moves all the attributes to the Sorted Columns pane.
= Moves all the attributes to the Available Columns pane.
; Moves the selected attribute down in the Sorted Columns list.
[ Moves the selected attribute up in the Sorted Columns list.
= Sort Ascending. Sorts the selected column in ascending order.
= Sort Descending. Sorts the selected column in descending order.
Available The attributes selected to appear as columns in the report.
Columns

Sorted Columns  The columns selected to be sorted.

Template-based View Wizard

This wizard enables you to define template-based views manually or by importing parameter data from a CSV
file.

To access Click the New |_| button and select Template Based View.
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Important The wizard enables you to create multiple template-based views based on the same

information template. When creating multiple views, the wizard includes the Save Views page as the
final page. When creating a single template-based view, the wizard finishes with the
Parameters page and opens the new view in the Editor. You can save the new view from

within the Editor.

Relevant « "How to Create a Template Based View" on page 237

tasks « "How to Create Multiple Template Based Views" on page 238

Wizard The Template-based View Wizard contains:

map Select Template Page > Import Parameter Values Page > Enter Parameters Page > Select
Location for Views Page > Summary Page > Save Views Page

See also « "Building a Business View" on page 218

« "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

Select Template Page

This wizard page enables you to select a template on which to base your view.

Important If you don't want to use any of the templates in the tree, you can create a new template first
information = and then build a view based on it. For details on creating a template, see "How to Create a
Template" on page 233.

Wizard The Template-based View Wizard contains:

map Select Template Page > Import Parameter Values Page > Enter Parameters Page >Select

Location for Views Page > Summary Page > Save Views Page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
|%| Refresh. Refreshes the template tree.
|§| Expand All. Expands all the folders in the template tree.
|ﬁ| Collapse All. Collapses all the folders in the template tree.
© Find Next. Goes to the next occurrence of the selected search phrase in the tree.
(@ Find Previous. Goes to the previous occurrence of the selected search phrase in the
tree.
Highlight All. Highlights all occurrences of the search phrase in the tree.

<Template tree> Displays the existing templates in tree format.
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Ul Element (A-
Z) Description
Find Enter a template name or a portion of a name in the Find box to locate a template in the

list.

Import Parameter Values Page

This wizard page enables you to import parameter values from a CSV file.

Important If you are creating a large number of views based on the same template, you can save the
information parameter values in a CSV file and import them directly into the wizard.

Note: If the CSV file contains any non-English characters, you must use UTF-8
encoding to ensure that the characters are displayed properly.

Wizard The Template-based View Wizard contains:

map Select Template Page > Import Parameter Values Page > Enter Parameters Page

>Select Location for Views Page > Summary Page > Save Views Page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

Add Select this option to enter the parameter values manually, whether for a single view or for
parameter multiple views.

values

manually

Import Select this option to import the parameter values from a CSV file. Click the ellipsis =]
parameter button to browse your files for the required file.

values from

a CSV file

Use Select the Use Advanced Naming option to automatically name the created views based
Advanced on parameter values. In the box, enter an expression containing at least one parameter
Naming name in angle brackets. The views are named based on the values of the selected

parameter.

Enter Parameters Page

This wizard page enables you to set the values of the template's parameters for each new view created.

Important If you are creating multiple views, click Next after you set the parameter values to proceed
information to the Save Views page. If you are creating a single view, click Finish after you set the
parameter values to open the new view in the Editor.
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Wizard The Template-based View Wizard contains:

map Select Template Page > Import Parameter Values Page > Enter Parameters Page > Select

Location for Views Page > Summary Page> Save Views Page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

Add view instance. Adds a new view instance.

E Remove view instance. Deletes the selected view instance.

<Parameter |n each parameter column, enter or select the required parameter value for each view.
columns>

Reset Click to reset the selected parameter to its original value.

Use Select the Use Advanced Naming option to automatically name the created views based
Advanced  on parameter values. In the box, enter an expression containing at least one parameter name
Naming in angle brackets. The views are named based on the values of the selected parameter.

Note: All view names must be unique.

View Name Enter names for each of the new views, or use the default names assigned.

Select Location for Views Page
This wizard page enables you to select the location in which to save the created views.

Important All created views must be saved in the same location.
information

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > Enter Parameters Page > Select
Location for Views Page > Summary Page> Save Views Page

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z) Description

E:] New Folder. Creates a new folder in the view tree.
|%| Refresh. Refreshes the view tree.

|§| Expand All. Expands all the folders in the view tree.
|E| Collapse All. Collapses all the folders in the view tree.
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Ul Element (A-

Z) Description

& Find Next. Goes to the next occurrence of the selected search phrase in the tree.

@ Find Previous. Goes to the previous occurrence of the selected search phrase in the

tree.

=] Highlight All. Highlights all occurrences of the search phrase in the tree.

<View tree> Select a folder (or the root) from the view tree.

Find Enter a template name or a portion of a name in the Find box to locate a template in the
tree.

Summary Page

This wizard page displays the details of the created views before saving.

Wizard The Template-based View Wizard contains:

map Select Template Page > Import Parameter Values Page > Enter Parameters Page > Select

Location for Views Page > Summary Page > Save Views Page
User interface elements are described below:

Ul Element
(A-Z) Description

Save view | A summary of the views created including the name of the base template, the number of
summary views created, and the location selected for saving the views.

Save Views Page
This wizard page enables you to save the new views you created.

Important This wizard page is only relevant when you are creating multiple template-based views.
Information

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page > Enter Parameters Page > Select
Location for Views Page > Summary Page> Save Views Page

User interface elements are described below:

Ul Element

(A-2) Description

Save A table displays the names of the new views and a message indicating whether each view
Results was saved successfully or not.
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Template Parameter Values Dialog Box
This dialog box enables you to edit the parameters of a template-based view.

To access  From within a template-based view in the Modeling Studio, right-click a query node with
parameters defined and select Show Node Parameters, or click the Show Parameters

F> putton on the toolbar.

Important When you open the dialog box from the shortcut menu by right-clicking a query node with

information parameters defined, the dialog box only displays the parameters for the selected query node.
When you open the dialog box from the toolbar, it displays all the parameters defined for any
of the query nodes in the view.

Relevant "How to Create a Template Based View" on page 237
tasks
See also « "Building a Business View" on page 218

« "Modeling Studio User Interface" on page 244
« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

<Parameters> Edit the values of the parameters.

TQL Query Editor

This feature enables you to build and edit TQL queries.

To access  Toopenanew TQL query in the TQL Query Editor, go to the Modeling Studio, click the New
|_| button and select Query.

To open an existing TQL query in the TQL Query Editor, go to the Resources tab of the left
pane in the Modeling Studio and select Queries as the Resource type. Right-click a TQL
query in the tree and select Open Query or double click a TQL query or drag a TQL query
onto the empty canvas. The TQL query opens in a new tab.

Important | To save your TQL query, use the Save button on the Modeling Studio main toolbar.
information

Relevant "How to Define a TQL Query" on page 20
tasks

See also « "Viewing TQL Query Results" on page 14
o "Modeling Studio User Interface" on page 244

« "Best Practices for Modeling" on page 151

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-2) Description
D Show View Results in IT Universe. Goes directly to the selected view in IT Universe
Manager.
Note: This button only appears for views, templates, or perspectives.
T Create Relationship. Enables you to draw a relationship from one query node to another.

Calculate Query Result Count. Calculates the number of instances found for each TQL
query node or relationship.

=% Preview. Displays a preview of the TQL query results as they would appear in IT Universe
Manager.
3¢ Delete. Deletes the selected query node or relationship from the query.

Query/View Definition Properties.

|l

For queries, opens the Query Definition Properties dialog box which enables you to edit the
type, scope, and priority of the TQL query.

For views, opens the View Definition Properties dialog box.

[ Report Properties. Opens the Report Properties dialog box, which enables you to set the
title, subtitle, and format for the view's topology report. For details, see Report Properties
Dialog Box.

Note: This button only appears for views, templates, or perspectives.

& Assign Tenants. Opens the Assign Tenants dialog box which enables you to assign
tenants to the resource.

Note: This button is only available when multi-tenancy is enabled.

Manage Security. Enables you to assign the selected resource to specific roles or resource
groups.

<Py Show Parameters. Opens the Template Parameter Values dialog box which enables you to
edit the parameters of a query node in a template-based view.

Note: This button only appears for template-based views.
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Ul Element
(A-2) Description

<Legend>  Indicates the icons displayed next to Cls with any of the following special designations:
« ltis defined as a contact query node in a perspective
« lItis afederated Cl
« It has attributes defined
« It has selected identities defined
« Itis hidden in the query results
« lItis defined as the output query node of a pattern-based model
« It has a subgraph defined

<Main For details, see "Main Menu" on page 136.
menu>

<Shortcut  Fordetails, see "Shortcut Menu Options" on page 28.
menu
options>

<Topology  For details, see "Topology Map Sidebar" on page 147.
Map
Sidebar>

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected query node and relationship.

Important The Advanced pane appears in the lower part of the window in the following managers and
information = user interfaces: Modeling Studio, Impact Analysis Manager, Enrichment Manager, the Input
Query Editor and Trigger Query Editor in DFM.

A small green indicator # appears next to the tabs that contain data.

Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20

« "How to Create a Pattern View" on page 232

« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

User interface elements are described below:

Ul Description
Elements
(A-Z)
4k If the window is not wide enough to display all the tabs, use the left and right arrows to move

to the required tab.
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Ul
Elements
(A-Z)

Attributes

Cardinality

Data
Sources

Details

Edit

Element
Layout

Element
Type

HPE Application Performance Management (9.40)

Description

Click Show List to display a list of the available tabs for the current module. You can select
a tab from the list.

Displays the attribute conditions defined for the query node or the relationship. For details,
see "Attribute Tab" on page 62.

Cardinality defines how many query nodes you expect to have at the other end of a
relationship. For example, in a relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes that are connected to between
one and three IP Addresses. For details, see "Cardinality Tab" on page 64.

Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Displays the following information:

« CI Type/Element Type. The CIT of the selected query node/relationship.

« Element Name. The name of the query node or relationship. This appears only in the
Modeling Studio.

« Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A red mark indicates that it is not visible.
In the Modeling Studio, this is indicated by the word Yes or No.

« Include subtypes. A green check indicates that both the selected Cl and its children are
displayed in the topology map. A red mark indicates that only the selected Cl appears.
This item does not appear in the Modeling Studio.

Click Edit to open the relevant dialog box for the selected tab.

Displays the attributes selection for the selected query node or relationship. It lists the
attributes selected to be included in the query results (when Specific Attributes is selected
as the attributes condition). It also lists the excluded attributes and any selected qualifiers
for attributes. For details, see "Element Layout Tab" on page 69.

Note: This tab appears only in the Modeling Studio.

Displays the subtype conditions defined for the query node or relationship. For details, see
"Element Type Tab" on page 67.

Note: This tab appears only in the Modeling Studio.
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] Description
Elements
(A-Z)

Enrichment Displays the Enrichment rule defined for the selected query node or relationship. If the

Rules Enrichment rule is used to update the attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if required. For details, see "Query
Node/Relationship Definition Dialog Box" on page 375.

Note: This tab appears only in Enrichment Manager.

Impacted Indicates which query node is impacted by the changes that occur in the selected trigger
Query query node. If required, you can click Edit to open and modify the Impacted Query Nodes
Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box" on page 313.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or the relationship. For details,
see "Qualifier Tab" on page 71.

Note: This tab appears only in Enrichment Manager and Impact Analysis Manager.

Selected Displays the element instances that are used to define what should be included in the TQL
Identities query results. For details, see "ldentity Tab" on page 72.

Views Containing Selected Cl Dialog Box

This dialog box enables you to display a list of the views containing the selected ClI.

T
° Click the Show views containing selected Cl/model G button in the Model Editor or select
access .. .
Show containing views from the shortcut menu.
See « "Building a Business View" on page 218
also

« "Modeling Studio User Interface" on page 244
« "Best Practices for Modeling" on page 151

User interface elements are described below:

Ul Element Description

(A-Z)
Bt Show View Results in IT Universe. Goes directly to the selected view in IT Universe
Manager.
ﬁ Delete Selected Item(s). Deletes the selected view.
el Disconnect view from perspective. Disconnects the selected view from its perspective.
The view becomes a pattern view.
Find Enter a view name or a portion of a view name in the Find box to locate it in the list.
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Ul Element Description
(A-Z)

Find Next Click to go to the next occurrence of the selected search phrase in the list.

Find Click to go to the previous occurrence of the selected search phrase in the list.
Previous

Highlight Click to highlight all occurrences of the search phrase in the list.

View Name Displays the list of views dependent on the selected template or perspective.

Note: The name of the current view appears in faded text.

Watchpoints Updates Dialog Box

This dialog box displays the changes found in related Cls by a watchpoint defined for a model.

To access =
From within a model in the Model Editor, click the Watchpoint #4 button and select

Watchpoints Updates or right-click a Cl in the model and select Watchpoint >
Watchpoints Updates.

Important = The Watchpoints Updates dialog box indicates any changes found involving the Cls related

information = to the model via the associated reveal path. If a new related Cl is found which is not included
in the model, the suggested update is an added ClI. If a Cl in the model is found to no longer
be related via the path, the suggested update is a removed CI.

This option is only enabled when watchpoints are defined for the model and Cls have been
found.

See also « "Revealed Cls and Watchpoints" on page 228
« "Modeling Studio User Interface" on page 244

User interface elements are described below:

Ul Element (A-Z) Description

Accept Select the check boxes for the Cls you want to add to your model or remove from
your model.

Accept All Click Accept All to apply all the suggested changes to your model.

Cl The names of the Cls found by the watchpoint.

Cl Type The types of the Cls found by the watchpoint.

Clear All Click Clear All to clear the check boxes for all the found Cls.

Restore Select the check boxes for the Cls in the Suppressed Cls pane that you want to

consider for inclusion in your model.
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Ul Element (A-Z) Description

Show/Hide Toggle between hiding and displaying the Suppressed Cls pane of the dialog box.

Suppressions

Suggested Indicates whether the suggested change is an added ClI or a removed CI.

Update

Suppress Select the check boxes for the Cls you want to exclude from your model or leave in
your model.

Suppress All Click Suppress All to decline all the suggested changes to your model.

<Query/Template/Perspective Name> Dependencies Dialog
Box

This dialog box enables you to clarify the status of dependent resources when saving changes to a query,
template, or perspective.

To access | Inthe Modeling Studio, make a change to a query, template, or perspective with dependent
resources. When you click Save, the dialog box opens.

Important = Any change made to a resource affects the views or custom reports based on that resource.
information Before the changes are saved, you need to specify the desired result on the dependent
resources. For each dependent resource, select one of the available options: Delete or Re-
Apply.
Dependent resources include views based on a query, template, or perspective, and custom
reports based on a view, for example, a View Change report.

User interface elements are described below:

ul Description

Element

(A-Z)

Delete Select this option to delete the selected dependent resource.

Re-Apply Select this option to apply the revised query, template, or perspective to the selected
dependent view. The view type remains the same as it was previously (pattern view, template-
based view, or perspective-based view). In the case of custom reports, the report is updated
according to the revised view.

Resource ' The dependent resources are displayed in a tree format.
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This chapter includes:

® Impact Analysis Manager OVerview .. 304
®* How to Define an Impact Rule —Workflow ... . 304
* Impact Analysis Manager User Interface ... ... 307

Impact Analysis Manager Overview

Impact Analysis Manager enables you to define the interdependencies between components in your IT
infrastructure to simulate how infrastructure changes (for example, a new software installation or upgrade) can
impact your system.

By creating Impact rules based on TQL queries, you can determine the true origin of a problem and its
business impact. Each Impact rule you define is attached to a specific Impact Analysis TQL query. For more
information about TQL queries, see "Topology Query Language" on page 13.

You define Impact rules to specify a causal relationship between two or more Impact Analysis query nodes.
Define one query node as the trigger, or the query node that represents the changes you want to make to the
system, and another query node as the one that is impacted. After the causal relationship is established,
Impact Analysis Manager enables you to determine the effect of the changes occurring in root cause query
nodes.

You then run the Impact rules in IT Universe Manager to simulate how the changes impact your system and
discover the root causes of the changes (for details, see "Run Impact Analysis Dialog Box" on page 211).
This enables you to evaluate and handle accordingly, the possible implications of any action, update, new
deployment, or a failure of the service delivery.

A simulated change in an impacted Cl can alter the Cl's map status, which is manifested through an addition
of a status icon to the Cl's symbol. The Topology Map displays the statuses of the trigger Cls as well as all
statuses of the Cls that are impacted by it. Each color represents a different status.

For details about the status icons and the colors that represent them, see "Show Impact Pane" on page 214.
You can then generate a report displaying the following:

« Clsinthe system that are impacted by the changes.
« Trigger Cls (the Cls that represent the changes you want to make to the system).

« Cls that belong to a specific business service.

How to Define an Impact Rule - Workflow

This section describes how to define an Impact rule whereby a change in CPU operation impacts the node to
which it is connected.

This task includes the following steps:
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« "Create an Impact Analysis TQL Query" below

o "Define an Impact Rule" below

1. Create an Impact Analysis TQL Query

To create an Impact Analysis TQL query, you need to create an Impact Analysis TQL and then add the
TQL query nodes and relationships that define the query.

Select Admin > RTSM Administration > Modeling > Impact Analysis Manager to open the Impact
Analysis Manager. For details about how to create an Impact Analysis TQL query, see "New Impact
Rule/Impact Rule Properties/Save As Impact Rule Wizard" on page 315. For details about how to add
query nodes and relationships to a query, see "How to Add Query Nodes and Relationships to a TQL
Query" on page 21.

Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a Composition relationship. The
TQL query results must comply with the direction of the arrows.

(

=
2
(11}

Compositian

I I

Chu

Note: An Impact Analysis TQL query is subject to certain validation restrictions. For details,
see "Troubleshooting and Limitations — Topology Query Language" on page 77.

2. Define an Impact Rule

When you define an Impact rule, you must specify the required causal relationship between the query
nodes. Define one query node as the trigger, or the query node that represents the changes you want to
make to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger query node and select Define Impacted to
open the Impacted Query Nodes dialog box. Select the query node you want the trigger query node to
impact. Then click the Add button to open the Impact Rules Definition dialog box to set conditions for
defining impacted query nodes. For details about how to define an Impact rule, see "Impact Rules
Definition Dialog Box" on page 314.

Note: The change state option in the Impact rule definition is no longer relevant for Impact Analysis.

The only supported state is operation.

Example of an Impact Rule:
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The Conditions area in the Impact Rules Definition dialog box defines the conditions under which the
simulated change in the system is triggered. The Severity area defines the severity of the impact on
the impacted query node.

The Impact rule in this example states that when the CPU operation is not in the normal state, the
node is impacted. Since the severity is set to 100% of the trigger's severity, the severity of the node
is the same as the severity of the CPU, which is determined when Impact Analysis is run.

E Impact Rules Definition

Description: | |

| Conditions

State: | operation | - |

Operator: | Mot equal |v |

Walue comparison: | Marmal |v |

i_) Range o - %

(") Fixed severity:

(®) Severity relative to trigger severity (%):

In the resulting TQL query, an upward arrow appears next to the query node defined as the trigger
query node and a downward arrow appears next to the query node defined as the impacted query
node.

=N
Fode

Composition

v

AT

Cpu

+

Note: To retrieve the Impact Analysis results, you must run the Impact rule in IT Universe
Manager. For details, see "How to Retrieve Impact Analysis Results — Scenario" on page 178.

HPE Application Performance Management (9.40) Page 306 of 393



Modeling Guide
Chapter 10: Impact Analysis Manager

mpact Analysis Manager User Interface

This section includes (in alphabetical order):

Details Dialog BoX ... il 307
Impact Analysis Manager Page ... ... ... 307
Impacted Query Nodes Dialog BoX ... 313
Impact Rules Definition Dialog BOX ... ... L 314
New Impact Rule/Impact Rule Properties/Save As Impact RuleWizard ................................... 315

Details Dialog Box

This dialog box displays the new Impact rule you created in the Impact Rules Definition dialog box.

To access In the Impact Analysis Manager, click Next in the Impacted Query Nodes dialog box.
Relevant tasks | "How to Define an Impact Rule — Workflow" on page 304

See also « "Impact Analysis Manager Overview" on page 304

« "Impact Analysis Manager User Interface" above

User interface elements are described below:

Ul Element (A-Z) Description
Description The description of the new Impact rule.

State The category you chose from the State list in the Impact Rules Definition dialog box.

mpact Analysis Manager Page

This page enables you to define Impact rules.

To access  Select Admin > RTSM Administration > Modeling > Impact Analysis Manager.

Important = When selecting query nodes to function as Impact Analysis triggers, they must comply with
information = certain restrictions. For details, see "Troubleshooting and Limitations — Topology Query
Language" on page 77.

Relevant "How to Define an Impact Rule — Workflow" on page 304
tasks
See also o "Impact Analysis Manager Overview" on page 304

» "Impact Analysis Manager User Interface" above

Impact Rules Pane

This area displays a hierarchical tree structure of predefined folders and Impact rules. Each Impact rule is
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associated with a TQL query.

Important You can create your own Impact rules, or work with the default rules provided with your HPE
information = Application Performance Management installation.

The predefined folders are provided for the default Impact rules; you can modify these
folders, or add additional folders according to your organization's requirements.

You can drag and drop Impact rules or folders to move them from one folder to another.

User interface elements are described below:

Ul Element (A-Z)
B

=

PTe,

Description

New Folder. Creates a new folder.

New. Creates an Impact rule. Opens the New Impact Rule Wizard.

Delete. Deletes the selected folder or Impact rule.
Refresh. Refreshes the data content of the hierarchical tree
structure that may have been modified by other users.

Save. Saves the Impact rule to the RTSM. (Enabled only when a
new Impact rule is created or when changes are made to an existing
one.)

Properties. Opens the Impact Rule Properties Wizard. Enables you
to change the description of the rule.

Assign Tenants. Opens the Assign Tenants dialog box which
enables you to assign tenants to the impact rule.

Note: This button is only available when multi-tenancy is
enabled.

Manage Security. Enables you to assign the selected impact rule to
specific roles or resource groups.

Preview. Generates a preview of the results of the selected Impact
rule.

Export To XML. Enables you to export an Impact rule to an XML
file.

Import From XML. Enables you to import XML files that contain
saved Impact rules to the Impact Analysis Manager.

Represents a folder.

Represents an Impact rule.
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Ul Element (A-Z)

<Impact Rules tree>

Description

Displays the existing Impact rules in tree format.

Note: Only Impact rules appear in the tree. TQL queries of type
Impact Analysis (created in the Modeling Studio) do not appear.

The following options are available by right-clicking a folder or Impact rule:

Ul Element
(A-Z)

Assign
Tenants

Delete

Export To
XML

Import From
XML

Manage
Security

New

New Folder
Preview
Properties
Rename
Folder

Save

Save As

Editing Pane

Description

Opens the Assign Tenants dialog box which enables you to assign tenants to the
selected impact rule.

Note: This option is only available when multi-tenancy is enabled.

Delete the selected folder or Impact rule.

Displays a standard Save As dialog box, enabling you to save the Impact rule as an XML
script. This option can be used to move an Impact rule from one workstation to another,
provided the related TQL query is also relocated.

Imports XML files that contain saved Impact rules to Impact Analysis Manager.

Assign the selected impact rule to specific roles or resource groups.

Creates an Impact rule. Opens the New Impact Rule Wizard.
Creates a new folder.
Generates a preview of the results of the selected Impact rule.

Opens the Impact Rule Properties Wizard. Enables you to change the description of the
rule.

Rename the folder.

(Enabled only when a new Impact rule is created or when changes are made to an
existing one.) Saves the Impact rule to the RTSM.

Displays the Save As Impact Rule Wizard, enabling you to create new Impact rules
based on an existing query.

This area displays the selected Impact rule, which consists of query nodes that are defined in the TQL query
and the relationships between them.

HPE Application Performance Management (9.40)

Page 309 of 393



Modeling Guide
Chapter 10: Impact Analysis Manager

Important « When you select a folder in the Impact Rules pane, the editing pane is empty.

information | \when you select an Impact rule in the Impact Rules pane, the editing pane displays the

selected rule, which consists of TQL query nodes that are defined in the TQL query and
the relationships between them.

Relevant "How to Add Query Nodes and Relationships to a TQL Query" on page 21
tasks

See also When selecting query nodes to function as Impact Analysis triggers, they must comply with
certain restrictions. For details, see "Troubleshooting and Limitations — Topology Query
Language" on page 77.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-

Z) Description

Indicates a trigger query node. Located to the right of the trigger query node's icon.

Indicates an impacted query node. Located to the right of the impacted query node's
icon.

E| Indicates query nodes that are both impacted and trigger query nodes.

<Main Menu> For details, see "Main Menu" on page 136.
<Query Node> = A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between two query nodes.

<Shortcut For details, see "Shortcut Menu Options" on page 28.

menu options>

<Toolbar> For details, see "Toolbar Options" on page 139.

<Tooltip> Hold the cursor over a query node or relationship to view its tooltip.

The tooltips contain the following information:

« Element name. The name of the query node.

« CI Type. The CIT of the query node as defined in the Cl Type Manager. For details,
see "Cl Type Manager" on page 319.

« Definitions of the selected query nodes and relationships. The attribute
conditions, as described in "Query Node/Relationship Properties Dialog Box" on
page 61.

« Names of the trigger and the impacted query nodes. This is only relevant if the
query node over which the cursor is hovering is the trigger query node.

Cl Type Selector

This area displays a hierarchical tree structure of the Cl Types found in the RTSM.
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Important The CI Type Selector is part of Enrichment Manager, Impact Analysis Manager, and Trigger
information TQL Editor.

To create or modify a TQL query, click and drag query nodes to the Editing pane and define
the relationship between them. Your changes are saved to the RTSM. For details, see "How
to Add Query Nodes and Relationships to a TQL Query" on page 21.

Note: The number of instances of each CIT in the RTSM is displayed to the right of
each CIT.

Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20

« "How to Create a Pattern View" on page 232

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements (A-Z) Description

o Add CI Type to Map. Moves the selected Cl type to the Editing pane.
|§| Refresh. Refreshes the Cl type tree.

|E| Search. Searches for the Cl type entered.

|E| Expand All. Expands all subtrees within the Cl type tree.

|E| Collapse All. Collapses the subtrees within the ClI type tree.
<Search window> Enter the name or part of a name of a Cl type for which to search.

Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically) available by right-clicking a Cl
Type:

Menu Item Description

Add CI Type Select to add the selected Cl type to the Editing pane.

to Map

Go to Cl Type  Takes you directly to the selected Cl type in CIT Manager.

Definition

Show CIT Opens the CIT Instances window, which displays all instances of the selected CIT. For
Instances details, see "Cl Instances Dialog Box" on page 55.

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected query node and relationship.
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Important The Advanced pane appears in the lower part of the window in the following managers and
information = user interfaces: Modeling Studio, Impact Analysis Manager, Enrichment Manager, the Input
Query Editor and Trigger Query Editor in DFM.

A small green indicator * appears next to the tabs that contain data.

Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233

« "How to Create a Perspective" on page 234

User interface elements are described below:

ul Description
Elements
(A-Z)
4k If the window is not wide enough to display all the tabs, use the left and right arrows to move
to the required tab.
z Click Show List to display a list of the available tabs for the current module. You can select

atab from the list.

Attributes Displays the attribute conditions defined for the query node or the relationship. For details,
see "Attribute Tab" on page 62.

Cardinality = Cardinality defines how many query nodes you expect to have at the other end of a
relationship. For example, in a relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes that are connected to between
one and three IP Addresses. For details, see "Cardinality Tab" on page 64.

Data Displays the data sources set for the selected query node.

Sources
Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

« CI Type/Element Type. The CIT of the selected query node/relationship.

« Element Name. The name of the query node or relationship. This appears only in the
Modeling Studio.

« Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A red mark indicates that it is not visible.
In the Modeling Studio, this is indicated by the word Yes or No.

« Include subtypes. A green check indicates that both the selected Cl and its children are
displayed in the topology map. A red mark indicates that only the selected Cl appears.
This item does not appear in the Modeling Studio.

Edit Click Edit to open the relevant dialog box for the selected tab.
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] Description

Elements

(A-Z)

Element Displays the attributes selection for the selected query node or relationship. It lists the
Layout attributes selected to be included in the query results (when Specific Attributes is selected

as the attributes condition). It also lists the excluded attributes and any selected qualifiers
for attributes. For details, see "Element Layout Tab" on page 69.

Note: This tab appears only in the Modeling Studio.

Element Displays the subtype conditions defined for the query node or relationship. For details, see
Type "Element Type Tab" on page 67.

Note: This tab appears only in the Modeling Studio.

Enrichment Displays the Enrichment rule defined for the selected query node or relationship. If the

Rules Enrichment rule is used to update the attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if required. For details, see "Query
Node/Relationship Definition Dialog Box" on page 375.

Note: This tab appears only in Enrichment Manager.

Impacted Indicates which query node is impacted by the changes that occur in the selected trigger
Query query node. If required, you can click Edit to open and modify the Impacted Query Nodes
Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box" below.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers Displays the qualifier conditions defined for the query node or the relationship. For details,
see "Qualifier Tab" on page 71.

Note: This tab appears only in Enrichment Manager and Impact Analysis Manager.

Selected Displays the element instances that are used to define what should be included in the TQL
Identities query results. For details, see "ldentity Tab" on page 72.

Impacted Query Nodes Dialog Box

This dialog box enables you to define which query node in the TQL query is the trigger Impact Analysis query
node and which query nodes are impacted by the changes that occurred in the system.

To access  Right-click the query node or relationship that functions as a trigger and select Define
Impacted. The Impacted Query Nodes dialog box opens to display the query nodes in the
TQL query.

Important Before creating the TQL query, you must know which query node in the query is the trigger
information ' Impact Analysis query node and which are impacted by the changes beforehand. The
definition is performed here.
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Relevant "How to Define an Impact Rule — Workflow" on page 304
tasks
See also o "Impact Analysis Manager Overview" on page 304

« "Impact Analysis Manager User Interface" on page 307

User interface elements are described below :

Ul Element

(A-Z) Description

Impacted Contains a list of the Impact Analysis query nodes in the Impact rule. Select the query
Query nodes to be impacted by the trigger query node. Click Next to view details for the selected

Nodes pane  query node.

Impact Rules Definition Dialog Box

This dialog box enables you to set conditions for defining impacted query nodes, define the scope of the
trigger conditions, and define the severity of the impact.

To access | Inthe Impact Analysis Manager, click Add on the Details page of the Impacted Query
Nodes dialog box.

Important « Inthe Conditions area, set conditions for defining impacted query nodes. When this
information condition is met, the simulated change in the system is triggered.

For example, you can define an Impact Analysis condition that states that the operational
state of the query node is other than Normal. When the operational state of the query
node instance changes and is no longer Normal, the condition is met and the simulated
changes in the system are triggered.

« Inthe Scope area, define how many instances of the trigger query node should fulfill the
conditions for triggering the changes in the system.

You can apply the trigger conditions to a single instance of a trigger query node, to a
certain percentage of the trigger instances, or to all of them.

For example, you can define that impact is calculated when at least 10% of the system’s
nodes are down.

« Inthe Severity area, define the severity of the Impact Analysis impact.

Relevant "How to Define an Impact Rule — Workflow" on page 304
tasks
See also « "Impact Analysis Manager Overview" on page 304

« "Impact Analysis Manager User Interface" on page 307

User interface elements are described below :

Ul Element
(A-Z) Description
All All instances should fulfill the conditions.
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Ul Element
(A-Z)

Any
Description

Fixed
severity

Function

Operator

Range

Severity
relative to
trigger
severity (%)

State

Value
comparison

Description
One instance or more should fulfill the conditions.
A description of the Impact rule you are defining.

Define a fixed severity level for every system change generated. Then, select the required
severity level from the list.

Select Function (displayed when you selected the All and Range options in the Scope
area) to define a severity level for the system changes, as a function of the severity levels of
all the trigger query node instances that are included in the range. From the list, select either
Average or Max.

For example, if you select Average, the severity level of the system changes is the average
severity of all the trigger instances.

Select the required operator. For a list of the operators you can use for defining an attribute
condition, see "Attribute Operator Definitions" on page 33.

A certain percentage of all instances should fulfill the conditions. For example, if you enter a
range of 50% to 100%, the changes are triggered when 50% or more of the instances meet
the conditions.

Select Severity relative to trigger severity (%) (displayed when you selected the Any
option in the Scope area) to define a severity level for each system change that is relative
(as a percentage) to the severity of the trigger event.

Enter the percentage in the box provided.

Choose the required state. The states that appear in the list are the states that are defined in
the State Manager. For details, see "State Manager" in the HPE Universal CMDB
Administration Guide.

Select the required attribute.

New Impact Rule/Impact Rule Properties/Save As Impact Rule

Wizard

This wizard enables you to create or modify an Impact rule.

To access

« Tocreate an Impact rule, right-click anywhere in the Impact Rules pane and click New or

click the New | = button.

« Tomaodify an Impact rule, right-click an Impact rule in the Impact Rules pane and select
Properties.

« Tocreate a new Impact rule based on an existing query, right-click an Impact rule in the
Impact Rules pane and select Save As.
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Important « Any major change made to the TQL query after creating an Impact rule causes the

information system to delete the rule. These changes include deleting a root cause or impacted query
node or changing the Min and Max relationship definitions. For details, see "Cardinality
Tab" on page 64.

« Minor changes, such as adding a query node to the TQL query, do not cause the deletion
of the rule.

« Thelmpact Analysis TQL query that serves as the basis of the Impact rule, is subject to
certain validation restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language” on page 77 . If the TQL query is not valid, it cannot be used
for the creation of an Impact rule.

Relevant "How to Define an Impact Rule — Workflow" on page 304.

tasks

Wizard The New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard contains:
Map

"Impact Rule General Attributes Page" below > "Impact Rule Base Query Page" on the next
page > "Impact Rule Groups Page" on page 318

See also « "Impact Analysis Manager Overview" on page 304

« "Impact Analysis Manager User Interface" on page 307

Impact Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the Impact rule.

Important « The Impact Analysis TQL query that serves as the basis of the Impact rule, is subject to

information certain validation restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 77. If the TQL query is not valid, it cannot be used for
the creation of an Impact rule.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard"
on the previous page.

« By default, this wizard is set to display a Welcome page. You can choose not to display
the Welcome page by changing the user preferences. For details, see "User Preferences
Dialog Box" on page 77.

Wizard The "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard" on the
map previous page contains:

Impact Rule General Attributes Page > Impact Rule Base Query Page > Impact Rule
Groups Page

See also "IT Universe Manager" on page 158

User interface elements are described below:

Ul Element

(A-2) Description

Rule (Optional) Enter a description of the Impact rule.
Description
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Ul Element
(A-2) Description

Rule Name Enter a unique name for the Impact rule.

The rule name cannot contain any of the following characters: \/: " <> | % ?. The final
character cannot be a blank space.

Note: If the Impact rule name is either empty, contains a name used by another Impact
rule, or uses invalid characters, the Next and Finish buttons are disabled.

Impact Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Impact rule is based. You
can use an existing query or create a new query.

Important « Thelmpact Analysis TQL query that serves as the basis of the Impact rule is subject to

information certain validation restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 77. If the TQL query is not valid, it cannot be used for
the creation of an Impact rule.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard"

on page 315.
Wizard The New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard contains:
map Impact Rule General Attributes Page > Impact Rule Base Query Page > Impact Rule
Groups Page
See also "IT Universe Manager" on page 158

User interface elements are described below :

Ul Element (A-Z) Description

Base the Impact rule on = Select this check box if you want to base the Impact rule on a new TQL query.
a new query The query results are based on the attributes defined for the new TQL query.

Base the Impact rule on = Select this check box if you want to base the Impact rule on an existing TQL
an existing query query. Select the required Impact Analysis TQL query from the drop-down list.

Base Query Description = (Optional) Enter a description of the TQL query.

Base Query Name Enter a unique name for the Impact Analysis TQL query.

If you selected the Base the Impact rule on an existing TQL option, select
the Impact Analysis TQL query on which you want to base the rule.

Save a new query based @ Select to save a new TQL query based on your Impact rule definition.
on the current definition
Note: This field only appears in the Save As Impact Rule wizard.
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Impact Rule Groups Page

This wizard page enables you to define where you can run Impact rules.

Important « Thelmpact Analysis TQL query that serves as the basis of the Impact rule, is subject to

information certain validation restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 77. If the TQL query is not valid, it cannot be used for
the creation of an Impact rule.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard"
on page 315.

« By default, this wizard is set to display a Completion page after clicking Next on this
page. You can choose not to display the Completion page by changing the user
preferences. For details, see "User Preferences Dialog Box" on page 77.

Wizard The Impact Rule Groups Page contains:
map Impact Rule General Attributes Page > Impact Rule Base Query Page > Impact Rule
Groups Page

See also "IT Universe Manager" on page 158

User interface elements are described below :
Ul Element (A-Z) Description

<Impact Rule Displays the available bundles. Select the bundle(s) in which to include this Impact
bundles> Rule.

For new Impact rules, the UCMDB: Rule will run within UCMDB application
option is selected by default.
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This chapter includes:

ClTYPES OVEIVIEW ... 319
ClType AttribUtes L 320
Cl Type Relationships .l 321
Deprecated Cl TYPeS ... .. 321
System TYPe Manager . ... 322
How to Create @ Cl TYPe ... 322
How to Create a Relationship Ty e .. 324
How to Create a Calculated Relationship Type ... i, 324
How to Create List and Enumeration Definitions ... ... .. ... . . 325
How to Create an Enumeration Definition —Workflow ... ... 326
View Descriptions for Cl Types and Relationships ... ... ... 327
Cl Type Manager User Interface ... .. ... . 328

Note to HPE Software-as-a-Service customers: The datain Cl Type Manager can be viewed but not
edited.

Cl Types Overview

A configuration item (Cl) can represent hardware, software, services, business processes, or any component
of your IT infrastructure. Cls with similar properties are grouped under a Cl type (CIT). Each CIT provides a
template for creating a Cl and its associated properties.

Every Cl must belong to a Cl type. The following are the main categories of CITs:

L]

Business Element. CITs that correspond to the logical elements of your business, such as processes
and organizational groups.

IT Process Record. CITs that correspond to changes that occur in your IT infrastructure.
Monitor. CITs that handle incoming metrics collected from your business universe.

Location. CITs that correspond to the location of devices and business organizations or people supporting
a function.

Party. CITs that correspond to an active entity such as a person or organization.
CI Collection. A logical collection of Cls.

Infrastructure Element. CITs that correspond to the physical elements (hardware and software) installed
in your business environment.

The CITs are arranged in a tree structure under these categories in the Cl Types pane. You can browse the Cl
Type model by expanding the tree in the Cl Types pane. The CIT selected in the left pane is displayed in the
topology map along with all the potential valid relationships to other CITs.
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You can also define new CITs to match your business needs. For details on defining new CITs, see "Create
Configuration Item Type/Relationship/Calculated Relationship Wizard" on page 335.

Cl Type Attributes

Every Cl type has attributes which define it, such as name, description, and default value. The CITs grouped
under other CITs in the CI Type tree inherit attributes from the higher-level CITs.

When you define a new Cl type, you first select a Base Configuration Item Type from a list of existing CITs.
Your new CIT inherits the attributes of the existing CIT. You can then set the attributes for the new CIT. You
edit the attributes of an existing CIT by selecting a CIT from the tree in the Cl Types pane and selecting the
Attributes tab of the topology map. For details on CIT attributes, see "Attributes Page" on page 337.

This section includes the following topics:

« "CI Type ldentification Methods" below
« "CIl Type Naming" below

Cl Type Identification Methods

Every Cl created is given an automatically generated global ID, which is used to distinguish different
instances of the same Cl type. RTSM provides identification methods which enable you to set conditions
under which two Cl instances are defined as identical, and are consequently merged into a single instance.
For example, the By key attributes method involves defining Cls with certain matching attributes to be
identical. You can also select additional identification methods as described in "Details Page" on page 336.

If you select the By key attributes option, you can designate one or more of the CIT's attributes as key
attributes, which are used as identifiers of the CIT. When you define an instance of a CIT, the CIT's key
attributes are mandatory fields for Cls of that type. You can assign as many key attributes as youwant to a
given CIT. If you do not assign a key attribute when defining a new CIT or changing the identification method
of an existing CIT to By key attributes, you must select the ABSTRACT_CLASS qualifier on the Qualifier
page of the wizard.

You can change or remove the key attributes of an existing CIT if the key attribute values for all instances of
that CIT are unique. Similarly, you can change the identification method to By key attributes only if the key
attribute values for all instances of that CIT are unique. If the selected changes result in multiple instances of
a CIT with identical key attribute values, an error message indicates that the action is not permitted, as the
CIT instances would be merged.

If you select other identification methods, you cannot define key attributes for the CIT, but it retains the key
attributes of its parent CIT. These key attributes are mandatory fields for Cls of that type and they cannot be
removed. For those identification methods, there are no restrictions on the qualifiers selected.

Identification is also relevant for Cls of sibling Cl types, if at least one of the Cl types inherits its identification
method from the common ancestor CIT. For example, the Cl types Router and Switch Router are sibling

Cl types, descendants of the ancestor CIT Node. If at least one of them has Inherited from parent as the
identification method, then Cls of the two types could be merged if the identification criteria are met. In such a
case, the Cl type of the merged Cl is that of the sibling that was most recently updated. If one of the Cls had
attributes that do not exist in the ClI type of the merged Cl, they are filtered out of the merged CI.

Cl Type Naming

Entity names in HPE Application Performance Management for RTSM-based applications follow the
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conventions described below:

« CIT attributes values. All primitive types are supported: long, double, float, string, and so on.

« CIT attributes values-type string. All special characters are supported. The maximum length is 4000
characters.

« CIT name. Only the following characters are permitted: a-z, A-Z, 0-9 and underscore (_). Note also:
« The first character must not be a number.

« The name field is case sensitive, but you cannot use the same name with different cases for different
ClITs.

« The maximum length is 200 characters.

« CIT attribute name. Only the following characters are permitted: a-z, A-Z, 0-9 and underscore (_). Note
also:

« Thefirst character may be a number.
« The attribute name field is not case sensitive.
« The maximum length is 200 characters.

« CIT attribute length. The total length of all the attribute values in one CIT cannot exceed 8K bytes due to
a Microsoft SQL Server limitation. This limitation is relaxed under certain circumstances. For details, see
http://msdn.microsoft.com/en-us/library/ms186981.aspx.

Cl Type Relationships

A relationship defines the link between two Cls. Relationships represent the dependencies and connections
between the entities in your IT environment. When you select relationships or calculated relationships in the
drop-down box in the CI Types pane, the topology map displays all the valid instances of CITs linked by the
selected relationship. For details about calculated relationships, see <!-- apply UCMDB_only condition to this
paragraph -->Using Calculated Relationships<!-- apply AM_only condition to this paragraph -->Impact
Modeling.

The same attributes defined for CITs are also defined for relationships. You can also assign key attributes for
relationships but it is not required. For details on defining new relationship types, see "Create Configuration
Iltem Type/Relationship/Calculated Relationship Wizard" on page 335.

Deprecated Cl Types

CITs and relationships that are scheduled to be removed in a subsequent product version are known as
deprecated CITs. Such CITs appear in the user interface in strikethrough font. You can hold the pointer over a
deprecated CIT to display a tooltip with information about it, including which CIT replaces it.

Note: The strikethrough font is only visible when a font size of 14 points or higher is selected for the
topology map.
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Deprecated CITs appear in the CIT tree in Modeling Studio; however, it is not recommended to use them in
building new TQL queries and views. In place of a deprecated CIT, use the CIT indicated in the tooltip as its

replacement. Deprecated CITs do not appear in out-of-the-box queries and views.

CIT attributes which are scheduled to be removed are deprecated attributes. They also appear in strikethrough
font in the user interface.

The following image displays a TQL query containing a deprecated CIT:

Mntainment

IpAdaress

—— Composition
e j

Mode Eile

System Type Manager

System Type Manager enables you to create a predefined list whose values define an attribute type. For more
information, see "System Type Manager Dialog Box" on page 353.

You can create the following attribute types:

« List. Enables you to create a predefined list of values, for example, Location.

« Enumeration. Enables you to create a predefined list of values, as well as assign each value a color.
Enumerations are designed to be used as severity value lists by states. For details, see "State Manager"

inthe RTSM Administration Guide.
Severity lists are used for:
« Retrieving Impact Analysis results in IT Universe Manager. For details, see "IT Universe Manager" on
page 158.

« Creating an Impact rule. For details, see "Impact Analysis Manager" on page 304.

You can use both List and Enumeration values for:

« Editing the attributes of a CIT. For details, see "How to Create a Cl Type" below.

« Defining an attribute condition for a TQL query node or relationship. For details, see "Query
Node/Relationship Properties Dialog Box" on page 61.

How to Create a Cl Type

This task describes the process you follow to create a CIT using the Create Cl Type wizard.

This task includes the following steps:
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« "Prerequisites" below

« "Define the Cl Type" below

« "Set the Cl Type Attributes" below

« "Assign Qualifiers to the CI Type" below
« "Assignanlcon to the Cl Type" below

o "Customize the CI Type Menu" below

o "Define the Cl Type Default Label" below

« "Define the Matching Rules" below

1. Prerequisites

From the CI Type Manager, select Cl Types from the list box in the CI Types pane. Then click New |_|
to start the Create Cl Type Wizard.

2. Define the Cl Type

Enter the name, description, and base configuration item type for the new CI type and select an
identification method for it. For details, see "Details Page" on page 336.

3. Setthe Cl Type Attributes
Edit the attributes of the new ClI type. For details, see "Attributes Page" on page 337.

Note: List and Enumeration definitions are created in the System Type Manager. If required, you can
create additional List and Enumeration definitions. For details, see "How to Create List and
Enumeration Definitions" on page 325.

4. Assign Qualifiers to the Cl Type

Assign qualifiers to the definition of the new CI type. For details, see "Qualifiers Page" on page 340.

5. Assign an Icon to the Cl Type

Select anicon to assign to the new ClI type. For details, see "Icon Page" on page 343.

6. Customize the Cl Type Menu

Select the menu items and commands to appear in the shortcut menu for the new ClI type. For details,
see "Attached Menu Page" on page 344.

7. Define the Cl Type Default Label
Define the attributes to appear in the Cl type label. For details, see "Default Label Page" on page 346.

8. Define the Matching Rules

If necessary, define the matching rules for the new CI type. For details, see "Matching Rules Page" on
page 347.

Note: This step is only relevant for customers running HPE Universal CMDB Configuration
Manager.
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How to Create a Relationship Type

This task describes the process you follow to create a relationship type using the Create Relationship wizard.
This task includes the following steps:

« "Prerequisites" below

« "Define the Relationship" below

« "Set the Relationship Attributes" below

« "Assign Qualifiers to the Relationship" below
« "Customize the Relationship Menu" below

« "Define the Relationship Default Label" below

—_

Prerequisites
From the Cl Type Manager, select Relationships from the list box in the CI Types pane. Then click New
|_| to start the Create Relationship Wizard.

2. Define the Relationship
Enter the name, description and base CI type for the new relationship. For details, see "Details Page" on
page 336.

3. Set the Relationship Attributes

Edit the attributes of the new relationship. For details, see "Attributes Page" on page 337.

Note: List and Enumeration definitions are created in the System Type Manager. If required, you can
create additional List and Enumeration definitions. For details, see "How to Create List and
Enumeration Definitions" on the next page.

4. Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see "Qualifiers Page" on page 340.

5. Customize the Relationship Menu

Select the menu items and commands to appear in the shortcut menu for the new relationship. For
details, see "Attached Menu Page" on page 344.

6. Define the Relationship Default Label

Define the attributes to appear in the relationship label. For details, see "Default Label Page" on page
346.

How to Create a Calculated Relationship Type

This task describes the process you follow to create a calculated relationship type using the Create
Calculated Relationship wizard.

This task includes the following steps:
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« "Prerequisites" below
« "Define the Calculated Relationship" below
« "Assign Qualifiers to the Relationship" below

« "Add Required Triplets" below

1. Prerequisites
From the Cl Type Manager, select Calculated Relationships from the list box in the Cl Types pane.

Then click New |_| to start the Create Calculated Relationship Wizard.

2. Define the Calculated Relationship

Enter the name, description and base ClI type for the new calculated relationship. For details, see
"Details Page" on page 336.

3. Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see "Qualifiers Page" on page 340.

4. Add Required Triplets
Add the required triplets. For details, see "Triplets Page" on page 342.

How to Create List and Enumeration Definitions

This section describes the tasks for creating List and Enumeration definitions.
This task includes the following steps:

« "Create a List Definition" below

« "Create an Enumeration Definition" below

1. Create a List Definition

You can create a List definition of predefined values. For example, a List definition called Location
might contain:

« New York
o Boston
« Baltimore

For details, see "Create/Update List/Enumeration Definition Dialog Box" on page 348.

2. Create an Enumeration Definition

You can create an Enumeration definition, which enables you to assign a color for each value on the list.
For details, see "Create/Update List/Enumeration Definition Dialog Box" on page 348. For an example of
an Enumeration definition, see "How to Create an Enumeration Definition — Workflow" on the next page.
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How to Create an Enumeration Definition - Workflow

The following steps describe how to create an Enumeration definition.
Note: To retrieve the required results, you must follow each step in this task.

To create an Enumeration definition:

1. Select Admin > RTSM Administration > Modeling > Cl Type Manager.

2. From the Main Menu, select Cl Types > System Type Manager to open the System Type Manager
dialog box.

3. Click the Add |/ button to open the Create List Definition dialog box.

Note: Alternatively, you can select Admin > RTSM Administration > Administration > State
Manager and then click the New Enumeration button to open the Create Enumeration Definition
dialog box.

4. Select Enumeration.

5. Inthe Name box, enter the required name.

6. (Optional) In the Display Name box, enter the required display name.
This example describes how to create the following severity list:

Key Value Severity Represented
0 Green Normal

1 Orange Major

2 Red Critical

Click the Add & button to create a new row.

8. Inthe Value box, enter Normal, in the Key box, enter @, and in the Color section, select Green.

9. Click the Add + button to create another row.

10. Inthe Value box, enter Major, in the Key box, enter 1, and in the Color section, select Orange.

11. Click the Add || button to create another row.
12. Inthe Value box, enter Critical, in the Key box, enter 2, and in the Color section, select Red.
The following image shows the Enumeration Definition section after the changes:
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Create Enumeration Definition
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Display Name: | |
Type: () List ® Enumeration
Enumeration Definition
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13. Click OK to save your changes.

View Descriptions for Cl Types and Relationships

You can view a complete list of available Cl types in tree format in the left pane of Cl Type Manager. You can
search incrementally for a specific Cl type as described in "Cl| Type Manager Page" on page 332. To see a
description for a particular Cl type, select it from the tree and hold the pointer over the icon which corresponds
toit in the Topology Map. A tooltip containing a description of the Cl type is displayed.

For relationships, select Relationships in the left pane and search incrementally by the first letter of the
relationship. Select the relationship you want and hold the pointer over its icon in the Topology Map to display
a tooltip containing a description of the relationship.

For detailed information on CI types and relationships, you can generate the UCMDB CI Types and
Relationships Information PDF. For details, see "Export Selected CITs to PDF Dialog Box" on page 352.
Alternatively, you can access the UCMDB Class Model Reference by clicking the View UCMDB Class

2
Model ' “<=* button on the Cl Types pane toolbar.
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Cl Type Manager User Interface

This section includes (in alphabetical order):

* Add/Edit Attribute Dialog BOX . ... oo 328
* Add/Remove Relationship Dialog BoX ... il 331
¢ ClTypeManager Page ....... ... i 332
* Create Configuration Item Type/Relationship/Calculated Relationship Wizard ... ... .......... 335
® Create/Update List/Enumeration Definition Dialog Box ... .. . .. .. 348
¢ Export Selected CITs to Excel Dialog BOX ... ... i i 351
® Export Selected CITs to PDF Dialog BOX .. .. ..o 352
® System Type Manager Dialog BoX ... il 353

Add/Edit Attribute Dialog Box

This dialog box enables you to define a new attribute to add to a CIT or to edit an existing attribute of a CIT.

To access In the Cl Type Manager, select the Attributes tab, then click the Add button, or select an
attribute and click the Edit button or double-click the attribute.

Important In Edit mode, fields that cannot be changed are disabled. For CI types with instances, some
information fields cannot be edited. For details, see "Attributes Page" on page 337.

Relevant « "How to Create a Cl Type" on page 322
tasks « "How to Create a Relationship Type" on page 324

See also o "Cl Types Overview" on page 319
o "CI Type Attributes" on page 320

Details Tab
User interface elements are described below:
Ul Element
(A-Z) Description
Attribute Enter a unique name for the new attribute. Only the following characters are permitted: a-z,
Name A-Z, 0-9 and underscore (_). Note also:

« Thefirst character may be a number.
» The attribute name field is not case sensitive.
« The maximum length is 200 characters.
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Ul Element
(A-Z) Description
Attribute Select one of the following options:
Type « Primitive. Choose from one of the following field types: boolean, bytes, date number,
double number, float number, integer, list of integers, list of strings,
long number, string, xml.
« Enumeration/List. Contains alist of Enumerations and Lists defined in the System
Type Manager. For details, see "System Type Manager" on page 322.
This option enables you to define an attribute with a predefined value. For example, a
location attribute might be defined by a location list containing the following values:
Singapore, Paris, New York.
Default Enter or select a default value for the attribute. The options for the Default Value field vary
Value depending on the attribute type you selected.
Note:
« The Default Value field is available only when the Default Value Policy check box
is selected.
« If you select the Primitive attribute types 1ist of integersorlist of strings,
you can enter multiple values.
Default Select the check box to specify whether the attribute will have a default value.
Value
Policy

Description Enter a description for the new attribute. The description can be up to 2,048 characters long.

Note: This field is optional.

Display Enter a name for the new attribute to identify it in HPE Application Performance
Name Management.

Note: This field is optional.

Scope Select the scope of the new attribute (the class model to which it belongs).
Value Size Enter a value for the maximum physical size of the new attribute. (Enabled for bytes and

stringonly).

Advanced Tab

User interface elements are described below:

Ul Element
(A-Z) Description

Asset Data  Select to display the attribute value in the Asset Report.
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Ul Element
(A-Z)

Comparable

Discovery
Auto Trim

Discovery
Auto
Truncate

Editable

Index

Lower Case

Managed

Not Tracked
for History

Password

Required

Static
Unique
Upper Case

Use Update
Value
Policy

Visible

Description
Select to enable this attribute to be used for comparing compound Cls.

When selected, results sent from the Probe are trimmed. That is, leading and trailing
spaces and tabs are trimmed, so that there are no white spaces at the beginning or at the
end of the resullt.

If selected, when attributes of type STRING exceed the size limit, Discovery truncates the
value. For details, see Server-Side Data Normalization in the RTSM Data Flow
Management Guide.

Select to enable future editing of the attribute. Only attributes that are marked as Editable
(or ones that have values) are displayed in the Properties tab in IT Universe Manager.

Select to accelerate the attribute retrieval performance. This option is recommended for
attributes that are used frequently in search conditions. For example, IP address is usually
an index attribute of a node.

When this option is selected, the attribute value appears in lower case.
This designation is only relevant for users of HPE Universal CMDB Configuration Manager.

Note:

« When this qualifier is selected for a given attribute, the attribute appears as a visible
column in the CI Instances dialog box. For details, see "Cl Instances Dialog Box"
on page 55.

« Managed is not relevant for attributes of the type list of integers or list of strings.

Select to exclude this attribute from History storage.

When this option is selected, the attribute value appears as asterisks (a hidden value).

Select to define this attribute as a required one, if its value is required for the creation of the
CIT.

Select to define this attribute as static.
When this option is selected, different instances of this Cl type must have unique values.
When this option is selected, the attribute value appears in upper case.

For details on this qualifier, see "The Use Update Value Policy Qualifier" on page 19.

Select to display this attribute in the Properties tab in IT Universe Manager.

UCMDB Browser Qualifiers

User interface elements are described below:
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Ul Element (A-
Z) Description

CMS Browser  Select to enable this attribute to be editable in the UCMDB Browser.
Editable

CMS Browser Select to enable this attribute to be searchable in the UCMDB Browser.
Searchable

CMS Browser | Select to enable this attribute to be viewed in the UCMDB Browser.
Visible The Visible in preview mode field determines whether the attribute is displayed in
preview mode of the UCMDB Browser.

The Properties group assignment field determines the group in the properties widget
where the attribute is displayed.

Hide in When CMS Browser Visible is selected, select Hide in Modeling to prevent the
Modeling attribute from appearing in the Assisted Modeling feature in the UCMDB Browser.

Hide in Export = Select to enable this attribute to be excluded from exported search results in the
Search Results UCMDB Browser.

Add/Remove Relationship Dialog Box

This dialog box enables you to add or remove default or new relationships between CITs, which define their
physical or logical connections.

To access | Inthe Cl Type Manager, right-click a CIT ortwo CITs and select Add/Remove
Relationship.

Important = When adding a relationship between two CITs, select the two CITs to be linked by holding
information the CTRL key and clicking the CIT names. Then right-click one of them and select
Add/Remove Relationship.

See also o "Cl Types Overview" on page 319
« "Cl Type Relationships" on page 321

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2) Description

<query node1 to query Select the relationships to add in the direction of the first query node to the
node2> second.

<query node2 to query Select the relationships to add in the direction of the second query node to
node1> the first.

Relationship Name A list of the possible relationships.
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Cl Type Manager Page

This page enables you to view the information in the Cl Type model, which contains the definitions of all
configuration item types (CITs) defined in the system and the relationships that define the connections
between them. Each CIT has its own attributes, as well as the attributes inherited from its parent CIT.

To access | Select Admin > RTSM Administration > Modeling > Cl Type Manager.

Important Cl Type Manager consists of the following panes:

information « CI Types. Displays a hierarchical list of Cl Types and relationships. The number

appearing next to the CIT indicates the number of instances of that CIT which exist in the
CMDB.

« Topology Map. Displays a topology map of the CITs and relationships in the system.

Relevant « "How to Create a Cl Type" on page 322

tasks « "How to Create a Relationship Type" on page 324
« "How to Create a Calculated Relationship Type" on page 324
See also o "CIl Types Overview" on page 319

o "Cl Type Attributes" on page 320

o "CIl Type Relationships" on page 321

« "Deprecated Cl Types" on page 321

« "View Descriptions for Cl Types and Relationships" on page 327
« "CI Type Manager User Interface" on page 328

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

| . | New. Opens the Create Configuration Item Type Wizard which enables you to define
anew Cl type. For details, see "Create Configuration ltem
Type/Relationship/Calculated Relationship Wizard" on page 335.

Delete. Deletes the selected Cl type or relationship. This option is only available for
Cl types that have no children and no instances.

Note:

« When you delete a Cl type or relationship, all resources dependent on that ClI
type or relationship are also deleted. When you click Delete, the Confirm
Delete dialog box displays links for each type of dependent resource. Click
the links to display the dependent resources. The dependent resources can
include queries, views, reports, Enrichments, or Impact rules.

« Deleting a Cl type that is part of the out-of-the-box Class Model may disable
UCMDB’s licensing mechanism. Disabling of the license mechanism will
result in restricted access to UCMDB. Access to UCMDB will only be
granted after the impacting Class Model changes are reverted. To
troubleshoot these issues, refer to the UCMDB licensing log.
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Ul Element (A-Z) Description

|%| Refresh. Refreshes the data content of the hierarchical tree structure that may have
o been modified by other users.
|| Save. Saves the changes made to a Cl type.
|@| Import From XML. Enables you to import CITs from an extemal file.
@ Export To XML. Enables you to export a CIT as an XML file. Use this option to
o move CITs from one server to another.
|§| Export Class Model. Enables you to export a CIT. Choose the export format. The
o available options are:
« PDF. The table data is exported in PDF format.
« XLS. The table data is formatted as an .xIs (Excel) file that can be displayed in a
spreadsheet.
= View UCMDB Class Model. Opens the Class Model Reference, which contains
Lei information on all packages, Cl types, and relationships in the class model.
<ClI Select one of the following options:
;;g:/Relatlonshlp « CI Types. Display the Cl types in the CIT model.

« Relationships. Display the relationships in the CIT model.

« Calculated Relationships. Display the calculated relationships in the CIT
model.
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Ul Element (A-Z) Description

<Editing Pane> The following tabs are available:

Dependencies. Displays the Cl Type model in a topology map, including the
CITs and the relationships between them. The name of the selected Cl type or
relationship appears in the border at the top of the pane. When you point to a CIT,
atooltip displays the display name of the CIT and its description.

Details. Enables you to edit the basic information about the Cl type selected in
the left pane. For details, see "Details Page" on page 336.

Attributes. Enables you to edit the attributes of the selected CIT. For details, see
"Attributes Page" on page 337.

Qualifiers. Enables you to assign qualifiers to the selected CIT. For details, see
"Qualifiers Page" on page 340.

Triplets. Enables you to create a calculated relationship. For details, see
"Triplets Page" on page 342. This tab appears only for calculated relationships.

Icon. Enables you to assign an icon to the selected CIT. For details, see "Icon
Page" on page 343. This tab does not appear for relationships.

Attached Menu. Enables you to customize the shortcut menu of a Cl by adding
menu items and commands (for example, ping, run a program, open a URL). The
customized menu is displayed when you right-click a Cl instance in IT Universe
Manager. For details, see "Attached Menu Page" on page 344.

Default Label. Enables you to define attributes that appear in the CIT label. You
can include more than one attribute by using the function buttons. For details, see
"Default Label Page" on page 346.

Matching Rules. Enables you to define matching rules for use in HPE Universal
CMDB Configuration Manager. For details, consult the Configuration Manager
documentation. This tab does not appear for relationships and only appears when
UCMDB is running with Configuration Manager.

<Main Menu> For details, see "Main Menu" on page 136.
<Toolbar> For details, see "Toolbar Options" on page 139.
Cl Types Pane A hierarchical tree structure of the Cl Type model containing the inheritance

relationships among CITs, and displaying the number of instances of each CIT in the
RTSM. All CITs included in the Cl Type model are classified as eithera CIT ora
relationship. You can drill down and view the relationships and neighbors of the
selected CIT in the topology map. You can search in the list of CITs or relationships
using the Incremental Search by entering the first letter of the CIT or relationship
repeatedly until you reach the required selection. You can also search fora CIT or
relationship by entering its full name.

Shortcut Menu

Cl Type Manager includes the following options available by right-clicking a Cl type in the Cl Types pane or

the Dependencies map:
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Ul Element
(A-Z) Description

Add/Remove Opens the Add/Remove Relationship dialog box, which enables you to add or remove
Relationship ' relationships from CITs. For details, see "Add/Remove Relationship Dialog Box" on page

331.
Delete Deletes the selected Cl type. This option is only available for Cl types that have no
Selected children and no instances.
Item
Note: When you delete a Cl type or relationship, all resources dependent on that ClI
type or relationship are also deleted. When you select Delete Selected Item, the
Confirm Delete dialog box displays links for each type of dependent resource. Click
the links to display the dependent resources. The dependent resources can include
queries, views, reports, Enrichments, or Impact rules.
Export To Enables you to export a CIT as an XML file. Use this option to move CITs from one server
XML to another.
New Opens the Create Configuration Item Type Wizard which enables you to define a new Cl
type. For details, see "Create Configuration Item Type/Relationship/Calculated
Relationship Wizard" below.
Show CIT Opens the Show All Instances dialog box, which displays all instances of the selected
Instances CIT. For details, see "Cl Instances Dialog Box" on page 55.

Create Configuration ltem Type/Relationship/Calculated
Relationship Wizard

This wizard enables you to define a new configuration item type or relationship.

To Click a Cl type or relationship in the topology map or Cl Types pane of the Cl Type Manager

access and select New or click the New |_| button in the ClI types pane.

Relevant .« "How to Create a Cl Type" on page 322
tasks « "How to Create a Relationship Type" on page 324
« "How to Create a Calculated Relationship Type" on page 324

Wizard | The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map Details Page > Attributes Page > Qualifiers Page > Triplets Page > Icon Page > Attached Menu

Page > Default Label Page > Matching Rules Page

See also | « "Cl Types Overview" on page 319
« "CI Type Attributes" on page 320
« "CI Type Relationships" on page 321

The Create Configuration Item Type wizard includes the following pages:
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« "Details Page" below

« "Attributes Page" on the next page
« "Qualifiers Page" on page 340

« "Triplets Page" on page 342

« "lcon Page" on page 343

« "Attached Menu Page" on page 344
« "Default Label Page" on page 346

« "Matching Rules Page" on page 347

Details Page

This wizard page enables you to enter basic information about the new CI type you are defining.

Important For general information about the Create Configuration Item Type Wizard, see "Create
information | Configuration Item Type/Relationship/Calculated Relationship Wizard" on the previous

page.

Wizard The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map Details Page > Attributes Page > Qualifiers Page > Triplets Page > Icon Page > Attached

Menu Page > Default Label Page > Matching Rules Page

User interface elements are described below:

Ul Element

(A-Z) Description

Base CI Select a base CIT for the CIT you are creating. The new CIT inherits the base CIT's
Type attributes.

Note: This field only appears in the Create Cl Type Wizard. It is not relevant when
editing an existing CIT in the Details tab of Cl Type Manager.

Created By | The userwho created the new CIT.

Note: This field is optional.

Description = A description for the new CIT. The description can be up to 2,048 characters long.

Note: This field is optional.

Display The name of the CIT as it appears in the HPE Application Performance Management
Name interface.

Note: This field is optional.
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Ul Element
(A-2) Description

Identification Every new CI defined has an identification based on its CMDB ID and global_id properties.
You can set an additional identification method for instances of the selected CIT. The
following options are available:

« By key attributes. Select attributes from the Available Attributes pane and move them
to the Selected Attributes pane. These attributes are defined as the CIT's key
attributes. CIT instances with matching values for all of the key attributes are merged
into a single instance.

« By identification rule. Click the Edit button to define an XML identification rule. For
an example of an XML identification rule, see How to Create an Identification Rule
Document in the RTSM Data Flow Management Guide.

« Inherited from parent. The CIT uses the same identification method as its parent
CIT.

« No identification. No additional identification method.

Note: For relationships, only the By key attributes option is available.

Name The unique name of the new CIT. Only the following characters are permitted: a-z, A-Z, 0-9
and underscore (_). Note also:
« Thefirst character must be a-z or A-Z.

« The name field is case sensitive, but you cannot use the same name with different
cases for different CITs.

« The maximum length is 200 characters.

Scope Select the scope of the new CIT (the class model to which it belongs).

Attributes Page

This wizard page enables you to edit the attributes of the Cl type.

Important For each attribute, there are columns which display its name, display name, type,
information = description and default value. There are also columns for each attribute qualifier. A check
mark indicates that the qualifier is selected.

Click the Edit button to edit attribute details and qualifiers. For Cl types with instances,
some qualifiers cannot be modified, as displayed in the Qualifier can be modified when
there are CIT instances column. If a qualifier is modified for a selected attribute for a Cl
type with instances, the attribute of each Cl instance is changed accordingly (for example, if
the Visible attribute is selected, the Cl instances become visible in IT Universe Manager).

Wizard The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map Details Page > Attributes Page >Qualifiers Page > Triplets Page > Icon Page> Attached

Menu Page > Default Label Page > Matching Rules Page

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-Z)

=

2]

<Attributes>

Asset Data

CMS
Browser
Editable

CMS
Browser
Searchable

CMS
Browser
Visible

Description

Add. Enables you to define a new attribute. For details, see
"Add/Edit Attribute Dialog Box" on page 328.

Edit. Opens the Edit Attribute dialog box. For details, see
"Add/Edit Attribute Dialog Box" on page 328.

Note: If you modify an attribute belonging to a CIT's parent,
the text tumns light blue. If you modify an attribute belonging to
the CIT itself, the text remains dark blue.

Delete. Deletes the selected attribute. This option is only active
for newly defined attributes.

Reset. Resets the attribute settings after editing a pre-existing
attribute.

Select Columns. Enables you to select the columns to appear
using the Select Columns dialog box. For details, see "Select
Columns Dialog Box" on page 389.

Displays all attributes associated with the new CIT. Attributes
appearing in black are ones that the new CIT inherits from the
base CIT. Attributes appearing in dark blue are ones that are
private to this CIT and its descendants. Attributes appearing in
light blue are inherited ones that have been modified for the new
CIT.

Indicates whether the attribute value is displayed in the Asset
Report. For details see Asset Report.

Note: When this qualifier is selected for a given attribute, the
attribute appears as a visible column in the Cl Instances
dialog box. For details, see "Cl Instances Dialog Box" on
page 55.

Indicates whether this attribute is editable in the
UCMDB Browser.

Indicates whether this attribute is searchable in the UCMDB
Browser.

Indicates whether this attribute is visible in the UCMDB Browser.
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Ul Element
(A-Z)

Comparable

Default
Value

Description

Discovery
Auto Trim

Discovery
Auto
Truncate

Display
Name

Editable

Index

Key

Lower Case

Description

Indicates whether this attribute is to be used for comparing
compound Cls. For details, see Compare Cls Report. The
changes in the value of such an attribute are saved in the History.

Note: When this qualifier is selected for a given attribute, the
attribute appears as a visible column in the Cl Instances
dialog box. For details, see "Cl Instances Dialog Box" on
page 55.

The default value for the attribute. This value appears when the
new CIT is defined and there is no runtime value for the attribute.

A description of the attribute.

Indicates whether the results sent from the Probe are trimmed.

Indicates whether the auto-truncate feature for attributes of type
STRING is enabled.

The attribute name that appears in the HPE Application
Performance Management interface.

Indicates whether the attribute can be edited.

Only attributes that are marked as Editable (or ones that have
values) are displayed in the Properties tab in IT Universe
Manager.

Indicates whether the attribute has been defined as an index
attribute, which enables you to accelerate the attribute retrieval
performance.

This option is recommended for attributes that are used frequently

in search conditions. For example, IP address is usually an
index attribute of a node.

Indicates whether the attribute is defined as a key attribute.

Note: This columnis only relevant when By key attributes
is selected as the identification method.

Indicates whether to keep the attribute value in lower case.
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Qualifier can be

Ul Element modified when there
(A-2) Description are CIT instances
Managed This designation is only relevant for users of HPE Universal Yes
CMDB Configuration Manager.
Note: When this qualifier is selected for a given attribute, the
attribute appears as a visible column in the Cl Instances
dialog box. For details, see "Cl Instances Dialog Box" on
page 55.
Name The actual name of the attribute (compare to Display Name). The = N/A
name must be in English.
Not Tracked = When this qualifier is selected for a given attribute, the attribute is | Yes
for History not monitored by History.
Required Indicates whether this attribute is defined as a required one, Only if the attribute in
whose value is required for the creation of the CIT. the instances is not
empty
Static Indicates whether this attribute is defined as static. No
Type The type of the attribute. N/A
UDM Scope | Indicates whether the attribute is included in the UDM class No
model.
Unique Indicates whether this attribute is defined as unique, for which No
different instances of this Cl type must have unique values.
Upper Case Indicates whether to keep the attribute value in upper case. Yes
Visible Indicates whether this attribute is displayed in the Properties tab  Yes

in IT Universe Manager.

Qualifiers Page

This wizard page enables you to assign qualifiers to a Cl type definition.

Important | Qualifiers enable you to define added attribute definitions to the CIT. In the Qualifiers list,

information = select the required qualifiers using the Add buttons to move your selections to the
Configuration Item Type Qualifiers list. You can make multiple selections by holding the
CTRL key.

Wizard The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map

Details Page > Attributes Page > Qualifiers Page > Triplets Page > Icon Page> Attached
Menu Page > Default Label Page > Matching Rules Page

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-
Z) Description
= Moves all qualifiers to the Configuration Item Type Qualifiers list.
) Adds the selected qualifier to the Configuration Item Type Qualifiers list. Select
multiple qualifiers by holding the CTRL key.
& Removes the selected qualifier from the Configuration Item Type Qualifiers list.

fift

<Configuration

Item Type
Qualifiers>

<Qualifiers>

Removes all qualifiers from the Configuration Item Type Qualifiers list.

To define a new, custom qualifier, enter the qualifier name in the text box and click
Insert. The qualifier appears in the Configuration Iltem Type Qualifiers list.

The list of qualifiers that define attributes of the new CIT. For example, you can use a
qualifier to define a CIT as abstract, which means that you cannot create instances
fromit.

The list of available qualifier options.

ABSTRACT_ You cannot create instances of this CIT.

CLASS

BLE_LINK_ A relationship that has been assigned this qualifier is loaded by an online BLE engine

CLASS TQL and becomes part of the Dashboard status calculations.

CONTAINER This qualifier is assigned to relationships that signify a containment relationship, such
as Membership, Composition, Containment.

HANDLER The name of the handler for the attribute.

HIDDEN_ Instances of this CIT do not appear anywhere in the application.

CLASS

ITU_HIDDEN_  Instances of this CIT do not appear in the topology map application.

CLASS

MAJOR_APP Cl types that are assigned this qualifier appear in the Application Breakdown custom
report. For details, see Application Breakdown Report.

MODELING_ Enables a CIT to act as a model in the Modeling Studio. For details, see "Business Cl

ENABLED Models" on page 223.

Note: This qualifier can only be selected for Cl types that are descendants of the
Cl type Configuration Item.

NETWORK_ A qualifier common to all the Cl types that represent a network device. It can be used

DEVICES for TQL queries related to network devices and serves as a replacement for Cl types in
aquery.

READ_ONLY_ | This CIT cannot be edited.

CLASS
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Ul Element (A-
Z) Description

RECURSIVE_ Relevant for relationships. When the Cl at one end of a relationship is deleted, the
DELETE system checks the CI at the other end of the relationship. If it is not related to any other
Cls, itis also deleted.

Note: This qualifier appears only in the qualifier list in Modeling Studio.

SERVICE_ Relevant for the UCMDB Browser. Only Cl Types that have this qualifier are available
MODEL inthe UCMDB Browser as a service, and may be used to create Service Models in the
UCMDB Browser.

STRONG_ Relevant for relationships. Indicates that the root_container attribute of end2 is
CONTAINMENT  assigned the ID of end1.

Triplets Page

This wizard page enables you to create a calculated relationship. Each row on the Triplets page represents
one of the allowed steps in the path leading from the source ClI to the target Cl in the topology map.

Note: This step of the wizard is only relevant for calculated relationships.

Important « This page is displayed if you select Calculated Relationships in the drop-down box in
information the Cl Types pane.

« Fordetails about calculated relationships, see "Impact Modeling" on page 82.
« For general information about the Create Configuration Iltem Type Wizard, see "Create
Configuration Item Type/Relationship/Calculated Relationship Wizard" on page 335.

Wizard The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map Details Page > Attributes Page > Qualifiers Page > Triplets Page > Icon Page> Attached

Menu Page > Default Label Page > Matching Rules Page
See also "Impact Modeling" on page 82

User interface elements are described below:

Ul Element

(A-Z) Description

= Add. Enables you to define the allowed steps in a path in the topology graph leading from
the source Cl to the target Cl in the calculated relationship. Opens the Add Triplet dialog
box. For details, see "Add Triplet Dialog Box" on page 53.

|§| Edit. Enables you to edit the triplet. Opens the Edit Triplet dialog box. For details, see "Add

o Triplet Dialog Box" on page 53.

5¢ Delete. Deletes a selected triplet.

Relationship The required relationship connecting the two query nodes.
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Ul Element

(A-2) Description

Relationship The source and target of a relationship.

Direction
e = Thedirection is from source to target.
« = Thedirection is from target to source.

Source The required source query node.

Target The required target query node.

Icon Page

This wizard page enables you to select anicon to assign to the new CI Type.

Note: This step of the wizard is not relevant for relationships.

Important Each CIT is displayed with a default icon. However, you can attach different icons to the
information same CIT when certain conditions apply. For example, you can associate different icons
with the same CIT when one of its attribute values changes.

Wizard The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map Details Page > Attributes Page > Qualifiers Page> Triplets Page > lcon Page >Attached

Menu Page >Default Label Page > Matching Rules Page
User interface elements are described below:

Ul Element (A-Z) Description

4n Add Icon Function. Adds a row.

Note: Only active if Change the Configuration Item Type icon
according to its attribute value is selected.

E Remove Icon Function. Removes the selected row.
Note: Only active if Change the Configuration Item Type icon
according to its attribute value is selected.

Attributes Select an attribute to determine the icon assigned to the CIT.

Change the Configuration = Enables you to assign an icon for each attribute value. For example, you
Item Type icon according = could define two values for the City attribute: if City=London, one icon is
to its attribute value displayed. If City=Beijing, anothericon is displayed.

Note: If you change the icon of a CIT that appears in an existing view,
the CIT's icon is not updated in the view.
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Ul Element (A-Z) Description

Configuration Item Type Select the group to which the CIT belongs.

Main Icon

Icon Select anicon to associate with the value you entered in the Value column.
Value Enter a value corresponding to the attribute you selected. You can add a

new line for each value you enter.

Attached Menu Page

This wizard page enables you to customize the shortcut menu of a Cl by adding menu items and commands
(for example, ping, run a program, open a URL). The customized menu is displayed when you right-click a Cl
instance in IT Universe Manager.

Important If a CIT does not have a method defined specifically forit, the CIT inherits all the menus
information ' from its parent CIT or the nearest ancestor that does have a method defined for it.

If you create or modify a menu, the change occurs only in the specific CIT that is being
edited.

Wizard The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map Details Page > Attributes Page > Qualifiers Page > Triplets Page > Icon Page > Attached

Menu Page > Default Label Page > Matching Rules Page

User interface elements are described below:

Ul Element

(A-2) Description

= Select a menu item from the tree and click the button. A new entry appears under the
selected item.

ﬁ Click to remove a menu item.

|K Click to move a selected menu item up in the menu.

[l Click to move a selected menu item down in the menu.

<Tree> Hierarchical tree containing the default menu items.

Caution: It is not recommended to edit the definitions of the default menu items.
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Ul Element
(A-2) Description

Command To connect to a specific location on the World Wide Web, select URL, and enter the exact
Internet address, for example, http://www.hpe.com/go/software. (Available only if you
select the URL command type option.)

Note: If you use a variable in the Command field, use the format command name %1
and define the CIT attributes as described in "Parameters" below. The parameter
values replace %1 according to their order in the list. For example, %1 is replaced by the
first parameter in the list, %2 is replaced by the second parameter in the list, and so on.

Description  Enter a description for the method. (This is for internal use only and does not appear in the

menu.)
Existing Select to choose a command from a list of defined methods inherited from the IT Universe
Method CIT and all its ancestors.
Icon Select the icon to appear next to the menu option in the shortcut menu.

Note: This field is optional.

Menu Item Enter a name for the new menu item as it should appear in the menu.

Name

Method Enables you to add a command to the menu.
Note: To create a method and not override the existing method, it is recommended to
create a new menu item and place the new method there.

Method Enter a name for the command.

Name

New Method Select to add an action (for example, ping) to the menu item.

Parameters  To add attributes to the command or URL, click the Add Parameter button and select the
attribute from the list.

To delete an existing entry, select it and click the Remove Parameter button.

Note: Parameters are not relevant when Inner Process is selected.

Require Select the check box for users to confirm access to a menu item before the item is
user displayed.
confirmation

Separator To place a separator between two menu items:

Click OK to place a separator underneath the selected menu option.

Shortcut Press any key combination to create a shortcut for the menu item, for example, CTRL+h.

Note: This field is optional.
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Ul Element
(A-2) Description

Sub-Menu Select to create a sub-menu under the selected menu option.

EJ I History
| Note L\\\*ﬂ ] AddMote
% Delete Sub—*‘menu
B, MNew RelatedCI < MarL
Actions ]
Type Choose a command type:

« URL. Opens a web page to the specified URL. Enter the URL of a Web page for the
command to open in the URL box.

« Inner Process. Triggers an internal HPE Application Performance Management action.
Select an action from the drop-down list of actions.

« Execute. Triggers an executable action. Enter an executable command in the
Executable box.

Note: In the Executable box, enter only the name of the executable file (for
example, notepad. exe). Do not enter a path to the executable file. A path cannot
execute a program.

Note: After making changes to a Cl type in an older version of UCMDB (for example, UCMDB version
9.05), when upgrading UCMDB to the latest version, some new functionality may be missing from the
shortcut menu for Cls of that type orits descendants in IT Universe Manager. In that case, edit the
attached menu for that Cl type and add the missing functionality.

Default Label Page

This wizard page enables you to define attributes that appear in the Cl type label. You can include more than
one attribute by using the function buttons.

Important | You build a label by selecting attributes in the Cl Type Attributes pane and adding them to
information the Format pane, using the operators in the Format pane to connect them.

The label appears as the title under a Cl of the new CI Type. The label definition can be
customized to include different attribute values. For example, if the function label of the node
CIT is composed of hostname and network, the displayed label is: serverl 10.0.65.0.

Labels can also be created using regular expressions.

Wizard The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map Details Page > Attributes Page > Qualifiers Page > Triplets Page > Icon Page > Attached

Menu Page > Default Label Page > "Matching Rules Page" on the next page

User interface elements are described below:
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Ul
Element
(A-2) Description

= Add selected attribute. Adds the selected attribute to the Format pane.

Parentheses. Adds parentheses to the formatted text (use in conjunction with the other
functions).

-~
it

& And. Places an AND operator between two attributes in the formatted text. For example,
network_netaddr&network_domain displays the network address and the domain of a query
node.

0 Or. Places an OR operator between two attributes in the formatted text.

F Regular Expression. Adds a regular expression (using regular expression syntax) to the label

: definition. The structure of the entry is (v1, v2, v3), where v1 represents the selected attribute,
v2 represents the regular expression itself (which divides the value into groups), and v3
represents the number of the selected group.

For example, if the selected attribute is a name, consisting of a first name, a space, and a
surname, the regular expression would be (name, (\S*)(\s*)(\S*), 3), which indicates
that the surname can be used for the name attribute in the default label.

For examples of how to use regular expression syntax, see "Regular Expression Examples”
on page 392.

Undo. Reverses the last change you made.
| Redo. Repeats the last action you took.

Clear. Clears the Format pane.
Q Restore Default. Restores the default settings.

Cl Type Displays the available options of attributes to be included in the CIT label.
Attributes

Cl Type Displays the attributes that you select to appear in the CIT label.
Label
Definition
Format

For example, to label a node by its host name and operating system, choose the host_
hostname and host_os attributes. The CIT label is host1l UNIX.

You can define conditions using AND and OR combinations.

Note: To delete an attribute from the Format pane, highlight it and press the Delete key.

Matching Rules Page

This wizard page enables you to define matching rules for comparable attributes for use in HPE Universal
CMDB Configuration Manager.
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Important This page is only relevant when Configuration Manager is installed. For details on matching
information | rules, refer to the Configuration Manager documentation.

Note: You can activate the Matching Rules page manually by setting the Enable
Configuration Manager Matching Rules setting to true in the Infrastructure Settings
Manager.

Wizard The Create Configuration Item Type/Relationship/Calculated Relationship Wizard contains:

map Details Page > Attributes Page > Qualifiers Page > Triplets Page > Icon Page > Attached

Menu Page > Default Label Page > Matching Rules Page
User interface elements are described below:

Ul Element
(A-2) Description

™ Moves the selected comparable attributes to the Matching Rule Priorities pane or the
Required Matching Attributes pane. Select multiple attributes by holding the CTRL key.

'S Removes the selected attribute from the Matching Rule Priorities pane or the Required
Matching Attributes pane.

A

Moves all attributes to the Matching Rule Priorities pane or the Required Matching
Attributes pane.

it

Removes all attributes from the Matching Rule Priorities pane or the Required Matching
Attributes pane.

rym Sets the order of the matching rules using the up and down buttons.

Comparable A list of all the attributes of the selected CI type with the comparable qualifier selected.

Attributes

Matching Rule The attributes selected are used by Configuration Manager, according to the priority
Priorities defined, to determine if the matching rule is satisfied.

Required The values of the selected attributes of component Cls must match to satisfy the
Matching Configuration Manager matching rule, when comparing between composite Cls.
Attributes

Wildcards cannot be used when specifying a required matching attribute. If an exact
match is not found, component Cls are not compared.

Create/Update List/Enumeration Definition Dialog Box

This dialog box enables you to define a new List or Enumeration definition. The List or Enumeration definition
you have created appears in the System Type Manager dialog box, where you can edit it if required (for
details, see "System Type Manager Dialog Box" on page 353).

To access Click the Add button in the System Type Manager dialog box.
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Important = You can access the Create/Update Enumeration Definition dialog box from the State
information = Manager as well. For details, see State Manager in the RTSM Administration Guide.

Relevant « "How to Create List and Enumeration Definitions" on page 325
tasks « "How to Create an Enumeration Definition — Workflow" on page 326
See also « "System Type Manager" on page 322

« "System Type Manager Dialog Box" on page 353

User interface elements are described below:

Ul Element

(A-2) Description

Display Enter the name you want to appear in the list of System Type Definitions. If you leave this
Name field empty, the entry in the Name field is used.

Enumeration Enables you to create a predefined list of values, as well as assign each value a color. For
details, see "Enumeration Definition Area" on the next page.

List Enables you to create a predefined list of values. For details, see "List Definition Area"
below.
Name Enter a unique name for the definition.

List Definition Area

This area enables you to create a predefined list of values.

To access Select List in the Create List/Enumeration Definition dialog box.
Important For example, a Location attribute might be defined by a location list containing the
information following values:

« New York

« Boston

« Baltimore

The following elements are included (unlabeled elements are shown in angle brackets):

ul

Element

(A-Z) Description

G Add. Adds a List definition. Double-click inside the row and either select a date from the
calendar that appears (if you chose the type Date) or type the required value.

E Remove. Deletes the selected List definition.

=M Sort. Sorts the list in alphabetical order.
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ul
Element
(A-2) Description
Type Choose one of following field types:
« Date
« Double
« Integer
« Long
o String

Enumeration Definition Area

This area enables you to create a list from a predefined list of values (similar to List), with capabilities such as
assigning a color for every value.

To access  Select Enumeration in the Create List/Enumeration Definition dialog box.

Important Enumerations are designed to be used as severity value lists by states. You can use
information Enumerations for lists that require key values.

Note:
« If an existing enumeration definition is designated as a default value fora CIT
attribute, you cannot change its value.

« If you change the value of an existing enumeration definition, all Cl instances of that
CIT that include attributes with the selected value, are reset to the default value for
that attribute.

See also "How to Create an Enumeration Definition — Workflow" on page 326

User interface elements are described below:

ul
Element
(A-Z) Description

Add. Adds an Enumeration definition.

E Remove. Deletes the selected Enumeration definition.

it

Color Select a color that indicates the severity level.

Note: Gray is only enabled when you create an Enumeration of the type Admin.
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ul
Element
(A-2) Description

Key Type a number to create an enumeration that describes a severity list for a category.

Assign key values according to the following rules:

« Thelist of key values must always begin with zero (0). (Zero represents the Normal state.)
Otherwise, it does not appear in the State Manager (for details, see State Manager in the
RTSM Administration Guide).

« The list must always be numbered consecutively.
For an example of an Enumeration definition, see "How to Create an Enumeration Definition —
Workflow" on page 326.

Value Type a value, either a string or a number, for example, Red or my value. The value appears in
the tooltip for the Cl in IT Universe Manager.

Export Selected CITs to Excel Dialog Box

This dialog box enables you export selected Cl types to an Excel report.

To access In the CI Type Manager, click the Export Class Model £l button and select Export

Selected CITs to Excel.

Important You can select a CIT and a relationship to serve as the root Cl type and root relationship for
information ' the report. If you do not select a CIT or relationship, the default values are used. The root
CIT and root relationship are independent of each other.

The report displays the root CIT and all its descendant CITs. The report contains the
following pages:

o CIT Hierarchy. Displays the CITs under the root CIT in tree format with links to their
attributes.

« Relationship Hierarchy. Displays the relationships under the root relationship in tree
format with links to their attributes.

« CIT Attributes. Displays the name, type, description and display level for the CIT
attributes of each CIT under the root CIT.

« Relationship Attributes. Displays the name, type, description and display level for the
relationship attributes of each relationship under the root relationship.

« Valid Relationships. Displays all the valid relationships for each CIT under the root
CIT.

« Enumerations. Displays all the enumeration definitions from the System Type Manager.
(Not dependent on the root CIT or root relationship.)

« Lists. Displays all the list definitions from the System Type Manager. (Not dependent on
the root CIT or root relationship.)

You can select the pages you want to display in the report.
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See also « "Cl Types Overview" on page 319
« "View Descriptions for Cl Types and Relationships" on page 327
« "Universal Data Model (UDM) Overview" on page 382

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

(A-Z) Description

Root Click the ellipsis IZI button to select a CIT to serve as the root Cl type. If you do not select

Cl Type a CIT, the default root Cl type used . To change the default value, edit the Object root
setting in Infrastructure Settings Manager.

Root Click the ellipsis ez button to select a relationship to serve as the root relationship. If you

Relationship o not select a relationship, the default root relationship used. To change the default value,
edit the Link root setting in Infrastructure Settings Manager.

Select pages Select the pages to display in the report (select the check boxes for all the required pages).
to display The following options are available:

o CIT Worksheets. Includes the CIT Hierarchy and the CIT Attributes worksheets.

« Relationship Worksheets. Includes the Relationship Hierarchy and Relationship
Attributes worksheets.

« Valid Relationships Worksheet. Includes the Valid Relationships worksheet.
« Type Definition Worksheets. Includes the Enumerations and Lists worksheets.

Export Selected CITs to PDF Dialog Box

This dialog box enables you export selected Cl types to a PDF report.

T —
0 access In the CI Type Manager, click the Export Class Model |i| button and select Export
Selected CITs to PDF.
Important The output of this dialog box is the UCMDB CI Types and Relationships Information
information PDF, describing the Universal Data Model.
See also o "Cl Types Overview" on page 319

« "View Descriptions for Cl Types and Relationships" on page 327
o "Universal Data Model (UDM) Overview" on page 382

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
All Data Select to display all the information on the selected CITs.

Changes Only  Select to display only the changes in the selected CITs from the previous data model.
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Ul Element (A-

Z) Description

CITs Click the ellipsis |Z| button to select CITs to export.

Filter Select to filter the attributes in the report by qualifiers. Enter the required qualifiers in the
attributes by box. The report displays only the attributes with the selected qualifiers.

qualifiers

Relationships  Cjick the ellipsis | button to select relationships to export.

Show Select the scope of the selected CITs and relationships:
Properties « UDM. Includes CITs and relationships from the UDM.

« CMS. Includes only CITs and relationships used in the CMS
Show Select to include qualifier information in the exported report.
Qualifiers
Show Select to include relationship information in the exported report.

Relationships

Show Valid
Links

Select to include valid link information in the exported report. The valid link section
displays all the valid relationships for the selected CITs.

System Type Manager Dialog Box

This dialog box enables you to display the attribute types you defined in the Create List/Enumeration
Definition dialog box.

To access Inthe CI Type Manager, click the Cl Types menu and select System Type Manager.

Relevant tasks .« "How to Create List and Enumeration Definitions" on page 325

« "How to Create an Enumeration Definition — Workflow" on page 326

See also o "Cl Types Overview" on page 319

« "System Type Manager" on page 322

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-
Z) Description
=k Add. Enables you to create a predefined list whose values define an attribute type. You

can create a definition for the following attribute types:

o List definition.
« Enumeration definition.

For a description of these attribute types, see "Create/Update List/Enumeration
Definition Dialog Box" on page 348.
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Ul Element (A-

Z) Description

|§| Edit. Enables you to edit an existing definition. For details, see "Create/Update

o List/Enumeration Definition Dialog Box" on page 348.

|§| Delete. Deletes an existing definition. Select the system type definition you want to

delete and click the Delete button.

<System Type  Thelist of Enumeration and List definitions created in the System Type Manager.
Definitions>
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This chapter includes:

® Enrichment Manager OVerview ... L 355
* How to Define an Enrichment Rule — Scenario ... .. ... .. 356
* How to Add Enrichment Query Nodes and Relationships to an Enrichment TQL Query ......_.........._. 360
* How to Define a Tenant Association Rule ... ... 361
* Enrichment Manager User Interface ... ... . .. 362

Enrichment Manager Overview

Enrichment rules can be used for several purposes:

« Adding new Cls and relationships to the RTSM.
« Deleting specific Cl instances from the RTSM.
« Updating the attribute values of specific Cl instances in the RTSM.

Enrichment query nodes and relationships differ from other query nodes and relationships in that they are
conceptual deductions that represent real relationships and Cls that cannot be discovered automatically by
the discovery process.

Enrichment query nodes and relationships are created as part of a TQL query, whose other TQL query nodes
are regular ones, meaning TQL query nodes that already exist in the RTSM. For more information about TQL
queries, see "Topology Query Language" on page 13.

The following example displays a regular query node of type Node linked to a Websphere AS Enrichment
query node by an Enrichment Composition relationship.

Enrichment S
query node od
Yiebsphere AS

) *
Enrichment + Composition
relationship .
Existing query node —

MNode
Containment

!
m

IpAddress
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By placing an Enrichment query node within a TQL query context, the query receives data from its attributes,
and uses it to insert new information into the RTSM.

When you create Enrichment rules, the following results can occur:

« The RTSM is enlarged. Add Enrichment query nodes and relationships that are currently not included in
the RTSM.

The following Enrichment rule example displays a regular Windows query node (that already exists in the
RTSM) connected to a Log File Enrichment query node by an Enrichment Composition relationship.

Enrichment .
query node

Log File

+ Camposition

N

Existing query node a2 |

Windows

This Enrichment rule states that for every Windows Cl instance that is found in the RTSM, a new Log File
Clinstance is created, and linked to the Windows CI with a Composition relationship.

« Specific Cl instances are deleted from the RTSM. For an example, see "How to Define an Enrichment
Rule — Scenario" below.

« The values of Cl attributes are updated. Use an Enrichment rule to update the attributes of a Cl that
already exists in the RTSM.

The following Enrichment rule example illustrates that a regular Windows query node (that already exists in
the RTSM) has been updated with an Enrichment rule.

%J

Windows

This Enrichment rule states that every Windows Cl found in the RTSM is updated with the attribute value
defined in the Enrichment rule.

How to Define an Enrichment Rule - Scenario

This task describes how to create the following Enrichment rule:
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AnIP Address Cl is connected to two identical Node Cls: one Node Cl is identified by its IP address and the
other is identified by its lowest MAC address. For every such instance, delete the Node Cl that is identified by
its IP address from the RTSM.

Note: To reach the required result, you must implement each one of the following steps.

This task includes the following steps:

o "Create an Enrichment TQL Query" below

« "Define the Query Node of Type Node that Is Identified by its Lowest MAC Address" on the next page
« "Define the Query Node of Type Node that is Identified by its IP Address" on page 359

« "Define the Enrichment Rule" on page 359

1. Create an Enrichment TQL Query

To create an Enrichment TQL query, you need to define an Enrichment rule and then add the regular TQL
query nodes and relationships that define the query.

Note: You can add Enrichment query nodes and relationships only after at least one regular query
node has been added to the query.

Select Admin > RTSM Administration > Modeling > Enrichment Manager. For details about how to
create an Enrichment TQL query, see "New Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard" on page 369. For details about how to add query nodes and relationships to a
query, see "How to Add Query Nodes and Relationships to a TQL Query" on page 21.

You can add query nodes of a federated CI type to the Enrichment TQL query, but if the actions defined in
the Enrichment rule affect those query nodes, their source is automatically set to UCMDB when you
save the rule. You cannot update or delete a federated query node or a relationship to or from a federated
query node.

Example of an Enrichment TQL Query:

A new Enrichment TQL query called doubleHosts1 (located under the Network folder) is created in
Enrichment Manager.

Rule Name: | doubleHosts? |

Rule Description: Delete incomplete host

Rule iz Active

The doubleHosts1 Enrichment rule is displayed in the Enrichment Rules pane.
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[1-'13'.1 doubleHostz

[1-'13'.1 doubleHost=1

[ Updste_Broadcast_|P

In this Enrichment TQL query, an IP Address query node is linked to two query nodes of type Node
by a Containment relationship. The query results must comply with the direction of the arrows.

Mode_2 Mode
Containtment_2

Containment

il

I[pAddress

Note: A TQL query is subject to certain validation restrictions. For details, see "Troubleshooting
and Limitations — Topology Query Language" on page 77.

2. Define the Query Node of Type Node that Is Identified by its Lowest MAC
Address
At the top of the Enrichment Manager page, select Query mode. In the editing pane, right-click the
required query node of type Node, select Query Node Properties to open the Query Node Properties

dialog box. Then define an attribute condition in the Attribute tab. For details on how to define an attribute
condition, see "Query Node/Relationship Properties Dialog Box" on page 61.

Example of an Attribute Condition Definition that Identifies the Node by its Lowest MAC
Address:

In the Attribute tab, this attribute condition definition identifies the required Node by its lowest MAC
address.
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« Attribute name — Node is Complete
o Operator — Equal

o Value —True

3. Define the Query Node of Type Node that is Identified by its IP Address

At the top of the Enrichment Manager page, select Query mode. In the editing pane, right-click the
required query node of type Node, and select Query Node Properties to open the Query Node
Properties dialog box. Then define two attribute conditions in the Attribute tab. For details on how to
define an attribute condition, see "Query Node/Relationship Properties Dialog Box" on page 61.

Example of an Attribute Condition that Enables a Node to Be Identified by its IP Address:

This attribute condition is the first attribute condition you need to define in the Attribute tab to enable
the query node of type node to be identified by its IP Address.

Attribute name — Node is Complete
Operator — Equal
Value — False

This is the second attribute condition you need to define in the Attribute tab to enable the query node
of type node to be identified by its IP address.

Attribute name — Node is Complete
Operator — Is null
Value — Value cannot be changed

4. Define the Enrichment Rule

Define the Enrichment rule that deletes all instances of the query node of type Node that are identified by
their IP addresses. From the toolbar, select Enrichment mode. In the Enrichment Rules pane, select the
doubleHosts1 Enrichment rule. Then right-click the query node of type Node that is identified by its IP
address and select Delete Relationship/Query Node Item.

Example of a Query Node of Type Node Containing a Removed Indicator:

The query node of type Node now has a removed indicator to denote that all node instances that
have identical attribute and cardinality settings are removed from the RTSM. The Enrichment query
now looks like this.
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How to Add Enrichment Query Nodes and
Relationships to an Enrichment TQL Query

This section describes how to add Enrichment query nodes and relationships to an Enrichment TQL query in
Enrichment Manager.

To add Enrichment query nodes and relationships to a TQL query:

1. From the tree in the Enrichment Rules pane, select the Enrichment rule to which you want to add
Enrichment query nodes and relationships or create a new one. For details, see "New Enrichment
Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard" on page 369.

2. From the Query/Enrichment drop-down at the top of the page, select Enrichment Mode.

Enrichment Mode | bl
Query Mode
Enrichment Mode

3. From the tree displayed in the Cl Type Selector, click and drag the query nodes you want to function as
an Enrichment query node on to the editing pane. These are the TQL query nodes that are included in the

query. Added Enrichment query nodes are displayed by an added EI indicator.

Note: You can add more than one Enrichment query node to a rule.

4. Link the Enrichment query node to an existing TQL query node or query nodes, to provide the Enrichment
query node with the needed context for its operation.

The following are the Enrichment rule validations:

« You must link the new Enrichment query node to at least one of the existing TQL query nodes in the
rule.

« Enrichment query nodes can only be linked to one another with an Enrichment relationship.

« If the new Enrichment query node must be contained (according to its CIT definition) in another query
node, you must use the Composition relationship to connect this Enrichment query node to an
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existing TQL query node.
« You cannot link an Enrichment query node to a TQL query node that is hidden.

5. To add a relationship between two query nodes, do one of the following:

« Select the required query nodes by holding the CTRL key and clicking the TQL query nodes, right-
click and select Add Relationship.

« Click the Create Relationship n button and draw a line between the required query nodes.

Added Enrichment relationships are displayed by an added EI indicator.

The Add Relationship dialog box opens. For details, see "Add/Edit Relationship Dialog Box" on page
45,

6. Click OK. The selected query nodes are linked by the relationship you have selected.

How to Define a Tenant Association Rule

The following task describes how to define a Tenant Association rule.

Note: This task is only relevant when multi-tenancy is enabled.

1. Run the New Tenant Association Rule Wizard

In Enrichment Manager, click the small arrow next to the New Enrichment Rule |_| button and select
New Tenant Association Rule. Enter the general attributes and base query information on the wizard
pages. For details, see "New Tenant Association Rule/Tenant Association Rule Properties/Save As
Tenant Association Rule Wizard" on page 372.

Note: Make sure to select the Rule is Active check box on the Rule General Attributes page of the
wizard to activate the rule.

2. Build the Rule Query

If you are basing your Tenant Association rule on a new query, build the query by dragging the required
CITs onto the canvas and inserting the required relationships.

3. Update the Owner Tenant of a Selected Query Node

Right-click the query node to be updated by the Tenant Association rule and select Update Owner
Tenant. The Update Owner Tenant dialog box opens. Select the method by which to update the owner
tenant (By value or By attribute) and select the required parameters for that option. Click OK. For
details, see "Update Owner Tenant Dialog Box" on page 379.

Note: You can update the owner tenant of more than one query node in the rule.
4. Update the Consumer Tenants of a Selected Query Node

Right-click the query node to be updated by the Tenant Association rule and select Update Consumer
Tenants. The Update Consumer Tenants dialog box opens. Select the method by which to update the
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consumer tenants (By value or By attribute) and select the required parameters for that option. Click
OK. For details, see "Update Consumer Tenants Dialog Box" on page 378.

Note:

« You can update the consumer tenants of more than one query node in the rule.

« You can update both the owner tenant and the consumer tenants of the same query node in a
single Tenant Association rule.

5. Save the Rule

Click Save || to save the Tenant Association rule. The rule runs according to the frequency defined by
its priority.

Enrichment Manager User Interface

This section includes (in alphabetical order):

® Enrichment Manager Page ... . 362
* New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard .................... 369
®* New Tenant Association Rule/Tenant Association Rule Properties/Save As Tenant Association Rule

I Zard 372
* Query Node/Relationship Definition Dialog Box ... ... ... 375
* Query Node Definition — Advanced Attribute Dialog Box ........ . ... ... ... ... 377
® Update Consumer Tenants Dialog BOX ... .. . 378
® Update Owner Tenant Dialog BoX ... ... L 379

Enrichment Manager Page

This page enables you to define Enrichment rules. These rules, which are based on a specific TQL query, can
be used for several purposes, including:

« Adding new Cls and relationships to the RTSM.
« Deleting specific Cl instances from the RTSM.
« Updating the attribute values of specific Cl instances in the RTSM.

To access  Select Admin > RTSM Administration > Modeling > Enrichment Manager.

Important Enrichment Manager has two modes in which you can work. Always check the
information = Enrichment/Query mode list on the toolbar to verify the currently selected mode.

Relevant "How to Define an Enrichment Rule — Scenario" on page 356

tasks "How to Define a Tenant Association Rule" on the previous page

See also « "Enrichment Manager Overview" on page 355

« "Enrichment Manager User Interface" above
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Enrichment Rules Pane
This area displays a hierarchical tree structure of predefined folders and Enrichment rules. Each Enrichment
rule is associated with a TQL query.

Important You can create your own Enrichment rule, or work with the out-of-the-box (factory)
information = Enrichment rules provided with your HPE Application Performance Management
installation.

The default folders are provided for the out-of-the-box queries. You can modify these folders,
or add additional folders according to your organization's requirements.

You can drag and drop Enrichment rules or folders to move them from one folder to another.

User interface elements are described below:

Ul Element
(A-2) Description
& New Folder. Creates a new folder.
New. Creates an Enrichment rule. Opens the New Enrichment Rule wizard.
Note: In a multi-tenancy environment, click the small arrow to the right of the button to
display the options. New Enrichment Rule opens the New Enrichment Rule wizard.
New Tenant Association Rule opens the New Tenant Association Rule wizard.
5 Delete. Deletes the selected folder or Enrichment rule.
'S Refresh. Refreshes the data content of the hierarchical tree structure that may have been
modified by other users.
] Save. Saves the Enrichment rule to the RTSM. (Enabled only when an Enrichment rule is
created or when changes are made to an existing one.)
Fi'i:n" Properties. Opens the New Enrichment Rule/Properties wizard. Enables you to change
the description and the activation state of the Enrichment rule.
Preview. Generates a preview of the results of the selected Enrichment rule.
Note: This button is not available when multi-tenancy is enabled.
= Represents a folder.
121 Represents an Enrichment rule.
& Represents a Tenant Association rule.

Note: This icon is only relevant when multi-tenancy is enabled.
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Ul Element
(A-Z) Description

<Enrichment Displays the existing Enrichment rules in tree format.

Rule tree>
Note: Only Enrichment rules appear in the tree. TQL queries of type Enrichment

(created in the Modeling Studio) do not appear in the tree.

The following elements are available by right-clicking a folder or Enrichment rule:

Ul Element
(A-Z) Description
Delete Deletes the selected folder or Enrichment rule.

Export To Displays a standard Save As dialog box, enabling you to save the Enrichment rule as an
XML XML script. This option can be used to move an Enrichment rule from one workstation to
another, provided the related TQL query is also relocated.

Import Imports XML files that contain saved Enrichment queries to the Enrichment Manager.
From XML

New Creates an Enrichment rule. Opens the New Enrichment Rule wizard.

Enrichment

Rule

New Folder Creates a new folder.

New Tenant Creates a Tenant Association rule. Opens the New Tenant Association Rule wizard.
Association
Rule

Preview Generates a preview of the results of the selected Enrichment rule.

Properties  Opens the New Enrichment Rule/Properties wizard. Enables you to change the description
and the activation state of the rule.

Rename Renames the folder.
Folder
Save (Enabled only when a new Enrichment query is created or when changes are made to an

existing one.) Saves the Enrichment rule to the RTSM.

Save As Displays the Save As Enrichment Rule wizard, enabling you to define a new name and
description for a query. This option can be used for creating a new Enrichment rule based on
an existing one.

Editing Pane

This area enables you to create and define Enrichment query nodes and relationships.
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Important .
information

When you select a folder in the Enrichment Rules pane, the editing pane is empty.

« When you select an Enrichment rule in the Enrichment Rules pane, the editing pane

displays the selected rule, which consists of TQL query nodes that are defined in the
TQL query and the relationships between them, and the Enrichment query nodes and
relationships that are created and added to the rule.

The Enrichment Manager has two modes in which you can work: Enrichment mode and
Query mode.

The mode in which you are working determines the options that appear in the shortcut
menu. For details, see the editing pane description below.

You can calculate the number of instances that were created as aresult of an
Enrichment rule and remove the instances created from an Enrichment rule from the
RTSM. For details, see "Additions Count" on page 140 and "Remove Enrichment
Results" on page 145.

Relevant "How to Define an Enrichment Rule — Scenario" on page 356
tasks
See also For details on how to create a TQL query, see "How to Add Query Nodes and Relationships

to a TQL Query" on page 21.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)

[+]
=

Description

Indicates an added Enrichment query node or relationship.

Indicates a query node or relationship that has been deleted from the RTSM.

Indicates an updated query node or relationship.

Enrichment Made | = The Enrichment Manager has two modes in which you can work: Enrichment

Guery Mode
Enrichment Mode

mode and Query mode.

Working in:

Query and Enrichment + Query mode enables you to define regular (non-Enrichment) relationships

mode

<Main Menu>
<Query Node>

<Relationship>

and query nodes and add them to the TQL query you defined.

« Enrichment mode enables you to define Enrichment relationships and
query nodes and add them to the TQL query you defined.

For details, see "Main Menu" on page 136.
A component from which TQL queries are built.

The entity that defines the relationship between two query nodes.

<Shortcut menu> For details, see "Shortcut Menu Options" on page 28.
options
<Toolbar> For details, see "Toolbar Options" on page 139.
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Ul Element (A-Z) Description

<Tooltips> Hold the cursor over a query node or relationship to view its tooltip.
The tooltips contain the following information:

« Element name. The name of the query node.

o CI Type. The CIT of the query node as defined in the Cl Type Manager. For
details, see "C| Type Manager" on page 319.

« Definitions of the selected query nodes and relationships. The attribute
conditions, as described in "Query Node/Relationship Properties Dialog
Box" on page 61.

Cl Type Selector

This area displays a hierarchical tree structure of the Cl Types found in the RTSM.

Important The CI Type Selector is part of Enrichment Manager, Impact Analysis Manager, and Trigger
information TQL Editor.

To create or modify a TQL query, click and drag query nodes to the Editing pane and define
the relationship between them. Your changes are saved to the RTSM. For details, see "How
to Add Query Nodes and Relationships to a TQL Query" on page 21.

Note: The number of instances of each CIT in the RTSM is displayed to the right of
each CIT.

Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20

« "How to Create a Pattern View" on page 232

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements (A-Z) Description

o Add CI Type to Map. Moves the selected Cl type to the Editing pane.
|§| Refresh. Refreshes the Cl type tree.

|E| Search. Searches for the Cl type entered.

|E| Expand All. Expands all subtrees within the Cl type tree.

|E| Collapse All. Collapses the subtrees within the ClI type tree.
<Search window> Enter the name or part of a name of a Cl type for which to search.

Shortcut Menu Options

HPE Application Performance Management (9.40) Page 366 of 393



Modeling Guide
Chapter 12: Enrichment Manager

The CI Type Selector includes the following elements (listed alphabetically) available by right-clicking a Cl
Type:

Menu Item Description

Add CI Type Select to add the selected Cl type to the Editing pane.

to Map

Go to Cl Type  Takes you directly to the selected Cl type in CIT Manager.

Definition

Show CIT Opens the CIT Instances window, which displays all instances of the selected CIT. For
Instances details, see "Cl Instances Dialog Box" on page 55.

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected query node and relationship.

Important = The Advanced pane appears in the lower part of the window in the following managers and
information = user interfaces: Modeling Studio, Impact Analysis Manager, Enrichment Manager, the Input
Query Editor and Trigger Query Editorin DFM.

A small green indicator #* appears next to the tabs that contain data.

Relevant « "How to Define an Impact Rule — Workflow" on page 304
tasks « "How to Define an Enrichment Rule — Scenario" on page 356
« "How to Define a TQL Query" on page 20
« "How to Create a Pattern View" on page 232
« "How to Create a Template" on page 233

» "How to Create a Perspective" on page 234

User interface elements are described below:

ul Description
Elements
(A-Z)
4k If the window is not wide enough to display all the tabs, use the left and right arrows to move

to the required tab.

= Click Show List to display a list of the available tabs for the current module. You can select
a tab from the list.

Attributes Displays the attribute conditions defined for the query node or the relationship. For details,
see "Attribute Tab" on page 62.

Cardinality Cardinality defines how many query nodes you expect to have at the other end of a
relationship. For example, in a relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes that are connected to between
one and three IP Addresses. For details, see "Cardinality Tab" on page 64.
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] Description

Elements

(A-Z)

Data Displays the data sources set for the selected query node.
Sources

Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

« CI Type/Element Type. The CIT of the selected query node/relationship.

« Element Name. The name of the query node or relationship. This appears only in the
Modeling Studio.

« Show in query results. A green check indicates that the selected query
node/relationship is visible in the topology map. A red mark indicates that it is not visible.
In the Modeling Studio, this is indicated by the word Yes or No.

« Include subtypes. A green check indicates that both the selected Cl and its children are
displayed in the topology map. A red mark indicates that only the selected Cl appears.
This item does not appear in the Modeling Studio.

Edit Click Edit to open the relevant dialog box for the selected tab.
Element Displays the attributes selection for the selected query node or relationship. It lists the
Layout attributes selected to be included in the query results (when Specific Attributes is selected

as the attributes condition). It also lists the excluded attributes and any selected qualifiers
for attributes. For details, see "Element Layout Tab" on page 69.

Note: This tab appears only in the Modeling Studio.

Element Displays the subtype conditions defined for the query node or relationship. For details, see
Type "Element Type Tab" on page 67.

Note: This tab appears only in the Modeling Studio.

Enrichment Displays the Enrichment rule defined for the selected query node or relationship. If the

Rules Enrichment rule is used to update the attributes of a Cl, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if required. For details, see "Query
Node/Relationship Definition Dialog Box" on page 375.

Note: This tab appears only in Enrichment Manager.

Impacted Indicates which query node is impacted by the changes that occur in the selected trigger
Query query node. If required, you can click Edit to open and modify the Impacted Query Nodes
Nodes dialog box. For details, see "Impacted Query Nodes Dialog Box" on page 313.

Note: This tab appears only in Impact Analysis Manager.
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] Description
Elements
(A-Z)

Qualifiers Displays the qualifier conditions defined for the query node or the relationship. For details,
see "Qualifier Tab" on page 71.

Note: This tab appears only in Enrichment Manager and Impact Analysis Manager.

Selected Displays the element instances that are used to define what should be included in the TQL
Identities query results. For details, see "ldentity Tab" on page 72.

New Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard

This wizard enables you to create or modify an Enrichment rule.

To access « Tocreate a new Enrichment rule, right-click anywhere in the Enrichment Rules pane and

click New Enrichment Rule or click the New Enrichment Rule|;| button.

« Tomodify an existing Enrichment rule, right-click an Enrichment rule in the Enrichment
Rules pane and select Properties.

« Tocreate a new Enrichment rule based on an existing query, right-click an Enrichment
rule in the Enrichment Rules pane and select Save As.

Important « When creating a new Enrichment rule, bear in mind that the application does not allow
information you to make any changes in the TQL query that are necessary for the rule. These
changes include the following:

« Deleting, from the Enrichment TQL query, the query nodes or relationships connected
to the Enrichment query node, causing a query node to become unattached to any
relationship.

« You cannot change the cardinality definition to 0 (not required) of a query node or
relationship that is used in an Enrichment rule. For details on relationship cardinality,
see "Query Node/Relationship Properties Dialog Box" on page 61.

« AnEnrichment TQL query that serves as the basis for Enrichment rules, is subject to
certain validation restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 77. If the TQL query is not valid, you cannot save it.

Relevant "How to Define an Enrichment Rule — Scenario" on page 356

tasks

Wizard The New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard
map contains:

Rule General Attributes Page > Rule Base Query Page
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See also « "Enrichment Manager Overview" on page 355
« "Enrichment Manager User Interface" on page 362

« "Topology Query Language" on page 13

Rule General Attributes Page
This wizard page enables you to enter a unique name and description for the Enrichment rule.

Important « AnEnrichment TQL query that serves as the basis for Enrichment rules is subject to
information certain validation restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 77. If the TQL query is not valid, you cannot save it.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
Rule Wizard" on the previous page.

« By default, this wizard is set to display a Welcome page. You can choose not to display
this page by changing the user preferences. For details, see "User Preferences Dialog
Box" on page 77.

Wizard The New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard
map contains:

Rule General Attributes Page > Rule Base Query Page
See also "Topology Query Language" on page 13

User interface elements are described below:

Ul Element

(A-Z) Description

Rule (Optional) Enter a description of the rule.

Description

Rule is (Optional) Select this option to activate the rule in the system as soon as it is saved.
Active

Default: Not selected.

Note:

« If an active Enrichment rule is deactivated (by clearing the Rule is Active check
box), all changes that occur in the RTSM relating to the rule are deleted from the
system. When you deactivate an Enrichment rule, a red X appears next to the
Enrichment rule in the Enrichment Rules pane.

« Toreactivate the rule, right-click the rule in the Enrichment Rules pane and select
Properties. In the General Attributes page, select Rule is Active.

Rule Name @ Enter a unique name for the Enrichment rule. The rule name cannot contain any of the
following characters: \/ : " <>| % ?. The final character cannot be a blank space.

Note: If the rule name is either empty, contains a name used by another Enrichment
rule, or uses invalid characters, the Next and Finish buttons are disabled.

HPE Application Performance Management (9.40) Page 370 of 393



Modeling Guide
Chapter 12: Enrichment Manager

Ul Element

(A-2) Description

Update When this option is selected, the Enrichment rule updates the Last Access Time property of
Last the Cls it affects. When the check box is cleared, the Enrichment rule does not update the
Access attribute and therefore does not perform touch on those Cls. This ensures that the

Time Enrichment rule does not affect the aging of the relevant Cls.

Note:

« For out-of-the-box Enrichment rules, this option is selected by default.

« Fornew Cls created by the Enrichment rule, the Last Access Time property is
updated even when the check box is cleared.

Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Enrichment rule is based.

Important « An Enrichment TQL query that serves as the basis for Enrichment rules, is subject to
information certain validation restrictions. For details, "Troubleshooting and Limitations — Topology
Query Language" on page 77. If the TQL query is not valid, you cannot save it.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
Rule Wizard" on page 369.

« By default, this wizard is set to display a Completion page after clicking Next on this
page. You can choose not to display the Completion page by changing the user
preferences. For details, see "User Preferences Dialog Box" on page 77.

Wizard The New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule Wizard
map contains:

Rule General Attributes Page > Rule Base Query Page
See also "Topology Query Language" on page 13
User interface elements are described below:
Ul Element (A-Z) Description

Base the Select this check box if you want to base the Enrichment rule on a new TQL query.
Enrichment rule The TQL results are based on the attributes defined for the new TQL query.
on a new query

Base the Select this check box if you want to base the Enrichment rule on an existing TQL
Enrichment rule query. Select the required Enrichment TQL query from the drop-down list.

on an existing

query Note: You cannot base an Enrichment rule on a TQL query that contains

complex class conditions.

Base Query (Optional) Enter a description of the TQL query.
Description
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Ul Element (A-Z) Description

Base Query Name  Enter a unique name for the Enrichment TQL query.

If you selected the Base the Enrichment rule on an existing TQL option, select
the Enrichment TQL query on which you want to base the rule.

Base Query Select a priority level for the new TQL query (Low, Medium, High, or Express). This
Priority setting determines how often the query is rerun automatically by the system to
include updated information from the RTSM.

Save a new query | Select to save a new TQL query based on your Enrichment rule definition.

based on the
current definition Note: This field only appears in the Save As Enrichment Rule wizard.

New Tenant Association Rule/Tenant Association Rule
Properties/Save As Tenant Association Rule Wizard

This wizard enables you to create or modify a Tenant Association rule.

To access « Tocreate a new Tenant Association rule, right-click anywhere in the Enrichment Rules
pane and click New Tenant Association Rule or click the down arrow next to the New
|_| button and select New Tenant Association Rule.

« To modify an existing Tenant Association rule, right-click a Tenant Association rule in the
Enrichment Rules pane and select Properties.

« Tocreate anew Tenant Association rule based on an existing query, right-click a Tenant
Association rule in the Enrichment Rules pane and select Save As.

!mportarft & denotes an active Tenant Association rule.
information
)
"t denotes an inactive Tenant Association rule.
Note:
« This wizard is only available when multi-tenancy is enabled.
« A TQL query that serves as the basis for Tenant Association rules is subject to
certain validation restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 77. If the TQL query is not valid, you cannot
save it.
Relevant « "How to Define a Tenant Association Rule" on page 361
tasks « Multi-Tenancy Workflow in the HPE Universal CMDB Administration Guide
Wizard The New Tenant Association Rule/Tenant Association Rule Properties/Save As Tenant
map Association Rule Wizard contains:

Rule General Attributes Page > Rule Base Query Page
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See also « "Topology Query Language" on page 13
« Multi-Tenancy Overview in the HPE Universal CMDB Administration Guide
« Tenant Association Rules in the HPE Universal CMDB Administration Guide

Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the Tenant Association rule.

Important « AnEnrichment TQL query that serves as the basis for Enrichment rules is subject to
information certain validation restrictions. For details, see "Troubleshooting and Limitations —
Topology Query Language" on page 77. If the TQL query is not valid, you cannot save it.

« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
Rule Wizard" on page 369.

« By default, this wizard is set to display a Welcome page. You can choose not to display
this page by changing the user preferences. For details, see "User Preferences Dialog
Box" on page 77.

Wizard The New Tenant Association Rule/Tenant Association Rule Properties/Save As Tenant
map Association Rule Wizard contains:

Rule General Attributes Page > Rule Base Query Page
See also "Topology Query Language" on page 13

User interface elements are described below:

Ul Element

(A-Z) Description

Rule (Optional) Enter a description of the rule.

Description

Rule is (Optional) Select this option to activate the rule in the system as soon as it is saved.
Active

Default: Not selected.

Note:

« If an active Tenant Association rule is deactivated (by clearing the Rule is Active
check box), all changes that occur in the RTSM relating to the rule are deleted from
the system. When you deactivate a Tenant Association rule, a red X appears next to
the rule in the Enrichment Rules pane.

« Toreactivate the rule, right-click the rule in the Enrichment Rules pane and select
Properties. On the General Attributes page, select Rule is Active.

Rule Name Enter a unique name for the Tenant Association rule. The rule name cannot contain any of
the following characters: \/: " < >| % ?. The final character cannot be a blank space.

Note: If the rule name is either empty, contains a name used by another Tenant
Association rule, or uses invalid characters, the Next and Finish buttons are disabled.
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Ul Element

(A-2) Description

Update When this option is selected, the Tenant Association rule updates the Last Access Time
Last property of the Cls it affects. When the check box is cleared, the Tenant Association rule
Access does not update the attribute and therefore does not perform touch on those Cls. This
Time ensures that the Tenant Association rule does not affect the aging of the relevant Cls.

Note:

« For out-of-the-box Tenant Association rules, this option is selected by default.

« Fornew Cls created by the Tenant Association rule, the Last Access Time property
is updated even when the check box is cleared.

Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on which the Tenant Association rule

is based.
Important « An Enrichment TQL query that serves as the basis for Enrichment rules, is subject to
information certain validation restrictions. For details, "Troubleshooting and Limitations — Topology
Query Language" on page 77. If the TQL query is not valid, you cannot save it.
« Forimportant information on the effects of making changes to the TQL query after
creating it, see "New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
Rule Wizard" on page 369.
« By default, this wizard is set to display a Completion page after clicking Next on this
page. You can choose not to display the Completion page by changing the user
preferences. For details, see "User Preferences Dialog Box" on page 77.
Wizard The New Tenant Association Rule/Tenant Association Rule Properties/Save As Tenant
map Association Rule Wizard contains:
Rule General Attributes Page > Rule Base Query Page
See also "Topology Query Language" on page 13

User interface elements are described below:

Ul Element (A-Z) Description

Base the Tenant Select this check box if you want to base the Tenant Association rule on a new
Association rule on | TQL query. The TQL results are based on the attributes defined for the new TQL
a new query query.

Base the Tenant Select this check box if you want to base the Tenant Association rule on an

Association rule on | existing TQL query. Select the required TQL query from the drop-down list.
an existing query

Base Query (Optional) Enter a description of the TQL query.
Description
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Ul Element (A-Z) Description

Base Query Name Enter a unique name for the TQL query.

If you selected the Base the Tenant Association rule on an existing TQL
option, select the TQL query on which you want to base the rule.

Base Query Priority | Select a priority level for the new TQL query (Low, Medium, High, or Express).
This setting determines how often the query is rerun automatically by the system
to include updated information from the RTSM.

Save a new query Select to save a new TQL query based on your Tenant Association rule definition.
based on the current
definition Note: This field only appears in the Save As Tenant Association Rule wizard.

Query Node/Relationship Definition Dialog Box

This dialog box displays the attributes of the selected query node/relationship. The key attributes and the
required attributes of the selected query node appear in bold.

To access | Right-click a query node or relationship when in Enrichment mode (select Enrichment from
the Query/Enrichment drop-down list at the top of the Enrichment Manager page) and
select Update Relationship/Query Node.

Important Use an Enrichment rule to update the value of Cl attributes in the RTSM, or to add data to
information = attributes that currently do not have values. You can use this option, for example, for
simultaneously adding a note to all Cl instances.

You must fill in the value of the key attributes and the required attributes of the Enrichment
query node. The method you use to define these values determines the number of instances
created.

If you enter a dynamic value, you can create numerous instances. For example, entering the
dynamic value of a host_key for the CIT Node or an |IP address attribute for the CIT

IpAddress.

Relevant "How to Define an Enrichment Rule — Scenario" on page 356

tasks

See also « "Enrichment Manager Overview" on page 355

« "Enrichment Manager User Interface" on page 362

Attributes Area
User interface elements are described below :

ul

Element

(A-2) Description

Name The attribute name.
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ul
Element
(A-2) Description

Type The field type of the selected attribute.

Value The value as defined in one of the following:

« TheValue box in the Set Attributes area.
« The combination of the values in the By Attribute boxes in the Set Attributes area.

« The Value column if you selected Simple in the Type column in the Query Node Definition -
Advanced Attribute dialog box.

« The combination of the values in the Value column and the column to the right of the Value
column if you selected By Attribute in the Type column in the Query Node Definition -
Advanced Attribute dialog box.

Set Attributes Area

User interface elements are described below :

Ul Element
(A-Z) Description

Advanced | Define an attribute value using the Query Node Definition - Advanced Attribute dialog box.

==/, Advanced. Opens the Advanced Attribute dialog box.

Q‘ Clear. Clears the Value column in the Attributes area.

Note: This element is only active when an attribute of the field type string is selected.

By Define an attribute using attributes from other query nodes in the TQL query.

Attribute « Inthe box to the left, select the required query node.

« Inthe box to the right, select the query node’s required attribute.

[El]l Apply. Adds the selected attribute definition to the Value column in the Attributes area.

Q’ Clear. Clears the Value column in the Attributes area.

RegExp (Appears only when you select an attribute of the field type string.) Enter the group number

Group only if you are adding a regular expression using regular expression syntax. This is the part of
the regular expression pattern to focus on when creating the attribute. A set of parentheses (
) constitutes a group.

Regular (Appears only when you select an attribute of the field type string.) Add a regular expression
Expression using regular expression syntax. Enter the regular expression pattern.

For examples of how to use regular expression syntax, see "Regular Expression Examples”
on page 392.
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Ul Element
(A-Z) Description

Value (in Define a constant value. Enter the required value in the Value box or select a value from the
the Set Value list.

Attributes = -

area) |@| Apply. Adds the value definition to the Value column in the Attributes area.

|Q| Clear. Clears the Value column in the Attributes area.

Query Node Definition - Advanced Attribute Dialog Box

This dialog box enables you to define query node and relationship attributes of the type String using simple or
complex expressions. You can also create complex expressions using regular expression format.

To Select an attribute of the type string in the Query Node Definition dialog box. Select
access Advanced and then click the Advanced button.

Relevant | "How to Define an Enrichment Rule — Scenario" on page 356
tasks

See also « "Enrichment Manager Overview" on page 355

« "Enrichment Manager User Interface" on page 362

User interface elements are described below :

Ul Element

(A-Z) Description

=k Add. Enables you to define an attribute value using simple or complex expressions.
Creates a new entry in the Type column. Click the new entry and select either Simple or
By Attribute. For details, see the description for the Type column below.

E Delete. Deletes the selected attribute value.

|X| Up. Moves a selected row up.

|:| Down. Moves a selected row down.

Advanced (This list is only available if you select By Attribute in the Type column.) Click the entry
Value inside the box and select the required attribute.

Concatenate Use all the attribute values listed in this dialog box.

RegExp (This list is available only if you select By Attribute in the Type column.) Click inside the
Group RegExp Group column, click the (S button, and enter the group number in the Value

for RegExp Group dialog box that opens. This is the part of the regular expression pattern to
focus on when creating the attribute. A set of parentheses () constitutes a group.
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Ul Element
(A-2) Description
Regular (This list is only available if you select By Attribute in the Type column.) Click inside the

Expression Regular Expression column, click the = button, and enter the regular expression
pattern in the Value for Regular Expression dialog box that opens.

For examples of how to use regular expression syntax, see "Regular Expression
Examples" on page 392.

Type Click the entry inside the Type column and select one of the following options:
« Simple. Define a constant value using a simple expression.
« By Attribute. Define an attribute using attributes from other query nodes in the TQL.
Default is: Simple

Use first Use the first attribute value listed in this dialog box that is not empty.

attribute

with value

Value « Ifyouselect Simple in the Type column, click inside the Value column, click the

(—— button, and enter the required value in the Value for Simple dialog box.

Note: If you define an attribute value using only one Simple expression, the Value
column cannot be empty.

« If you select By Attribute in the Type column, click inside the Value column and select
the required value from the list.

Update Consumer Tenants Dialog Box
This dialog box enables you to define a rule for updating the consumer tenants of a Cl.

To access In Enrichment Manager, select Enrichment Mode. Right-click the required query node in
the Tenant Association rule and select Update Consumer Tenants.

Important This dialog box is only available when multi-tenancy is enabled.

information

Relevant "How to Define a Tenant Association Rule" on page 361

tasks

See also « Multi-Tenancy Overview in the HPE Universal CMDB Administration Guide.

o Tenant Association Rules in the HPE Universal CMDB Administration Guide
User interface elements are described below:

Ul Element (A-Z) Description

Append selected When this option is selected, the consumer tenants selected are appended to the
value to original original consumer tenants of the updated query node.
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Ul Element (A-Z)

Get attribute value
from

Override original
value

Select nodes

Select tenant

Update consumer
tenants

Description

Select the tenancy attribute of the selected query nodes to apply to the updated
query node. The options are:

« Owner Tenant attribute. Applies the owner tenants of the selected query nodes
as the consumer tenants of the updated query node.

« Consumer Tenants attribute. Applies the consumer tenants of the selected
query nodes as the consumer tenants of the updated query node.

Note: This element is only relevant when By Attribute is selected.

When this option is selected, the consumer tenants selected replace the original
consumer tenants of the updated query node.

Move the selected query nodes from the Available Nodes pane to the Selected
Nodes pane using the arrow buttons.

Note: This element is only relevant when By Attribute is selected.

Move the selected tenants from the Available Tenants pane to the Selected Tenants
Pane using the arrow buttons.

Note: This element is only relevant when By Value is selected.

Select a method for updating the consumer tenants. The available options are:

« By Value. Select tenants directly from the available tenants.

« By Attribute. Select other query nodes in the rule. The updated query node is
assigned the consumer tenants of the selected query nodes.

Update Owner Tenant Dialog Box

This dialog box enables you to define a rule for updating the owner tenant of a Cl.

To access In Enrichment Manager, select Enrichment Mode. Right-click the required query node in
the Tenant Association rule and select Update Owner Tenant.

Important This dialog box is only available when multi-tenancy is enabled.

information

Relevant "How to Define a Tenant Association Rule" on page 361

tasks

See also « Multi-Tenancy Overview in the HPE Universal CMDB Administration Guide.

« Tenant Association Rules in the HPE Universal CMDB Administration Guide

User interface elements are described below:
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Ul Element (A-
Z) Description
Select tenant Select a tenant from the drop-down list.
Note: This element is only relevant when By Value is selected.
Select owner Select a query node from the drop-down list.

tenant from
Note: This element is only relevant when By Attribute is selected.

Update owner Select a method for updating the owner tenant. The available options are:

tenant « By Value. Select a tenant directly from a drop-down list.

« By Attribute. Select another query node in the rule. The updated query node is
assigned the owner tenant of the selected query node.
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Chapter 13: RTSM Data Model Introduction

This chapter includes:

® Universal Data Model (UDM) OVEIVIEW . ... ... e 382

Universal Data Model (UDM) Overview

The Universal Data model (UDM), provides the information model that enables HPE Software products to
integrate using a common language. The UDM provides the vocabulary in the form of Cl types and the
relationships between them, and their attributes. This vocabulary and the artifacts derived from it are used to
enable integrations in an enterprise environment, to enable faster design and deployment, and to facilitate
ease of maintenance and integration evolution. The UDM is applied to many management products and
solutions, including HPE Application Performance Management and its integrations.

You can generate the UCMDB CI Types and Relationships Information PDF, which provides information on
specific Cl Types and Relationships in the UDM. For details, see "Export Selected CITs to PDF Dialog Box"
on page 352. You can also access the UCMDB Class Model Reference by selecting Help > UCMDB Class
Model.
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This chapter includes:

® Export to UML Tool — OVerview .l 383
* How to Export the Class Model ... .. 383
* How to Convert XML of a Selected Part of the Class Model ... ... ... . . ... 384
® Exportto UML Tool UserInterface . .......... ... oo 385
¢ Tool Plug-in INpUt il 386

Note: Currently, Altova UModel versions 2008 and 2009 are supported.

Export to UML Tool - Overview
The Export to UML tool enables you to export selected sections of the RTSM class model to a format

compatible with UML tools, and to view the model as a UML diagram.

The input for the tool is the RTSM class model XML file retrieved by the JMX service UCMDB:service=Class
Model Services/
exportClassModelToXmil().

Note: To access the JMX console, enter the following address in your browser: http://<server_
name>:21212/jmx-console, where <server_name> is the name of the machine on which HPE
Application Performance Management is installed.

How to Export the Class Model

This task describes how to use the Export Class Model to UML tool wizard.
This task includes the following steps:

« "Prerequisites" below
e "Runthe UML Tool" below

« "View the Exported File in Altova" on the next page

1. Prerequisites
Set up the tool by extracting the following zip file to any location:
<APM root directory>:\odb\tools\ExportClassModel.zip

2. Run the UML Tool
You use the Export Class Model to UML wizard to choose the CIT and its attributes to be exported to the
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UML tool.

For details on working with the Export to UML wizard, see "Export Class Model to UML Wizard" on the
next page.

3. View the Exported File in Altova
a. InAltova, select File > Import From XMI File.

b. Select the XMl file. The class model entry appears in the Model Tree pane.
c. Right-click the entry and select Show in new diagram > Content. Click OK.

How to Convert XML of a Selected Part of the Class
Model

This task describes how to use the custom plug-in to convert the XML of a selected part of the class model to
the UML tool format.

The plug-in can be either a Java class or an XSLT text file. If you use a Java class, it must implement the
ITransformToUML(ExportToUML.jar) interface; the transformToUML() method receives an XML string as
a parameter and returns a byte array that is written to the output file.

For details on the custom plug-in input, see "Tool Plug-in Input" on page 386.
This task includes the following steps:

« "Activate the Plug-in Using a Java Class" below
« "Activate the Plug-in Using an XSLT Text File" below

Activate the Plug-in Using a Java Class

Add the display name and fully-qualified class name to the config.xml file in the ExportToUML directory, as
follows:

<ConverterToUML>

<Name><display name></Name>

<Class><fully qualified class name></Class>
</ConverterToUML>

Continue with the procedure for exporting the class model. For details, see "How to Export the Class Model"
on the previous page.

Activate the Plug-in Using an XSLT Text File

In this case, XSLT from the specified file is applied to the class model XML and is written to the output file.

Add the display name and full path of the XSLT file to the config.xml file in the ExportToUML directory, as
follows:

<ConverterToUML>
<Name><display name></Name>
<XsltFile><Full path_of the XSLT file></XsltFile>
</ConverterToUML>
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Continue with the procedure for exporting the class model. For details, see "How to Export the Class Model"
on page 383.

Export to UML Tool User Interface

This section includes:

® Export Class Model to UML Wizard ... ... L 385

Export Class Model to UML Wizard

This wizard enables you to choose the CIT and its attributes to be exported to the UML tool.

To access  Browse to the location where you extracted the tool. Right-click ExportClassModel.jar in
the ExportClassModel directory. Select Open With > Java 2 Platform SE binary.

Important By default the tool opens the ClassModel.xml file in the ExportClassModel directory. You
information = open other files through the File > Open Class Model File menu.

Relevant "How to Export the Class Model" on page 383
tasks

Wizard The Export Class Model to UML wizard contains:
map

"Export Class Model to UML Wizard" above > "Select Valid Links" below > "Export
Selected Items" on the next page

See also « "Export to UML Tool — Overview" on page 383

o "Tool Plug-in Input" on the next page
User interface elements are described below:
Ul Element (A-Z) Description
File Displays a list of XML files. Open the file that contains the class model.

Select Attributes Select the attributes to be displayed in the UML tool.

Pane The attributes of the selected CIT are displayed in this pane. The attributes are
colored as follows:
« Attributes inherited from the parent CIT are black.
« Attributes specific to this CIT are dark blue.
Select Cl Types The CITs displayed here are retrieved from the ClassModel.xml file.
Pane

Select the CIT and its sub nodes to be exported to the UML tool.

Use the buttons to select or clear all subindex.

Select Valid Links

This wizard page enables you to select links that can be used between two CITs.
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Important General information about the wizard is available in "Export Class Model to UML
information Wizard" on the previous page.
Wizard map The Export Class Model to UML wizard contains:

Select Valid Links > Export Selected Items

User interface elements are described below:

Ul Element

(A-Z) Description

Removes the filter from the list of CITs.

Filter by Enables you to filter the list of valid links. You can filter the list of CITs and you can sort the

list by CIT or relationship.

Export Selected ltems

This wizard page enables you to export the selected CITs and their attributes to the UML tool.

Important General information about the wizard is available in "Export Class Model to UML
information Wizard" on the previous page.
Wizard map The Export Class Model to UML wizard contains:

Select Valid Links > Export Selected Items

User interface elements are described below:

Ul Element
(A-Z) Description
Export Click to browse to the UML file, in XMI format, to which you want to add the UCMDB CITs

and their attributes.

If there are no valid links for a pair of CITs, a no valid links message is displayed in the
Select Valid Links page.

Tool Plug-in Input

The input for the plug-in is an XML string (selected classes/attributes/valid links) in the following form:

<?xml version="1.0" encoding="IS0-8859-1"?>
<Class-Model>
<Class class-name="hostresource" display-name="Host Resource"
visibility="public">
<Attribute name="isvirtual" display-name="Is Virtual" visibility="public"/>
<Attribute name="city" display-name="City" visibility="public"/>
</Class>
<Class class-name="host_node" display-name="Computer" visibility="public">
<Derived-From class-name="host"/>
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</Class>
<Class class-name="vax" display-name="VAX" visibility="public">
<Attribute name="root_actualdeletionperiod" display-name="Actual Deletion
Period" visibility="public"/>
<Attribute name="data_allow_auto_discovery" display-name="Allow CI Update"
visibility="public"/>
<Derived-From class-name="host_node"/>
</Class>
<Class class-name="host" display-name="Host" visibility="public">
<Attribute name="host_iscomplete" display-name="Host Is Complete"
visibility="public"/>
<Attribute name="host_isroute" display-name="Host Is Route"
visibility="public"/>
<Attribute name="host_hostname" display-name="Host Name"
visibility="public"/>
<Attribute name="host_os" display-name="Host Operating System"
visibility="public"/>
</Class>
<Class class-name="unix" display-name="Unix" visibility="public">
<Derived-From class-name="host_node"/>
</Class>
<Valid-Link ID="host_member_host" display-name="Member" visibility="public">
<Endl class-name="host"/>
<End2 class-name="host"/>
</Valid-Link>
<Valid-Link ID="host_container_f_hostresource" display-name="Container link"
visibility="public">
<End1l class-name="host"/>
<End2 class-name="hostresource"/>
</Valid-Link>
</Class-Model>
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This chapter includes:

¢ Columns User INterface ... ... 389

Columns User Interface

This section includes (in alphabetical order):

¢ Select Columns Dialog BOX .. ... . 389
¢ Sort Column Content Dialog BoX ... il 390

Select Columns Dialog Box

This dialog box enables you to choose the information you are interested in displaying. You can hide a column
or display a hidden column.

To access ) I , ;
Click the Select Columns ™" button. This button appears above every table in a report.

Important The order of the columns in the list in the Visible Columns pane determines the order of the

Information columns displayed in the table. To change the order of table columns, move them to the
required position using the up and down arrow buttons or by dragging a column to a new
location.

The following elements are included:

Ul Element
(A-Z) Description
g 3 Displays a column. Moves the selected column from the Available Columns pane to the
Visible Columns pane.
o Hides a selected column. Moves the selected column from the Visible Columns pane to
the Available Columns pane.
=3 Displays all hidden columns. Moves all the columns from the Available Columns pane
to the Visible Columns pane.
= Hides all columns. Moves all the columns from the Visible Columns pane to the
Available Columns pane.
|F| Moves a selected column up in the list in the Visible Columns pane.
|?| Moves a selected column down in the list in the Visible Columns pane.
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Ul Element

(A-2) Description

Available The columns in this pane do not appear in the table.
Columns

Visible The columns in this pane are visible in the table.
Columns

Sort Column Content Dialog Box

This dialog box enables you to set or change the sort order for the entries displayed in a table.

Toaccess  (ick the Sort Column Content =1 button.

Important « To sort a table by one column:
Information Move the column name from the Available Columns to the Sorted Columns list.
Select the name and decide whether to sort in ascending (upward triangle) or descending
(downward triangle) order by clicking the relevant button.
« To sort a table by more than one column:
Move the column names from the Available Columns to the Sorted Columns list. For
each column, decide whether to sort in ascending or descending order.
« To change the order in which columns are sorted:
Inthe Sorted Columns list, select an entry, and click the Up or Down arrow to change
the order. (Entries higher in the list are sorted before entries lower in the list.) A number is
displayed in the table's column headers.

Note: Only columns that are displayed can be sorted. For details on how to define
which columns are displayed in the table and in which order, see "Select Columns
Dialog Box" on the previous page.

The following elements are included:

ul
Element
(A-2) Description
g Y Moves the selected column from the Available Columns pane to the Sorted Columns
pane. You can double-click the selection to perform the same procedure.
'S Moves the selected column from the Sorted Columns pane to the Available Columns
pane.
= Moves all the columns from the Available Columns pane to the Sorted Columns pane.
= Moves all the columns from the Sorted Columns pane to the Available Columns pane.
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ul
Element
(A-2) Description
¢ fn Moves the selected column up or down in the list to increase or decrease its priority in
establishing the sort order.
B Bk Enables you to sort the column content in ascending or descending order.

In the Sorted Columns pane, select a column name and click the ascending or descending
button.

Available = The columns whose content is not sorted.

Columns

Note: You can select multiple columns.
Sorted The columns whose content is sorted in either ascending or descending order.
Columns

HPE Application Performance Management (9.40) Page 391 of 393



Chapter 16: Regular Expression Examples

This chapter includes:

* Examples of Regular EXpressions ... ... oo 392

Examples of Regular Expressions

« Enter aregular expression to define an IP address (aa.yy.zz.mm):

To: In the First Field Enter: In the Second Field Enter:
Create label by aa (YIS 1
Create label by yy CLDOCLL 2
Create label by zz CL1 LD 2
Create label by mm LI LD 2

« Enter aregular expression to create the label by the first or last letters of the selected attribute:

To: In the First Field Enter: In the Second Field Enter:
Create label by the first letter () 1
Create label by the last letter (")) 2
Create label by the first two letters () 1
Create label by the last two letters (M) 2
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by email. If an email
client is configured on this system, click the link above and an email window opens with the following

information in the subject line:
Feedback on Modeling Guide (Application Performance Management 9.40)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and send
your feedback to docteam@hpe.com.

We appreciate your feedback!
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